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1
Using This Manual

This chapter provides information about this manual.

Contents

• About this Manual on page 1-1

• Related Documentation on page 1-2

• Typographical Conventions on page 1-3

• Contacting Us on page 1-5

About this Manual
This Software Manual introduces the Thermo Scientific™ Qtegra™ 
Intelligent Scientific Data Solution™ (ISDS) Software suite and 
describes the configuration and operation of the iCAP™ 7000 
Plus Series ICP-OES instrument with Qtegra ISDS Software. For 
information about the operating procedures for the iCAP 7000 
Plus Series ICP-OES system, we recommend that you read the 
Operating Manual.

With Qtegra ISDS Software, the Configurator tool is provided to set up 
Configurations and settings specific to your individual systems and 
users. In the Qtegra tool you have access to the creation of Templates 
and LabBooks, can query results, manage your files, look for help. Here 
you define the Template’s settings and create your LabBook for 
measurement.

Who Uses this Guide

This iCAP 7000 Plus Series ICP-OES Software Manual is intended for all 
personnel the need to perform measurements with the iCAP OES mass 
spectrometer.

Scope of this Guide

The iCAP 7000 Plus Series ICP-OES Software Manual includes the 
following chapters:

• Chapter 3: “Configurator” describes the Configurator tool, which 
contains all tools necessary to configure and adjust the Qtegra ISDS 
Software framework for your laboratory.
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• Chapter 4: “Qtegra” describes the principal tool for preparing and 
running measurements. The Qtegra tool is the main Qtegra ISDS 
Software module and is used to design, start and stop the 
measurements.

• Chapter 5: “Templates” describes the analytical workflow for sample 
measurement that is defined in a Template.

• Chapter 6: “LabBooks” describes that LabBooks are based on the 
settings specified in the Templates in Qtegra. These setting can still 
be adjusted in the LabBook before the measurements is run.

• Chapter 8: “Qtegra Reports” describes the necessary steps to create 
and execute Reports using the Qtegra Report Editor.

• Chapter 9: “Method Parameters” describes the Method Parameters, 
which are dependent on the evaluation method assigned to the 
LabBook.

• Further chapters describe the evaluation methods and their typical 
use case.

• Additional chapters describe the basic mathematical methods used 
by Qtegra ISDS Software. This includes information about 
statistical calculations, linear and polynomial regression as well as 
Gaussian error estimation for regression analysis.

Related Documentation
In addition to this Software Manual, Thermo Fisher Scientific provides 
the following documents for the iCAP 7000 Plus Series ICP-OES 
instrument:

• Operating Manual

• Consumables and Parts Catalog

• Installation Guide

• iCAP 7000 ICP-OES Spectrometer Qtegra ISDS Software Installation 
Procedure (section 2 of 3) 

• Data Processing Algorithms Manual

The Operating Manual represents the Original Operating Instructions. 
Thermo Fisher Scientific provides this Software Manual as additional 
reference documents for the iCAP 7000 Plus Series ICP-OES 
instruments.

A printed version of the Operating Manual is shipped with the 
instrument. 
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Typographical Conventions
This section describes typographical conventions that have been 
established for Thermo Fisher Scientific manuals.

Signal Words

Make sure you follow the precautionary statements presented in this 
manual. The special notices appear different from the main flow of text:

Data Input

Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click Close”.

• Procedures often end with “click OK”, which is omitted in many 
cases. “Click Save to save your changes” is also no more shown as the 
final step.

Tip Points out possible material damage and other important 
information in connection with the instrument.
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Topic Headings

The following headings are used to show the organization of topics 
within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
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Contacting Us
There are several ways to contact Thermo Fisher Scientific. You can use 
your smartphone to scan a QR Code, which opens your email 
application or browser.

Contact Link / Remarks QR Code

Brochures and Ordering 
Information

www.thermofisher.com/icp-oes

Service Contact www.unitylabservices.com

Technical Documentation 
SharePoint

❖ To get user manuals for your product

1. With the serial number (S/N) of your instrument, request 
access on our customer SharePoint as a customer at 
www.thermoscientific.com/Technicaldocumentation

2. For the first login, you have to create an account. Follow the 
instructions given on screen. Accept the invitation within six 
days and log in with your created Microsoft™ password.

3. Download current revisions of user manuals and other 
customer-oriented documents for your product. Translations 
into other languages may be available there as well.

Customer Feedback ❖ To suggest changes to this manual

You are encouraged to report errors or omissions in the text or 
index. Send an email message to the Technical Editor at 
documentation.bremen@thermofisher.com.

http://www.thermofisher.com/icp-oes
http://www.unitylabservices.com/
http://www.thermoscientific.com/Technicaldocumentation
mailto:documentation.bremen@thermofisher.com
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2
Introduction to Qtegra ISDS Software

This Software Manual describes the Thermo Scientific Qtegra 
Intelligent Scientific Data Solution (ISDS) configurable software 
package for elemental analyses for configuration and operation of the 
Thermo Scientific iCAP 7000 Plus Series ICP-OES. Qtegra ISDS 
Software is a true end-to-end solution for workflow-driven analysis. You 
can use this suite of applications for a variety of Thermo Fisher 
Scientific products.

The main Qtegra ISDS frameworks introduced in this chapter are:

Contents

• Firmware Update on page 2-2

• Setting User Levels on page 2-3

• Quick Start on page 2-10

• Configurator Overview on page 2-11

• Qtegra Overview on page 2-13

• Central Data Storage on page 2-14

• Qtegra LabBook Signing on page 2-19

• Compliance with your SOP on page 2-37

• Advanced Audit Policy on page 2-41
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Firmware Update
When a firmware update is available, the Firmware Update dialog 
opens automatically if the controlling computer has access to the 
Internet, see Figure 2-1.

❖ To install the firmware update

1. Click .

2. Follow the instructions.

Figure 2-1. Firmware Update dialog
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Setting User Levels
Qtegra ISDS Software is used by different people with different 
functions. At the beginning, Qtegra ISDS Software is installed and 
configured. These steps usually are done by an Administrator. In the 
daily laboratory use, a Qtegra User prepares the measurement, for 
example, the User selects or creates a LabBook to be scheduled.

When you open additional Qtegra ISDS Software tools, for example, 
Instrument Control, you need QtegraAdministrator rights. Without 
these rights a message box is shown that explains that required privileges 
to run the program are missed. How to set the Qtegra ISDS Software 
user levels is described in this chapter.

The Qtegra ISDS Software user levels are defined over the Windows 
User rights. To grant all Qtegra ISDS Software users access to the 
desired user interface, Windows™ offers two options to be performed by 
an Administrator.

❖ To display the Users and Groups folders

1. Open Start > Windows Administrative Tools > Computer 
Management.

2. In the Computer Management window, expand System Tools and 
Local Users and Groups. The Users and Groups folders are shown. 
See Figure 2-2.

Or, an Administrator opens the Microsoft Management Console 
(MMC).

❖ To open the Microsoft Management Console (MMC)

1. Click the Start button.

Figure 2-2. Computer Management window
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2. Type mmc into the search box and press <Enter>. After confirming 
the User Account Control message, the Console window opens, see 
Figure 2-3.

3. In the left pane, click Local Users and Groups.

4. If you do not see Local Users and Groups, it is probably because that 
snap-in has not been added to Microsoft Management Console. 
Follow these steps to install it:

a. In the Console window, click File > Add/Remove Snap-in.

b. Select Local Users and Groups, and then click Add. See 
Figure 2-4.

c. In the Choose Target Machine dialog, select Local computer, 
and then click Finish.

Figure 2-3. Console window

Figure 2-4. Adding Local Users and Groups
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d. Click OK to close the Add or Remove Snap-ins dialog. The 
entry Local Users and Groups (Local) is shown, see Figure 2-5.

5. Double-click Local Users and Groups to expand the entry.

6. Double-click the Groups folder.

❖ To create Qtegra user groups if these groups are not available

1. Click Action > New Group, see Figure 2-6.

2. In the New Group dialog, enter QtegraAdministrator as Group 
name. Members of this group can change all Qtegra ISDS Software 
and instrument settings.

3. Repeat step 1 up to step 2 for QtegraSystemAdministrator, 
QtegraDataAdministrator, QtegraManager, QtegraSupervisor, 
QtegraAnalyst, and QtegraUser, where members of this group have 
roles as described in Table 3-5.

Figure 2-5. Console with Local Users and Groups

Tip If the Qtegra groups are not available on your Windows 
system, the installation process obviously failed. Nevertheless, you 
can add the Qtegra groups to Windows.

Figure 2-6. Creating new group
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4. Double-click the desired Qtegra group and click Add to add all 
desired Windows users to this Qtegra group. Standard Windows 
dialogs guide you through the selection of users.

a. In the first step, enter the desired users (see Figure 2-7).

-or-

b. Click Advanced to open the extended search dialog (see 
Figure 2-8).

c. As final step of your user selection, click OK to close all dialogs.

Figure 2-7. Selecting Windows users

Figure 2-8. Advanced search for Windows users
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After login, every Windows user on the Qtegra ISDS PC automatically 
is granted access with his or her Qtegra role that is defined by 
membership in one of the Qtegra user groups.

The following examples shows how to add a user to a Qtegra user group. 
The user (“Thermo”) is configured on the system and has Windows 
rights.

❖ To add a Windows user to a Qtegra user group

1. Right-click the Windows Start menu and select Computer 
Management from the shortcut menu.

2. In the left pane, expand Local Users and Groups and select Users.

3. In the middle area, select the user (“Thermo”) you wish to add to a 
Qtegra user group.
The right pane shows the user and the More Actions item.

4. Click More Actions and select Properties from the shortcut menu.
The Thermo Properties dialog opens.

Tip If a single Qtegra ISDS user is added to more than one Qtegra 
user group, the user has the rights of the highest group in the 
hierarchy.

Figure 2-9. Expanding current Local Users and Groups
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5. Select the Member Of tab.

6. Click Add to open the Select Groups dialog.

7. In the lower field, enter the object name, that means, enter the 
Qtegra user group, for example “qtegraanalyst”. Make sure to type 
the correct (part of the) Qtegra user group.

8. Click Check Names to verify the object name.
In our example, the name will change to 
“THERMO-PC\QtegraAnalyst”, where the prefix comes from your 
PC name.

Figure 2-10. Member Of tab of the selected user

Figure 2-11. Select Groups dialog

Figure 2-12. Updated object name
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9. Click OK to see the additional membership in the Properties 
dialog.

10. Close the Properties dialog. Close the Computer Management 
window.

After next login, the user “Thermo” can start Qtegra and operates as a 
QtegraAnalyst.

Figure 2-13. Member Of tab with new membership
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Quick Start
The Thermo Fisher Scientific field service engineer installs the 
iCAP 7000 Plus Series ICP-OES at your site. He also sets up the Qtegra 
ISDS Software for first use. 

Five Clicks to get a Result

1. Open your LabBook.
A LabBook contains all the details that are relevant to your 
experiment, for example, all the instrument’s parameters, sample 
information, and data collection and reporting parameters.

2. Click the Get Ready button.
The Get Ready button communicates with the instrument to start 
the peristaltic pump, ignite the plasma, allow it to warm up, and do 
a performance check. In the time it takes you to prepare your 
calibration standards and load them into the autosampler, the 
instrument has done everything it needed to be prepared for the 
day’s analysis.

3. Load your sample information.
Qtegra ISDS Software is flexible, so you can type your sample 
names in one by one, or you can import your entire sample from an 
external spreadsheet.

4. Analyze your samples.
Once your samples are added to the LabBook, you are ready to start 
your analysis. A single click loads the LabBook into the scheduler 
and runs it.

5. Export your data.
Whether you want your data electronically or in a hard copy, data 
reporting can be done with a single button click. Export your data 
into one of the pre-loaded Report templates or create your own 
Report template.
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Configurator Overview
The Configurator tool is used by your network Administrator and your 
laboratory manager. Different applets are provided to edit general 
settings of the hardware and software and to configure and adjust the 
Thermo Scientific Qtegra ISDS framework for your laboratory. For 
details on the Configurator tool, see “Configurator” on page 3-1.

The user interface of the Configurator tool is shown in Figure 2-14:

Table 2-1 gives a short description of each applet.

Figure 2-14. User interface of Configurator

Table 2-1. Applets of the Configurator

Applet Description

Access Control Allows the Administrator to define the access permissions for 
the different programs and applications in the user interface.

Access Rights Introduced with Qtegra ISDS Software version 2.10, allows to 
control the access permissions by granting or denying access to 
the Qtegra applications in general and the Configurator 
applets in particular.

Experiment Configurator Allows the Administrator to define instrument settings, 
communication ports, and combine instrument sets and 
evaluation strategies for a specific Experiment Configuration. 
Templates and LabBooks created in Qtegra are based upon 
these Configurations.

Reports Allows the Administrator to create new and to edit existing 
Report templates.
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Settings Gives access to the settings database (registry) and controls 
default settings such as the default directory path for Qtegra. 
The settings stored here should not normally need any 
modifications.

Signature Workflow Signatures allow to document that a workflow stage (Acquired, 
Verified and Approved) has been performed by a known person. 
Each stage can be revoked. In the Configurator, the stages are 
defined and the access rights for signing and revoking are set 
individually for all user groups.

Standards Central database editor for stock solutions and standards.

Table 2-1. Applets of the Configurator, continued

Applet Description
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Qtegra Overview
The Qtegra tool is the main Qtegra ISDS module and is used to design, 
start and stop the measurements. The Home Page tab offers access to all 
pages of the Qtegra tool. By default, the Home Page opens on the 
Dashboard page.

The analytical workflow is based on the design of a measurement in a 
Template. Sample analysis and data acquisition is then performed in 
LabBooks created from the Template with appropriate information on 
the samples. For details on the Qtegra tool, see “Qtegra” on page 4-1.

The user interface of the Qtegra tool is shown in Figure 2-15:

Tip If you can read Unreleased and untested version! on the 
Dashboard page, your version of Qtegra is not released for scientific 
purposes, but only as an internal test version, which may be unstable. 
Please contact your Thermo Fisher Scientific field service engineer to 
get a released version.

Figure 2-15. User interface of Qtegra
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Central Data Storage
Native instrument data are usually stored on the local computer and 
final results are stored in LIMS by utilizing synchronization tools. In 
some cases, it could be of advantage if the native data files are stored in a 
central location rather than on the local PC.

Qtegra ISDS Software offers the capability to use network location for 
manual synchronization or as a central data repository. Technically it 
utilizes symbolic links, offered by the Windows 7 and successor 
operating systems, which are underlying the permissions of the active 
directory.

Prerequisites

If you plan to enable chained links Windows needs to be prepared for 
the handling of this. This can be easily achieved by calling the Windows 
command on the command line. Press <Win> + <R> and type 
fsutil behavior set SymlinkEvaluation R2R:1

Please note that you must call this command with evaluated privileges. 
To achieve this, call the Command Prompt with right-click by using 
Run as administrator.

By default, the File Service of Qtegra ISDS Software does not have 
access to the server location, therefore it must be decorated with 
credentials, which are sufficient to log on to the server.

Figure 2-16. Shortcut menu of cmd.exe
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❖ To set the access permission for the File Service

1. Open the Computer Management window and navigate to 
Services and Applications > Services.

2. Double-click File Service to open the Properties window, see 
Figure 2-17.

3. On the Log On tab, type the credentials (for example, user name 
and password) required to access the remote server.

4. Confirm with OK and - as prompted - restart the service.

5. Confirm the following message box with Yes, since restarting File 
Manager forces the restart of a couple of dependent services.

Using Network Locations

Qtegra ISDS Software offers some build-in functionality to handle 
network links located in the File Manager. You may also use this link 
for local folders.

❖ To create a link to an external location

1. From the Qtegra - [Home Page] navigation pane, click File 
Manager.
The File Manager page opens with the tree structure and list view.

2. Under Workspace or from the list view, right-click the desired 
folder, and from the shortcut menu, select Create Link to Folder.

Figure 2-17. File Service Properties window



Introduction to Qtegra ISDS Software
Central Data Storage

2-16 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

The standard Select Folder dialog opens to select the folder you 
want to link, see Figure 2-18.

3. To confirm your selection, click Select Folder. 
An editor opens and gives the option to type a name for the newly 
created folder link, see Figure 2-19.

4. Type the desired name.

Figure 2-18. Select Folder dialog

Tip You can select a local folder as well as a network location. 
Make sure to have sufficient credentials for the network file service 
when accessing a network folder. For details on credentials, see 
“Prerequisites” on page 2-14.

Figure 2-19. Renaming folder link

Labeled Components: 1=folder, 2=folder link

Figure 2-20. Icons for folders and folder links

1 2
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To distinguish folders from links, Qtegra ISDS Software displays 
links with a different icon. While normal folders are displayed 
within a standard folder symbol (1 in Figure 2-20), linking folders 
are represented with a connector on the bottom (2 in Figure 2-20).

Whenever you are browsing for a file (LabBook, Template, or others), 
the folder link (indicated by special icon) is displayed beside the other 
folders.

Tip We do not recommend to store the results of your measurement 
directly from the acquisition onto network locations if the network is 
not 100% reliable. This could cause a data loss for the measured 
sample.

Figure 2-21. Folder link in Browse for file dialog
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A link can also be removed from the Qtegra File Manager.

❖ To delete a link to an external location

1. From the shortcut menu of the selected item, click Delete. 
Note that only the link is deleted and not the folder nor the content 
of the folder.

While the delete command deals with the link the copy command will 
copy the content of the folder to another location but not to the link.

❖ To copy a link to another location

1. From the shortcut menu of the selected folder link, click Copy.

2. Select the folder you want the content of the folder link to be 
copied, and then from the shortcut menu, click Paste.
The content will be copied soon. This may take a few seconds as all 
subfolders are also copied.

Tip The Browse for file dialogs also offer the above described function 
to create a folder link, see Figure 2-22.

Figure 2-22. Create Link to Folder command in Browse for file dialog
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Qtegra LabBook Signing
For good laboratory practice and standard compliance Thermo 
Scientific Qtegra ISDS Software offers the ability to sign LabBooks. 
Qtegra ISDS Software uses the user’s certificate storage offered by 
Microsoft Windows.

In order to use the signing features for LabBooks inside Qtegra ISDS 
Software it is necessary to have a valid certificate, which includes a 
private key. Normally valid certificates will be provided by the 
laboratory IT administrators or by a trust center. Two typical service 
providers are:

• http://www.trustcenter.de/ (Germany)

• http://www.verisign.com/ (US)

Almost all trust center companies offer a free certificate for private use, 
which may serve for testing. Another option to receive a valid certificate 
is to use the below described built-in feature of Windows.

Creating a Self-Signed Signature

The file encryption feature of Windows uses a certificate and its private 
key for encrypting your hard drive. Therefore, it is possible to use the 
available wizard to generate a self-signed certificate.

❖ To generate a self-signed certificate

1. Open Control Panel > User Accounts.

2. Select Manage your file encryption certificate, see Figure 2-23.

Tip In order to be able to create a self-sign signature you must have 
administrator rights. Ask your Administrator.

Figure 2-23. Make changes to your account

http://www.trustcenter.de/
http://www.verisign.com/
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The Encrypting File System wizard opens, see Figure 2-24.

3. Click Next.

4. Select Create a new certificate and click Next, see Figure 2-25.

Figure 2-24. Encrypting File System wizard start

Figure 2-25. Selecting to create a new certificate
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5. Select the first radio button Make a self-signed certificate and 
store it on my computer and click Next, see Figure 2-26.

After a short time period the new certificate will be available to the 
system.

6. Select Back up later if you only intend to use this certificate for 
testing, see Figure 2-27.

Figure 2-26. Selecting a self-signed certificate

Figure 2-27. Selecting back-up for self-signed certificate

Tip If you wish to back up the key now, select the first option, 
select the back-up location and enter a password.
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7. Do not change your current encryption settings, see Figure 2-28, 
and click Next.

8. Finish the Encrypting File System wizard, see Figure 2-29.

9. Click Close.

You can now sign a LabBook. Qtegra ISDS Software offers the signing 
feature for every measured LabBook.

Figure 2-28. Selecting encryption settings

Figure 2-29. Finishing Encrypting File System wizard
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The Certificate Manager

The Certificate Manager can be called by pressing <Win> + <R> and 
typing certmgr.msc in the Run dialog. It can be used to explore and 
maintain currently installed certificates, see Figure 2-30.

Using a Centralized Certification Authority (CA)

In this scenario, a Windows server of the domain is running as a 
certification authority (CA) where a domain user can request trusted 
certificates from the server. These certificates can be used by Qtegra 
ISDS Software to sign a LabBook. In order to simplify the example, 
there is only one Windows Server 2012 r2 running the Active Directory 
Service. The current Domain is called “CERTTEST” and the server is 
also acting as the certification authority, which can be achieved by 
running Active Directory Certificate Services.

Request Certificate from Server

This step is only necessary for setting-up a new domain user. Already 
existing users should have their certificate with the private key on there 
main computer - the computer which is used for signing emails. With 
the domain setup and the certification authority in place, the following 
steps are necessary to request a certificate for a user.

❖ To request a certificate

1. Log on to the machine or to one of the machines, which should be 
available for signing.

Figure 2-30. Certificate Manager



Introduction to Qtegra ISDS Software
Qtegra LabBook Signing

2-24 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

2. Press <Win> + <R> and then type certmgr.msc in the Run dialog to 
start the Windows Certificate Manager, see Figure 2-31.

The Certificate Manager displays the certificate storage of the 
current user, see Figure 2-32.

Figure 2-31. Starting the Windows Certificate Manager

Figure 2-32. Certificate Storage of current user
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3. Right-click the Personal folder and select Request New Certificate 
from the shortcut menu, see Figure 2-33.

4. Follow the steps presented by a Certificate Enrollment wizard, see 
Figure 2-34.

Figure 2-33. Request New Certificate

Figure 2-34. Certificate Enrollment Wizard start
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5. Select the certificate enrollment policy, see Figure 2-35.

6. Click Next.

7. In the Request Certificates dialog, choose User certificate, which 
allows Secure Email, see Figure 2-36.

Figure 2-35. Selecting Certificate Enrollment Policy

Figure 2-36. Requesting New Certificate
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8. Click Enroll to display the Certification Installation Results page, 
see Figure 2-37.

9. Click Finish.

The private key is now stored locally in your personal certificate 
storage, see Figure 2-38.

Figure 2-37. Finishing Certificate Enrollment

Figure 2-38. Certificate storage for current user

Tip It is one of the fundamentals of asymmetric cryptography that the 
private key is never known by a server.
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Export Certificate with Private Key

The following simple steps are required to export a user certificate.

❖ To export a user certificate

1. Log on to the machine and user, which contains the certificate with 
the private key in the users certificate storage.

2. Start the Windows Certificate Manager as described in “Request 
Certificate from Server” on page 2-23.

3. Select the certificate to-be-exported in the Personal folder.

4. Choose Export from the shortcut menu, see Figure 2-39.

Figure 2-39. Exporting certificate
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5. Follow the Certificate Export Wizard, see Figure 2-40.

6. Choose to export the private key, see Figure 2-41.

Figure 2-40. Certificate Export Wizard

Figure 2-41. Selecting export of private key
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7. Select the file format, see Figure 2-42.

8. Make sure to set an export password to protect your private key, see 
Figure 2-43.

Figure 2-42. Selecting file format for private key

Figure 2-43. Entering password for private key
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9. Select a file name and a location for the export, see Figure 2-44.

10. Click Finish to complete the Certificate Export Wizard, see 
Figure 2-45.

After a successful export, a PFX file will be available in the selected 
export folder.

Import Certificate with Private Key on a Different Machine

The following simple steps are required to import a user certificate.

Figure 2-44. Entering file name and location for private key

Figure 2-45. Completing the Certificate Export Wizard
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❖ To import a private key

1. Log on to the machine where you want to access your private key 
(for example, for signing of LabBooks with Qtegra ISDS Software) 
with your domain user login.

2. Locate the PFX file, which was created during the exportation of 
your certificate (see “Export Certificate with Private Key” on 
page 2-28).

3. Double-click the PFX file to start the Certificate Import Wizard and 
follow the steps.

4. Choose Current User, see Figure 2-46.

5. In the wizard, select the PFX file, see Figure 2-47.

Figure 2-46. Certificate Import Wizard

Figure 2-47. Selecting PFX file
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6. Enter the password that you have specified during export, see 
Figure 2-48.

7. Select the option to automatically select the certificate store, see 
Figure 2-49.

Figure 2-48. Entering password

Figure 2-49. Selecting certificate store
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8. Click Finish to complete the wizard, see Figure 2-50.

Signing in Qtegra ISDS Software

There are two possibilities to sign a Qtegra LabBook with the 
credentials of a certain user:

• If the Qtegra ISDS Software is installed under the account of the 
specific user, the user can sign the LabBook from within his/her 
account.

• Qtegra ISDS Software allows the current user to change credentials 
for signing.

❖ To sign a Qtegra ISDS Software LabBook with user login

1. Log on with your domain user login if the Qtegra ISDS Software is 
installed under your account.

2. Select Signing in a completed LabBook.

Figure 2-50. Completing the Certificate Import Wizard
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3. Click Sign, see Figure 2-51.

4. In the Select certificate for signature dialog, choose an available 
certificate.

❖ To sign as different user

1. Select the Sign with different user check box, see Figure 2-52.

Figure 2-51. Signing LabBook

Figure 2-52. Signing LabBook with different user
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2. Click Sign and type the necessary credentials (user name and 
password for the different user), see Figure 2-53.

Final Note

Concerning security issues and in order to avoid spreading ones private 
key over multiple machines, signing of LabBooks can also be performed 
offline - disconnected from the instrument. Using the Qtegra ISDS File 
Manager feature Create Link To Folder (see Figure 2-54) allows to 
connect to a shared folder making LabBooks available to multiple users. 
The LabBook to-be-signed can be opened in that location and signed 
locally with the current credentials.

Figure 2-53. Entering password

Tip In order to access a user profile, it is currently necessary to be 
signed-in on the current machine to be able to use the “Sign with 
different user” feature. This issue will be fixed in future versions.

Figure 2-54. Folder shortcut menu item Create Link to Folder
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Compliance with your SOP
Each organization has rules, policies, procedures, and standards which 
are written in the Standard Operating Procedures (SOP). Such an SOP 
can follow Part 11 in Title 21 of the Code of Federal Regulations, 
Electronic Records, Electronic Signatures (21 CFR Part 11) which includes 
the U.S. federal guidelines for storage and protection of electronically 
stored data and the application of electronic signatures. These guidelines 
have been developed to ensure that electronic records are reliable, 
authentic and comprehensible. 

An important implication in 21 CFR Part 11 is that organizations must 
implement rules to confirm that proper methods, procedures, and 
controls are in place. As a result prevention of data falsification, data 
reconstruction and system security must be addressed.

Qtegra ISDS Software provides a wide range of features, which enable 
laboratories to operate within SOP compliance. These features include 
audit trails, support for electronic signatures and tools for the integrated 
data management.

Your SOP should require both technical and procedural compliance. To 
achieve technical compliance, the organization must use software that 
contains the required security features and functions. To achieve 
procedural compliance, your organization must establish SOP and 
policies that define how to use processes and systems in a compliant 
matter.

Configuring the system to be compliant with SOP

❖ To set Qtegra to be compliant with your SOP

1. Open the Configurator.
The list of applets, the display region for applet settings and the 
viewer region are shown.

2. From the Configurator list of applets, select Settings.

Table 2-2. Qtegra supported sections of 21 CFR Part 11

Section Title

11.10 Controls for closed systems

11.30 Controls for open systems

11.50 Signature manifestations

11.70 Connection signature / document

11.100 General requirements for electronic signatures

11.200 Electronic signatures components and controls

11.300 Controls for identification codes / passwords
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3. In the display region for applet settings, expand Settings and then 
expand Compliance Settings. See Table 2-3 for details on 
compliance parameters.

Table 2-3. Compliance Settings parameters

Tree item Default Recommended Comment

Enable global compliance True True Beside other settings, a true global compliance 
value removes any limitation on the number 
of files with the .log extension. Without 
limitation, a Qtegra user in a regulated 
environment can maintain a complete set of 
log files that provide full information, for 
example, during an audit.

Enable compliant system log False True If system event logging is set to True, every log 
on and off from users to and from the system 
is logged.

LabBook > Prevent exporting 
and reporting of modified 
LabBooks

False True If set to True, the Export button (and 
<Ctrl> + <E> function of the LabBook 
toolbar is disabled after the LabBook 
evaluation results have been modified. The 
Save Report function is also disabled but 
shows the results of the modified LabBook.

LabBook > Prevent multiple 
signing by a single user

False True If set to True, a user can only sign a single 
stage of a LabBook. After a stage has been 
signed, the next Sign button remains disabled 
for the current user.

LabBook Backup > 
Automatic backup after 
analysis

False

See Table 14-11 for details on automatic 
backup settings.LabBook Backup > 

Backup folder
Workspace

LabBook Backup > 
Backup suffix

<empty>

Two stage identity checks > 
Require for Commenting

False True Activate an additional ID check (that means, 
the user must re-enter his password) before a 
LabBook or Template is saved.

Two stage identity checks > 
Require for Exporting

False True Activate an additional ID check (that means, 
the user must re-enter his password) before a 
LabBook is exported.
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4. Close the Configurator tool and switch to Qtegra.

Qtegra ISDS Software implements some of these controls directly and 
relies on the security functions in your computer operating system for 
other parts, namely:

• The audit trail
Every alteration of a Template or LabBook is recorded in the history 
of each. These can be viewed, compared, exported or printed.

• Electronic signatures
With Qtegra ISDS Software it is possible to electronically sign each 
LabBook with so-called digital SSL certificates that are issued by 
Trusted CA Certificate Authorities.

• The Qtegra ISDS Software layer controls the file operations.

• The Administrator restricts user access and controls software feature 
access through the Access Control (part of the Qtegra ISDS 
Configurator tool).

• Your computer security functions manage user authorization.

• The Windows permission management maintains electronic record 
security.

Resetting the system to ignore compliance with SOP

By default, Qtegra ISDS Software is configured to prevent changes to 
the Sample List during measurement of a LabBook. This is done in 
order to provide maximum data traceability during analysis in a SOP 

Two stage identity checks > 
Require for Reporting

False True Activate an additional ID check (that means, 
the user must re-enter his password) before a 
Report is generated.

Two stage identity checks > 
Require for Signing

False True Activate an additional ID check (that means, 
the user must re-enter his password) before a 
LabBook is signed or a signature is revoked.

Table 2-3. Compliance Settings parameters, continued

Tree item Default Recommended Comment

Tip During installation, the Qtegra ISDS Software setup creates 
the Windows groups QtegraUser, QtegraSupervisor, 
QtegraAnalyst, QtegraManager, and QtegraAdministrator. 
QtegraSystemAdministrator and QtegraDataAdministrator must 
be added manually (see page 2-5). No other Qtegra ISDS 
Windows groups are allowed – all Qtegra ISDS users will have to 
be assigned to one of the supplied Windows groups. Qtegra ISDS 
Software allows to change the Windows group names. Domain 
groups can not be added to Qtegra ISDS Windows groups.
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compliant environment. In this default state, if changes are necessary, 
you must stop the LabBook before you can change the Sample List. Any 
changes to the Sample List can then be commented and captured in 
Audit Trail.

❖ To allow changes to the sample list during measurement

1. In the Configurator tool, Settings applet, Settings section, 
Compliance Settings group, set the Enable global compliance 
value to False to allow these changes nevertheless.

2. You may also set the Enable compliant system log value to False to 
stop system event logging, which would ignore compliance with 
SOP, too.

Figure 2-55. SystemEventLog setting

Tip When the Enable global compliance value is set to False, 
changes to the Sample List in a running LabBook are not captured 
in the Audit Trail. Moving, deleting, or renaming a Template or 
LabBook then is no more logged. 
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Advanced Audit Policy
In order to log account activities, for example, “User account 
management logs” (see Figure 2-58) the Administrator must adjust the 
Windows OS to enable the logging for Windows and Qtegra ISDS 
Software.

This section describes how to enable the Advanced Audit Policy for 
Qtegra ISDS Software System Event logging.

❖ To enable the Advanced Audit Policy

1. In the Configurator tool, Settings applet, expand 
Settings > Compliance Settings, and select the 
Enable compliant system log item. Make sure that Misc > Value is 
set to True.

2. In Windows, press <Win> + <R> and type gpedit.msc in the Run 
dialog to open the Local Group Policy Editor.

3. In the Local Group Policy Editor, expand the folder tree under 
Computer Configuration, see Figure 2-56.

Expand Local Computer Configuration > Windows Settings > 
Security Settings > Advanced Audit Policy Configuration > System 
Audit Policies - Local Group Policy Object.

4. Select the following items and change their Audit Events setting 
from Not Configured to Success and Failure. To do so, right-click the 

Tip This instruction shows how to change the Windows settings with 
regard to the Local Group Policy. These changes are only necessary 
when Qtegra ISDS Software is used in laboratories regulated under 
21 CFR Part 11 compliance.

Figure 2-56. Expanded folder tree for System Audit Policies
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subcategory items and select Properties from the shortcut menu.
The Properties setting dialog opens, see Figure 2-57.

5. Set these properties for Account Management, see Figure 2-58.

Figure 2-57. Properties setting dialog with activated check boxes

Figure 2-58. Account Management setting
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6. Set these properties for Logon/Logoff, see Figure 2-59.

7. Set these properties for Policy Change, see Figure 2-60.

Figure 2-59. Logon/Logoff setting

Figure 2-60. Policy Change setting
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8. Set these properties for System, see Figure 2-61.

9. To activate the changes in the Windows log, navigate to Computer 
Configuration > Windows Settings > Security Settings > Local 
Policies > Security Options and change the value from Not Defined 
to Enabled. To do so, right-click the subcategory items and select 
Properties from the shortcut menu.
The Properties setting dialog opens, see Figure 2-62.

Figure 2-61. System setting

Figure 2-62. Properties setting dialog with Enabled option
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10. Set this property for Security Options, see Figure 2-63.

11. Close the Local Group Policy Editor.

12. Restart your computer.

Installation Qualification Operational Qualification (IQ/OQ)

Since version 2.4 of Qtegra ISDS Software, the setup procedure ends 
with an Installation Qualification (IQ) including an Operational 
Qualification (OQ). Both qualifications ensure that your instrument 
works as specified.

Figure 2-63. Security Options setting

Figure 2-64. LIMS integration
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The IQ/OQ is run once after every Qtegra ISDS Software installation 
or upgrade, whereas IQ is run on every start of Qtegra ISDS Software. 
Results are protocoled in the Log View and displayed as information 
when IQ is run without failures and as error when there occurred a 
problem.

The full IQ/OQ package is only available as part of the iCAP OES 
Qualification Kit. With this kit there is no limit on the frequency with 
which the IQ/OQ process can be performed. It can be run as often as 
the system SOP requires.

After the installation, the IQ/OQ procedure starts automatically and 
displays the following window, see Figure 2-65.

The IQ steps ensure that all the files and assemblies necessary to run any 
part of the IQ/OQ procedure are found in the correct versions and 
locations. They also ensure that all files necessary for running the Qtegra 
ISDS Software are installed in the correct location and have the correct 
size and name. The OQ step ensures the accurate evaluation of the 
LabBooks.

A more comprehensive summary of the result for each test is shown in 
the lower part of the IQOQ window, when you click the desired line 
selector to the most left of the table.

Tip Any changes to the IQOQ LabBooks cause an IQ failure when 
Qtegra ISDS Software is started. To avoid this failure never change the 
originally delivered and installed files. If changes in an example 
LabBook are necessary, safe a copy of this LabBook.

Figure 2-65. IQ/OQ status window
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The IQ/OQ Report is saved to 
C:\Users\<User>\Documents\Thermo\Qtegra\IQOQ and opens 
automatically in your PDF viewer. It can be saved to another location or 
printed out as a hard-copy for storage, see Figure 2-66.

Figure 2-66. Part of an IQ/OQ Report
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3
Configurator

The Configurator tool contains all tools necessary to configure and 
adjust the Qtegra ISDS Software framework for your laboratory.

Contents

• User Interface of the Configurator Tool on page 3-2

• Access Control on page 3-4

• Access Rights on page 3-11

• Experiment Configurator on page 3-15

• File Access Rights on page 3-23

• Reports on page 3-24

• Settings on page 3-26

• Signature Workflow on page 3-28

• Standards on page 3-31

❖ To open the Configurator tool

1. Click Start > Thermo Qtegra > Configurator to open the 
Configurator.
-or-
Create a desktop shortcut to Configurator and double-click this 
icon.

The list of applets, the display region for applet settings and the 
viewer region are shown.
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User Interface of the Configurator Tool
The Configurator tool has three regions, as shown in Figure 3-1:

The list of applets (see also “Configurator Overview” on page 2-11) 
shows the icons for all applets available in the Configurator tool. The 
applet settings are displayed when you click the icon.

Labeled Components: 1=list of applets, 2=display region for applet settings, 3=viewer region

Figure 3-1. User interface of the Configurator tool

3

21

Tip By default, Enable global compliance is set to True. The 
Configurator will therefore only show a reduced list of applets. To see 
all applets as shown here, switch off the global compliance parameter. 
For details, see “Configuring the system to be compliant with SOP” 
on page 2-37.
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Viewer Region

The Viewer region (see Figure 3-2) of the Configurator tool displays a 
list of log files, such as errors and warnings.

For details on the Viewer region tools, see “Log View” on page 4-88.

 

Figure 3-2. Viewer region of the Configurator tool

Tip The Viewer region is also shown in Qtegra and in the Instrument 
Control tool (see “Log View Region” on page 4-38).
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Access Control
The Access Control applet of the Configurator tool allows the 
Administrator to control the Virtual instruments, Virtual evaluations, 
and User Actions.

❖ To open the Access Control

1. From the Configurator list of applets, select Access Control.

With the Access Control applet, the responsible person defines who has 
access to parts of programs and what type of access permission is granted 
or denied to a user group. Figure 3-3 shows a typical structure.

Granting Access Rights

In the Access Control applet, you can define for each user group, which 
buttons and controls are visible and activated.

❖ To grant or deny access to the user interface

1. Expand Virtual instruments, Virtual evaluations, or User Actions 
and the tree items below.
The Access mode settings are shown on the right.

2. Click the user group for which you wish to change the access rights, 
for example, Normal user.

3. Click  to expand the list of access rights, see Figure 3-3.

4. Select the new access right for the user group, for example, Read 
only.
The new access rights are defined for the expanded component.

Figure 3-3. Layout of the Access Control applet
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Access rights can be granted on three major components Audit Trails, 
File Manager, and LabBooks.

Table 3-1. Access rights for Audit Trails

Audit Trail Description

History > Export Allows the user to export the history entries. 
Default is Full access for Normal user.

History > View Allows the user to view the history entries. 
Default is Full access for Normal user.

System Log > Export Allows the user to export the system log 
entries. Default is Full access for Normal user.

System Log > Show All Allows the user to show the entire list of log 
entries in the System Log page, which is 
controlled by the Show All check box. See 
“System Log Page” on page 4-69. Default is 
Full access for Normal user.

System Log > View Allows the user to view the system log 
entries. Default is Full access for Normal user.

Table 3-2. Access rights for the File Manager page

File Manager Description

All Items Allows the user to copy, cut, paste, and rename 
the items. Default is Full access for Normal 
user.

Files Allows the user to delete, export, and import 
files to Qtegra ISDS Software. Default is Full 
access for Normal user.

Folders Allows the user to create links, delete, and 
create new folders on the File Manager view. 
Default is Full access for Normal user.

LabBook Allows the user to copy, create, cut, delete, 
edit, and paste LabBooks on the File Manager 
view. Default is Full access for Normal user.

Report Allows the user to copy, create, cut, delete, 
edit, and paste Reports on the File Manager 
view. Default is Full access for Normal user.

Template Allows the user to copy, create, cut, delete, 
edit, and paste Templates on the File Manager 
view. Default is Full access for Normal user.
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Table 3-3. Access rights for LabBooks

LabBooks Description

Electronic Signatures Allows the user to sign (and lock) different 
stages of a LabBook and to revoke the 
signature. Default is Full access only for 
Administrator and Data Administrator.

Evaluation Results Allows the user to include and exclude data 
entries to and from the eQuant Evaluation 
Concentration Ratios view, the 
Concentrations view, and the Survey 
Concentrations view. Allows the user to 
include and exclude data entries to and from 
the Raw Data Raw Intensities view, the Raw 
Intensity Ratios view, and the Survey 
Intensities view. Default is Full access for 
Normal user.

Method 
Development

Allows the user to copy, create, cut, and paste 
Element Finder and Plasma Optimization 
methods. Allows the user to create LabBooks 
from Method Development and to perform 
Actions. Default is Full access for Normal user.

Method Parameters Allows the user to edit and modify the Method 
Evaluations, Instruments, Interference 
Correction, and Standards data. Default is Full 
access for Normal user.

Sample List Allows the user to add, copy, delete, edit, and 
move samples in the Sample List. Default is 
Full access for Normal user except 
Quality Control with Full access for the Data 
Administrator only.

Settings Gives the user access to Flags and Limits. 
Default is Full access for Normal user.
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Types of access rights that can be granted or denied are listed in 
Table 3-4.

Setting History and System Log Export and View Rights

To be compliant with quality requirements, an Administrator may set or 
reject the access rights for the history and system log function of Qtegra 
ISDS Software.

❖ To set the access rights on the history or system log function

1. Expand User Actions > Audit Trails > History.

2. Select the Export or View item.
The Access mode settings are shown on the right.

3. Click the user group for which you wish to change the access rights, 
for example, Normal user.

4. Select the new access right (Hidden, Read only, or Full access) and 
enter a comment.
The new access rights are defined for this item and affect the history 
of LabBooks, Templates and Tune Settings.

Generating an Access Control Report

For each user action, you can export the access control permissions to 
get an overview of your settings.

Table 3-4. Access rights for Qtegra

Name Description

Full access The user can both see the certain program, 
application, or menu item and edit the settings.

Read only The user can only see the certain program, 
application, or menu item; changes are not allowed.

Hidden Same as Read only: The user can only see the certain 
program, application, or menu item; changes are 
not allowed.

Tip Full access rights by default are granted to the System 
Administrator, Administrator, Data Administrator, Manager, Supervisor, 
Analyst, and normal User groups. Users who have not been assigned 
(by the Windows administrator) to a Qtegra ISDS Software group 
belong to the Unknown user group. For this group, every access mode 
is set to Read only.

Tip The following steps refer to the history function. Replace 
“History” by “System Log” to adapt the description accordingly.
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❖ To generate an access control Report

The print out shows the access control permissions focused on the User 
Actions component.

1. Expand Export to show the menu and select the file format for the 
Report.

a. Select Save as HTML to compile an HTML Report that is 
shown in your browser.
The Browse For Folder dialog is opened to select the folder 
where you want to save the HtmlReport folder with the 
index.html file and all images used.

b. Select Save as PDF to compile a PDF Report that is shown in 
your PDF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the PDF file.

c. Select Save as RTF to generate a Report that is displayed in 
Microsoft Word or your alternative RTF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the RTF file.

d. Select Save as XML to generate a Report that is displayed in 
your browser.
The Browse For Folder dialog is opened to select the folder 
where you want to save the XML output.

The Report shows a matrix of Full access for full access rights and Hidden 
or Read only for denied access rights, see Figure 3-4.

Figure 3-4. Detail view of an access control Report
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Viewing History Entries

❖ To view, compare and export the history of entries

1. In the Access Control applet, click History to open the History 
window.

2. To compare the history entries, press <Ctrl> or <Shift> and select 
the range of history entries you wish to compare.

3. Click Compare to compare the selected entries.
The Comparison dialog opens and shows all selected entries column 
by column.

4. Resize or minimize the Comparison dialog to make all entries 
visible. The column header shows the date of selected entry with the 
oldest version left and the newest version right.

5. Click the triangle in front of the items to collapse and expand the 
items to focus on the interesting parts.

6. Select Show differences only if you wish to view only the 
differences, which is the default setting.
When removing the tick, Qtegra ISDS Software needs a few seconds 
to update the list and to show all history entries. Differences then 
are shown in bold letters.

7. Click Close to close the Comparison dialog.

8. Expand the Export button to select the file format for the history 
export.

a. Select Save as HTML to compile a HTML history that is 
displayed in your browser.
The Save As dialog is opened to select the folder where you want 
to save the HTML output.

b. Select Save as PDF to compile a PDF history that is displayed in 
your PDF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the PDF file.

Tip Viewing and exporting the history is only available if the Enable 
global compliance value is set to True.

Tip The History window is only opened when entries are 
available. You will neither see the History window nor get any 
notification that your click has been executed if no history entries 
are available.

Tip Qtegra ISDS Software allows the selection of any number of 
entries for comparison purposes but only 2 history entries can be 
exported for comparison.
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c. Select Save as RTF to generate a history that is displayed in 
Microsoft Word or your alternative RTF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the RTF file.

d. Select Save as XML to generate a history that is displayed in the 
browser.
The Browse For Folder dialog is opened to select the folder 
where you want to save the XML output.

9. Click Close to close the History window.
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Access Rights
The Access Rights applet of the Configurator tool introduced with 
Qtegra ISDS Software version 2.10 allows to control the access 
permissions by granting or denying access to the Qtegra applications in 
general and the Configurator applets in particular.

This applet shows one matrix of all Qtegra user groups and the Qtegra 
applications, that means, the Configurator, InstrumentInstall, Qtegra, 
and ServiceStatus tools. The second matrix shows all Qtegra user groups 
and the Configurator applets, see Figure 3-5 with the default settings.

If a cell of the matrix shows green ‘Allowed’, members of the 
corresponding Qtegra user group can run the application or open the 
Configurator applet. The default settings give the Administrator access 
to all applications and applets. The settings for the 
System Administrator can not be changed and are therefore displayed in 
gray.

When opening an application with insufficient user rights, a message is 
shown, see Figure 3-6.

The application itself is not opened.

Figure 3-5. Layout of the Access Rights applet

 

Figure 3-6. Message for insufficient privileges

Tip By default, the minimum user level for Applications (except 
Qtegra) and Configurators is defined as Administrator. Other user 
groups cannot open these programs.



Configurator
Access Rights

3-12 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

After selecting Prohibited or Allowed from the listbox, click outside the 
matrix to enable the Save button. Click Save to make your changes 
available after a comment was entered in the confirmation dialog.

Click History to view, compare and export the history of a 
Configuration. See “Viewing History Entries” on page 3-9 for details.

User Roles

During setup of Qtegra ISDS Software, Thermo Fisher Scientific 
provides the user groups shown in Table 3-5. The Windows user 
installing Qtegra ISDS Software is added to the Administrator group.

Table 3-5. User roles provided by Qtegra

Namea Description

System Administrator* The System Administrator has only access to 
the Configurator tool to set up the user 
group functionality.

Administrator The Administrator is responsible for the 
instrument setup, configuration settings and 
technical services.

By default, the Administrator has full access 
to all programs and applications available 
except Post Analysis Manipulation.

Data Administrator* The Data Administrator is responsible for 
the acquired data.

By default, the Data Administrator has full 
access to programs and applications available 
and to Post Analysis Manipulation.

Manager The Manager is responsible for method 
setup/creation and instrument maintenance.

By default, the Manager has limited access to 
programs and applications. The access rights 
are granted by the Administrator by 
changing the minimum required user level 
for the selected application.

Supervisor The Supervisor is an optional user role with 
some extended access rights that are defined 
in your environment.

By default, the Supervisor has limited access 
to programs and applications. The access 
rights are granted by the Administrator by 
changing the minimum required user level 
for the selected application.
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Changing the Group name or User name

If policies or internal rules require, you can change the Windows group 
name or the User name provided by Qtegra ISDS Software.

❖ To change a Windows Group name or Display name for the user

1. In the Settings applet, expand Settings > Groups.

2. Select the group item you want to rename, for example, User.
The right pane displays the current values.

Analyst The Analyst is an optional user role with 
some extended access rights that are defined 
in your environment.

By default, the Analyst has limited access to 
programs and applications. The access rights 
are granted by the Administrator by 
changing the minimum required user level 
for the selected application.

User The User is responsible for sample 
measurement.

By default, the User has limited access to 
programs and applications. The access rights 
are granted by the Administrator by 
changing the minimum required user level 
for the selected application.

a The Qtegra user group marked with an asterisk is not created during installation. See page 2-5 
for creation of Qtegra user groups.

Table 3-5. User roles provided by Qtegra, continued

Namea Description

IMPORTANT There is a risk of losing access. If you are a member of 
the Administrator group, which actually should be changed, make sure 
to temporarily become a member of another group with the right to 
use the Configurator. After successful verification of your Group name 
change, remove yourself from the other group.
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3. Click into the field you want to change and type the desired name 
for the Display name or for the Windows group name. There is no 
restriction regarding the characters.

4. Stop typing with <Enter> and add your comment into the 
Confirmation dialog that is shown immediately.
The new value is shown in the list boxes, where you set the access 
control.

IMPORTANT While changing the Windows group name, make 
sure to change this name also in the Windows Computer 
Management under System Tool > Local User and Groups > 
Groups. Otherwise, users of the renamed group can no more run 
the Qtegra ISDS Software.

Tip When changing the Windows user group name, make sure to 
type the correct name of the Windows group. See“Setting User 
Levels” on page 2-3 for details.
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Experiment Configurator
The Experiment Configurator applet of the Configurator tool 
combines instrument sets. Each combination is saved as specific 
Configuration for later use in the Qtegra ISDS Software when creating a 
LabBook or Template.

In the Experiment Configurator applet, all virtual instruments, virtual 
evaluation types and preset configurations are listed on tabbed pages, see 
Figure 3-7.

The commands available in Experiment Configurator are summarized 
in Table 3-6.

Tip Access to this module is defined in the “Access Control” on 
page 3-4. Generally, only the Administrator has full access to this 
module.

Figure 3-7. Layout of the Experiment Configurator applet

Table 3-6. Experiment Configurator commands

Commands Description

To create a new Configuration. Adds New Experiment 
Configuration to be renamed.

To save the current Configuration.

To delete the current Configuration.
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❖ To open the Experiment Configurator

1. From the Configurator list of applets, select Experiment 
Configurator.

Creating a new Configuration

A Configuration provides Qtegra ISDS Software with the hardware 
parameters of your instruments. As Administrator, make sure that a 
Configuration based on your instrument is available.

❖ To create a new Configuration

1. From Configurator > Experiment Configurator, click New to add 
a new Configuration, see Figure 3-8.

2. Type a name and click anywhere outside the field.
-or-

To load all current Configurations.

To view, compare and export the history of a 
Configuration. See “Viewing History Entries” on 
page 3-9 for details.

Table 3-6. Experiment Configurator commands, continued

Commands Description

Figure 3-8. Add new Configuration
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Press <Enter> to confirm.
The name is accepted as there are no restrictions with regard to the 
character range. The Configuration is displayed in the 
Configuration Details view.

3. Type a Description in Configuration Details.

4. From the right-hand pane of available Instruments, select your 
instrument, see Figure 3-7.

All supported instruments and peripherals are listed in the 
Instruments tab.

5. Drag iCAP OES from the Instruments tab to your new 
Configuration and drop when  is shown, see Figure 3-9.

The Configuration item is expanded and shows one instrument.

6. Drag the peripheral you wish to add from the Instruments tab to 
your new Configuration, see Figure 3-10.

Figure 3-9. Add iCAP OES to your Configuration

Figure 3-10. Instrument and autosampler added to your Configuration
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❖ To rename a Configuration

1. From Configurator > Experiment Configurator, select the 
Configuration you wish to rename.
The Configuration Details window shows the name and 
description.

2. In the Name field, change the name according to your needs.

3. Optionally, add or change the Description.

Editing the Settings of Instruments

In the Experiment Configurator applet, your Administrator edits the 
settings for the instrument in the Configurations field.

❖ To edit the instrument or peripheral settings

1. From Configurator > Experiment Configurator, open the list of 
Configurations and right-click the instrument or peripheral you 
wish to edit the settings for, see Figure 3-11.

Figure 3-11. Right-click the instrument item to edit the settings
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2. Click Edit settings to open the Settings dialog, see Figure 3-12.

3. The setting parameters are grouped, for example, Sample 
Introduction or General. When changing the values, take the 
description in the lower tile into account.

4. Click a cell to change the value.

If a drop-down menu is available for this cell, the drop-down arrow 
is shown, see Figure 3-13.
If the cell represents a Boolean variable, just double-click to switch 
between True and False.

Figure 3-12. Settings dialog for iCAP OES in Configurator

Figure 3-13. Drop-down menu of Settings in the Experiment 
Configurator
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5. Select an item from the list.

6. Some peripherals provide several setting pages. Select the tabs, for 
example, FAST Setup and Autosampler to set up all parameters.

Enabling the Drain Flow Sensor

The Drain Flow Sensor is a unique safety and time saving device which 
uses a bubble counter to check that at least one bubble passes from the 
instrument spray chamber drain every two minutes. This ensures that if 
the sample introduction becomes blocked/sample tubing has detached 
that valuable time and gas is not wasted by continuing the run. This is 
also an excellent safety feature, as it will ensure a safe controlled 
shutdown from an automated sequence, activate nudge mode on the 
pump to save the tubing and leave everything ready for the user to assess 
and re-start the system, with no need to re-fill all the sample tubes.

This option allows you to enable/disable the drain flow sensor when 
using accessories that do not have a drain actively pumping liquid waste 
via the instrument peristaltic pump, for example, ultrasonic nebulizer or 
hydride accessory.

❖ To enable the drain flow sensor of iCAP 7000 Plus Series ICP-OES

1. From the Configurator list of applets, select Experiment 
Configurator.

2. In the list of Configurations, right-click the instrument you wish to 
enable the drain flow sensor for iCAP 7000 Plus Series ICP-OES.

3. Click Edit Settings (see Figure 3-11) to open the Settings dialog, 
see Figure 3-14.

Figure 3-14. Drain flow sensor settings for iCAP OES in Configurator
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4. In the iCAP OES tab, click the Drain Flow Sensor Enabled cell.

5. Click  to open the drop-down list and select True.

❖ To reset settings to factory default

1. From Configurator > Experiment Configurator, open the list of 
Configurations and right-click the instrument or peripheral you 
wish to reset the settings for, see Figure 3-11.

2. Click Edit settings.

3. In the Settings dialog, click  to reset all values to the 
defaults as set from the factory.

Managing Configurations

In the Experiment Configurator applet, Configurations can be loaded 
from the database, saved and activated as a preset, and deleted.

❖ To load all Configurations from the database

1. From Configurator > Experiment Configurator, click Load to 
load all Configurations from the database.
The Configurations list is updated.

For typical applications with the iCAP 7000 Plus Series ICP-OES 
instrument, pre-configured system combinations are made available in 
the Preset Configurations tab by the Thermo Fisher Scientific field 
service engineer upon delivery of the system.

❖ To create a Preset Configuration

1. From Configurator > Experiment Configurator, open the list of 
Configurations and right-click the Configuration you wish to add to 
the list of Preset Configurations.

2. Select Add to preset configuration from the shortcut menu to add 
the Configuration to the list of Preset Configurations.

❖ To activate a Preset Configuration

1. Select the Preset Configurations tab.

2. Select the preset Configuration you wish to work with.
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3. Drag the preset Configuration to Configurations, see Figure 3-15.

The preset Configuration is now added to the Configurations list.

❖ To delete a Configuration

1. From Configurator > Experiment Configurator, select the 
Configuration you wish to delete.

2. Click Delete to delete the selected Configuration.
A confirmation dialog opens.

3. Click Yes to delete the Configuration.

Figure 3-15. Selecting a preset Configuration
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File Access Rights
The File Access Rights applet of the Configurator tool introduced with 
Qtegra ISDS Software version 2.10 allows to manage the file access by 
permissions. Especially the Qtegra System Administrator uses this applet 
as he has no access to the Qtegra File Manager.

With the File Access Rights applet, the responsible person defines the 
file access rights by selecting a principal and setting the permissions 
respectively on the file or folder level currently selected. Figure 3-16 
shows a typical structure.

Refer to “Setting File Permissions” on page 4-60 for a detailed 
description on how to manage file permissions. Adapt the folder 
structure from the Qtegra File Manager page accordingly.

Figure 3-16. Layout of the File Access Rights applet
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Reports
The Reports applet of the Configurator tool allows you to create new 
Report templates or to edit existing templates.

The Reports applet (see Figure 3-17) determines the layout of the 
Reports. 

The commands available in the Reports applet are summarized in 
Table 3-7.

❖ To open the Reports applet

1. From the Configurator list of applets, select Reports.

Tip By default, Enable global compliance is set to True. The 
Configurator will therefore only show a reduced list of applets. To see 
all applets as shown here, switch off the global compliance parameter. 

Figure 3-17. Layout of the Reports applet

Table 3-7. Reports commands

Commands Description

To create a new Report template. 

To open/load a Report in the file format *.imrep.

To save the current Report template.

To load a template from the XML database.
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❖ To create a new Report template

1. From Configurator > Reports, click Create to create a new Report 
template.

2. Type a Report name.

3. Configure the layout.

4. Click Save to save the Report template.
The file is saved in the file format *.imrep.

❖ To edit an existing Report template

1. From Configurator > Reports, click Load and browse for the 
Report file.

2. Select the Report file you wish to edit.

3. Click OK to open the file.

4. Edit the file.

5. Click Save to save the Report template.
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Settings
The Settings applet of the Configurator tool controls default settings, 
for example, the default directory path for Qtegra or the default settings 
for dwell time.

The Settings applet (see Figure 3-18) gives access to the settings database 
(registry).

❖ To open the Settings applet

1. From the Configurator list of applets, select Settings.

2. Scroll through the list of settings and select the item you want to 
change. Details of the selected item are displayed in the right-hand 
pane.

3. Click into the field where you want to change the value. In some 
cases, a listbox offers the values to be selected. In other cases, type 
the desired value. Be sure to type only valid values.

❖ To enable debug messages

1. From the Settings applet, expand Settings > Logging and click 
ShowAll.

2. Set the Value for Misc to True.

❖ To enable extended debug logging in the Sample List

1. From Configurator > Settings, expand Logging and click 
SampleListSynchronisationLoggingEnabled.

Figure 3-18. Layout of the Settings applet
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2. Set the Value for Misc to True.

Compliance Settings

For details, see “Compliance with your SOP” on page 2-37.

Viewing History Entries

For details, see “Viewing History Entries” on page 3-9.

Tip Activate this logging feature only if you experience 
unexpected issues in the Sample List. Better leave it False because 
otherwise a significant amount of log messages is added to the log 
files, which need to be stored.
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Signature Workflow
Signatures allow to document that a workflow stage has been performed 
by a known person. By default, Qtegra ISDS Software provides the three 
stages Acquired, Verified and Approved. Each stage can be revoked. In the 
Signature Workflow applet of the Configurator, the stages are defined. 
In the Access Control applet of the Configurator, the access rights for 
signing and revoking are set individually for all user groups.

❖ To define Signature Workflow stages

1. Open Configurator > Signature Workflow.
The currently available stages are shown.

2. To rename the item, select an existing item and edit the Display 
Name if desired.
The selected item gets yellow highlighted.

3. Tick Signing locks the LabBook to protect the LabBook against 
any changes after signing. 
In some cases it makes sense to lock a LabBook beginning with a 
higher level. After a LabBook is locked by signature, it always 
remains locked when getting the next signature.

As Qtegra ISDS Software provides three workflow items by default, you 
can add additional items or remove existing items.

Figure 3-19. Default definition of the Signature Workflow

Tip When changing the Display Name, always make sure that the 
items represent hierarchical levels. A typical signing workflow 
(Acquired, Verified, Approved) is shown by default. Do not re-order 
the workflow by renaming the items.

Tip After changing the Display Name, the access rights remain as 
originally defined.
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❖ To add workflow items

1. Open Configurator > Signature Workflow.
The currently available stages are shown.

2. Click .
A new line is appended to the list.

3. Change the Display Name according to your needs and tick 
Signing locks the LabBook if desired.

4. Drag the selected item to the desired position to represent the 
correct stage, that means, select the item and move the mouse 
pointer while the mouse button is pressed.

5. Set the access rights for Sign and Revoke under Access 
Control > User Actions > LabBooks > Electronic Signatures. See 
“Granting Access Rights” on page 3-4.

❖ To delete workflow items

1. Open Configurator > Signature Workflow.
The currently available stages are shown.

2. Select the stage you want to delete.
The selected stage gets yellow highlighted.

3. Click .
A confirmation dialog opens.

4. Click Yes.
The workflow item is removed from the Signature Workflow view.

❖ To view the workflow history

1. Open Configurator > Signature Workflow.
The currently available stages are shown.

2. Click .
The Signature Workflow History window opens a list of available 
history entries.

3. Select the entries (press <Ctrl> to select multiple entries). 

4. Click Export if you want to export the history as HTML, PDF, 
RTF, or XML.
-or-
Click Compare to show the differences between the Signature 
Workflow items.

Tip To make the new settings available, the Configurator tool 
must be restarted before the next step is performed.
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To view, compare and export the history of the Configuration, see 
“Viewing History Entries” on page 3-9.
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Standards
The Standards applet of the Configurator tool gives access to the 
standards database. New standard files, Internal Standard files and 
isotope dilution standard files are created here.

The Standards applet (see Figure 3-20) shows a list of standards on the 
left. On the right pane, the associated elements and their concentration 
in the standard solution are displayed as well as the periodic table.

Figure 3-20. Layout of the Standards applet



Configurator
Standards

3-32 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

The Standards commands are summarized in Table 3-8.

❖ To open the Standards applet

1. From the Configurator list of applets, select Standards.

❖ To load all standards from the standard database

1. From Configurator > Standards, click Load to load all standards 
from the database.

❖ To save standards to the standard database

1. From Configurator > Standards, change or add standards 
according to your needs.

2. Click Save to save the standards to the database.

❖ To delete standards from the standard database

1. From Configurator > Standards, open the Standard(s) list and 
select the row you wish to delete.

2. Click Delete.
A confirmation dialog opens.

3. Click Yes.
The standard is deleted from the database.

Table 3-8. Standards commands

Commands Description

To create a new standard or Internal Standard.

To delete the selected standard(s).

To load all standards from the preset standard 
database.

To save the standards files to the database.

To open the History for Standards dialog, where 
you can view, compare and export history 
entries. See “Viewing History Entries” on 
page 3-9 for details.

Tip Some standards offered to be created with the  menu 
are designed for other instruments rather than the iCAP 7000 
Plus Series ICP-OES instrument.
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❖ To select molecules as standard

1. From Configurator > Standards, open the Standard(s) list and on 
the top right, click the collapse button to expand the Molecules list.
The Molecules list opens, see Figure 3-20.

2. To add molecules to your standard, tick Use in standard of the 
Molecules list.
The molecule is immediately copied to your standard list.

3. Define the concentration and unit of the analytes as required.
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4
Qtegra

Qtegra is the principal tool for preparing and running measurements. 
The Qtegra tool is the main Qtegra ISDS Software module and is used 
to design, start and stop the measurements.

Contents

• User Interface of the Qtegra Tool on page 4-2

• Dashboard Page on page 4-5

• LabBooks Page on page 4-22

• Templates Page on page 4-36

• LabBook Query Page on page 4-41

• File Manager Page on page 4-51

• System Log Page on page 4-69

• Help Page on page 4-75

• Scheduler on page 4-80

• Completed LabBooks on page 4-87

• Log View on page 4-88

❖ To open the Qtegra tool

1. Double-click the icon on your desktop to open Qtegra.
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User Interface of the Qtegra Tool
The user interface of the Qtegra tool is shown in Figure 4-1.

The Home Page (1 in Figure 4-1) by default shows the Dashboard page. 
It gives access to all pages of the Qtegra tool for the creation and 
management of Template and LabBook files, for measurement, result 
analysis, and to the Help Page.

The Log View tab (2 in Figure 4-1) shows system messages, warnings 
and errors of the iCAP 7000 Plus Series ICP-OES instrument.

The Completed LabBooks tab (3 in Figure 4-1) lists the LabBooks 
previously run.

The Scheduler tab (4 in Figure 4-1) lists all LabBooks assigned to be 
run.

Labeled Components: 1=Home Page tab, 2=LogView tab, 3=Completed LabBooks tab, 4=Scheduler tab

Figure 4-1. Home Page of Qtegra
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1
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❖ To move the Scheduler, Log View or Completed LabBooks

1. On the Qtegra - [Home Page], right-click the Scheduler, Log View 
or Completed LabBooks title bar or tab.
The shortcut menu opens, see Figure 4-2.

2. Select Floating to show the selected tab in a separate window.
Move the window or resize as required.

3. Make sure Auto Hide is deselected.

4. Click and drag the title bar of Scheduler, Log View or Completed 
LabBooks.

5. Move the cursor over the position indicators, see Figure 4-3.

Figure 4-2. Shortcut menu of title bar

Tip You can click  Auto Hide in the top right corner of a tab 
area to hide the selected tab when the cursor leaves this area and 
click  to cancel.

Figure 4-3. Position indicator to move tab
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The selected tab is shown in the background, and the new position 
of the tab is indicated as colored, see Figure 4-4.

6. Drop the selected tab where you wish to place it.

Figure 4-4. Moving the Scheduler tab
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Dashboard Page
The Home Page opens with the Dashboard page by default when you 
start the Qtegra tool.

The Dashboard page of Qtegra offers several functions to prepare the 
iCAP 7000 Plus Series ICP-OES system for measurement, close down 
the system or change the Configuration, and shows on one page the 
instrument controls and main settings of the iCAP 7000 Plus Series 
ICP-OES instrument, see Figure 4-5.

The Get Ready button (1 in Figure 4-5) gives access to the Get Ready 
procedure (“Getting Ready” on page 4-6). It also switches on and off the 
plasma to start and stop your iCAP 7000 Plus Series ICP-OES 
instrument.

Labeled Components: 1=Get Ready button, 2=current Configuration status, 3=iCAP 7000 Plus Series ICP-OES 
thumbnail to change Configuration, 4=function buttons and check box for organic matrix (not shown), 5=important 
parameters of the iCAP 7000 Plus Series ICP-OES system, 6=instrument selector (peripheral selector), 7=current 
Configuration

Figure 4-5. Dashboard Page of Qtegra
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Next to the Get Ready button, the action currently taken and the status 
of the current Configuration are displayed (2 in Figure 4-5).

The iCAP 7000 Plus Series ICP-OES thumbnail (3 in Figure 4-5) opens 
the Select Configuration dialog (“Changing the Configuration” on 
page 4-18). Here you can change the Configuration according to your 
system setup.

With the buttons at the right side (4 in Figure 4-5) below the 
iCAP 7000 Plus Series ICP-OES thumbnail, the torch can be aligned, 
and spectrometer optimization and post ignition defaults can be set. 
When carrying out a torch alignment with organic samples, the check 
box on the right side should be selected.

The main part (5 in Figure 4-5) of the Dashboard page presents an 
overview of all main settings of the iCAP 7000 Plus Series ICP-OES 
instrument. The parameters for the iCAP OES Spectrometer can be 
changed here and are set with the Apply button.

On top of the Dashboard page, the currently loaded Configuration (7 in 
Figure 4-5) is displayed. Below, the progress of the Get Ready procedure 
is shown if activated.

❖ To open the Dashboard page of Qtegra

1. On the Qtegra - [Home Page] navigation pane, click Dashboard.
The Dashboard page of Qtegra opens.

Getting Ready

The Get Ready procedure on the Dashboard page of Qtegra helps to 
start the instrument. It switches on the plasma and waits for the 
instrument to warm up. The Spectrometer Optimization is performed, 
followed by the performance checks if so defined.

The Spectrometer Optimization may be performed at any time, and is 
a routine, which ensures that the wavelengths are correctly located on 
the detector. This routine will automatically run when the plasma is 
ignited. During this routine, the pump will stop and the nebulizer gas 
will be turned off - this is because the routine uses plasma wavelength 
positions, so no sample is required.

The Nebulizer Optimization optimizes the nebulizer pressure settings 
for the performance tests.

Tip It is recommended that the Spectrometer Optimization is carried 
out prior to analysis.

Tip Standard concentric glass nebulizers are optimized for a flow of 
approximately 0.4 to 0.7 L/min. Ensure that gas flows in excess of 
0.7 L/min are not used as this may result in sub-optimal performance. 
Other nebulizers may run at higher flows.
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The performance checks are defined by the Sensitivity, Relative 
Standard Deviation, and Detection Limit tests.

Once the Performance Report is passed, the instrument is ready for 
operation.

If the Performance Report fails, check for causes and run the tests again. 

❖ To prepare the iCAP 7000 Plus Series ICP-OES system for measurement

1. On the Dashboard page, click the red Get Ready button.
The Get Ready dialog opens, see Figure 4-6.

2. Move to rinse when idle can be selected when using an autosampler 
if the probe has not been used for a while.

3. If you select Warm up, type the time in Minutes.

4. To optimize spectrometer parameters, select Spectrometer 
Optimization.

5. To optimize the nebulizer, select Nebulizer Optimization.

Tip The performance checks should be run using the standard 
aqueous solutions kit.

Tip The performance checks should not be run using the Sprint Valve 
(7600 model only).

Figure 4-6. Get Ready dialog for iCAP 7000 Plus Series ICP-OES
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6. Select Run Performance Checks.

7. If you select Perform Detection Limit Check, enter Nebulizer 
Flow (L/Min).

8. If you run the tests using an autosampler, enter Wash time (s) and 
Uptake time (s). Set the Rack and Vial position for Multi Element 
Test Solution and Blank solution to define the Sample positions.

9. With Manual Sampling, type the Wash time (s) and the Uptake 
time (s).
The default for both of 30 s is usually sufficient.

As good laboratory practice needs validated tests this item always is 
checked when you open this dialog.

10. If an autosampler is configured, for Sample positions in the lower 
extension of Figure 4-6, select the desired vials from the table to 
specify the sample positions for Multi Element Test Solution and 
Blank solution. 

From the Position Kind drop-down list, select Vial to move the 
probe to the rack and vial specified in the next columns. Select 
Home to move the probe to its home position. Select Rinse to move 
the probe into the rinse position where the probe is washed and 
moved up to rinse as often as set in the hardware.

From the Rack drop-down list, select the desired rack number, 
where the vial is placed.

Type the Vial number for each sample.

11. Click OK.
The plasma is switched on. During warm-up the Dashboard shows 
the remaining warm-up time, see Figure 4-7.

The Get Ready button shortly shows yellow until the state changes 
to ready while the plasma is switched on. When the warm-up starts 
the button is already green. After warm-up, the Spectrometer 
Optimization starts.
You can click Skip to skip the warm-up.

12. If you wish to stop the procedure, click Stop.

Tip The performance check can also be run directly from the 
green Get Ready button, that is, without closing down the system 
first, see “Repeating Get Ready” on page 4-14.

Figure 4-7. Dashboard during warm-up
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The Spectrometer Optimization is performed and if passed, the 
Sensitivity test starts, see Figure 4-8.

With manual sampling, after the stabilization process, a dialog 
opens, see Figure 4-9.

13. Move the sample probe to the wash position and click OK.

The washing starts. After washing, a dialog opens, see Figure 4-10.

14. With manual sampling, aspirate your solutions according to the test 
and click OK.
When using an autosampler, this is automatically performed.

The sample uptake starts, followed by the performance test. 

The Performance Check is followed by the Relative Standard 
Deviation test and the Detection Limit. 

The procedure finishes and the display changes accordingly.

As the entire Get Ready procedure (all options are activated in the 
Get Ready dialog) performs many steps, for example, the Warm up 
procedure, the Spectrometer Optimization, the Nebulizer 

Figure 4-8. Dashboard starting the performance checks

Figure 4-9. Waiting For Response dialog for wash position

Figure 4-10. Waiting For Response dialog for standard solution
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Optimization, and Performance Checks, then not all steps can be 
shown in the Dashboard. Instead, a horizontal slider is added below 
the Get Ready procedure icons to scroll through all steps.

The display shows Failed for tests that have not been passed 
successfully, see Figure 4-11.

15. Click View results to open the Performance Report in a separate 
tab, see also “File Manager Page” on page 5-1 on location of 
Reports.

16. Click Clear to close Get Ready.

Additional Instrument Settings

On the Dashboard page of Qtegra, Torch Alignment and Post Ignition 
Defaults can be defined, and a button for Spectrometer Optimization 
is provided, see Figure 4-12.

Figure 4-11. Dashboard showing Get Ready failed

Figure 4-12. Additional function buttons on the Dashboard page
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For maximum sensitivity and optimum results the alignment of the 
plasma image is critical. Whenever a torch has been removed or replaced 
in the instrument, or if the torch body or center tube has been replaced, 
a torch alignment procedure should be carried out.

The 2 ppm Zinc solution for Torch Alignment should be made up with 
either an aqueous or an organic matrix as required. The organic matrix 
is ideally kerosene.

Post Ignition Defaults can be set in order to immediately change 
start-up settings, all at the same time.

Spectrometer Optimization is a routine, which ensures that the 
wavelengths are correctly located on the detector. See also “Getting 
Ready” on page 4-6.

❖ To align the torch of your iCAP 7000 Plus Series ICP-OES system

1. On the Dashboard page, click Torch Alignment.
The Waiting for user response dialog opens, see Figure 4-13.

2. Start aspirating the 2 ppm Zinc solution for some seconds.

3. Click OK.

4. Aspirate until the test is finished.
The progress of the test can be followed in the message bar at the 
bottom of Qtegra, see Figure 4-14.

 

Four Alignment steps are performed. After Radial, slit=UV follows 
Radial, slit=Vis, Axial, slit=UV, and Axial, slit=Vis.
The message Torch Alignment: Passed is shown when the test 
succeeded.

Figure 4-13. Waiting for response dialog Torch Alignment

Figure 4-14. Torch Alignment progress message example
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❖ To set post ignition defaults of your iCAP 7000 Plus Series ICP-OES 
system

1. On the Dashboard page of Qtegra, click Post Ignition Defaults.
The Post Ignition Defaults dialog opens, see Figure 4-15.

2. Select RF Power to change the value.
The default and range depend on the iCAP 7000 Plus Series 
ICP-OES model. For details, see “Measure Modes” on page 9-12.

3. Click the Purge Gas Flow edit box to select Normal or High.
The default and range depend on the iCAP 7000 Plus Series 
ICP-OES model.

4. Select Auxiliary Gas Flow to change the value.
The default and range depend on the iCAP 7000 Plus Series 
ICP-OES model. For details, see “Measure Modes” on page 9-12.

5. Select Coolant Gas Flow to change the value.
The coolant gas flow is only adjustable for iCAP 7600 instruments. 
For details, see “Measure Modes” on page 9-12.

6. Select Nebulizer Gas Flow to change the value.
The nebulizer gas is only adjustable for iCAP 7400 and iCAP 7600 
instruments. For details, see “Measure Modes” on page 9-12.

7. Select Additional Gas Flow to change the value.
The additional gas flow is only adjustable for iCAP 7600 
instruments that are fitted with a gas Mass Flow Controller. For 
details, see “Measure Modes” on page 9-12.

Figure 4-15. Post Ignition Defaults dialog
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8. Select Pump Speed to change the value.
The default and range depend on the iCAP 7000 Plus Series 
ICP-OES model. For details, see Analysis Mode parameters in 
“Acquisition Parameters” on page 9-14.

9. Click OK.
These values are now applied as defaults whenever the instrument is 
switched on.

❖ To optimize the spectrometer

1. On the Dashboard page, click Spectrometer Optimization.
The spectrometer optimization starts. A message in the Log View 
shows when the process is finished.

Shutting Down the System

In your laboratory environment, the instrument remains in a ready 
state. Qtegra ISDS indicates this state with a green surrounded Get 
Ready button on the Dashboard page.

The iCAP 7000 Plus Series ICP-OES system can be shut down with the 
Shut Down option on the Dashboard page of Qtegra.

❖ To close the iCAP 7000 Plus Series ICP-OES system down

1. On the Dashboard page, click the green Get Ready button to 
display three options, see Figure 4-16.

2. Click Shut Down.
A message opens (see Figure 4-17) to ensure that the sample probe is 
removed from the analyte solution.

Figure 4-16. Additional options on Get Ready button

Tip If the plasma is on, while you are opening this dialog, it is not 
automatically switched off.

Figure 4-17. Remove probe message when shutting down the 
instrument
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3. Remove the probe from the solution.

4. Click Yes to proceed with shutting down the system.

a. If you click Yes (see Figure 4-17), the iCAP 7000 Plus Series 
ICP-OES system shuts down and the plasma switches off.

b. Independent from any setting in the Configurator > Experiment 
Configurator > Peristaltic Pump Shutdown Behavior, the 
peristaltic pump is switched off.

c. The instrument changes to Not Ready. The Get Ready icon 
changes to red.

d. You may now work inside the instrument.

-or-

Click No (see Figure 4-17) if you wish to cancel the shut down 
process.

a. If you click No, an Error message opens to inform about 
canceling the shut down, see Figure 4-18.

b. Click OK to leave the instrument unchanged and in Ready state.

c. The Get Ready button remains green.

Repeating Get Ready

The Get Ready procedure can be run for the iCAP 7000 Plus Series 
ICP-OES system directly with the Repeat Get Ready option from Get 
Ready button on the Dashboard page of Qtegra.

Figure 4-18. Canceling Shut Down error message
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❖ To repeat Get Ready directly from the Get Ready button

1. On the Dashboard page, click the green Get Ready button to 
display three options, see Figure 4-16.

2. To set desired start parameters, click Repeat Get Ready. The Get 
Ready dialog opens with the settings last selected, see Figure 4-6.

a. Set all parameters according to your needs. For details, see 
“Getting Ready” on page 4-6.

b. Click OK to set the instrument into the Get Ready state.

Opening a Report

A performance Report for the iCAP 7000 Plus Series ICP-OES system 
can be accessed directly with the Show Report function on the 
Dashboard page of Qtegra.

❖ To open a Performance Report directly from the Get Ready button

1. On the Dashboard page, click the green Get Ready button to 
display three options, see Figure 4-16.

2. To navigate to the Reports folder, click Open Report.

Qtegra shows the File Manager page and opens the tree to select the 
desired Report. You will see three subfolders PerformanceReport, 
AutotuneReport and DetectorSetup.

Select a subfolder and open the desired Report. For working with 
the File Manager page, see “File Manager Page” on page 4-51.
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Peripheral Settings on the Dashboard

The Dashboard shows the hardware configuration as loaded. Select the 
instrument or the peripheral to display a symbolic view of the settings, 
see Figure 4-19.

❖ To open the peripheral settings page

1. Open the Dashboard page of Qtegra.

2. Depending on your Configuration, a peripheral is shown below the 
instrument iCAP OES. Click the peripheral, for example, ESI 
SC-4DX (4 in Figure 4-19) to display its setting.

3. On the lower part, find additional tabs (3 in Figure 4-19) to change 
the data view of the autosampler ESI SC-4DX.

4. Select Tools > Initialize (6 in Figure 4-19) to start the 
communication with the autosampler.
Select Calibrate to start the calibration wizard.

5. Select Settings > Racks to define the tray layout and to specify the 
autotune position.
Select Settings > Rinse to define the wash, pump and flush 

Labeled Components: 1=Configuration loaded, 2=data view region of instrument/peripheral, 3=tabs for specific 
settings of peripheral, 4=peripheral selector, 5=instrument selector, 6=data view menu

Figure 4-19. ESI autosampler on Dashboard
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parameters.
Select Settings > Motors to set the horizontal, rotational and 
vertical speed and accelerator parameters, see Figure 4-20.

6. Select the Valves & Pumps tab (3 in Figure 4-19) to switch the 
FAST Pump on or off.

7. Select the FAST Method tab (3 in Figure 4-19) to display the initial 
view, see Figure 14-32.

8. From the User Methods list box, select the desired method,
-or-
Click the browse buttons to select the method from the File Open 
dialog.

Figure 4-20. Motors setting of the ESI autosampler data view
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The FAST method is displayed under a new tab close to the initial 
+ tab, see Figure 4-21.

Changing the Configuration

It is frequently necessary to change the Configuration of the iCAP 7000 
Plus Series ICP-OES instrument. 

With the Change Configuration function on the Dashboard page of 
Qtegra you can easily change the Configuration.

❖ To change the Configuration

1. On the Dashboard page, click Change Configuration.
The Select Configuration dialog opens.

Figure 4-21. ESI FAST: Method tab showing Events and Actions

Tip See “Autodilution Using the ESI prepFAST II Method” on 
page 14-24 for details on how to create a prepFAST configuration 
and a prepFAST template.

Tip Refer to the Installation Manual of your peripheral.
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2. Select the Configuration you wish to load, see Figure 4-22.

3. Click OK.
The selected Configuration is loaded and shown in the header of the 
Dashboard page.

Checking the System Status

Before starting a measurement, the system status should be checked on 
the Dashboard of Qtegra.

Figure 4-22. Select Configuration window
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❖ To check the system status

1. On the Dashboard page, check the values and indicators of each 
subsystem, see Figure 4-23.

A green Get Ready indicator signals the system is ready for 
operation.

Adjusting System Parameters

The system parameters can be adjusted on the Dashboard page of 
Qtegra.

❖ To adjust the system parameters

1. On the Dashboard page, enter new values for an iCAP OES 
Spectrometer parameter, for example, Pump Speed, see Figure 4-24.

Figure 4-23. System Statuses on Dashboard

Figure 4-24. Adjusting system value on the Dashboard
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2. Click inside any other edit box.
The Apply button becomes available, see Figure 4-25.

3. Click Apply.
The values are applied immediately.

Figure 4-25. Applying values on Dashboard
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LabBooks Page
On the LabBooks page of Qtegra, see Figure 4-26, LabBooks are 
created and opened.

A LabBook that has not been scheduled includes the Method 
Parameters, the Sample List for the measurement, and Automatic 
Export settings. LabBooks created from a Template inherit the Method 
Parameters from the Template. The Sample List for the measurement is 
in this case generated from the Sample Definition of that Template.

Data of analytical concentrations, raw intensities and other data formats 
can be defined to be automatically exported from a LabBook, either to 
an associated LIMS system or as Report documentation.

Once a LabBook is running, an Evaluation Results view allows you to 
see the results in real time. Upon completion of a scheduled LabBook, 
all raw intensities and concentrations are stored within the LabBook.

Additionally, for LabBooks that have finished acquiring data and have 
exited the Scheduler, there are Reports, Log Messages, Query and 
Signing views. See “LabBooks” on page 6-1 for details on LabBooks.

Figure 4-26. LabBooks Page of Qtegra

Tip Any values entered that are not within the given range are marked 
with an exclamation mark.
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❖ To open the LabBooks page of Qtegra

1. On the Qtegra - [Home Page] navigation pane, click LabBooks.
The LabBooks page of Qtegra opens.

Opening a LabBook

LabBooks are opened either from the LabBooks page of Qtegra, which 
is described here, or from the File Manager page, see “File Manager 
Page” on page 4-51.

❖ To open a LabBook in Qtegra

1. Open the LabBooks page of Qtegra.

2. Below , click Open.

The Browse for LabBook window opens, see Figure 4-27.

3. Select a LabBook.

4. Click OK to open the LabBook.
The LabBook opens in a new tab in the Qtegra tool.

Figure 4-27. Browse for LabBook window
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❖ To open a Recent LabBook

1. On the LabBooks page, click a LabBook in the Recent LabBooks 
section, see Figure 4-28.

The selected LabBook opens in a separate tab.

Creating LabBooks

Selecting the Desired Configuration

Every measurement is controlled by a LabBook. This means that you 
must create LabBooks as often as you run an experiment. To optimize 
this creation process, a LabBook is created by use of existing data and 
defined actions. A Template consists of three sections that describe 
Initial Actions, Continuing Actions and End Actions. See “Defining 
QC Settings in Sample Definition (eQuant only)” on page 9-43 for 
details. Every LabBook is based on a Template that provides the 
experiment structure and individual sample data that define your 
experiment.

As Qtegra User, make sure to create a LabBook that uses the desired 
Configuration.

Figure 4-28. Recent LabBooks
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❖ To create a pre-configured LabBook

1. On the Dashboard page, click the thumbnail of your instrument in 
the top right corner.
The Select Configuration window opens.

2. From the Configurations list, double-click the desired item to load 
this Configuration. The headline changes to “Dashboard - <Name 
of Configuration>”.

LabBooks are created from blank Templates, existing Templates or from 
existing LabBooks on the LabBooks page of Qtegra.

There are 2 ways of filling the Template with sample data:

• Type the amount of samples.

-or-

• Import samples from a CSV file, for example, from a LIMS system.

After loading your specified number of samples into your LabBook you 
must enter additional data for all these samples, i.e., the columns of the 
Sample List are actually left blank. You need to add the Label, the 
position inside the autosampler (Rack, Vial), the Amount and Dilution. 
As your LabBook may contain a large number of samples, you can use a 
CSV file and a CSV Import (page 4-25) to directly import all these 
sample data into your LabBook. See the following steps when using the 
import method.

CSV Import

If you find sample definition headers, for example, used in your LIMS 
system, that do not match with the Sample List headers used in Qtegra, 
an Administrator can create a file providing the CSV structure. The 
CSV structure is controlled by a mapping file that can be edited with a 
standard text editor. Save this file in UTF-8 encoding with “.xml” as file 
extension under 
C:\ProgramData\Thermo\Qtegra\_Application Data\SampleLists\TranslationTable.

For a typical mapping file, see left-hand image in Figure 4-29.
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The mapping file corresponds to an Excel sheet that contains the item 
name as header in the first row. All recurring <Item> tags must apply to 
the number of columns in your Excel sheet.

For example, <Name>Name</Name> from the LIMS is translated to 
<Translation>Label</Translation> for Qtegra.

Figure 4-29. Example of XML mapping file for use of CSV import; right-hand image shows use of special characters

Tip Ensure that you use the exact column header as used in Qtegra. 
For example, Qtegra recognizes ml for milliliter and not mL.
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A typical translation of LIMS import is shown in Table 4-1.

For details on using the character reference, refer to 
https://en.wikipedia.org/wiki/Numeric_character_reference.

❖ To import LabBook data from CSV

1. Save your Excel file with the sample data as “CSV (comma 
delimited)” to create the CSV file for the import of sample data into 
your LabBook. Check the delimiter in the CSV file and adapt the 
<Delimiter> entry inside the mapping file if necessary.

Leave the samples file on a network drive, a shared folder, or a local 
drive before continuing.

2. Open the LabBooks page, type a name for your LabBook and select 
a Location.

Table 4-1. Example of LIMS import

Qtegra Sample List <Translation> What the LIMS supplies <Name>

Label Name

Dilution factor DF

Amount Sample Weight

Final Quantity Final Volume

Rack Number AS Rack

Vial Numbers Vial

Tip The use of special characters, such as “é” is not supported by the 
XML standard. To be able to enter special characters in the XML 
mapping the appropriate numeric reference must be used. To use a 
numeric character reference, enter an ampersand “&” followed by the 
pound sign “#”, the decimal code number and a semicolon, for 
example, “&#233;” will generate “é” (see right-hand image in 
Figure 4-29).

Figure 4-30. Excel file and corresponding CSV file with sample data

Tip The name must be unique, otherwise Qtegra displays a red 
exclamation mark and the creation process is interrupted.

https://en.wikipedia.org/wiki/Numeric_character_reference
https://en.wikipedia.org/wiki/Numeric_character_reference
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3. From the Template Name list, select the desired Template.

4. Check Import from CSV to enable the following list boxes.

5. Click [...] to search for your CSV file. Next time you may only select 
the CSV file from the list.

6. Click [...] to search for your mapping file with “.xml” extension. 
Next time you may only select the XML file from the list.

7. Click Create LabBook to generate the LabBook table with all 
specified contents. Qtegra switches to display the Sample List, see 
Figure 4-31.

Creating a LabBook

You can either create a LabBook from the LabBooks page or from an 
already opened Template.

❖ To create a LabBook from an opened Template

1. The Template toolbar offers a button to create a LabBook. See 
“Template Toolbar” on page 5-2.

Figure 4-31. Sample List filled with sample data



Qtegra
LabBooks Page

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 4-29

❖ To create a LabBook in Qtegra

1. Open the LabBooks page of Qtegra. On first run, no Recent 
LabBooks is shown. Perform step 2 to step 4 to create your LabBook.

2. Type a Name for the LabBook.

3. Select a Location (see Figure 4-32) for your desired folder.
Qtegra starts with “LabBooks” as default location. We recommend 

Figure 4-32. Typing the Name for a new LabBook
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individual folders per user, “Toms Files”, for example. See 
Figure 4-33.

4. To create a new LabBook select one of the following options:

a. Create a new LabBook from an existing Template
Choose this option, when your LabBook shall base on a 
template that is shipped with this software or that was created in 
the past. Templates are stored on your system. This option may 
be used generally to compile the LabBook from an unmodified 
Template and a Sample List from a CSV file (see “CSV Import” 
on page 4-25).
Select a Template Name from the drop-down list. Type a 
number for Samples. If a Sample List is available, select Import 
from CSV, and select a CSV name and a Mapping Name from 
the drop-down list to run the import.

b. Create a new LabBook from an existing LabBook
Choose this option, when your LabBook shall base on a 
formerly used LabBook that is selected from the LabBook 
Name drop-down list. All sample lines are set back to initial 
values. This option is used, when a measurement failed and 
needs to be scheduled once again.

Tick the Import Calibration check box to use the calibration 
curves from the existing LabBook. See “Importing Calibration 
Data from an Existing LabBook” on page 4-32 for details.

Alternatively, open a LabBook and copy it to create a new 
LabBook. See “Copying an existing LabBook” on page 4-31 for 
details.

c. Create a new LabBook from a blank Template
Choose this option, when you want to create a LabBook for a 
new analysis method without having Method Parameters (see 
“Method Parameters Settings” on page 9-3 for defining). You 

Figure 4-33. Creating new LabBooks folder
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may develop analytes, Measurement Modes and Sample Lists. 
Select an Evaluation from the drop-down list.

5. Click Create LabBook to display your new LabBook. During this 
procedure the message “Loading Workspace, please wait” is 
displayed.

6. On the Content pane, click Sample List to check the Sample List 
parameters.

The final Sample List is defined by the number of samples selected 
when creating a LabBook. The Sample List in the LabBook is 
created from the parameters defined in “Sample Definition for a 
Template” on page 5-5.

7. Click Automated Export to define the data for export.
See “Automatic Export - Template” on page 5-10 for details.

8. On the toolbar of the LabBook page, click Save to save your 
LabBook.

Copying an existing LabBook

A common method to create a LabBook uses existing LabBooks that ran 
already. You have the choice to exclude desired entries before creating a 
new LabBook. The advantage of this method is the reliability of your 
source LabBook that ran successfully.

❖ To copy an existing LabBook

1. Open the File Manager page of Qtegra, and select your source 
LabBook.
The LabBook opens as its own tab.

2. Optionally, exclude unwanted values as follows:

a. In the Concentrations table, select the concentration of 
elements that are unwanted to calculate the calibration curve, 
see Figure 4-34.

b. To remove unwanted concentration values resulting from the 
last calibration, right-click to open the shortcut menu and select 
Exclude entry, see Figure 10-36.
Point to another cell. The entry is displayed light-gray to 
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indicate the exclusion. The calibration curve is calculated 
without the excluded value.

c. In case of accidental exclusion, click the light-gray cell and select 
Include entry from the shortcut menu.

3. Save the modified LabBook.

4. Finally, select Create > New LabBook to generate a new LabBook.

The new LabBook is based on all source data except the following:

• All suspended entries

• All excluded entries

• Samples that where added during QC

All entries are set to be evaluated, that means all entries in the Evaluate 
column are checked and used in the Evaluation Results, Exports, 
Queries, and Reports.

Importing Calibration Data from an Existing LabBook

When you wish to create a new LabBook from an existing LabBook, you 
can copy the calibration curves to skip the time-consuming calibration 
lines, which shortens the overall runtime. Another advantage of this 
method is the reliability of your source LabBook that ran successfully 
and contains a sufficient calibration.

Figure 4-34. Included and excluded concentration
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❖ To import calibration data from an existing LabBook

1. Open the LabBooks page of Qtegra, and select the Create a new 
LabBook from an existing LabBook option based on your source 
LabBook.

2. Tick Import Calibration to import the calibration data into the 
new LabBook.
The calibration data will then be shown in your LabBook and in the 
evaluation results.

3. Click Create LabBook.
The new LabBook opens as its own tab. The Sample List is created 
according to the existing LabBook and shows the status of the initial 
BLK and STD samples already green indicated.

4. When you schedule this LabBook, the measurement starts with the 
first sample line that is not already finished, that means, it does not 
show a green indicator. In the example (see Figure 4-36, right-hand 
image) the measurement is starting with sample line 4 Blank 
solution.

Figure 4-35. Import Calibration check box

Tip This check box is only available if the existing LabBook 
contains a calibration.

Tip Only successful analyses from the calibration block are 
imported. If, for example, one of the analyses in the calibration 
block fails due to a QC failure, then this failing analysis is not 
copied across into the created LabBook.

Labeled Components: left-hand=finished LabBook, right-hand=new 
LabBook

Figure 4-36. Sample list with imported calibration data
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Editing a LabBook

LabBooks are edited in Qtegra. Editing a LabBook involves a number of 
parameters, see “LabBooks” on page 6-1 for a complete description of 
LabBooks.

❖ To edit a LabBook

1. From the LabBooks page, open your LabBook.

2. Edit your LabBook.
See also “Method Parameters Settings” on page 9-3 and “Sample 
List of LabBook” on page 6-13.

3. On the toolbar of your LabBook page, click Save to save your 
LabBook.

Deleting a LabBook

LabBooks are deleted on the File Manager page of Qtegra.

❖ To delete a LabBook

1. On the File Manager page, click the LabBooks folder (or the 
subfolder for the LabBook you wish to delete), see Figure 4-37.

Figure 4-37. File Manager - LabBooks
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2. Right-click the LabBook you wish to delete in the right-hand list.
A shortcut menu opens, see Figure 4-38.

3. Select Delete from the shortcut menu.
The LabBook is deleted.

Closing a LabBook

LabBooks are closed in Qtegra by clicking the appropriate button on the 
toolbar of the LabBook or by simply closing the tab of the LabBook.

❖ To close a LabBook

1. On the toolbar of your LabBook page, click Close to close your 
LabBook.

-or-

Click Close in the tab of the LabBook.

Figure 4-38. Shortcut menu of the File Manager
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Templates Page
On the Templates page of Qtegra, see Figure 4-39, Templates for your 
methods are created and opened.

A Template contains all basic information on analytes, acquisition 
parameters, standards and sample definitions as well as Automatic 
Export settings. Templates are generally created by the Administrator for 
different types of applications. Once a Template is created and saved, it 
can serve as the basis for different analytical measurements (LabBooks).

❖ To open the Templates page of Qtegra

1. On the Qtegra - [Home Page] navigation pane, click Templates.
The Templates page of Qtegra opens.

Figure 4-39. Templates Page of Qtegra

Tip Any values entered that are not within the given range are marked 
with an exclamation mark.
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Opening a Template

Templates are opened either from the Templates page of Qtegra, which 
is described here, or from the File Manager page, see “File Manager 
Page” on page 4-51.

❖ To open a Template in Qtegra

1. Open the Templates page.

2. Below , click Open.

The Browse for Template dialog opens, see Figure 4-40.

3. Select a Template.

4. Click OK to open the Template.
The Template opens in a new tab of the Qtegra tool.

Figure 4-40. Browse for Template dialog



Qtegra
Templates Page

4-38 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

❖ To open a Recent Template

1. From the Templates page, select a Template in the Recent 
Templates section, see Figure 4-41.

The selected Template opens in a separate tab.

Creating a Template

Templates are created from blank Templates, existing Templates or 
existing LabBooks in Qtegra. For blank Templates, you need to select a 
system Configuration. Configurations, including peripherals 
(Instruments), are defined by your Administrator in the Experiment 
Configurator applet of the Configurator tool (see “Experiment 
Configurator” on page 3-15).

Figure 4-41. Recent Templates
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❖ To create a new Template in Qtegra

1. On the Templates page, type a Name for the Template and select a 
Location, see Figure 4-42.

2. Select the first option if you wish to Create a blank Template, and 
select a Configuration and an Evaluation from the drop-down lists.
With the selected Configuration a number of predefined sets of 
parameters for the Template, for example, instrument and 
peripheral settings, are automatically loaded.

3. Select the second option if you wish to Create a new Template 
from an existing Template and select a Template Name from the 
drop-down list.
-or-
Type the Template name or browse  to choose it.

4. Select the third option if you wish to Create a new Template from 
an existing LabBook and select a LabBook Name from the 
drop-down list.
-or-
Type the LabBook name or browse  to choose it.

5. Click Create Template to create the new Template.
A new tab opens for the new Template.

6. In the tab of your Template, define the Method Parameters.
See “Method Parameters Settings” on page 9-3 for details.

7. Click Sample Definition to set up the Sample List parameters.
See “Sample Definition for a Template” on page 5-5 for details.

The final Sample List is defined by the number of samples selected 
when creating a LabBook. The Sample List in the LabBook is 
created from the parameters in Sample Definition in the Template.

8. Click Automated Export to define the data for export. See 
“Automatic Export - Template” on page 5-10 for details.

Figure 4-42. Typing the Name for a Template
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9. On the toolbar of your Template page, click Save to save your 
Template.

Editing a Template

Templates are edited in Qtegra. See “Templates” on page 5-1 for a 
complete description of the parameters involved.

❖ To edit a Template in Qtegra

1. From the Templates page, open your Template.

2. Edit the Method Parameter settings.
See “Method Parameters Settings” on page 9-3 for details.

3. Edit the Sample Definition settings.
See “Sample Definition for a Template” on page 5-5 for details.

4. On the toolbar of your Template, click Save to save your Template.

Closing a Template

Templates are closed by clicking the appropriate button on the toolbar 
of the Template or by simply closing the tab of the Template.

❖ To close a Template

1. On the toolbar of your Template, click Close to close your 
Template.

-or-

Click Close in the tab of the Template.
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LabBook Query Page
On the LabBook Query page of Qtegra, you define the location of the 
LabBooks and the period of time measurements were done, see 
Figure 4-43, and parse through the available results.

You can then narrow down the query for the LabBooks meeting these 
criteria by further defining Instrument, Evaluation type and Template.

Figure 4-43. LabBook Query Page of Qtegra
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On the resulting Query page, you select the data you wish to view, see 
Figure 4-44.

For details, see “Displaying Result Data” on page 4-43 and “Managing 
Results Data Presets” on page 4-46.

Figure 4-44. LabBook Query Page of Qtegra Query view
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Reports of the selected data are created on the Reports view of a 
LabBook Query Result page, see Figure 4-45.

For details, see “Generating Reports” on page 4-47 and “Getting Started 
with Qtegra Reports” on page 8-2.

❖ To open the LabBook Query page of Qtegra

1. From the Qtegra - [Home Page] navigation pane, click LabBook 
Query.
The LabBook Query page of Qtegra opens.

Displaying Result Data

The parameters of a measurement are set to be displayed on the 
LabBook Query page of Qtegra.

❖ To display the result data on the Result page of Qtegra

1. Open the LabBook Query page.

2. In the Parameters view of the LabBook Query page, select the 
Location from the drop-down list.

Figure 4-45. LabBook Query Page of Qtegra Reports view
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3. Type the Pattern and select the date for Modified when the 
LabBooks were acquired, see Figure 4-46.

If you type * (asterisk) in the Pattern field, all LabBooks in the 
folder are searched. Type an asterisk followed by a fixed string and 
another asterisk (for example, *fast*) to return all LabBooks with 
the string “fast” in the name, which may refer to all prepFAST 
LabBooks. The search string is not case-sensitive. As an alternative, 
type wrk37* to collect all LabBooks with a name starting with 
“wrk37” to indicate, for example, the employee number 37.

4. Click Find to start the search for LabBooks that match the defined 
values.
The LabBooks field displays the first entries in the list of results, see 
Figure 4-47.

5. Select Instrument, Evaluation and Template from the drop-down 
lists.

6. For Samples, type the Label as in the Sample List, for example, 
Sample 1.

Figure 4-46. Files section in LabBook Query page

Figure 4-47. LabBooks found in LabBook Query page
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7. Click run query to start the query.
Qtegra collects the data, see Figure 4-48.

8. In the left pane, select the check boxes for the data you wish to 
display.

The results are displayed when the query has been executed, see 
Figure 4-49.

9. Click Refresh to refresh the display.

Figure 4-48. LabBook Query page collecting data in Qtegra

Figure 4-49. LabBook Query page displaying results in Qtegra
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10. Click Hide if you wish to hide the units.
The columns Unit are hidden. Repeat to display the units again.

Managing Results Data Presets

In Qtegra, the display options for result data of a measurement can be 
saved as presets, see Figure 4-50.

❖ To save a result data preset

1. From the LabBook Query page, select the results you wish to display 
as described in “Displaying Result Data” on page 4-43.

2. Above the results table, click Save as to save the preset as new preset.
The Save New Preset dialog is displayed, see Figure 4-51.

3. Type a Name for the preset.

4. Type a Description.

5. Click OK.
The preset is added to the list.

Figure 4-50. Results display presets on LabBook Query Page of Qtegra

Figure 4-51. Save New Preset dialog in Qtegra

Tip Result data presets saved here will be available as well in the 
Query view of a completed LabBook.
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❖ To save a preset

1. From the LabBook Query page, select the results you wish to display 
as described in “Displaying Result Data” on page 4-43.

2. Select a preset from the drop-down list.
The data is displayed according to the selected preset.

3. Change column widths or select different check boxes on the left to 
change the presented data.

4. Click Refresh to refresh the display.

5. Click Save to save the result data preset.

❖ To delete presets

1. From the LabBook Query page, select the results you wish to display 
as described in “Displaying Result Data” on page 4-43.

2. From the Preset list, select the preset you wish to delete.

3. Click Delete to delete the result data preset.
The Delete Preset dialog is displayed, see Figure 4-52.

4. Click Yes.
The preset is deleted from the list.

Generating Reports

In the Reports view of the LabBook Query page of Qtegra, you 
generate result data Reports from presets.

Generally, you can structure your Report to your needs, add headings, 
tables and graphs to specify the presentation of the result data.

❖ To open the Reports view on the LabBook Query page

1. From the LabBook Query page, display your result as described in 
“Displaying Result Data” on page 4-43.

Figure 4-52. Delete Preset dialog in Qtegra

Tip For details on creating Report presets, see “Getting Started with 
Qtegra Reports” on page 8-2.
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2. In the LabBook Query Result view, select the Reports tab.
The Reports page opens, see Figure 4-53.

❖ To generate a Report

1. From the LabBook Query page, display your result as described in 
“Displaying Result Data” on page 4-43.

Figure 4-53. LabBook Query Reports page
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2. In the LabBook Query Result view, select the Reports tab.
Previously defined Reports are listed on the left pane, see 
Figure 4-54.

3. From the left pane, select a Report from the list and then

Click Execute Report.

-or-

Click Update above the list.

Figure 4-54. LabBook Query Reports page showing defined Reports

Tip In a completed LabBook, this is the Reports page of the 
Query view.
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The Report is generated as defined in the Report layout selected and 
displayed in the Report Preview on the right pane, see Figure 4-55.

4. Print the Report.

-or- 

Save the Report if desired.

Figure 4-55. LabBook Query Reports page showing an executed Report
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File Manager Page
On the File Manager page of Qtegra, see Figure 4-56, you organize 
your Template and LabBook files as well as the Reports generated by the 
Get Ready process.

❖ To open the File Manager page of Qtegra

1. From the Qtegra - [Home Page] navigation pane, click File 
Manager.
The File Manager page of Qtegra opens.

❖ To open a Template from the File Manager page of Qtegra

1. From the File Manager page, select the Templates directory.

2. Double-click the Template you wish to open.
The Template is opened in a new tab.

❖ To open a LabBook from the File Manager page of Qtegra

1. From the File Manager page, select the LabBooks directory.

2. Double-click the LabBook you wish to open.
The LabBook is opened in a new tab.

Figure 4-56. File Manager Page of Qtegra
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❖ To create a new folder in the Workspace

1. From the File Manager page, right-click Workspace to create a new 
folder, see Figure 4-57.

2. Select New Folder from the shortcut menu.

3. Type a name for the new folder.

4. Click anywhere in the folder.
-or-
Press <Enter>.
The new folder is accepted.

❖ To create a new folder in LabBooks or Templates

1. From the File Manager page, right-click the LabBooks or 
Templates folder to create a new folder, see Figure 4-58.

Figure 4-57. Shortcut menu File Manager Workspace

Tip When you have created a very long path to a folder under 
Windows, Qtegra cannot use this path to read or save files. To indicate 
this behavior, Path too long is displayed in the folder tree of the File 
Manager.

Figure 4-58. Shortcut menu File Manager subfolder
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2. Select New Folder from the shortcut menu.

3. Type a name for the new subfolder.
The first subfolder is shown on the right.

4. Click anywhere in the Workspace.
-or-
Press <Enter>.
The new subfolder is accepted.

❖ To create a network link to a folder in LabBooks or Templates

1. From the File Manager page, right-click the LabBooks or 
Templates folder for which you wish to create a link to a network 
folder.

2. Select Create Link to Folder from the shortcut menu, see 
Figure 4-59.

3. In the Select Folder dialog, select the folder you wish to create the 
network link to.

4. Click Select Folder.

Figure 4-59. Shortcut menu File Manager subfolder showing Create Link 
to Folder

Tip Your Administrator must have prepared the Windows system, 
refer to Central Data Storage.
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5. Enter a name for the new folder, see Figure 4-60.

6. Enter a name for the new folder.

7. Click anywhere in the folder.
-or-
Press <Enter>.
The new name is accepted.

Managing Files

On the File Manager page of Qtegra, you can explore, cut, copy, delete, 
rename, or export your Templates and LabBook files.

❖ To cut a Template or LabBook file

1. From the File Manager page, select the folder, for example, LabBooks 
to show the file you wish to cut.

Figure 4-60. Naming new network link to folder

Tip Be careful when you store data to the network location. 
LabBooks should not be opened in several locations at the same 
time.
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2. Right-click the file you wish to cut, see Figure 4-61.

3. Select Cut from the shortcut menu.

4. Select the new folder.

5. Right-click in the new folder, see Figure 4-62.

6. Select Paste from the shortcut menu.
The file you cut is moved to the selected folder.

❖ To copy and paste a Template or LabBook file

1. From the File Manager page, select the folder, for example, LabBooks 
to show the file you wish to copy.

Figure 4-61. Shortcut menu of file for cut

Figure 4-62. Shortcut menu of file for paste



Qtegra
File Manager Page

4-56 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

2. Right-click the file you wish to copy, see Figure 4-63.

3. Select Copy from the shortcut menu.

4. Select the location for the file.

5. Right-click and select Paste from the shortcut menu.
The file is copied to the selected location.

❖ To delete a Template or LabBook file

1. From the File Manager page, select the folder to show the file you 
wish to delete.

2. Right-click the file you wish to delete, see Figure 4-64.

Figure 4-63. Shortcut menu of file for copy

Figure 4-64. Shortcut menu of file for delete
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3. Select Delete from the shortcut menu.
A confirmation dialog opens, see Figure 4-65.

4. Click Yes.
The file is deleted.

❖ To rename a Template or LabBook file

1. From the File Manager page, select the folder to show the file you 
wish to rename.

2. Right-click the file you wish to rename, see Figure 4-66.

3. Select Rename from the shortcut menu.

4. Type the new name for the file.

5. Click anywhere in the folder.
-or-
Press <Enter>.
The new name is accepted.

❖ To export a Template or LabBook file

From the File Manager page, you can export files from the Qtegra ISDS 
Workspace by generating a copy of the original file.

Figure 4-65. Confirmation dialog to delete file

Figure 4-66. Shortcut menu of file for rename
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1. From the File Manager page, select the folder to show the file you 
wish to export.

2. Right-click the file you wish to export, see Figure 4-67.

3. Select Export from the shortcut menu.
The Browse For Folder dialog opens, see Figure 4-68.

4. Select a folder and click OK.
The selected file is copied to the selected destination.

Displaying additional File Information

The columns shown in the File Manager can be manually selected to 
show additional information as required. The choice of columns 
displayed is defined from a shortcut menu.

Figure 4-67. Shortcut menu of file for export

Figure 4-68. Browse For Folder dialog
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❖ To display additional file information

1. From the File Manager page, select a folder to define the columns 
displayed.

2. Right-click the table header to show a shortcut menu.

3. The choices provided in the shortcut menu are described in 
Table 4-2.

Tip The column choice defined is then displayed to all folders.

Table 4-2. File Manager page - shortcut menu commands

Menu Command Description

Size Column 
To Fit

Resizes the width of the currently selected 
column to display all its contents.

Size All 
Columns To 
Fit

Resizes the width of all columns to fully display 
their contents.

Name The file name.

Type The Folder, LabBook, Report, or Template to 
specify the file type.

Created The original creation date of this file. Do not mix 
with File Created.

Type Specifies the file as Folder, LabBook or Template.

Modified The date of last modification.

Size The file size in KB (kilo bytes).

Configuration The name of the Configuration used (LabBooks 
only).

Configuration 
Description

The description for the Configuration used for a 
LabBook.

Created By The user name of the Windows user account who 
created the file.

Template The Template the LabBook was created from 
(LabBooks only).

Last Changed 
By

The user name of the last Windows user account 
to save the LabBook.

Samples The number of samples in the LabBook.

Results The number of measured samples.

Acquired By The user name of the Windows user account who 
measured the LabBook.

Started At The date and time when LabBook measurement 
started.



Qtegra
File Manager Page

4-60 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

Setting File Permissions

With Qtegra ISDS Software 2.8 SR3, the file access may be managed by 
permissions. The Permissions dialogs appear like original Windows 
dialogs but the file service controls its own permissions inside Qtegra.

Defining Permissions

With access to the Permissions dialogs, you define the Access rights by 
selecting a principal and setting the permissions respectively at the file or 
folder level you currently have selected.

❖ To enable the Permissions feature

1. In the Configurator tool, select the Access Control applet.

2. Expand User Actions > File Manager > All Items to select the 
Permissions item.

3. The right pane shows the Access mode for 6 default User Groups. 
Initially, only the Administrator group has Full access to the 
Permissions feature. All other groups have restricted Read only rights.

4. Select the User Group and switch to Full access to grant the members 
of the group full access to the Permissions feature.

5. Restart Qtegra to apply the new settings.
The Permissions shortcut menu item is then available (see 

File Created The date and time when the LabBook or 
Template was created in the displayed folder. Do 
not mix with Created.

Finished At The date and time when LabBook measurement 
finished.

File Modified The date and time when the file was last 
modified.

More... Opens the Choose Columns dialog to select the 
desired columns and to arrange the columns sort 
order.

Table 4-2. File Manager page - shortcut menu commands, continued

Menu Command Description

Tip To be compatible with earlier Qtegra versions, no changes in the 
Configurator lead to the same behavior as before. Without 
permissions, the file access is only controlled by the settings under 
User Actions > File Manager > Files, Folders, LabBook, Report, and 
Template.
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Figure 4-69). User Groups with Read only rights see the inactive 
menu item and can not open the Permissions dialogs.

As an example on how to grant permissions, a member of Qtegra Users 
shall get Read only permissions on the LabBooks > Example Files folder.

❖ To set Read only permission for a LabBook folder

1. As an Administrator open Qtegra ISDS and select the File Manager 
page.

2. Expand the folder tree and select the folder, which access shall be 
restricted for Qtegra Users or Qtegra User Groups, for example, the 
QtegraAnalyst. 

3. Right-click the folder and select Permissions.

The Permissions dialog opens and initially shows no entry.

Figure 4-69. Shortcut menu of folder for Permissions

Figure 4-70. Empty Permissions dialog
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4. Click Add to add a principal and to set the permissions in the initial 
Permissions dialog.

5. Click Select a principal to select a user or a group.

a. Depending on the user management, the Location shows your 
Windows computer name or domain. Click Locations to select 
another location.

b. In the lower box, enter the object name for the principal. 

In case of Windows user management, the name appears as 
“Location\Username”. Enter, for example, thermo and click 
Check Names to autofill the box, resulting in 
“THERMO-PC\Thermo”. See left image of Figure 4-72.

-or-

In case of a domain using an Active Directory, the name appears 
as used company-wide. Enter, for example, thermo and click 
Check Names. In most cases, the Multiple Names Found 
dialog opens to show all matching names. Select the desired 
name and click OK to fill the Object Name box. See right 
image of Figure 4-72.

Figure 4-71. Initial Permissions dialog

Figure 4-72. Select User or Group dialog - left: local user group, 
right: domain account
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c. If you do not know the exact object name, click Advanced to 
open the Select User or Group dialog where you can search for 
the object.

d. Enter all known parts of the object and click Find Now to show 
the results. 
-or-
Leave the Name and Description empty and click Find Now to 
show the entire list with all available objects.
Double-click the desired entry to fill the Object Name box.

e. If your PC is connected to the Internet, click examples to show 
the explanations from the Microsoft TechNet webpage.

f. To remove objects that have been added by accident, just select 
the object and press <Del> on your keyboard.

Figure 4-73. Advanced Select User or Group dialog

https://technet.microsoft.com/library/dn789205
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6. The selected principal is displayed on top of the initial Permissions 
dialog.

7. To define the permission, tick the desired box under Basic 
permissions.
-or-
Click Show advanced permissions to define detailed permissions.

See Table 4-3 for a description of basic permissions.

Figure 4-74. Permissions dialog with principal

Tip All changes in the file structure, like creation, renaming or 
deletion of a folder, affect only the subfolders of the Qtegra 
Workspace. As soon as a file or folder is copied to another 
directory, the permission is lost.

Table 4-3. Basic permissions description

Permission Description

Full Control Allows all operations to be performed by the 
principal and equals the sum of Read and 
Write.

Read The principal can read the Template or 
LabBook file, that means, the file can be 
opened but not modified.
The principal can create a new Template or 
LabBook based on a file with Read permission. 
Note that the file is locked if no Modify 
permission is set, see the following example:
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See Table 4-4 for a description of advanced permissions.

Write With this permission all advanced permissions 
are included. Note that Read is not included.

Custom This permission is always disabled and only 
activated if an advanced permission is set.

Table 4-4. Advanced permissions description

Permission Description

Create files The principal can create a Template or 
LabBook. Note that creation does not include 
the Read, Modify or Execute permission.

Create folders Allows the principal in the File Manager to 
create a folder below the currently selected 
folder. With missing permission, the following 
dialog opens:

Rename files Allows the principal in the File Manager to 
rename a file. 

Rename folders Allows the principal in the File Manager to 
rename a folder.

Modify files This permission is necessary to modify the 
Template or LabBook. If the principal is 
granted with additional Read permissions, it 
also includes the initial steps after creation like 
setting up the analytes and standards. The file 
is locked if no Modify permission is set.

Delete files Allows the principal in the File Manager to 
delete a file. With missing permission, the 
following dialog opens:

Table 4-3. Basic permissions description, continued

Permission Description
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❖ To view or edit permissions

1. Select the File Manager page.

2. Expand the folder tree and select the folder, which permissions shall 
be viewed for Qtegra Users.

3. Right-click the folder and select Permissions. The Permissions 
dialog (see Figure 4-75) shows the currently defined access rights 
and optionally where the permissions are inherited from.

4. Select the principal entry and then click View (if inherited) or Edit 
to show the detailed permissions.

Delete folders Allows the principal in the File Manager to 
delete a folder.

Execute The principal can schedule the LabBook.

Figure 4-75. Permissions dialog with list of principals

Figure 4-76. Permissions dialog with advanced permission view

Table 4-4. Advanced permissions description, continued

Permission Description
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5. Click Show advanced permissions and clear or tick a check box to 
update the permissions as required.

Using Permissions

The following example explains how to use permissions. Imagine, your 
company analyses food and environmental samples.

In the example, ‘LabBooks’ is set up with Read permission for all 
principles using Qtegra. The ‘Shared’ folder has Write permission for 
both groups. The ‘Food’ folder has Write permission for the food group, 
and the ‘Enviro’ folder has Write permission for the environmental 
group.

This isolates the group folders ‘Food’ and ‘Enviro’ from being modified 
by the other domain group.

If your company uses Active Directory groups, this kind of restricting 
access to folders is the easiest and best way of administering Qtegra 
permissions.

If not, and you use local PC accounts, you will have to repeat setting up 
the permissions on every instrument PC.

If your company uses domain groups to allow or deny access to another 
user, you only add or remove the user to or from that group, and all 
instrument PCs will see the change.

Tip Any permission granted on a folder affects all files and folders 
below this file structure. All properties are inherited. If you define 
additional permissions on a lower file or folder level, the resulting 
permission is a combination of both settings.

Figure 4-77. Example for a folder hierarchy
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For new group members, simply add them to the respective domain 
group, ‘Food’ or ‘Enviro’, and they will automatically have the correct 
desired access on all instruments.

Displaying Reports

Once the performance check and tuning of the instrument is executed, 
the resulting data is generated and provided under 
File Manager > Workspace > Reports.

Expand the Reports item and select the subfolder as desired.

Figure 4-78. Reports tree on File Manager view
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System Log Page
The System Log page, see Figure 4-79, provides information about 
changes to the system as it may be required by your SOP. For details, for 
example, to enable compliance settings via Enable global compliance, 
refer to “Compliance with your SOP” on page 2-37.

Many customers, for example, pharmaceutic companies, want to set up 
the environment that it complies with 21 CFR Part 11. This page of the 
Qtegra ISDS Software allows to check your system regarding changes in 
special settings. The System Log keeps all system data. Qtegra ISDS 
extracts the relevant part and displays this part as a table that may be 
configured by the user.

❖ To open the System Log page of Qtegra

1. From the Qtegra - [Home Page] navigation pane, click System 
Log.
The System Log page opens.

The System Log displays a collection of compliant events initiated 
by Windows and Qtegra. The events are displayed as a list, which 
provides several functions to focus on the desired data. All 
information is collected from the Operating System and therefore 
displayed in more or less internal descriptors.

Figure 4-79. System Log Page of Qtegra

Tip System logs must be activated by setting the 
Enable compliant system log value in the Configurator to True. 
When set to False, no further events are collected but the existing 
entries may be displayed.
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By default, the list shows 6 columns that are explained in Table 4-5.

Filters are set on top of the System Log page, see Figure 4-80.

Initially, no entries are shown as no filter is active and Show All is 

not ticked.  is set by default to reduce the 
system load, that means, no further log entries are appended to the 
list but are collected in the background. With Show All enabled, 
events initiated by all users including, for example, System, Computer 
name, Network Service, and Local Service are shown.

❖ To filter the System Log

1. To reduce the amount of list entries and to focus on desired items, 
you may set a filter.

Table 4-5. System Log columns

Column Content

Occurred at Date and time stamp of the logged event.

Event Description of the event that is logged. Open 
the Category listbox above the list to see all 
possible events.

Username Name of the originator, who initiated the 
event. Examples are the current Windows 
computer shown as machine name, Windows 
user shown by the login name, Windows 
services shown as System, network service, local 
service, and others.

Event source Windows security eventlog to display Windows 
as originator. Qtegra to display this application 
as originator.

Original event id The Windows events are internally stored with 
an identifier. This id may help to get detailed 
information about the event.

Details If possible, Qtegra displays details about the 
event to show precise logged events, like setting 
values.

Figure 4-80. Filter settings on top of System Log page

Tip Every filter affects the complete System Log database. The 
displayed list nevertheless reduces the amount of items to 100 rows 
per page.
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2. To filter by Username, type at least a part of the desired name into 
the edit box. Qtegra does not distinguish between upper and lower 
case letters.

Click Apply Filter to update the list view accordingly.

3. To filter by a date or time range, click the triangle that opens a 
calendar sheet to select the begin in the From box and the end in the 
To box, see Figure 4-81.

Click Apply Filter to update the list view accordingly.

4. To filter by Event, open the Category list box and select the item(s) 
you want to focus. The list box always contains all possible events 
independent from the events listed in the System Log.

The selected categories are shown below this list box.
Click Apply Filter to update the list view accordingly.

Figure 4-81. Date selection and Time justification on System Log page

Tip Use the Category filter to focus on events that may contradict 
the rules from your SOP. In the filtered list, check the Details 
column to estimate the impact, see Table 4-6.
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Table 4-6. Events with critical impact on 21 CFR Part 11

Category/Event a Impact/Action

A windows system 
audit policy was 
changed

This event is written whenever a Windows 
setting relevant for auditing is changed. 
This can happen either by Qtegra itself 
when global compliance is established but 
also when the settings are changed 
manually or through a potentially existing 
Windows domain.

Changes by Qtegra can be identified when 
looking at the other events surrounding the 
audit policy change: Qtegra itself will write 
events that it is now going to change audit 
policy settings.

If no such context is found, this event 
indicates modifications originated from 
some other source. In that case, further 
investigation is necessary.

Tip Qtegra will only try to reapply the 
settings for global compliance on system 
restart.

Windows audit 
policies could not be 
applied as configured

Qtegra was not able to activate the 
Windows settings necessary for full 
auditing. After this event, the system is not 
in a compliant state. The reason for this has 
to be further investigated in the Windows 
system event log and may require 
modification of the Windows system or 
domain settings.

System log auditing 
stopped

This event is written when the Windows 
system services belonging to Qtegra are 
stopped either explicitly or during system 
shutdown. System modifications are not 
audited until those services are started 
again.

System log auditing 
is now permanently 
turned off

The setting for global compliance has been 
explicitly set to false and all auditing is now 
turned off until the setting is manually 
activated again.

* A windows user 
account was changed

The credentials of the user account were 
changed, for example, if the user was added 
to or removed from a user group.
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5. To remove a filter, click into the box on top of the System Log view 
and delete the entry.

Click Apply Filter to update the list view accordingly.

❖ To navigate through the results

1. After you clicked Apply Filter, the resulting system log events are 
listed.

2. Below the list, click the navigation buttons to leaf one page forward 
or backward or to scroll to the beginning or end.

3. Drag the slider on the right edge to scroll through the 100 items that 
are shown per page.

4. To suppress continuous updates, set .

* A windows audit 
policy setting differs 
from configuration

This event indicates differences in settings. 
Check both the Windows audit settings 
and the Qtegra configuration.

* A windows audit 
policy setting has 
been modified to 
match configuration

This security policy setting determines 
whether the operating system generates 
audit events when changes are made to 
authentication policy.

* System resources 
for auditing are 
exhausted

This event indicates an extremely high 
period of activity prevented Windows from 
logging a number of security events.

* A windows logon 
was attempted using 
explicit credentials

This event tracks different situations:
• A user connects to a server or runs a 

program locally using alternate 
credentials.

• This event is also logged when a 
process logs on as a different account 
such as when the Scheduled Tasks 
service starts a task as the specified user.

• With User Account Control enabled, 
an end user runs a program requiring 
admin authority. 

a Events marked with an asterisk are not critical regarding to your SOP settings but may 
appear in the System Log.

Table 4-6. Events with critical impact on 21 CFR Part 11, continued

Category/Event a Impact/Action

Tip When  is selected, the list is updated 
every minute. After update, the slider jumps to the first page. 
Therefore, you may lose your current view. The filter values 
remain active.
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❖ To arrange the System Log view

1. To move a column to another position, click the column header you 
want to move, and drag this selection horizontally to the desired 
position.
Arrows indicate the target position. Release the mouse button to 
move the column to the desired position.

❖ To export the System Log

The exported files always contain only the filtered data. To export a 
longer list, reset the filters and the max. rows value before you start to 
export.

1. Expand the Export button and select the file format for the Report.

2. Select Save as HTML to generate a Report that is displayed in the 
Browser.
The Browse For Folder dialog is opened to select the folder where 
you want to save the HTML output.

3. Select Save as PDF to compile a PDF Report that shows the 
(filtered) System Log. 
The PDF is shown in your PDF viewer.
The Save As dialog is opened to select the folder and to type the file 
name of the PDF file.

4. Select Save as RTF to generate a Report that is displayed in 
Microsoft Word or your alternative RTF viewer.
The Save As dialog is opened to select the folder and to type the file 
name of the RTF file.

5. Select Save as XML to generate a Report that is displayed in the 
Browser.
The Browse For Folder dialog is opened to select the folder where 
you want to save the XML output.
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Help Page
The Help page of Qtegra, see Figure 4-82, provides information about 
Qtegra, support and tools.

❖ To open the Help page of Qtegra

1. From the Qtegra - [Home Page] navigation pane, click Help.
The Help page of Qtegra opens.

Support on the Help Page

The Support section on the Help page of Qtegra offers access to the 
Qtegra Help.

❖ To open the Qtegra Online Help

1. On the Help page of Qtegra, click Qtegra Help.
The Software Manual opens in your PDF Viewer tool.

Customizing Home Page Settings

In the Tools section on the Help page of Qtegra, you can customize 
your Home Page settings.

❖ To customize the Home Page settings

1. On the Help page of Qtegra, click Options.

Figure 4-82. Help Page of Qtegra
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2. Under Available on the left pane, select Home Page, see 
Figure 4-83.

3. For Analysis on the right, select the number of entries for LabBook 
Recent List.

4. From the Clear drop-down list, select All entries or Unpinned 
entries if you wish to clear the list.

5. For Template on the right, select the number of entries for 
Template Recent List.

6. From the Clear drop-down list, select All entries or Unpinned 
entries if you wish to clear the list.

7. Click OK.

Customizing Scheduler Settings

In the Tools section on the Help page of Qtegra, you can define your 
Scheduler settings.

❖ To customize the Scheduler settings

1. On the Help page of Qtegra, click Options.

Figure 4-83. Home Page settings in Options dialog of Help page

Tip To customize the Scheduler, you can also click  on the toolbar 
of the Scheduler.
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2. Under Available on the left pane, select Scheduler to define the 
settings, see Figure 4-84.

3. For User Options on the right, select the stop behavior of the 
Scheduler from the drop-down list Stop.

4. Select the Always ask for stop behavior check box if you wish to be 
asked every time.

5. Select the suspend behavior from the drop-down list Suspend.

6. Select the Always ask for suspend behavior check box if you wish 
to be asked every time.

7. For System Options, select the close-down options from the 
Closedown drop-down list.

8. Click  to choose the Export Directory. After installation, this 
directory is set to
C:\ProgramData\Thermo\Qtegra\_Application Data\Workspace\Exports.

9. Type a number for History Entries to specify the maximum entries 
of completed LabBooks (refer to “Completed LabBooks”).

10. Select the Clear entries on start of next queue check box to clear 
the list of completed LabBooks with every start of the Scheduler.

11. For Start Queue, select Automatic if you want the measurement to 
start immediately when a LabBook is added to the Scheduler.

12. Click OK.

Registering Qtegra

The Tools section on the Help page of Qtegra offers access to the 
license manager of Qtegra.

Figure 4-84. Scheduler settings in Options dialog of Help page
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❖ To show details of registration information

1. On the Help page of Qtegra, click Register Qtegra.

2. The Qtegra Registration Manager opens with the Registration 
Overview about the license type, activation type, licensed optional 
features and modules.

3. In the Qtegra Registration Manager window, click Update 
Registration to add additional license keys or to update your 
address data.

For details on registering Qtegra, refer to the Installation Guide.

Information about Plug-ins

When solving problems with the plug-ins or to get information about 
the last changes of the plug-ins used in your instrument environment, 
you can get information about the installed version on this page. This 
may help the support staff or Thermo Fisher Scientific field service 
engineers.

❖ To show detailed information of installed plug-ins

1. On the Help page of Qtegra, click Plug-in summary.
A dialog opens and displays a list of available plug-ins, see 
Figure 4-85.

2. To display the plug-in details, select the desired plug-in on the left 
pane.
The right pane then shows a preview thumbnail of the selected item 
and its full name, description, version number, and the compatible 
Qtegra ISDS Software version number.
The changelog shows the history of changes.

Figure 4-85. plug-in Summary window
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The Plug-in Summary dialog provides the following options.

• Collapse and expand the Instruments and Evaluations plug-ins 
if desired.

• To show generic plug-ins, remove the tick from Hide generic 
plug-ins. A GenericInstrument is a user defined virtual 
instrument for advanced customers.

3. To close this summary view, click Close [×] in the upper right 
corner of the window.
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Scheduler
In the Scheduler tool of Qtegra, the measurement for a scheduled 
LabBook is executed. The completed LabBook is automatically deleted 
from the Scheduler and added to the list of Completed LabBooks.
Tip The Scheduler tab can be moved within Qtegra to change to a 
separate window.
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The buttons to control the Scheduler are summarized in the toolbar of 
the Scheduler, see Table 4-7.

Table 4-7. Control buttons for the Scheduler

Icon Meaning Description

Run Begins scheduling the LabBooks 
waiting in the ready queue.

Suspend Suspends the scheduling of 
LabBooks waiting in the ready 
queue.

Stop Stops the scheduling of LabBooks 
waiting in the ready queue.

Move to Top Moves the selected LabBooks to 
the head of the Scheduler waiting 
queue.

Move Up Moves the selected LabBook up 
one position in the Scheduler 
waiting queue.

Move Down Moves the selected LabBook down 
one position in the Scheduler 
waiting queue.

Move to Bottom Moves the selected LabBooks to 
the foot of the Scheduler waiting 
queue.

Remove Removes the selected LabBooks 
from the Scheduler waiting queue.

Remove All Removes all LabBooks from the 
Scheduler waiting queue.

Options Displays the Scheduler Options 
dialog to define stop and suspend 
behavior and system options 
regarding the close-down behavior, 
the export directory, number of 
history entries, and start queue 
behavior.
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❖ To open the Scheduler of Qtegra

1. From the Qtegra - [Home Page], click Scheduler to open the 
Scheduler tab, see Figure 4-87.

❖ To add a LabBook to the Scheduler and run it

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. On the toolbar of the LabBook, click Schedule to schedule the 
LabBook for execution.
-or-

Figure 4-86. Scheduler Options dialog

The Scheduler settings can be 
customized via the Options button 
in the Scheduler toolbar, or in the 
Tools section on the Help page of 
Qtegra.

Tip The Scheduler region can be moved within Qtegra to change to a 
separate window.

Table 4-7. Control buttons for the Scheduler, continued

Icon Meaning Description

Figure 4-87. Scheduler tool
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Press <Ctrl> + <R>.
The LabBook is added to the Scheduler.

3. In the Scheduler, select the LabBook and click Start to start the 
measurement.
The LabBook measurement starts, see Figure 4-88.

In the Scheduler, the Progress column shows the progress of the 
execution in percent.

❖ To stop the execution of a LabBook in the Scheduler

1. Check the progress of the execution to make sure a LabBook is 
currently running and the Scheduler toolbar buttons are enabled.

Tip If the Automatic check box has been selected for Start Queue 
in the Options settings of the Scheduler, the measurement starts 
immediately.

Figure 4-88. Scheduler tool

Tip The Configuration of this LabBook must match the currently 
loaded Configuration on the Dashboard. If an error message is 
displayed in the Log View indicating an incompatibility between 
the configuration saved in the LabBook and the current 
configuration, the LabBook is not added to the Scheduler. In this 
case, open the original LabBook and check the Summary page for 
the instruments configured and change your Configuration 
accordingly.
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2. On the Scheduler toolbar, click Stop.
The Stop Behavior dialog opens, see Figure 4-89.

3. Select Immediately to stop the execution of the LabBook and to 
remove it from the Scheduler queue.

Select After current sample to keep measuring the current sample 
and then stop the LabBook and remove it from the Scheduler 
queue.

Select After current experiment to perform the measurement of the 
current LabBook until its end. Then stop the Scheduler and keep all 
following LabBooks in their scheduled position. Click Start to start 
the next LabBook.

4. Tick Don’t ask again to keep your selection for all scheduled 
LabBooks. In case the Stop button is clicked no Stop Behavior 
dialog is displayed. Open the Scheduler Options dialog (see 
Figure 4-86) to clear this setting.

❖ To pause the execution of a LabBook in the Scheduler

Beside the option to pause a LabBook automatically, you may interrupt 
the execution in the Scheduler as follows:

1. Check the progress of the execution to make sure a LabBook is 
currently running and the buttons of the Scheduler toolbar are 
enabled.

Figure 4-89. Stop Behavior dialog
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2. On the Scheduler toolbar, click Pause.
The Suspend Behavior dialog opens, see Figure 4-90.

3. Select After current sample or After current experiment to define 
the suspend behavior.

4. Click OK.
The execution of the LabBook is paused after the selected action has 
been completed.

5. On the Scheduler toolbar, click Start again to resume the execution 
of the LabBook.

❖ To change the order of LabBooks in the Scheduler

1. Check the progress of the execution to make sure some LabBook are 
added to the Scheduler, and the buttons of the Scheduler toolbar are 
enabled.

2. In the Scheduler, select the LabBook you wish to move up or down 
in the queue.

3. Click one of the arrow buttons to move the LabBook to the desired 
position in the queue, for example, to the top of the queue, see 
Figure 4-91.

4. Click Delete to delete the selected LabBook.

5. Click Remove all to remove all entries of the queue.

Figure 4-90. Suspend Behavior dialog

Figure 4-91. Moving LabBook in Scheduler queue
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❖ To set additional options of the Scheduler

1. On the Scheduler toolbar, select Options to display the Scheduler 
Options dialog.

2. Refer to “Customizing Scheduler Settings” for additional User and 
System Options.
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Completed LabBooks
Upon completion of a LabBook, the LabBook is automatically deleted 
from Scheduler and added to the Completed LabBooks tab in Qtegra, 
see Figure 4-92.

To reduce the number of entries in this list of completed LabBooks, set a 
value for History Entries in the Options dialog. Tick the desired check 
box in the Options dialog to clear this list of completed LabBooks upon 
every start of the Scheduler.

❖ To open the Completed LabBooks tab

1. From the Qtegra - [Home Page], click Completed LabBooks to 
open the Completed LabBooks tab.
All LabBooks that have already been executed are listed.

❖ To open a LabBook from the Completed LabBooks

1. In the Completed LabBooks list, click the LabBook you wish to 
open.
The completed LabBook is opened in a new tab.

Figure 4-92. Completed LabBooks

Tip The Completed LabBooks tab can be moved within Qtegra to 
change to a separate window.
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Log View
The Log View region of Qtegra displays a list of messages, such as errors 
and warnings. By default, different levels of messages are displayed. The 
Viewer tab is also shown in the Configurator tool.

❖ To open the Log View region

1. From the Qtegra - [Home Page], click Log View to open the Log 
View region, see Figure 4-93.

❖ To scroll directly to incoming messages in the Viewer

1. In the Log View region, select the Viewer tab.

2. On the toolbar, click Scroll to message.
The Viewer scrolls directly to new incoming messages.

❖ To delete rows in the Viewer

1. In the Log View region, select the Viewer tab.

2. Select the row or rows you wish to delete.

3. On the toolbar, click Delete.
The selected row or rows are deleted from the Viewer tab.

❖ To clear all in the Viewer

1. In the Log View region, select the Viewer tab.

2. On the toolbar, click Clear all.
All entries are deleted from the Viewer tab, but all logged messages 
remain in the internal Qtegra ISDS Software database.

Tip The Log View region can be moved within Qtegra to change to a 
separate window.

Labeled Components: 1=Message level selectors, 2=Viewer toolbar

Figure 4-93. Log View region in Qtegra

1
2

Tip The row deletion and clear all actions in this Viewer do not 
change the permanently stored information in the internal Qtegra 
ISDS Software logs.
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To query the permanent logs, open the Search tab in the Log View 
region.

❖ To search all logged events

1. In the Log View region, select the Search tab.
A pane opens to enter search data, see Figure 4-94.

Initially, no filter is set and all search levels are selected (1 in 
Figure 4-94).

Labeled Components: 1= Filter settings area, 2=Collapse/Expand button, 
3=Export button, 4=Search button

Figure 4-94. Log View Search window

1

2

3

4
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2. To reduce the list of log messages displayed, use the drop-down 
menus to filter the items as per Table 4-8.

Table 4-8. Search filter settings

Filter Description

Time Provides a list of time ranges (Last hour, Last 
12 hours, Last 24 hours, Last 7 days).

Select Custom range to set the begin and end of 
the period in a dialog.

Select Any time to reset the filter.

Level Tick the check boxes

to set the filter for Info Messages, Warnings, 
Errors, or Fatal Errors.

Select all check boxes to reset the filter. For 
details refer to “Message levels”.

Depending on the value of 
Configurator > Settings > Logging > ShowAll an 

additional filter icon  is displayed to show 
all messages including debug messages.

Category Provides a list of software modules and services 
to select the category, which is responsible for 
the logged message.

AcquisitionService, Configurator, 
ControlManagerService, FileService, 
HardwareService, HubService, Qtegra, 
ServiceStatus are available.

Sub category Provides a list of all sub categories used in 
Qtegra ISDS Software. Select the sub category if 
you need to focus the Log View on this level.

Remove all selections to reset the filter.

Machine Provides a list of computer names, where this log 
file was created and updated.

Remove all selections to reset the filter.

User Provides a list of Qtegra users including the 
NT AUTHORITY \ SYSTEM user that 
represents automated Qtegra actions. Select the 
user to show log messages created by his/her 
activity.

Remove all selections to reset the filter.
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3. Click Search (4 in Figure 4-94) to display the search result.
On the right, the filtered log file shows the result list with the Level, 
Message, Time, Category, Sub category, Machine, and User.

4. Click the arrow button (2 in Figure 4-94) to collapse the Filter pane 
and to expand the search result list.

5. In the search result list, click the leftmost cell to select the 
appropriate rows. Right-click to open the shortcut menu where you 
may copy the selection to your Windows clipboard.

6. Click Export (3 in Figure 4-94) to save the search result list as a 
CSV file that may be opened with the associated program. The 
exported file is named LogViewMessages.csv, by default.

Message levels

Qtegra displays four levels of error messages.

Figure 4-95. Search result list

Table 4-9. Message levels

Level Description

Info Information message
This is the lowest level of message shown in the Log 
View. An information message is generated for 
informational purposes in Qtegra ISDS Software. 
It does not reflect any issue with the actual 
measurement. Example messages are: “Igniting the 
plasma”, “Rinsing autosampler”, Drain Sensor 
Enabled”, etc.

Warnings Warning message
This is the next highest level of message shown in 
the Log View. A warning message indicates an 
event in Qtegra ISDS Software that might possibly 
lead to an error. Example messages are: “Moving to 
rinse failed”, “Unable to move motors.”, “Export 
was incomplete”, etc.
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Unexpected Errors

Under rare circumstances, it can happen that Qtegra needs to be 
restarted. In this case, Qtegra opens a message to inform the user.

The message depends on the current status of Qtegra applet or 
LabBooks. In case Templates, LabBooks or applets are saved, an 
automatic restart is initiated. A count down is displayed, see 
Figure 4-96.

Errors Error message
This is the next highest level of message. An error 
message indicates possibly recoverable errors in 
Qtegra ISDS Software. Example messages are: 
“Failed to run exposure”, “Error during Nebulizer 
Optimization”, etc.

Fatal errors Fatal error messages
This is the highest level of message shown in the 
Log View. A fatal error messages indicates a severe 
error that may prevent Qtegra ISDS Software from 
continuing working properly. Example messages 
are: “Could not load calibration data, please ensure 
the file CidSpectrum.bin is available.”, 
“GetParameter for {0} failed”, etc.
It is recommended to call the Thermo Fisher 
Scientific field service engineer to solve the 
problem.

Table 4-9. Message levels, continued

Level Description

Figure 4-96. Qtegra restart message with count down
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In case files are changed but not saved, a slightly different message is 
shown, see Figure 4-97.

When this message is shown, click OK. Further messages will open and 
ask to save or close each Template, LabBook or applet with changes. 
Then Qtegra closes and restarts automatically. 

All open files will be automatically reopened on restart.

Figure 4-97. Qtegra restart message with OK button
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5

Templates

The analytical workflow for sample measurement is defined in a 
Template. A Template ideally suited when one or more analytical 
methods are run on a routine basis with fixed method parameters but 
varying sample numbers, for example, provided through a Laboratory 
Information Management System (LIMS). Templates are created as 
shown in “Templates Page” on page 4-36.

Templates are based on a particular Configuration, which is usually 
defined by the Administrator or Thermo Fisher Scientific field service 
engineer (see “Configurator” on page 3-1) and reflects your system 
setup. Each Template consists of a Method Parameters section, a Sample 
Definition section, an Automatic Export section, and a section for the 
Peripherals if so configured for this Configuration.

The Method Parameters within a Template are dependent on the 
evaluation method assigned to the Template (see “Evaluation Methods” 
on page 9-2). For every application an appropriate Template can be 
created.

Contents

• Template Toolbar on page 5-2

• Sample Definition for a Template on page 5-5

• Automatic Export - Template on page 5-10

❖ To open the Templates page in Qtegra ISDS Software

1. From the Qtegra - [Home Page] navigation pane, click Templates.
The Templates page of Qtegra opens.

2. Create or open a Template as shown in “Templates Page” on 
page 4-36.

The Template opens in a new tab with the following items.
Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 5-1
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Template Toolbar
The Template tab offers buttons to save, close or run a Template, see 
Figure 5-1.

Additionally, you can create a new LabBook or Template from the 
current Template, view the history of the current Template or hide the 
Content pane.

❖ To save a Template

1. Change the settings as appropriate.

2. Click Save to save the changes.
-or-
Press <Ctrl> + <S> to save your Template.
The Save Template dialog opens, see Figure 5-2.

3. Enter a Comment for the Template.
The comment will be shown in the History view.

4. Click OK.
The Template is saved.

❖ To close a Template

1. Click Close on the Template toolbar.

-or-

Click Close in the tab of the Template to close the Template.

Figure 5-1. Template toolbar

Figure 5-2. Save Template dialog
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❖ To create a LabBook or Template from an existing Template

1. In the Templates view, click Create.
The Create drop-down menu opens, see Figure 5-3.

2. Click New LabBook if you wish to create a new LabBook from the 
existing current Template.
The LabBooks view of the Home Page opens. See “Creating 
LabBooks” on page 4-24 for further details.

3. If you wish to create a new Template from the existing current 
Template, click New Template.
The Templates view of the Home Page opens. See “Creating a 
Template” on page 4-38 for further details.

❖ To view, compare and export the history of a Template

For details, refer to “To view, compare and export the history of a 
LabBook” on page 6-5 as your action is the same.

❖ To hide the Content pane

1. In the Templates view, the Content pane is shown on the left, see 
Figure 5-4.

2. Click Toggle.
-or-
Press <F11>.

Figure 5-3. Create drop-down in Templates toolbar

Figure 5-4. Content pane of Template visible
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The Content pane is hidden, see Figure 5-5. The main window area 
may be used to display the selected Method Parameter in a 
maximum size.

3. Click Toggle.
-or-
Press <F11> to show the Content pane again.

Figure 5-5. Content pane of Template hidden
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Sample Definition for a Template
In the Sample Definition view of a Template (see Figure 5-6) you define 
the sample type and actions inserted in the LabBook that you create 
from this Template.

The Sample Definition consists of three sections in your Template to be 
populated with Blanks, Standards, QCs, and Unknown samples.

In the Initial Actions you enter samples to be inserted once at the start 
of the Sample List. Usually, samples of type BLK, STD, and initial QC 
are defined here. Click the green Plus sign on the toolbar to add a line, 
where you can specify the initial action, for example, select BLK from 
the Sample Type drop-down menu and double-click the Label and type 
Blank. Add another line and specify at least one standard, for example, 
select STD from the Sample Type drop-down menu, select the standard 
solution Tune A from the Standard drop-down menu, and type STD as 
the Label.

The Continuing Actions lines make up a repeating unit of the Sample 
List when creating a LabBook. Typically, standard and unknown sample 
types are defined here, see Table 5-1. The Continuing Actions rows unit 
is repeated with the number of samples desired for the LabBook. If, for 

Figure 5-6. Sample Definition view

Tip For Sample Definition, the  button is added to 
the toolbar of the Template. Activated, this option restricts editing of 
the Sample List for the LabBook created from this Template. Samples 
can then only be added or deleted at the end of the Sample List.
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example, the Interval is set to 10, the QC sample will be inserted after 
each 10 samples. If the Interval is set to 5, the QC sample will be 
inserted after each 5 samples.

The End Actions rows are for samples (such as QC samples) to be 
inserted at the end of the Sample List.

Depending on the evaluation method selected for the Template, the 
columns of the components may differ. Columns that may be shown in 
Sample Definition and Sample List are explained in Table 14-5.

After creating a LabBook from the Template (see “Template Toolbar” on 
page 5-2 and “Creating LabBooks” on page 4-24), the column Special 
Blank is added to the Sample List (see Figure 6-15).

❖ To open the Sample Definition view of a Template

1. On the Templates view, click Sample Definition to open the 
Sample Definition view.

Table 5-1. Columns of Sample Definition > Continuing Actions

Column Description

Interval Amount of UNKNOWN samples to be added to 
your LabBook, until the next line is run. The first 
line always is locked and the Interval is set to 1. This 
line acts as a place holder for UNKNOWN samples 
to be added during creation of a LabBook.

Absolute Part of continuing actions in your Template. This 
option is only relevant for QC entries to become 
compliant with US EPA.
When you tick this check box, the sample is latest 
inserted as the sample line defined by the Interval. 
If, for example, due to other repetitions sample 
measurements are added and would therefore block 
the desired line, this option ensures QC at least to 
appear at the specified line.

Keep together Part of continuing actions in your Template. This 
option is only relevant for QC entries to become 
compliant with US EPA.
When you tick this check box, the sample is kept 
together with the following line. If, for example, a 
QC entry is inserted by its definition, both lines 
that are kept together will never be split. Instead, 
the other action (QC) is set above.
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Customizing the Columns for Sample Definition

You can show or hide the columns for Initial Actions, Continuing 
Actions and End Actions of the Sample Definition view and change the 
order in the table.

❖ To customize the appearance of columns

1. Open the Sample Definition view.

2. In the Initial Actions, Continuing Actions and End Actions 
section you wish to change, click the Field Chooser icon.
-or-
Open the shortcut menu on the table header and select 
Columns > More.

The Choose Columns window opens, see Figure 5-7.

3. Click the up/down arrow to move the column headings up or down.

4. Select a column in the right list and click the left arrow. 
-or-
Double-click a column heading in the right list to move it to the list 
of available columns.
This column is hidden in the Sample Definition view.

5. Click OK.
The columns are arranged accordingly.

Figure 5-7. Choose Columns window of Sample Definition
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Defining the Initial, Continuing and End Actions

In the Sample Definition view of Qtegra, Initial, Continuing and End 
Actions items are defined. Additional lines can be added and values can 
be defined.

❖ To define Initial, Continuing and End Actions

1. Open the Sample Definition view.

2. On the toolbar of the Template, open the Actions drop-down menu, 
see Figure 5-8.

3. Select the item you wish to add a line for.
A line is added to the selected item.

4. Type the values in each column to your needs.
-or-
Select an item from the drop-down menu, if available.
For details on the columns, see “Sample Definition for a Template” 
on page 5-5.

5. Click Save to save the changes to your Template.

Defining the Settings in Sample Definition

The settings for your experiment are defined in the Sample Definition 
section of your Template.

❖ To define the settings of your experiment

1. On the Template view, define Initial Actions, Continuing Actions 
and End Actions as appropriate.

2. Add as many rows as you need for your experiment.

3. Type a Label for each row.

Figure 5-8. Add lines for Sample Definition
5-8 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific



Templates
Sample Definition for a Template
4. Select a Sample Type from the drop-down list, see Figure 5-9.

For example, select STD for the calibration solution UNKNOWN 
for the samples, and BLK or AVERAGE BLK for blanks.

5. Type a value for each column.
-or-
Select an item from the drop-down list, as appropriate.

6. Click Save to save the changes to your Template.

Figure 5-9. Sample Type drop-down in Template Sample Definition

Tip For details on the columns, see “Sample Definition for a 
Template” on page 5-5.
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Automatic Export - Template
In the Automatic Export view of a Template in Qtegra, you define the 
export settings for your data as CSV or XML file and for Reports, see 
Figure 5-10.

Upon completion of the LabBook, the data are automatically exported 
as defined.

The export directory is defined under System Options in the Scheduler 
settings, see “Customizing Scheduler Settings” on page 4-76.

❖ To define automatic export settings

1. On the Templates view, expand  and click 
 to select the Automatic Export view.

Figure 5-10. Template Automatic Export settings

Tip The following description is demonstrated on a Template but 
does also refer to a LabBook.
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2. Select the CSV Export check box to define these export settings, see 
Figure 5-11.

3. For Available data, select the check boxes for the data you wish to 
export.
-or-
Select one of the pre-defined Schemes from the list box.

4. From CSV Export Options, select a Column separator from the 
drop-down list.
Usually, a Semicolon is used to separate singular items within one 
data set. You may select Tab instead or Custom for a user defined 
symbol. In this case, be aware of incompatibility, when you read the 
exported file with another application.

5. To keep decimal values in singular item, select a Decimal symbol 
that must be different from the Column separator.
Usually, a Point is used in most of the English speaking countries, 
and a Comma is used, e.g., in Central Europe.

6. Select the Export sample lines as rows check box to show the 
sample lines as rows.
If you do not select this check box, the sample lines are exported as 
columns.

7. Select the Group exported blocks check box to group the data 
output.

8. Select the Export complete LabBook check box if you wish to 
export one file for one LabBook.

9. Select the Export per sample check box if you wish to export one 
file per sample.

Figure 5-11. Automatic Export, CSV Export settings
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10. Click Save As on the toolbar of Available data to save the setting to a 
scheme.
The Save Export Scheme dialog opens, see Figure 5-12.

11. Type a Name and Description.

12. Click Save.
The settings for CSV Export are saved to this scheme.

13. Select SpreadsheetML Export to define these export settings, see 
Figure 5-13.

14. From Available data, select the data you wish to export.

15. From SpreadsheetML Export Options, select the Export complete 
LabBook check box if you wish to export one file for one LabBook.

16. Select the Export per sample check box if you wish to export one 
file per sample.

17. Click Save As on the toolbar of Available data to save the setting to a 
scheme.
The Save Export Scheme dialog opens, see Figure 5-12.

18. Type a Name and Description.

19. Click Save.
The settings for SpreadsheetML Export are saved to this scheme.

Figure 5-12. Save Export Scheme dialog

Figure 5-13. Automatic Export, XML settings
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20. Click Save to save the changes to your Template.

❖ To load a scheme for automatic export settings

1. On the Templates view, click  to open the 
Automatic Export view.

2. From the toolbar of Available data, open the Schemes listbox to 
select a scheme, see Figure 5-14.

3. Select the desired scheme to load this scheme.
The check boxes in the Available data pane are selected.

❖ To define Report export settings

1. On the Templates view, expand  and click 
 to open the Report Export view.

2. Click Add to add a row to the table.

Figure 5-14. Load Export Scheme list box

Tip Your selection of a scheme is independent from the export 
data format. This means, you can select a scheme for CSV Export 
as well as for SpreadsheetML Export.
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3. For Report name, expand the drop-down list, see Figure 5-15.

4. Select the Report, you wish to add.

5. For Action, expand the drop-down list and select the file format for 
the Report, see Figure 5-16.

a. Select Save as PDF to compile a PDF Report that is shown in 
your PDF viewer.
The Save As dialog (see Figure 6-7) is opened to select the folder 
and to type the file name of the PDF file.

b. Select Save as RTF to generate a Report that is displayed in 
Microsoft Word or your alternative RTF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the RTF file.

c. Select Save as XML to generate a Report that is displayed in the 
Internet Explorer.
The Browse For Folder dialog (see Figure 6-8) is opened to select 
the folder where you want to save the XML output.

6. Select Enabled for the Reports you wish to automatically export.

7. Select Per sample if you wish to create Reports per sample.

8. Double-click the field and type a name for your Report for Target 
file name.

Figure 5-15. Report name drop-down

Figure 5-16. Action drop-down
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9. Select a Printer from the drop-down list. The list offers all printers 
that are configured on your Windows system.
Default printer sends the LabBook or samples directly to the 
default printer of your Windows environment.

10. Repeat to add other Reports.

11. If you wish to delete a row in the table, click the gray field in front of 
the row or rows you wish to delete.

Click Delete and confirm the message dialog to delete the rows.

12. Click Save to save the changes to your Template.
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6
LabBooks

LabBooks are based on the settings specified in the “Templates” on 
page 5-1 in Qtegra. These setting can still be adjusted in the LabBook 
before the measurements is run.

Contents

• LabBook Toolbar on page 6-2

• Method Parameters of LabBook on page 6-11

• Summary of LabBook on page 6-12

• Sample List of LabBook on page 6-13

• Automatic Export of LabBook on page 6-19

• Flags and Limits on page 6-20

• Scheduling a LabBook on page 6-30

• Viewing the Results of a Measurement on page 6-32

• Log Messages on page 6-36

• Signing on page 6-39

• Query on page 6-44

• Reports on page 6-52

❖ To open or create a LabBook in Qtegra

• From the Qtegra - [Home Page] navigation pane, open a LabBook 
as described in “Opening a LabBook” on page 4-23.

• From the Qtegra - [Home Page] navigation pane, create a LabBook 
as described in “Creating LabBooks” on page 4-24.
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LabBook Toolbar
In the LabBook tab, Qtegra offers buttons to save, close, run, export a 
LabBook, to view the history, and to sort items, see Figure 6-1.

Additionally, you can create a new LabBook or Template from the 
existing LabBook, view the History of the current LabBook or hide the 
Content pane.

Once the LabBook has been executed, new functions become available 
on the toolbar. For the Sample List, buttons to add and change Sample 
List rows are offered, see “Sample List of LabBook” on page 6-13. 
Buttons to recalculate data are added to the toolbar for “Evaluation 
Results” on page 6-33.

❖ To save a LabBook

1. Change the LabBook settings as appropriate.

2. Click Save to save the LabBook.
The Save LabBook dialog opens. 

3. Enter a Comment for the LabBook.
The comment will be shown in the History view.

4. Click OK to save the LabBook.

❖ To close a LabBook

1. From the Qtegra - [Home Page] navigation pane, open a LabBook 
as described in “Opening a LabBook” on page 4-23.

2. Click Close on the toolbar.

-or-

Click Close in the tab of the LabBook to close the LabBook.

Figure 6-1. LabBook toolbar

Tip During the saving process you can not edit or modify any 
LabBook entries. Wait until the saving process is closed and the 
menu items are enabled.
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❖ To run a LabBook

1. From the Qtegra - [Home Page] navigation pane, open a LabBook 
as described in “Opening a LabBook” on page 4-23.

2. On the toolbar of the LabBook, click Schedule to schedule the 
LabBook.
The LabBook is added to the queue in the Scheduler and the 
LabBook is locked.

3. In the Scheduler, select the LabBook and click Run.
The LabBook measurement is executed.

❖ To create a LabBook or Template from an existing LabBook

1. In the LabBook view, click Create.
The Create drop-down menu opens, see Figure 6-2.

2. Click New Template if you wish to create a new Template from the 
current LabBook.
The Template view of the Home Page opens. See “Creating a 
Template” on page 4-38 for further details.

3. If you wish to create a new LabBook from the current LabBook, 
click New LabBook.
The LabBook view of the Home Page opens. See “Creating 
LabBooks” on page 4-24 for further details.

❖ To export LabBook data

1. On the toolbar of the LabBook, click Export.
-or-
Press <Ctrl> + <E>.

Tip If the Automatic check box has been selected for Start Queue 
in the Options settings of the Scheduler (see “Customizing 
Scheduler Settings” on page 4-76), the measurement starts 
immediately.

Figure 6-2. Create button in LabBook toolbar
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The Export data dialog opens, see Figure 6-3.

2. For Exporter, select CSV Export or SpreadsheetML Export.

3. In the Export Options section on the right pane, select the items as 
follows:

a. For the SpreadsheetML Export, select a Path and type a 
Filename.

b. For CSV Export, also select the Column separator, a Decimal 
Symbol, and select the check boxes for Export sample lines as 
rows, Group exported blocks, Export complete LabBook and 
Export per sample, as appropriate.

4. Click the browse buttons next to the Path entry to select another 
path where the exported LabBook will be saved.
The standard Save As dialog is opened to select the desired path.

5. Click Save to copy this selected path into the Export data dialog. 
The file is not yet exported.
The Save As dialog is closed.

6. If desired, select the check box Open file in Excel after export or 
Open containing folder after export.

7. From the Available data list, select the check boxes for the data you 
wish to export, or 
Open a Scheme to select pre-defined data.

Figure 6-3. Export data dialog of LabBook
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a. Click Save As to save the settings as your scheme.
The Save Export Scheme dialog opens, see Figure 6-4.

b. Type a Name and a Description.

c. Click Save.

8. In the Export data dialog, click .

❖ To view, compare and export the history of a LabBook

1. On the toolbar of the LabBook, click View History.
The History dialog for this LabBook opens, see Figure 6-5.

2. To compare the history entries, press <Ctrl> or <Shift> and select 
the range of history entries you wish to compare.

3. Qtegra allows to select more than two entries for comparison 
purposes.

Figure 6-4. Export scheme of LabBook

Figure 6-5. History dialog for LabBooks

Tip According to SOP compliance viewing and exporting the 
history is only allowed for specified user groups.
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4. Click Compare to compare the selected entries.
The Comparison dialog opens and shows all selected entries 
column by column, see Figure 6-6.

5. Resize or maximize the Comparison window to make all entries 
visible. The column header shows the date of selected entry with the 
oldest version left and the newest version right.

6. Click the triangle in front of the items to collapse and expand the 
items to focus on the interesting parts.

7. Select Show differences only if you wish to view only the 
differences, which is the default setting.
When removing the tick, Qtegra needs a few seconds to update the 
list and to show all history entries. Differences then are shown in 
bold letters.

8. Close the Comparison dialog.

9. Expand Export and select the file format for the history export.

a. Select Save as HTML to compile a HTML history.
The Browse For Folder dialog (see Figure 6-8) is opened to select 
the folder where you want to save the HtmlReport folder with 
the index.html file and all images used. The Browser opens to 
display the HistoryReport.

b. Select Save as PDF to compile a PDF history that is shown in 
your PDF viewer.

Figure 6-6. History Comparison dialog for LabBook
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The Save As dialog (see Figure 6-7) is opened to select the folder 
and to type the file name of the PDF file.

c. Select Save as RTF to generate a history that is displayed in 
Microsoft Word or your alternative RTF viewer.
The Save As dialog is opened to select the folder and to type the 
file name of the RTF file.

d. Select Save as XML to generate a history that is displayed in the 
Internet Explorer.
The Browse For Folder dialog (see Figure 6-8) is opened to select 
the folder where you want to save the XML output.

Once the folder is selected, click OK to open the XML file in 
your browser.

10. Expand Report and select History entries or History comparison.

Figure 6-7. Save As dialog for export as PDF

Figure 6-8. Browse For Folder dialog for export as XML
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a. With History entries, the History entries Report is opened to 
show the available history entries as on the initial dialog, see 
Figure 6-5.

b. With History comparison, the History Compare Result Report 
is opened to show the selected history entries similar to 
Figure 6-6.

11. Close the History dialog for this LabBook.

❖ To hide the Content pane

1. In the LabBook view, the Content pane is shown on the left, see 
Figure 6-9.

2. Click Toggle.
-or-
Press <F11>.
The Content pane is hidden, see Figure 6-10.

3. Click Toggle.
-or-
Press <F11> to show the Content pane again.

Figure 6-9. Content pane of LabBook visible

Figure 6-10. Content pane of LabBook hidden
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Sorting the Analytes

In several cases it is helpful to get the views of Method Parameters and 
Evaluation Results in a comparable layout. Qtegra provides a 
mechanism to sort the analytes according to your needs.

Once defined, the sort order is applied to the LabBook. An option 
allows to apply the selected sort order to the LabBook when it opens. 
The arrangement is valid for several views but, for example, not for the 
Reports that have their own sorting routine.

The sorting that you arranged in the Sort window is applied to the 
following views of your LabBook:

• Method Parameters

- Acquisition Parameters

- Interference Correction

- Quantification

- Quality Control

• Evaluation Results

- Concentrations

- Intensities

• Query

See the description below to understand the sort function.

❖ To arrange the analytes

1. On the toolbar of the LabBook, click Sort.
The Qtegra Sort window opens, see Figure 6-11.

Figure 6-11. Sort window
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2. The highlighted button above the list indicates the former arranged 
sort order. Click the desired button to sort the list according to your 
needs.

a. Click Manual and drag the list items to the desired position to 
sort the analytes.

b. Click Alphabetical to sort the analytes in alphabetical order. 
Alphabetical sort order includes the wavelength of the analyte, 
ratios and calculation traces .

c. Click By Wavelength to sort the analytes by their wavelength. 
Ratios and calculation traces are appended to this list. 

For Alphabetical and By Wavelength, click Ascending or Descending 
to revert the sort order.

As soon as you drag items to another position, the sorting option 
changes to Manual.

3. Click OK to apply the sort order to the currently opened LabBook. 
Note that this sort order is only saved permanently with the 
LabBook if Apply sort order is active.

4. Click Cancel to leave the open LabBook unchanged.

❖ To apply the sort order to your LabBook

1. On the LabBook toolbar, click Apply sort order.

2. The button changes yellow  to indicate the status for the sort 
function.

When you change the sorting of analytes, the sort order is applied to 
the LabBook. The sort order will be saved when the LabBook is 
saved. Once you open this LabBook again, the last specified sort 
order is used in the views, see “Sorting the Analytes” on page 6-9.
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Method Parameters of LabBook
Method Parameters differ for each LabBook and are inherited from the 
Template from which the LabBook is created in Qtegra. The type of 
Evaluation selected for the Template also controls the availability of the 
Method Parameters for the LabBook.

An example of the Method Parameters available for a LabBook based on 
an eQuant evaluation is shown in Figure 6-12.

All settings of the Method Parameters can be still be changed in the 
LabBook. For details, see “Method Parameters Settings” on page 9-3.

The color scheme of the periodic table of the LabBook is inherited from 
the definitions in the Template, see “Color Scheme of the Periodic 
Table” on page 14-62.

Figure 6-12. LabBook Method Parameters

Tip The Sample List of a LabBook is generated from the settings in 
Sample Definition of a Template, see “Sample Definition for a 
Template” on page 5-5.
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Summary of LabBook
A summary page is added to each LabBook in Qtegra. This page shows 
the Filename, information about Properties, Dates, People, and 
Instrument Plug-in Versions for the LabBook, see Figure 6-13.

❖ To show the summary of a LabBook

1. In the LabBook view, click Summary to view the summary of the 
LabBook.

2. The Instrument Plug-in Versions may help in case of problems 
when contacting the Qtegra ISDS Software support.

Figure 6-13. Summary of LabBook
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Sample List of LabBook
The Sample List of a LabBook is based on the number of samples 
selected for analysis, and on the structure of the Initial Actions, 
Continuing Actions and End Actions items defined in the section of the 
Templates (see “Sample Definition for a Template” on page 5-5).

An example of a Sample List in a LabBook created from an eQuant 
Template is shown in Figure 6-14.

Depending on the evaluation method of the LabBook, the columns of 
the components may differ. All columns that may be shown in Sample 
List are explained in Table 14-5.

Figure 6-14. Sample list of LabBook
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With Special Blank, see Sample List example in Figure 6-15, it is 
possible to subtract the calculated concentrations of a sample from those 
of one or more others.

Any values entered that are not within the given range are marked with 
an .

Special Functions of the Sample List

❖ To view the Sample List

1. In the LabBook view, click Sample List to view the Sample List of 
the LabBook.

❖ To add rows to the Sample List

1. In the Sample List of the LabBook, click Add to add a row at the 
end of the Sample List.

-or-

Figure 6-15. Sample List view with Special Blank

Tip Some functions are only available, when your LabBook is not 
finished.
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2. Click the arrow next to Add and select Add Rows from the 
drop-down menu.
The Number of rows dialog opens, see Figure 6-16.

3. Enter the number of rows to be added to the Sample List.

4. Click OK.
The rows are added at the end of the Sample List.

❖ To paste values from Excel

1. Open the Sample List of the LabBook.

2. From your Excel sheet, select a range of cells and press 
<Ctrl> + <C> to copy the desired range using the Windows 
clipboard.

3. In the Sample List, select the upper left target cell of the range you 
want to paste. Then right-click to open the shortcut menu and select 
Paste.
-or-
Press <Ctrl> + <V> to paste the values into your Sample List.

❖ To delete a row from the Sample List

1. In the Sample List of the LabBook, click the gray field in front of 
the row you wish to delete.
The row is selected.

2. Click Delete to delete the selected row.

❖ To show comments of the Sample List

1. In the Sample List of the LabBook. click Comments to show the 
comment for the selected row.
The list of comments opens below the Sample List.

Figure 6-16. Define the number of rows to be added to the Sample List

Tip If the Excel cells contain a value including the unit, both parts are 
separated by a blank.
You may only copy valid units that are supported by Qtegra ISDS 
Software. Units are always written with small letters. On errors, the 
tooltip of a red indicator shown next to the cell helps to understand 
the error.
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❖ To add comments of the Sample List

1. In the Sample List of the LabBook, show the comment for the 
selected row below the Sample List.

2. Click Add Comment to add a comment for the selected row.
The User Comment window opens, see Figure 6-17.

3. Type your comment.

4. Click OK.
The comment is added and the User Comment window closes.

❖ To hide comments of the Sample List

1. In the Sample List of the LabBook with opened list of comments, 
click Comments to hide the comment for the selected row.
The list of comments is hidden.

❖ To save user settings for the Sample List

1. In the Sample List of the LabBook, arrange the columns according 
to your needs as described in the chapter “Designing the LabBook 
Table” on page 14-48.

2. Click the arrow next to Options to show the menu items.

3. Click Save User Default to save the current column order of your 
Sample List.
The menu is collapsed and your setting is saved.

❖ To load user settings for the Sample List

1. In the Sample List of the LabBook, click the arrow next to Options 
to show the menu items.

2. Click Load User Default to load the column order that has been 
saved before.
The menu is collapsed and the setting is applied to the Sample List.

Figure 6-17. Add user comment to Sample List row
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❖ To specify user options for the Sample List

1. In the Sample List of the LabBook, click Options to show the 
Options dialog, see Figure 6-18.

The Restricted Mode functionality depends on the activation in the 
Sample Definition of a Template. This mode does only affect the 
composition of the Sample List in the LabBook according to the 
predefined repetition rules. See “Sample Definition for a Template” 
on page 5-5.
Once you removed the tick mark from this option, the restricted 
mode is turned off, which then allows you to modify all samples of 
the LabBook.
Click OK to make your changes available. A confirmation dialog 
opens, see Figure 6-19.

2. Click Yes to turn off the restricted mode.
-or-
Click No to cancel and to show the Options dialog.

3. In the User options section, tick Load default column order if 
available to use your defaults as default column order.

4. Tick Append sample on editing of the last row to automatically 
append a new sample row when editing the Label.
In the Label field, press <Enter> to close the edit mode and to 

Figure 6-18. Options dialog of Sample List with enabled Restricted 
Mode

Figure 6-19. Confirmation dialog when turning off the restricted mode
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append a new sample row.
If this check box is not ticked, click Add on the Sample List toolbar 
to append a sample row to the Sample List.
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Automatic Export of LabBook
Before measurement, you can define Automatic Export settings for a 
LabBook. Upon completion of the LabBook, the data are automatically 
exported.

You define the export settings for your data as CSV or XML file and for 
Reports, see Figure 6-20.

LabBooks inherit the Automatic Export settings from the Template. See 
“Automatic Export - Template” on page 5-10 for details.

Tip Automatic Export settings are not available for Completed 
LabBooks since they have already been exported if so defined. For 
export functions of Completed LabBooks, see “LabBook Toolbar” on 
page 6-2.

Figure 6-20. LabBook Automatic Export settings
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Flags and Limits
The functionality provided by Flags and Limits allows the user to 
replace (or reformat) values based on a series of defined criteria. The 
modified values are then displayed inside the Qtegra evaluation views 
and used for export or reporting. Flags and Limits is only enabled for 
LabBooks measured using the eQuant evaluation type. Flags is enabled 
for LabBooks using the aQuant or rQuant evaluation types.

Flags

In Flags you define changes made by replacement or reformatting of 
data according to a series of criteria or ‘flags’. For example, changing the 
color of values in QC analyses that lie outside of defined limits to make 
them easier to identify in the data set, see Figure 6-21.

To activate a Flag, select the check box for the corresponding Flag type. 
See Table 6-1 for an explanation of each General Flag.

The decisions made in Flags and Limits control the display of data in 
the Intensities and Concentrations views of Evaluation Results as well as 
data exported via Query Excel Export, SpreadsheetML Export or shown 
in Reports. Data export using CSV Export or Query CSV Export is also 
affected by the changes made in Flags and Values but ignores the color 
coding.

Tip The raw, original data is not affected and is never lost. The use of 
Flags and Limits is an optional feature. Access to Flags and Limits can 
be controlled by User Access Rights.

Figure 6-21. LabBook Flags
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Once a Flag check box has been selected, the formatting controls for 
that Flag become accessible. See “Setting the Format Options for 
Flagged Values” on page 6-24 for a detailed description on how to set 
the display options.

Limits (eQuant only)

The Limits page allows for Flags to be displayed based on values in the 
Qtegra ISDS LabBook. Values can be flagged against global criteria or 
per analyte for increased flexibility, see Figure 6-22.

Table 6-1. General Flags

Flag Impacts

Values with QC 
failures

Values outside defined QC failure limits. For 
details on QC failures, see “Quality Control 
Failure Rules” on page 10-6.

Values with QC 
warnings

Values outside defined QC warning limits. For 
details on QC warnings, see “Quality Control 
Failure Rules” on page 10-6.

Excluded values Values manually excluded in Evaluation 
Results views.

Values modified by 
user interaction

Displayed for average values to indicate that 
one or more value in that block has been 
manually excluded.

Values that are not 
available

Displayed when no value is available. For a 
complete list of potential reasons for “N/A”, 
see “N/A Indicator in Concentrations List” on 
page 14-33.

Tip The flags are applied with the priority displayed in Table 6-1. For 
example (based on the default formatting), the average concentration 
value for QC failure value will be displayed with red text even if one or 
more value has been excluded.

Figure 6-22. Limits window
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The Limits Category drop-down box defines the data type that should 
be assessed. Currently only Concentration Average is supported. The Low 
and High Limits settings of the Per Analyte settings section can be saved 
to (or recalled from) a template for use in multiple LabBooks.

To load a previously saved set of Limits, click Import. The Import 
Limits dialog opens the Limits folder in the Qtegra Workspace to show 
any previously created template files (.qtpl). The template files don’t save 
the limits set in the Global Settings sections. Select the desired template 
and click OK to apply the defined Flags and Limits settings to the 
analytes in the currently opened LabBook. Limits are evaluation mode 
dependent.

To save your definition of Limits, click Export to open the Export 
Limits dialogs, enter a name, and click OK.

Global low and high limits can be applied to all values in the LabBook 
by selecting one of the tick marks in the Global Settings section, see 
Figure 6-23.

See “Setting the Format Options for Flagged Values” on page 6-24 for a 
detailed description on how to set the formatting options for values 
flagged by the limits defined in Global Settings. Analyte specific limits 
can be defined individually for more flexibility.

The relevant tick mark in Global Settings however must first be 
activated to allow access to the per analyte settings.

❖ To specify Low and High Limits per analyte

1. To set the Low Limits, select the required limit Type: None, LOD 
(Limit of Detection), MQL (Method Quantification Limit), User 
defined.

Figure 6-23. Global Settings section
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The cells to the right become active depending on the choice made.

2. For a limit based on LOD or MQL, a Factor can be entered to 
adjust the Low Limit by a multiple of the LOD or MQL value.

3. For User defined, enter a value and unit to be used for the Low 
Limit.

4. Select Use Format to enable analyte specific choice of text, text 
position, font weight, and font color. See “Setting the Format 
Options for Flagged Values” on page 6-24 for a detailed description 
on how to set the display options.

5. To set the High Limits, select the required limit Type: None, 
Calibration Range, User defined.

The cells to the right become active depending on the choice made.

6. For a limit based on Calibration Range, a Factor can be entered to 
adjust the High Limit by a multiple of the value.

7. For User defined, enter a value and unit to be used for the High 
Limit.

8. Select Use Format to enable analyte specific choice of text, text 
position, font weight, and font color. See “Setting the Format 
Options for Flagged Values” on page 6-24 for a detailed description 
on how to set the display options.

Figure 6-24. Choices for Low Limits

Figure 6-25. Choices for High Limits
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Setting the Format Options for Flagged Values

The same formatting dialog is used in both Flags and Limits sections.

❖ To define Flag formatting

1. Select the Enabled check box in front of the item you want to flag.
The settings drop-down becomes active.

2. Click the Settings arrow to display the list of formatting and text 
options.

3. Expand the Color box to select a color from the Main palette or 
from the More colors option.

4. Select Bold if the values shall be displayed in bold style.

5. Type a Text if any additional or replacement text should be 
displayed as specified in the Position drop-down.

6. From the Position drop-down, select one of the following options:

• Not used: No text replacement takes place.
Default option to display the originally measured value.

• Left: The text is displayed left of the value.
Select this option to display the text as a prefix to the value. The 
value itself remains unchanged. Extend the text with a blank 
space to separate out your text and the value.

• Right: The text is displayed right of the value.
Select this option to display the text as a suffix to the value. The 
value itself remains unchanged. Start the text with a blank space 
to separate out the value and your text.

• Replace: The text is displayed instead of the value.
Select this option to display the desired text instead of the value. 
As noted above, the value itself is not affected and never lost, but 
is not displayed.

Figure 6-26. Formatting choices for Flags
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Once your choices are made, a preview of any changes is displayed.

The data display settings defined in Flags and Limits are then applied in 
the Evaluation Results views, Query, Data Export, and Reports. In the 
following examples, sample results with concentrations higher than the 
Calibration Range are shown with a bold violet font, see Figure 6-28.

Flags and Limits - Evaluation Results view

Concentrations

Sample results with concentrations higher than the Calibration Range 
are indicated with bold violet values, as shown in Figure 6-29.

Figure 6-27. Example of values modified by Flags

Figure 6-28. Example of Per Analyte Flag Settings

Figure 6-29. Example Concentrations view displaying a Calibration Range Flag for Cr267.716
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Intensities

Values outside a specified range are highlighted as set under Flags. As an 
example, see blue values with prefixed “mod” in Figure 6-30 that were 
modified by user interaction.

Flags and Limits - Query

The following screenshots are based on the same examples shown above 
for the Concentrations and Intensities views. Sample results with a 
concentration higher than the Calibration Range are shown in bold 
violet, values modified by user interaction are shown in blue with the 
prefix “mod”.

Figure 6-30. Example Intensities view displaying values of Se 196.090 modified by user interaction
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In the Query, values outside the specified ranges are highlighted as set 
under Flags and Limits, see Figure 6-31.

Figure 6-31. Example Query displaying a Calibration Range Flag (Cr) and user modified values (Se)
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Flags and Limits - Reports

All Reports containing the Concentration average can be selected to 
show the Flags and Limits settings.

Vertical Table Report

See the following example for a Vertical table report made from the 
Query, see Figure 6-32.

Figure 6-32. Vertical Table Report displaying a Calibration Range Flag (Cr) 
and user modified values (Se)
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Comprehensive Sample Report

See the following example for a Comprehensive sample report made from 
the Query, see Figure 6-33.

Figure 6-33. Comprehensive Sample Report displaying a Calibration Range 
Flag (Cr) 
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Scheduling a LabBook
To schedule a measurement, open a LabBook and run it. Or, select the 
desired LabBook in the File Manager and drag it to the Scheduler pane.

Evaluation results can be accessed in a running LabBook so results can 
be viewed in real time, see “Evaluation Results” on page 6-33.

In the Tools section on the Help page of Qtegra, you define your 
Scheduler settings, see “Customizing Scheduler Settings” on page 4-76.

❖ To run a LabBook

1. On the toolbar of the LabBook, click Schedule to schedule the 
LabBook for execution.
-or-
Press <Ctrl> + <R>.

The LabBook is added to the Scheduler. A Locker icon is shown in 
the LabBook toolbar to indicate that changes in the LabBook are 
unavailable. See Figure 6-34.

2. Depending on your Scheduler settings, the LabBook starts 
automatically. Alternatively, in the Scheduler toolbar, select the 
LabBook and click Run to start the measurement.

The LabBook measurement starts, see Figure 6-34. The LabBook 
tab indicates “[scheduled]” or “[Running]”.

❖ To modify a scheduled LabBook

1. As long as the measurement of your LabBook has not started, you 
can remove it from the Scheduler. In the Scheduler, select your 
LabBook and click the Locker icon.

2. In the confirmation message, click Yes.
Your LabBook is removed from the Scheduler.

3. Make your changes and save your LabBook.

Tip To customize the Options of the Scheduler, you can also click 
Options on the toolbar of the “Scheduler” on page 4-80.

Figure 6-34. LabBook scheduled indicators
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4. Click Run.
-or-
Press <Ctrl> + <R> to schedule your LabBook.

When the measurement has started the LabBook tab indicates 
“[Running]”.

The completed LabBook is automatically deleted from the Scheduler 
and added to Completed LabBooks, see “Completed LabBooks” on 
page 4-87. The LabBook tab changes to green and indicates 
“[Completed]”. If an error occurred during the acquisition, the 
LabBook tab changes to red.

Tip Your LabBook now is appended to the Scheduler list. Use the 
Up and Down buttons to move your modified LabBook to the 
desired position.

Figure 6-35. Measurement started for scheduled LabBook

Tip If the Automatic mode has been selected for Start Queue in the 
Options settings of the Scheduler (see “Customizing Scheduler 
Settings” on page 4-76), the measurement starts immediately.
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Viewing the Results of a Measurement
After acquisition, the results of the measurement are added to the 
completed LabBook and can be viewed in Qtegra. Log Messages can be 
viewed, the results can be electronically signed, different sets of queries 
can be placed and Reports can be printed.

❖ To view the results of a measurement

1. From the Qtegra - [Home Page], click Completed LabBooks.

2. In the Completed LabBooks tab, click the LabBook you wish to 
view.
The completed LabBook opens in a separate tab, see Figure 6-36.

Figure 6-36. Completed LabBook
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3. Expand iCAP OES to show the items added to the LabBook after 
measurement, see Figure 6-37.

The items Evaluation Results and Instrument State, and the 
menus Log Messages, Signing, Query and Reports have been 
added to the LabBook.

Evaluation Results

The Evaluation Results view displays the data acquired within a 
LabBook and can be viewed during the actual acquisition of a LabBook 
in Qtegra.

The presentation of the evaluation results differs, according to the 
“Method Parameters Settings” on page 9-3 defined. 

❖ To open the Evaluation Results view

1. In the Completed LabBooks list, select the LabBook you wish to 
view.
The completed LabBook is opened in a new tab.

2. Expand Evaluation Results to open the Evaluation Results view, 
for example, see Figure 6-38.

Figure 6-37. Added items of a completed LabBook

Figure 6-38. Evaluation Results sub-menus in completed LabBook
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The toolbar of the completed LabBook shows several additional buttons 
for Evaluation Results, see Figure 6-39.

The function of the additional buttons is explained in Table 6-2.

Figure 6-39. Toolbar of completed LabBook

Table 6-2. Additional buttons in toolbar for Evaluation Results

Button Icon Meaning

Recalculate Qtegra updates the data 
automatically whenever you make 
changes.
For some applications, however, the 
update is not performed 
automatically. The button then 
flashes to advise you there are some 
updates to be performed. 

Inter-Element 
Correction 

Switches the mathematical 
interference correction on and off.

Blank 
Correction 

Switches the Blank correction on and 
off.

Use Internal 
Standard 

Switches the use of an internal 
standard on and off.

Display 
Details

Displays an enlarged graph of the 
calibration curve including the 
calculated values for the background 
equivalent concentration (BEC), the 
instrumental detection limit (IDL) 
and the most common statistical 
data.

Hide 
Thumbnails

Hides or shows the thumbnails 
(small graphical display) of the 
evaluation results.

Display 
Settings

Opens the Display Settings dialog 
(see Figure 6-40) where you can set 
the digits to be displayed for 
evaluation results, set the Internal 
Standard Ratio display to True or 
False and enter a customized name 
for General.

Column Filter Switches the columns to be displayed 
for the selected result view.
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Display Settings can be set for any LabBook. Set parameters for the 
Calibration view, the Concentrations view, the Intensities view, the 
Ratios view, and general and quantification parameters according to 
your needs.

❖ To open the Display Settings dialog

1. On the LabBook toolbar, click Display Settings to open the 
Display Settings dialog, see Figure 6-40.

2. Select the item you want to change. A short description is shown 
below the list to explain the item. Thus you can see that, for 
example, the Correlation Coefficient is also known as R, and the 
Coefficient of Determination as R2.

Figure 6-40. Display Settings dialog showing the default values

Tip Changes are only valid for the currently selected LabBook. To use 
your settings in general, create your LabBooks from this modified 
LabBook.
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Log Messages
The Log Messages view of a LabBook is added to the LabBook after a 
measurement has been run for this LabBook.

The table in Log Messages contains all events with appropriate time 
stamps which occur throughout the manipulation of the LabBook. All 
information, warning and error messages are logged here including 
information about the service concerned.

❖ To open the Log Messages view

1. In the Completed LabBooks list, select the LabBook you wish to 
view.
The completed LabBook is opened in a new tab.

2. Click Log Messages to view the Log Messages of the completed 
LabBook, see Figure 6-41.

❖ To filter Log Messages

1. In the Log Messages view, click  in the header of the column you 
wish to filter the display of.

Figure 6-41. Log Messages in completed LabBook
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A drop-down menu opens, see Figure 6-42.

2. Select an item from the drop-down menu.
The column shows only the selected values.

❖ To customize filters in Log Messages

1. In the Log Messages view, click  in the header of the column you 
wish to filter the display of.

2. From the drop-down menu, see Figure 6-42, select (Custom).
The Custom Filter dialog opens, see Figure 6-43.

3. From the Filter based on drop-down menu, select Any or All.

Figure 6-42. Log Messages filter drop-down menu in completed 
LabBook

Figure 6-43. Custom Filter dialog of Log Messages in completed 
LabBook
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4. Click  of the left column to open the Rule drop-down menu, see 
Figure 6-44.

5. Select a rule from the drop-down menu.

6. Click  of the right column to open the Argument drop-down 
menu, see Figure 6-45.

7. Select an argument from the drop-down menu.

8. Click OK.
The specified rules are immediately applied to the table.

Figure 6-44. Rule drop-down menu of Custom Filter dialog

Figure 6-45. Argument drop-down menu of Custom Filter dialog



LabBooks
Signing

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 6-39

Signing
The Signing view of a LabBook is added to the LabBook after a 
measurement is completed.

Signing is used to protect the acquired data and to verify the operator. 
Certificates are required to activate the signing feature. These Digital 
SSL certificates are issued by Trusted CA Certificate Authorities (for 
example, VariSign, GlobalSign, Thawte and CAcert) and must be 
purchased separately. They are applied by your Administrator.

❖ To open the Signing view

1. In the Completed LabBooks list, select the LabBook you wish to 
view.
The completed LabBook is opened in a new tab.

2. Click Signing to open the Signing view, see Figure 6-46.

The LabBook may be signed in multiple steps, for example Acquired, 
Verified and Approved. All steps are defined and named in the 
Configurator (see “Signature Workflow” on page 3-28). After signing, 
every step can be revoked if sufficient user rights are set under 
Configurator > Access Control > User Actions > LabBooks > 
Electronic Signatures.

Tip Large companies will usually have their own certificates. Ask your 
Administrator. See “Qtegra LabBook Signing” on page 2-19 on how 
to make certificates available.

Figure 6-46. Signing in completed LabBook

http://www.varisign.com
http://www.globalsign.com
http://www.thawte.com
http://www.cacert.com
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After the first step has been signed, the Sign button switches to Revoke 
and the next step gets a Sign button. With a signature on the final step, 
the LabBook is approved and you therefore may not directly revoke the 
signature of the initial steps.

❖ To sign the LabBook

1. Open the Signing view of your LabBook.

2. In the pane representing the actual step, click Sign.
The Select certificate for signature dialog opens, see Figure 6-47.

A list of valid certificates which contain a private key necessary for 
signing is shown.

3. Select your certificate from the list and click Select.

4. Follow the instructions.
Any further step subsequently must be signed by the user as defined 
in the Configurator.

❖ To open a signed or locked LabBook

1. Every signed LabBook can be opened with a compatible version of 
Qtegra ISDS Software.

2. If a LabBook was locked (see page 3-28 for locking with signing) 
and then opened, the LabBook tab indicates the lock state.

This state shows that no changes can be made with this LabBook, 
for example, no data can be excluded in the Concentrations view, 
Standards are grayed out in the Standards view.

Figure 6-47. Select certificate for signature dialog

Figure 6-48. “locked” hint for signed LabBook
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3. If a LabBook was signed and then opened with a later version of 
Qtegra ISDS Software, the LabBook is indicated with a yellow hint 
in the toolbar.

The signed LabBook is protected and verified by the operator and 
can therefore not be modified.

Electronic signatures can be added to the Report to document the 
signing level.

❖ To add the Signature to the Report

1. Open the Reports view of your signed LabBook. At least the first 
level must be signed.

2. Expand the Reports tree and select one item.
The Report Preview is shown.

3. Click Edit Report on the Preview toolbar.

4. To place the signature in the page footer, select the Page footer from 
the Report Settings tree.
By default, “$(PageNumber) / $(PageCount)” is shown as 
placeholders.

a. Click Add to add a new placeholder.

b. Expand the Placeholders button and select Signature.
“$(Signature)” is shown in the Text box.

c. Click Execute Report to check the new footer in the Report.

Figure 6-49. Toolbar hint for signed LabBook
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d. Finally, close and reopen your LabBook to see the signature(s) in 
the Report’s footer, see Figure 6-50.

e. If you select XML Renderer as Output Format, the signature is 
appended to the code, see Figure 6-51.

Figure 6-50. Signatures in the Concentrations Report footer

Figure 6-51. Signatures in the Concentrations Report 
(XML Renderer)
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5. As an alternative, the signature can also be placed in the Content 
area with Data Tables from the Signatures source, see Figure 6-52.

6. Click Execute Report to show the current output.
The Report shows the Signature columns as specified. Based on the 
example in Figure 6-52, the Date and Time Zone (UTC based and 
with standard name), the name of the Signing computer and Domain, 
and the login name and display name of the Signing User are shown.

Figure 6-52. Signatures Table in the Report Editor
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Query
Query is used to gather and arrange LabBook data for export into third 
party packages (such as Excel) and for printing or saving as a Report 
(that allows for additional formatting changes, additional calculations 
etc.) The Query view of a LabBook is only available once data is 
acquired.

For Query, the toolbar of the completed LabBook adds the Query and 
Reports buttons, and the Create drop-down item New Report is 
activated, see Figure 6-53.

Data is gathered for export as a Query by selection from a series of data 
sources.

❖ To open the Query view

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Click Query in the content pane of the LabBook.

Figure 6-53. LabBook toolbar of a completed LabBook in Query
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3. On the toolbar of the LabBook, open the Query view to open the 
screen as shown in Figure 6-54.

The result data display of a query is defined by the selection of 
individual data categories and LabBook, Sample List or Results 
parameters. Perform at least step 1 to step 3 of the procedure as follows.

❖ To define result data display of a Query

1. In the Rows section of the Query view, select the individual data 
Categories you wish to display. 

-or-

Click All to select all data categories.

For details on the individual data categories, see page 6-49.

2. In the Columns section, click Expand to view all parameters, and 
select the LabBook, Sample List, and Results parameters you wish 
to display.

-or-

Click All to select all parameters.

Figure 6-54. Initial Query view of a completed LabBook
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3. In the Result section, click Update to display the selected result 
values, see Figure 6-55.

4. Click Hide Units to hide or show the units.

❖ To save a Query preset

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Open the Query view and define the result data.

3. On the toolbar of the Result pane, click Refresh or press <F5> to 
display the selected result values.

4. From the Presets drop-down list, click Save Preset As.
The Save New Preset dialog is displayed, see Figure 6-56.

5. Type a Name for the preset.

Figure 6-55. Query view with results in completed LabBook

Figure 6-56. Save New Preset dialog in Query view

Tip Result data presets saved here will be available as well in the 
Query view of the LabBook Query page, see “LabBook Query 
Page” on page 4-41.
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6. Type a Description.

7. Click OK.
The preset is added to the list.

❖ To export Query result data

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Open the Query view and define the result data.

3. On the toolbar of the Result pane, click Refresh or press <F5> to 
display the selected result values.

4. On the toolbar of your LabBook, click Export.
-or- 
Press <Ctrl> + <E> to open the Export data dialog, see Figure 6-57.

5. Select your export format from the Exporter drop-down menu.
Query Excel Export will generate an XML file that is opened with 
Excel, by default.
Query CSV Export will generate a comma separated file (*.csv) that is 
opened with a text editor, for example, Notepad.

Figure 6-57.  Export data dialog

Tip For tQuant and trQuant LabBooks, additionally Laser Data 
Reduction Export (compatible with both Iolite and GLITTER v 
4.4.4 and above) is available to define the analytes results to be 
exported.
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CSV Export and SpreadsheetML Export are not valid for Query tables 
and may therefore be ignored.

6. Type the Path for the export file, 
-or-
Click the browse button to open the standard dialog to navigate to 
the desired folder.

7. Edit the Filename for the export file, or keep the proposal.

8. Depending on your selection from the Exporter, the right pane of 
the Export data dialog varies.

a. For Query Excel Export, select Open file in Excel after export to 
automatically run the associated program displaying your 
exported file.

b. For Query CSV Export, select Open file in Notepad after 
export to automatically run the associated program displaying 
your exported file. Select the Column separator and Decimal 
Symbol from the list boxes.

9. Click Export. When the file name already exists, a message is 
displayed to confirm or deny overwriting.
The file is exported and opened immediately if so defined.

❖ To delete Query presets

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Open the Query view.

3. In the Results section on the right, select the preset you wish to 
delete from the Presets list.

4. Click Delete to delete the result data preset.
The Delete Preset dialog is displayed, see Figure 6-58.

Tip Query based exports are not suited for LIMS (“N/A” values 
are exported as “0”, zero, which may be imported into LIMS 
systems without forcing format errors). Best to use CSV Export and 
SpreadsheetML Export for laser.

Figure 6-58. Delete Preset dialog in Qtegra
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5. Click Yes.
The preset is deleted from the list.

Categories

The Categories section in the Query view of a LabBook lists the data 
types that can be added as rows in the exported data set. See Table 6-3 
for a description of the supplied categories. For additional information 
on each data type, see “Basic Mathematical Methods” on page 11-1 and 
“Data Processing Algorithms for eQuant” on page 13-1.

Table 6-3. Categories with reference to detailed description

Name Description

BEC The background equivalent concentration is defined as 
the analyte concentration that produces a net signal 
(peak minus background) equal to the background. See 
“Background Equivalent Concentration (BEC)” on 
page 13-5.

Blank Corrected Intensity 
Average

Calculated from the IS Corrected Intensity Average 
minus the intercept. See “Blank Corrected Intensity” on 
page 13-15.

Blank Corrected Intensity 
per Run

Calculated from the IS Corrected Intensity per Run 
minus the intercept. See “Blank Corrected Intensity” on 
page 13-15.

Coefficient of 
Determination

See “Coefficient of Determination (R2)” on page 11-4.

Concentration Average Arithmetic mean of Concentration per Run values. See 
“Average” on page 11-2. Note that the Concentration 
Average from standard addition measurements (aQuant) 
shows the concentration of the individual sample 
(“STD” or “ZERO STD”). To get the result 
concentration of a “STD” or “ZERO STD” block in the 
Query and Reports, select Zero Standard Concentration.

Concentration per Run Concentration value per run, corrected for any dilution 
or special blank.

Concentration RSD Relative standard deviation of Concentration per Run 
values. See “Relative Standard Deviation (RSD)” on 
page 11-2.

Concentration SD Standard deviation of Concentration per Run values. 
See “Standard Deviation (SD)” on page 11-2.

Correlation Coefficient The Pearson correlation coefficient is calculated from 
the Coefficient of Determination. See “Correlation 
Coefficient (R)” on page 11-4.

Intensity Average Arithmetic mean of Intensity per Run values. See 
“Average” on page 11-2. 

Intensity per Run Intensity value per run, corrected for interference. 

Intensity RSD Relative standard deviation of Intensity per Run values. 
See “Relative Standard Deviation (RSD)” on page 11-2.
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Intensity SD Standard deviation of Intensity per Run values. See 
“Standard Deviation (SD)” on page 11-2.

Intercept (a) Intercept of linear and 2nd order calibration curves.
f(x) = bx + a 
f(x) = cx2 + bx + a

IS Corrected Intensity 
Average

Arithmetic mean of IS Corrected Intensity per Run 
values. 

IS Corrected Intensity per 
Run

Intensity per Run values, corrected by Internal 
Standard.

Linear Factor (b) Factor used in calibration curve f(x) = bx + a

LOD See “Limit of Detection (LOD)” on page 13-4.

Measured Concentration 
Average

Arithmetic mean of Measured Concentration per Run 
values.

Measured Concentration 
per Run

Concentration measured per run, without correction for 
dilution or special blank.

MQL See “Method Quantification Limit (MQL)” on 
page 13-4.

Quadratic Factor (c) Factor used in calibration curve f(x) = cx2 + bx + a

Raw Intensity Average Arithmetic mean of Raw Intensity per Run values.

Raw Intensity per Run Intensities per run without any correction for 
interference.

Relative at% Arithmetic mean of Relative Atom Percent per Run 
values. See “Relative Atom Percent (RelAt%) and 
Relative Weight Percent (RelWt%)” on page 13-16.

Relative at% per Run Relative Atom Percent per Run.

Relative wt% Arithmetic mean of Relative Weight Percent per Run 
values. See “Relative Atom Percent (RelAt%) and 
Relative Weight Percent (RelWt%)” on page 13-16.

Relative wt% per Run Relative Weight Percent per Run.

RSE See “Relative Standard Error (RSE)” on page 11-2.

Standard Concentration Concentration value for the standard referred to for that 
analysis.

TuneSettings Tune Settings for a couple of instrument specific 
parameters, for example, Additional Gas Flow, 
Peristaltic Pump Speed, Plasma Power, Nebulizer Flow.

Zero Standard 
Concentration

Concentration of the zero standard using in Standard 
Addition calibration routines.

Table 6-3. Categories with reference to detailed description, continued

Name Description
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Query Reports

❖ To open the Reports view of a query

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Open the Query view and define the result data.

3. On the toolbar of the LabBook, click Reports to open the Reports 
view (see also “Qtegra Report Preview” on page 8-66).
For details on creating Reports, see “Using the Qtegra Report 
Editor” on page 8-15.

4. From the list of Reports, select one item.

5. On the toolbar of the Reports pane, click Display Report or click 
Execute Report below the list to display the selected Report.

The Report can be modified, printed or exported as described in 
“Qtegra Reports” on page 8-1.
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Reports
The Reports view of a completed LabBook displays the results of a 
measurement in Report formats previously created.

For creation of Reports, see “Using the Qtegra Report Editor” on 
page 8-15.

❖ To show a Report

1. Open a LabBook that contains results. It will be displayed in its own 
tab.

2. Click Reports to open the Report Preview, see Figure 6-59.

The results of the measurement are displayed using the layout of the 
first Report in the list on the left.

3. Select a Report layout to change the Report layout accordingly.

Reports Editor

In the Report Preview of a completed LabBook in Qtegra, you generate 
result data Reports from presets.

You can structure your Report to your needs, add headings, tables and 
graphs to specify the presentation of the result data. For details on 
creating Report presets, see “Report Settings Items” on page 8-25.

Figure 6-59. Report Preview of a completed LabBook
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Method Development

General Remarks
The Method Development tool of Qtegra ISDS Software provides two 
routines to support users in the method development process. The first 
routine, Element Finder, suggests wavelengths for the user’s 
measurement based on the selection of elements from the Periodic Table 
and by optionally performing a series of measurements on the sample of 
interest.

In the second routine, Plasma Optimization, plasma parameters are 
optimized in a multivariate manner. Only important parameters are 
optimized to reduce the time required to perform the optimization 
process. The routine allows the user to optimize the plasma parameters 
for highest average intensity, for best signal to background ration, or for 
best signal to square root of background ratio.

Contents

• General Remarks on page 7-1

• The Method View on page 7-2

• The Element Finder on page 7-4

• Plasma Optimization on page 7-12

• Working with Completed Methods on page 7-20
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The Method View

Start Page for Method Development

The Start Page for Method Development provides options to create a 
new method or to open a previously completed.

❖ To create a new method

1. From the Qtegra - [Home Page], click Method Development.
The Method Development page of Qtegra opens, see Figure 7-1.

2. Enter a unique Name for the method and select a Location if 
desired. A red frame around the Name box indicates that the name 
already exists. Enter a unique name to proceed to the next step.

3. Click  to create the new method.
A tab opens for the newly created method with two tiles shown. 
Once methods have been created and completed, they are shown in 
the History list located on the right hand side of the page, see “The 
Method View” on page 7-2.

4. Select either Element Finder or Plasma Optimization.

Figure 7-1. Method Development page

Figure 7-2. Initial view for creating a new method
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5. For Element Finder, the method view changes to the first step of 
the Method Creation wizard. See “The Element Finder” on 
page 7-4.
-or-
For Plasma Optimization, see “Plasma Optimization” on 
page 7-12.

Tip In Method Development the status indicator for the current 
configuration only indicates if the instrument is connected or not. 
To see if the Status is Ready or Not Ready return to the Dashboard 
on the Qtegra [Home Page].
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The Element Finder
This routine is used to determine a list of wavelengths that is best suited 
for analysis. The workflow does not explicitly require knowledge of the 
matrix or analyte elements that are present in the sample. If these are 
known, they can be selected on the appropriate screens.

The wavelengths found by the algorithm can then be used to create a 
pre-filled method. Alternatively, it is possible to determine elements 
contained in the sample by making a Fullframe measurement within 
Element Finder. Input from the user can be compared with or added to 
the Element Finder result.

Elements found by the Element Finder routine are marked as Matrix by 
default. This means that they are used by the algorithm to determine 
which wavelengths are best suited to the analysis but they will not be 
measured. Changing their type to Analyte Element will mean that they 
are measured when exported to a LabBook.

Creating a Method

The creation of a method is easy to execute. The Method Creation 
wizard provides all steps for user input.
Tip Select the Configuration that you want to use to perform Element 
Finder. If a Configuration is changed before the Element Finder result 
has been saved, all progress will be lost and the Method View page will 
be shown.
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Selecting Analyte Elements

❖ To select the analytes of your sample

1. In the step Select Analyte Elements, select the elements from the 
Periodic Table that you want to analyze. These elements are referred 
to as Analyte Elements within an Element Finder routine.
As in a normal LabBook, elements outside the instrument's 
detection capability can not be selected, see Figure 7-3.

Selected Analyte Elements are indicated by a green box in the top 
right hand corner of the element tile. The number within the tile 
denotes the amount of wavelengths that could be suitable for 
analysis and is updated with each subsequent element selection.
If an element has been selected by error, it can be removed by 
clicking on it again. The box in the top right hand corner will be 
removed.

2. Click Next to open the next page of the wizard.

Figure 7-3. Selection of Analyte Elements

Tip If you do not know what is in your sample, you can skip this 
step without selecting any element and clicking . For 
iCAP 6200 and 7200 this step must take place.
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Selecting Matrix Elements

❖ To select the Matrix Elements

1. In the step Select Matrix Elements, click to select the elements 
which are in your matrix from the Periodic Table. Matrix Elements 
are elements you do not want to analyze but are contained in your 
sample, see Figure 7-4.

Selected Matrix Elements are indicated by a blue box in the top right 
hand corner of the element tile. The number within the tile denotes 
the amount of wavelengths that could be suitable for analysis and is 
updated with each subsequent element selection.

Selected Analyte Elements are indicated by a light-colored tile, see 
Fe, Co, Ni in Figure 7-4. These elements therefore can not be 
selected as Matrix Elements. To change the Analyte and Matrix 
status, see “Viewing the Result” on page 7-9.

If an element has been selected by error, it can be removed by 
clicking on it again. The box in the top right hand corner will be 
removed.

2. Click Next to open the next page of the wizard.

Figure 7-4. Selection of Matrix Elements

Tip If you do not know which Matrix Elements are in your 
sample, you can skip this step without selecting any element and 
clicking . For iCAP 6200 and 7200 this step must take 
place.
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Element Finder

1. In this step, Qtegra shows the view to perform Element Finder, see 
Figure 7-5.

2. Under Parameters, from the Sample Type listbox, select Aqueous or 
Organic according to your sample.

3. From the Autosampler listbox, select either Manual sampler or 
<Autosampler> according to your instrument Configuration.
For details on autosampler settings, see “Autosampler Settings” on 
page 7-18.

4. Click  to execute the Element Finder 
measurement.

The Element Finder performs a series of Fullframe measurements 
starting with the visible spectrum followed by the ultraviolet 
spectrum.

The Run Element Finder area shows the progress and result of the 
Fullframe measurements.

Figure 7-5. Perform Fullframe page after execution

Tip Fullframe measurements in Element Finder can not be 
performed using an iCAP 7200 Duo instrument. A typical sample 
should be used at this point.
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After the Fullframe measurements are complete, they are analyzed 
and the elements that are found are displayed, see Figure 7-6.

5. In the Element Finder Result area, the number of analyzed 
elements and number of additional elements found are shown, see 
Figure 7-7.

6. If you would like to perform another Element Finder Measurement, 

click , and then .

7. Click Next to open the next page of the wizard.

Figure 7-6. Executing a Fullframe measurement

Figure 7-7. Element Finder view for a completed measurement
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Viewing the Result

In this step, the Result screen shows the wavelengths that are best suited 
to your analysis according to selections made on previous screens (if any) 
and output of the Element Finder measurement. By default, elements 
that are found by the Element Finder measurement are marked as 
Matrix Elements. Each element will automatically have a wavelength 
that is best suited to the analysis selected.

It is possible to change their type from Matrix to Analyte Elements, and 
if desired, modify the wavelengths that have been suggested by Qtegra.

Buttons below the suggested wavelength pane allow these changes to be 
made.

❖ To change the Analyte and Matrix type

1. Hover over the element tile and click the Toggle button (see 
Figure 7-8) to change the element from or to Analyte or Matrix as 
desired.

The Matrix indicator (blue) changes to the Analyte indicator 
(green).

2. Click  to update the view.

❖ To change suggested wavelengths

1. Click the row of the wavelength of the Analyte Element to display 
the spectrum view for the selected wavelength. Wavelengths of the 
visible spectrum are displayed in light yellow, wavelengths of the 
ultraviolet spectrum are displayed in violet.

Figure 7-8. Analyte/Matrix Toggle button
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The spectrum of only one Analyte Element wavelength can be 
shown at a time, see Figure 7-9.

2. By default, the list of elements shows 1 wavelength per element. To 
view all wavelengths available for the element, click 

.
The list is expanded. By default all wavelengths have a Preference of 
Automatic. The Preference of the wavelengths can be modified as 
desired.

3. From the listbox of the Preference column, select either Automatic, 
Exclude, or Include to specify the use of the specific wavelength. 
Automatic means that the algorithms within Element Finder will 
determine if the wavelength should be used.
The most intense wavelength that is suitable for analysis will be 
marked as Available for Analysis.
Include means that this wavelength must be used and will be 
included in the wavelengths used for analysis.
Exclude means that the wavelength will not be Available for 
Analysis.

Figure 7-9. Element Finder Result view

Tip If no Fullframe measurements have been performed then no 
spectra are displayed.

Tip If a change is made to the Preference column the wavelength 
originally suggested by Element Finder as Available for Analysis 
will then change its state to No. To keep the original wavelength as 
Available for Analysis change the Preference of that wavelength to 
Include.
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Entries in the Remarks column explain reasons for the wavelength 
Preference, for example, interferences with other wavelengths and 
corresponding elements.

4. From the listbox of the Measure Mode column, select either Axial 
or Radial. The possible Measure Modes will depend on the 
instrument Configuration.

5. Click  to show 1 wavelength per element.
The list is collapsed and shows the default view.

6. If any modifications have been made or if you have changed the 

element type from either Analyte or Matrix,  toggles 
its color. Click the button to update the view after your changes.

❖ To save the current method

1. After all changes are done, make sure that  is not 
highlighted.

2. Click  to save the current method.
A confirmation dialog opens to enter a comment.

3. The initial page is shown with the tiles to run the Element Finder or 
to perform the Plasma Optimization. The completed Element 
Finder routine is saved to the History entries, see Figure 7-10.

Figure 7-10. Method Development page with completed Element Finder result in the History pane
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Plasma Optimization
This routine is used to optimize the plasma parameters for your method.

Plasma optimization can be performed on the output of the Element 
Finder tool or on a custom selection of elements and wavelengths. The 
starting parameters are determined by the selected sample type, aqueous 
or organic.

The following parameters are optimized in a multivariate manner:

• Plasma power

• Plasma gas

• Nebulizer gas

• Radial viewing height (Radial instruments only)

During the optimization process the parameters are shown in real time. 
Once the optimization is complete it is possible to apply these 
parameters to a LabBook.

Optimizing the Plasma Parameters

Plasma parameters can be optimized for a previously completed Element 
Finder method or by selecting wavelengths through the wizard. In the 
following, both ways are described.

Plasma Optimization on Element Finder Result

❖ To optimize the plasma parameters using the output of the Element 
Finder

1. From the initial view of your method (see Figure 7-10), hover over 
the Element Finder method in the History pane to show additional 
buttons.

Tip If you have an iCAP 7200 Duo instrument, the plasma 
optimization is limited. Only plasma power is optimized, either 1150 
or 1300 W.
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2. Select Create Plasma Optimization.
The Periodic Table is shown with all Analyte Elements already 
selected, see Figure 7-11.

To use the pre-selection, perform the next step.

-or-

Deselect the Analyte Elements you do not wish to use for plasma 
optimization.
Select additional Analyte Elements you wish to use for plasma 
optimization.

3. Click Next to open the Perform Optimization page of the wizard, 
see Figure 7-12.

Figure 7-11. Selected elements for plasma optimization

Tip Modifying the wavelengths from the output of the Element 
Finder in this way, may lead to an incorrectly optimized set of 
plasma parameters.
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Plasma Optimization Wizard

❖ To optimize the plasma parameters by using the wizard

1. From the initial view of your method (see Figure 7-2), click Plasma 
Optimization to run the wizard.

2. Select the elements and wavelengths from the Periodic Table that 
you want to optimize plasma parameters for. 

Elements outside the instrument’s detection capability can not be 
selected, see Figure 7-12.

Selected elements are indicated by a green box in the top right hand 
corner of the element tile. By default, optimization is performed on 
the most intense wavelength of the selected element.

If an element has been selected by error, it can be removed by 
clicking it again. The box in the top right hand corner will be 
removed.

To select specific wavelengths hover over the tile and select Open 
Dialog.
-or-
Right-click the element tile.

Figure 7-12. Selection of elements for Plasma Optimization
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The Wavelength Selection dialog opens, see Figure 7-13.

Tick the wavelengths as desired. Close this dialog with OK.

3. Click Next to open the Perform Optimization page of the wizard, 
see Figure 7-14.

4. From the Sample Type listbox, select either Aqueous or Organic 
according to the composition of your sample.

Figure 7-13. Wavelength Selection dialog

Figure 7-14. Selection of optimization parameters
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5. From the Optimize for listbox, select Intensity, Signal to Background 
Ratio, or Signal to Square Root of Background Ratio.
Select Intensity to find the parameters that give the highest average 
intensity for the selected wavelengths. The optimized parameters 
will not give plasma parameters that will lead to the highest intensity 
for each individual wavelength.
Select Signal to Background Ratio to optimize plasma parameters 
to give the best average signal to background ratio for the 
wavelengths selected. As with Intensity the optimized parameters 
will not give plasma parameters that will lead to the best signal to 
background ratio for each individual wavelength. The signal to 
background ratio is a rough indicator of detection limit.
Select Signal to Square Root of Background Ratio to optimize 
plasma parameters to give the best signal to square root of 
background ratio for the wavelengths selected. As with Intensity 
and Signal to Background Ratio the optimized parameters will not 
give plasma parameters that will lead to the best signal to 
background ratio for each individual wavelength. The signal to 
square root of background is a better approximation of the detection 
limit than the signal to background ratio, however the optimization 
routine using this metric is likely to take longer than selecting any 
other metric.

6. From the Autosampler listbox, select either Manual sampler or 
<Autosampler> according to your instrument Configuration.
For details on autosampler settings, see “Autosampler Settings” on 
page 7-18.

7. Click  to perform the plasma optimization based on 
your selections.
The button changes to .

The Perform Plasma Optimization area shows the progress of the 
optimization process, see Figure 7-15.

Figure 7-15. Performing the plasma optimization

Tip A typical sample should be used to carry out the plasma 
optimization.
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8. If desired, click  to abort the optimization process.
A message is displayed in the Result area.

After the optimization process has successfully finished the Result 
area shows the optimized RF Power, Coolant Gas Flow, Nebulizer 
Gas Flow, and - depending on the instrument Configuration - 
Radial View Height values, see Figure 7-16.

9. Click  and enter a comment to save the plasma 
optimization file to the History.

The Method View page is shown with the tiles to run the Element 
Finder or to perform the Plasma Optimization. The completed 
Plasma Optimization routine is saved to the History entries, see 
Figure 7-17.

Figure 7-16. Viewing the optimization result values

Figure 7-17. Method page after successful Plasma Optimization
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Autosampler Settings

The Element Finder and Plasma Optimization wizards provide an 
option to specify autosampler parameters.

❖ To specify autosampler values

1. If an Autosampler, for example, CetacASX520 or ESI SC8DX is 

selected,  is shown. When this button is 
clicked, a dialog opens where it is possible to specify timings and 
sample positions, see Figure 7-18.

2. Type Wash time (s) and Uptake time (s).

3. For ESI SC autosamplers, set the flush time (s) for Rinse 1 and 
Rinse 2.

4. For ESI SC autosamplers, tick View Pump Settings to show 
detailed pump and flush settings for Rinse 1 and Rinse 2.
To close the Pump Settings view, remove the tick.

5. For CETAC ASX, under Sample position, select Vial, Home or 
Rinse for the Position Kind.

Figure 7-18. Select sample positions for autosampler dialog; top: CETAC 
ASX; bottom: ESI SC

Tip The minimum uptake time delay is set by the instrument to 
help ensure that the sample has entered the plasma. If you require 
a longer uptake time, simply set the time desired.
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On errors, the tooltip of a red indicator shown next to the cell assists 
in understanding the error.

6. Under Rack, select the Rack number where your sample is placed.

7. Under Vial, type the desired vial number.

8. In the second row, define the position parameters for the probe after 
completed plasma optimization.

9. Click OK to apply the sample and return positions.
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Working with Completed Methods
Completed methods can be used to create LabBooks or can be used to 
create new methods.

Creating a LabBook based on a Method

❖ To create a LabBook based on a Method Development result

1. From the Qtegra - [Home Page], click LabBooks.
-or-
From the Method View page, click Create LabBook.

The LabBooks page of Qtegra opens, see Figure 4-26.

2. Type a unique Name for the LabBook.

3. Select the option Create a new LabBook from a blank Template.

4. Select the Evaluation from the listbox.

5. Tick the Use Method Development result check box and select a 
method from the Method Development Name listbox.

6. Click Create LabBook.
The Create LabBook from Method Development result window 
opens, see Figure 7-19.

7. Tick the check box to select the desired Plasma Optimization and/or 
Element Finder result and click Create.

Once the Method Development results have been processed, your 
new LabBook is opened. The LabBook consists of all Analyte 
Elements, wavelengths, Measure Modes, acquisition parameters, and 
instrument parameters, which are saved in the method file. It is then 
possible to start with the creation of the Sample List.

Figure 7-19. Create LabBook from Method Development result window
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Opening an Existing Method

❖ To open an existing method

1. From the Qtegra - [Home Page], click Method Development.
The Method Development page of Qtegra opens, see Figure 7-1.

2. In the Open a method section, click  to select an 
existing method from the Open Method Development File dialog.
-or-
In the Recent methods list, select an existing method.

A new tab is opened for the selected method, see Figure 7-20.

Figure 7-20. List of recent methods
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Viewing Details of a Method

❖ To view details of a completed method

1. From the Qtegra - [Home Page], click Method Development.
The Method Development page of Qtegra opens, see Figure 7-1.

2. In the Open a method section, click  to select an 
existing method from the Open Method Development File dialog.
-or-
In the Recent methods list, select an existing method to open a new 
tab for the selected method, see Figure 7-20.

3. When hovering a History tile, the following command icons are 
shown:

Create Plasma Optimization
This command icon is shown on Element Finder entries only. Select 
this icon to create a Plasma Optimization based on the result of the 
Element Finder method, see “Optimizing the Plasma Parameters” 
on page 7-12.

Create new
This command icon is shown on Element Finder entries only. Select 
this icon to create a new method from the previously completed 
Element Finder. This allows rapid modification of the original 
method, starting with the first page of the Element Finder wizard, 
see “Creating a Method” on page 7-4. The original method will 
remain unchanged.

Once you have made any desired modifications it is possible to click 
Finish and save the method. This will then be added to the History 
list.

Show summary (Element Finder)
The view changes to show the Summary overview, see Figure 7-21.

The Element Finder Summary is composed of four sections. The 
first shows the date that the selected Element Finder was conducted, 
the user who performed it, any comments and state of the routine. 
The second sections shows all user selected Analyte Elements, 
followed by Matrix and Analyte Elements found by the Element 
Finder. The final section shows which wavelengths have been 
selected for Analyte Elements.
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Show summary (Plasma Optimization)
The view changes to show the Summary overview.
The Plasma Optimization Summary is composed of two sections, 
see Figure 7-22. The first shows the date that the selected Plasma 
Optimization was conducted, the user who performed it, any 
comments and state of the routine. The second section shows the 
final optimized parameters.

4. Click  to close the summary page.

Figure 7-21. Element Finder Summary page including the Cancel button in the lower right edge

Figure 7-22. Plasma Optimization Summary page including the Cancel 
button in the lower right edge
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8
Qtegra Reports

This chapter describes the necessary steps to create and execute Reports 
using the Qtegra Report Editor. All of the information was acquired 
with version 2.2 of the Qtegra ISDS Software.

Contents

• Getting Started with Qtegra Reports on page 8-2

- Concentrations Report

- Printing a Report

- Saving as HTML File

- Saving as PDF File

- Saving as RTF File

- Saving as XML File

- Automated Report Export

- Supplied Reports

• Using the Qtegra Report Editor on page 8-15

- Opening a Report Template

- Structure of the Qtegra Report Editor

- Editing a Report Template

- Previewing a Report

- Saving a Report Template

- Report Settings Items

- Report Content Items

- Text

- Modifying the Performance Report

- Support for Spectra

• Qtegra Report Preview on page 8-66

- Report Preview Toolbar

- Preview Area
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Getting Started with Qtegra Reports
Features in Qtegra ISDS Software allow flexible Report templates to be 
created so that data acquired by and stored in a LabBook can be easily 
distributed to colleagues or customers. A wide range of features are 
available: from support of graphics to allow the use of company logos to 
sophisticated calculations to allow data from multiple LabBooks to be 
combined in a single Report in order to meet the requirements of USP 
<232>.

Reports can be printed and exported in a variety of different formats 
including password protected PDF. Reports can be automatically 
generated per analysis in a LabBook-based acquisition to allow for on 
the spot data evaluation with color-coded flagging of Quality Control 
(QC) data carried through into the final Report.

Report creation is straightforward, and a series of example Report 
templates are supplied to allow for modified Reports to be easily 
generated.

This chapter outlines basic information about Qtegra Reports.

❖ To open the Reports view

1. From the Qtegra - [Home Page], click .

2. In the Completed LabBooks list, click the Name to open the 
LabBook you wish to view.
The completed LabBook is opened in a new tab.

3. Click  to open the Report Preview.

Concentrations Report

This section describes the use of a Report for one LabBook and for 
multiple LabBooks.
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Concentrations Report for One LabBook

A Report is applied to a single LabBook by first opening a LabBook and 
then selecting one of the available Reports. Several example Report 
templates are supplied with Qtegra ISDS Software. See Figure 8-1.

Figure 8-1. Example Report templates supplied with Qtegra ISDS Software

Thermo Scientific supplied example Reports

Tip The Reports shown here are supplied with the ICP-MS. The 
Reports supplied with the iCAP ICP-OES are different but are used 
the same way.
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Once selected, the Report template is populated with data from the 
open LabBook and displayed. See Figure 8-2.

The Reports entry is always available except when a scheduled LabBook 
is running. Then, the Content pane shows only the Method Parameters, 
the Evaluation Results, the autosampler or Manual Sample Control, and 
the Sample List entry.

Figure 8-2. Report template populated with data from a selected LabBook

The selected Report is applied to open the LabBook
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Concentrations Report for Multiple LabBooks

Once the criteria for a LabBook query have been defined and applied to 
multiple LabBooks, the resulting data set can be used to generate a 
Report, see Figure 8-3.

Creating Quantification Values for a Report

A Report can be modified in order to show quantification results in its 
lists. To provide the calculation traces, your Template or LabBook must 
be prepared accordingly.

Relative atom percent (Relative at%) and relative weight percent 
(Relative wt%) are calculated for analytes on the following conditions:

• A multi-calculation trace with “Sum” operator is defined.

• The analyte matches the selection defined for the multi-calculation 
trace.

• A concentration is available for the analyte.

See “Quantification” on page 9-33 for details on how to define 
calculation traces.

Figure 8-3. Generating a concentrations Report based on the results of a LabBook query

The selected Report is applied to the results of a LabBook query
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Adding Calculations to a Report

Calculation traces are certain operations provided by Qtegra (Average, 
Max, Min, RSD, SD, Sum) and can be customized under Method 
Parameters > Quantification > Calculation Trace.

❖ To add Calculation Traces to a Report

1. Open a finished LabBook with operations defined in Method 
Parameters > Quantification > Calculation Trace.

2. From the Content pane, select the Report template you wish to add 
calculation traces to. The template is populated with data from the 
LabBook.

3. On the Report Preview toolbar, click Edit Report to open the 
editor.

4. In the Report Content pane, expand Content > Grouping:Group by 
to select Result Table:Results table (1 in Figure 8-4).

5. From the five category tabs in the right pane (2 in Figure 8-4), select 
Columns and expand Customized Traces to see all customized 
traces, which you defined in the LabBook.

6. Select the item(s) you want to add to the Report and click Add from 
the Result columns toolbar.
The item(s) are appended to the list.

7. To check the result, click Execute Report from the main toolbar. 
The pages with the Results table show the calculated values from 
customized traces.
After checking the preview click Edit Report to switch back to the 
edit mode.

Labeled Components: 1=expanded Report Content pane, 2=five category 
tabs

Figure 8-4. Selecting the Results table

1 2



Qtegra Reports
Getting Started with Qtegra Reports

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 8-7

❖ To add Predefined Calculation Traces to a Report

1. Select Rows from the category tabs (2 in Figure 8-4). Double-click 
each item of interest (for example, LOD, MQL, Relative at%, 
Relative wt%) to move it from Available to Selected, see Figure 8-5.

2. The items selected in Figure 8-5 are printed in the Report as follows.

3. After checking the preview, click Edit Report to switch back to the 
edit mode.

Figure 8-5. Selecting predefined calculation traces

Figure 8-6. Predefined calculation traces shown in the Report
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Printing a Report

A Report containing the results from a LabBook can be printed by 
clicking the Print icon from the main reporting toolbar, see Figure 8-7.

❖ To print a Report

1. Open the Reports view as shown in “To open the Reports view” on 
page 8-2.

2. From the Report Preview toolbar, click Print to print the currently 
displayed Report.
A printer selection dialog is displayed.

Saving as HTML File

The populated Report can be saved as an HTML file by selecting 
HTML Renderer from the Output Format drop-down menu.

❖ To save the Report as an HTML file

1. Open the Reports view as shown in “To open the Reports view” on 
page 8-2.

2. From the Report Preview toolbar, expand the Output Format 
button to display the menu items. Select HTML Renderer, see 
Figure 8-8.

Figure 8-7. Printing a Report

Tip Printing will always create one Report that is currently 
selected. You may select each particular Report listed in the 
Reports section of the Content pane to the left and then click 
Print to print this Report.

Figure 8-8. Formatting a Report with an HTML renderer
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The Report is rendered and the HTML page is displayed.

3. Click the Save As button.
The Browse For Folder dialog is opened to select the folder where 
you want to save the HtmlReport folder with the index.html file and 
all images used.

4. Open the HtmlReport folder and double-click the index.html file to 
view the Report in your browser.

Saving as PDF File

The populated Report can be saved as a standard PDF file by clicking 
the Save As icon from the main reporting toolbar, see Figure 8-9.

❖ To save a Report

1. Open the Reports view as shown in “To open the Reports view” on 
page 8-2

2. From the Report Preview toolbar, click Save As to save the 
currently displayed Report as a PDF file.

The Save document dialog is displayed to select the path and to type 
the file name.

Alternatively, the Report can be saved as a password-protected PDF file.

❖ To save a password protected Report

1. Open the Reports view as shown in “To open the Reports view” on 
page 8-2

Figure 8-9. Saving a Report as PDF file

Tip Saving will always create one Report that is currently selected. 
You may select each particular Report listed in the Reports section 
of the Content pane to the left and then click Save As to save this 
Report.
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2. From the Report Preview toolbar, expand the Save As button to 
display the menu items. Select Save password protected Report, 
see Figure 8-10.

3. The PDF Password dialog is displayed to type and confirm the 
password.

4. Select Hide password to display an asterisk for every character you 
are typing into the password fields. This option toggles the display, 
this means, remove your selection to display the password as it was 
entered.

5. Type your password and then in the second field, reenter this 
password.
The OK button becomes available when both entries are identical.

The Save document dialog is displayed to select the path and to type 
the file name.

Figure 8-10. Saving a Report as password-protected PDF file

Figure 8-11. PDF Password dialog

Tip Saving will always create one Report that is currently selected. 
You may select each particular Report listed in the Reports section 
of the Content pane to the left and then click Save password 
protected Report to save this Report.
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6. When you open this PDF file from your Windows Explorer, a 
dialog is displayed to type the password before opening this file.

7. Type the correct password to display the Report in your PDF viewer.

Saving as RTF File

The populated Report can also be saved as a file in rich text format 
(RTF) using the same Save As dialog. Instead of the default PDF 
format, the RTF format must be selected from the drop-down menu of 
the dialog, see Figure 8-13.

Any RTF file so created can, for example, be opened in a text editor, for 
example, Microsoft™ Word™.

Saving as XML File

The populated Report can be saved as an XML file by selecting XML 
Renderer from the Output Format drop-down menu.

Figure 8-12. Document Open Password dialog

Figure 8-13. Saving a Report as RTF file
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❖ To save the Report as an XML file

1. Open the Reports view as shown in “To open the Reports view” on 
page 8-2.

2. From the Report Preview toolbar, expand the Output Format 
button to display the menu items. Select XML Renderer, see 
Figure 8-14.

The Report is rendered and the XML code is displayed.

3. Click the Save As button.
The Browse For Folder dialog is opened to select the folder where 
you want to save the XML file.

4. Finally, use an XSLT template to transform the data.

Automated Report Export

The same export possibilities as described at Printing a Report, Saving as 
PDF File, Saving as RTF File, and Saving as XML File can be 
automatically applied for each analysis generated by LabBook-based 
acquisitions. A combination of hard-copy printouts as well as file 
exports can be created for either individual analyses or for the entire 
LabBook of analyses.

The definition of the automatic export of Reports is made per LabBook 
in the Content pane at Automatic Export > Report Export, see 
Figure 8-15.

Figure 8-14. Formatting a Report with an XML renderer

Figure 8-15. Location of automatic export commands within a LabBook
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In the example shown in Figure 8-15, the Report “Concentrations” will 
be produced per analysis as both a PDF file and as a hard-copy (sent to 
the Windows-defined default printer). A “Comprehensive” Report will 
be generated as an RTF file. At the end of the LabBook, the “Method 
Summary” will be exported as an XML file.

The names of any file exported is defined by the Target File Name field 
as shown in Figure 8-15 where any text entered is used as a prefix for the 
automatically sequentially numbered files generated.

Supplied Reports

Some example Report templates are supplied with Qtegra for your 
instrument. They address most basic reporting requirements and are 
listed in Table 8-1.
Table 8-1. Example Report templates supplied with Qtegra ISDS 

Software

Report Name Report Content

Basic sample report Tables for all analytes are displayed with the 
wavelength, concentration average, and 
recovery percentage. 

Calibration Summary Calibration lines for all calibrated analytes are 
displayed along with the equation and 
correlation coefficient, R2. Background 
Equivalent Concentration (BEC) and 
Detection Limit (LOD) values are also 
recorded. Following this, the expected and 
read back concentrations for each standard 
are listed. Portrait format.

Comprehensive sample 
report

A single Report containing the most 
commonly required data. It includes 
information from the Reports Calibration, 
Method Summary and Sample List Summary 
as well as providing the Concentration 
Average and % RSD precision for every 
analysis in a LabBook. Portrait format.

Tip This Report populates tables for analytes 
depending on their status as Internal 
Standard or not. It should therefore be edited 
before use for each LabBook.

Concentrations report Per run (repeat) concentrations with average 
and % RSD precision. Landscape format.

Horizontal table report Concentration average for every analysis in a 
LabBook. Concentration per line, analytes 
per column. Portrait format.
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Intensities report Per run (repeat) intensities with average and 
% RSD precision. Landscape format.

Log-Messages The Report shows only log entries of the first 
5 samples measured. The Log-Message 
Report lists the entries with Level (UserInfo, 
Debug), Message string, Category (to 
indicate the Qtegra module), and the 
Sub-Category. The list is sorted by Time.

Method Summary Key analysis method parameters used for data 
acquisition. Shows the choice of Internal 
Standard.

Sample List Summary Index, label, and autosampler position for all 
analyses in a LabBook-based acquisition. Also 
shows the Start Time and active user account 
for each analysis. Portrait format.

Simple sample report Concentration average, % RSD and Standard 
Deviation (SD) are shown for every analysis 
in a LabBook. Portrait format.

Vertical table report Concentration average for every analysis in a 
LabBook. Concentration per column, 
analytes per line. Portrait format.

Table 8-1. Example Report templates supplied with Qtegra ISDS 
Software, continued

Report Name Report Content
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Using the Qtegra Report Editor
The Qtegra Report Editor is used for creating and editing Report 
templates. The editor allows creating, loading and saving Report 
templates, which are used to generate a Report from a LabBook of 
analyses.

Report templates can be manipulated (created, edited and saved) from 
an open LabBook. To populate a Report from a given template the 
LabBook must contain the appropriate data.

This chapter outlines how to work with the Qtegra Report Editor.

Opening a Report Template

❖ To open a Report template for editing

1. Open a LabBook.

2. Select the supplied Report template from the list of available Reports 
(Method Summary, for example).

3. Click the Edit Report button (2 in Figure 8-16).

The selected Report template is opened up in a new window inside 
the Qtegra application.

Figure 8-16. Opening a Report template for editing

1

2
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Structure of the Qtegra Report Editor

The basic structure of the Qtegra Report Editor is shown in 
Figure 8-17.

The Report Editor has the following components:

• The Toolbar (1 in Figure 8-17) that contains the main Report 
editor-related functions,

• The Report Content Area (2 in Figure 8-17) that shows the 
structure of the loaded Report template:

Report Settings: general settings for each page (header, footer, etc.)

Report Content: the Report objects used in the loaded Report

• The Report Area (3 in Figure 8-17), which displays the details of 
the selected Content item.

Toolbar

The toolbar provides commands:

• to manipulate Report templates (Load, Save etc.)

• to manipulate content items in Report templates (adding, deleting, 
moving, etc.).

The possible commands are listed in Table 8-2.

Figure 8-17. Main editor page of Qtegra Report Editor

1

2

3

Table 8-2. Commands of toolbar

Function Description

Creates a new Report template

Opens an existing Report template

Deletes the current Report template

Saves the current Report template
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❖ To create a Report template

1. From the Completed LabBooks list, click to open the LabBook you 
wish to view.
The completed LabBook is opened in a new tab.

2. On the toolbar of the LabBook, click  to open the 
drop-down menu.

3. Select New Report, see Figure 8-18.

Saves the current Report template under a new name

Adds a Report content item to the Report template.
See “Report Content Items” on page 8-33.

Deletes the selected content item(s)

Moves the selected content item(s) up the Report

Moves the selected content item(s) down the Report

Applies the Report template to the loaded LabBook

Figure 8-18. Completed LabBook selecting New Report

Table 8-2. Commands of toolbar, continued

Function Description
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The Report Editor for the new Report opens in a new tab, see 
Figure 8-19.

4. In the Content pane, type a Name and optionally a Description for 
the Report.
The Name entered is displayed as Report title in the generated 
Report.

❖ To delete a Report template

1. From the Completed LabBooks list, click to open the LabBook you 
wish to view.
The completed LabBook is opened in a new tab.

2. Click  in the content pane of your LabBook.

3. On the toolbar of the LabBook, click  to open the 
Reports view.

Figure 8-19. Title of Report

Tip You can also open new Reports by clicking New Report on 
the Reports Editor’s toolbar.
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4. Select the Report template you wish to delete and click Delete, see 
Figure 8-20.

The Report template is deleted from the list to the left.

❖ To save a Report template under a new name

1. Click Save to save the Report template.
The Save Report dialog opens, see Figure 8-21.

Figure 8-20. Reports page of completed LabBook, deleting Report

Figure 8-21. LabBook Query Save Report dialog
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2. Type a Filename and click OK.
The file name entered is immediately displayed in the tab of the 
Report and will be shown in the Reports view in the list on the left.

❖ To generate a Report

1. From the Completed LabBooks list, click to open the LabBook you 
wish to view.
The completed LabBook is opened in a new tab.

2. Click  in the content pane of your LabBook.

3. On the toolbar of the LabBook, click  to open the 
Reports view.

4. Select a Report from the list on the left and click Execute.

You can also click  below the list.

5. The Report is generated as defined in the Report template selected 
and displayed in the Report Preview on the right, see Figure 8-22.

6. Print the Report.

-or- 

Save the Report as desired.

Tip The shortcut menu of Reporting on the left offers commands 
to create a new folder or to import files. The shortcut menu of a 
folder on the left offers commands to cut, copy, delete, and 
rename folders.

Figure 8-22. Reports page of completed LabBook showing executed 
Report
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Report Content Area

The Report Content Area shows the content of the Report definition in 
a tree structure. The main nodes listed in Table 8-3 are available.

Report Area

The Report Area allows for the definition of content-specific features.

Editing a Report Template

The supplied Report templates meet the most common reporting 
requirements. They can be edited as required to generate new templates.

❖ To edit a Report template

1. Open a LabBook.

2. From the list of available Reports, select the Report template.

3. Once the Report is displayed with data from the open LabBook, 
click the Edit Report button, see Figure 8-16.

A Report template consists of two sections as shown in Figure 8-23:

• Report Settings

• Content

Table 8-3. Report Content Area

Node Description

Report Settings Contains items, which define the layout of the 
Report. These items can not be deleted.
See “Report Settings Items” on page 8-25.

Content Contains items, which define the content of the 
Report that is displayed.
See “Report Content Items” on page 8-33.

Figure 8-23. Report template consisting of Report Settings and Content
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Report Settings are general settings for the Report template that define 
the look and feel of the Report (page header, footer, etc.). An 
explanation of each setting is described at “Report Settings Items” on 
page 8-25.

Content are individual components that add functionality to a Report. 
An explanation of each content item is described at “Report Content 
Items” on page 8-33.

In the Report Content window, located on the left-hand side of an 
open Report template, select a particular item. The content-specific 
properties for the selected item are displayed in the Report Area on the 
right-hand side for editing, see Figure 8-24. This process is the same for 
both Settings and Content items.

Adding New Content to a Report Template

❖ To add new content to a Report template

1. On the Report template toolbar, click the Add button. See 
Figure 8-25.

Figure 8-24. Selecting a Report content item for editing

1

2
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2. From the drop-down menu showing the available content items, 
select the content type (Data or Graph, for example), see 
Figure 8-25.

Table 8-4 lists the available content types for a Report template. An 
explanation of each content item is provided at “Report Content Items” 
on page 8-33.

Figure 8-25. Available content types for a Report template

Table 8-4. Available content types for a Report template

Content type Description

Chart Chart data from a LabBook.
See “Chart” on page 8-34.

Data Numerical data (not results) from a LabBook 
presented in a table.
See “Data” on page 8-40.

Graph Graphical data from a LabBook.
See “Graph” on page 8-44.

Group By Allows ordering of content by grouping based on 
an aspect of the LabBook.
See “Group By” on page 8-45.

If data available Items below this item are only displayed if the 
result of this item contains values.

New Lines/
Page Breaks

Line or page breaks between other content types 
to improve layout of the Report.
See “New Lines/Page Breaks” on page 8-47.

Result Data Table Results from a LabBook presented in a table.
See “Result Data Table” on page 8-47.

Text User defined text to describe other content in a 
Report.
See “Text” on page 8-51.
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Re-Ordering Content

❖ To change the order of content items in the Report template

1. Select the content item.

2. On the toolbar, click the /  buttons.

Report Settings cannot be re-ordered as their positions in the Report 
template are fixed.

Temporarily Removing Content

The visibility of each content item in a Report is controlled by the Use 
in Report check box. This command is useful during Report creation 
and editing as content items can be temporarily removed from the 
display by toggling this field. Content is not permanently deleted from 
the Report template when using this feature, see Figure 8-26.

Permanently Removing Content

❖ To permanently remove content items in a Report template

1. In the Report Content window, select the content items to be 
permanently removed.

2. On the toolbar, click the Delete Content button.

Figure 8-26. Toggling display of content items in Report template
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Previewing a Report

Once the Report template is defined, it can be applied to the open 
LabBook by clicking the Execute Report button on the toolbar, see 
Figure 8-27.

Data from the selected LabBook is then used to populate the Report 
template, and the Report is displayed.

Saving a Report Template

❖ To save a Report template

1. Ensure that the edited Report template meets the reporting 
requirements.

2. Perform one of the two following alternatives:

a. To save the Report template over a previously defined version, 
click Save on the toolbar.

b. To create a new Report template, click Save As on the toolbar.

Report Settings Items

You create Report presets or templates easiest from the Reports view of 
a completed LabBook in Qtegra.

Generally, you can structure your Report to your needs, add headings, 
tables and graphs to specify the presentation of the result data.

Figure 8-27. Applying a Report template to an open LabBook
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A typical structure for a Report template is shown in Figure 8-28.

Image

A user-selectable image can be included at the top right of the Report 
header. A wide range of image formats is supported. Images are 
automatically resized for display in the header area. The position of the 
chosen image cannot be adjusted, see Figure 8-29.

Two commands are available. They are listed in Table 8-5.

This feature can be used, for example, to personalize Reports by adding 
a company logo to the generated Reports.

Figure 8-28. Example of the Report Content structure

Figure 8-29. Image selection for use in a Report

Table 8-5. Commands for image selection

Command Description

Shows a dialog to select the image file to be used 
in the Report.

Resets the image to the default Qtegra image.
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Page

The settings for the page type of the Report can be defined here, see 
Figure 8-30.

The commands listed in Table 8-6 are available.

Figure 8-30. Formatting a page of a Report

Table 8-6. Commands for page formatting

Command Description

Paper format Specify the paper size when saved as or printed.

Orientation Specify the orientation of the paper.

Margins Top Top margin, in mm.

Margins Bottom Bottom margin, in mm.

Margins Left Left margin, in mm.

Margins Right Right margin, in mm.

Font Size Font size for the Report content, in point.

Theme Select a color theme from the list box.
Dark, set as default, shows a black background 
on table headers and alternating gray and white 
background color on table entries.
Light shows all tables without background color 
neither on headers nor on table entries. This 
would be the recommended theme to be used in 
Reports that are frequently printed in order to 
reduce ink usage.
Select Custom to specify your own color set:
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The Report theme area is then expanded and 
provides Font and Color selection boxes to 
specify all parts of tables.

To check your settings, click the Execute Report 
button on the toolbar. For details, see 
“Previewing a Report” on page 8-25.

Table 8-6. Commands for page formatting, continued

Command Description
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Page Header

The settings of the page header of the Report can be defined here, see 
Figure 8-31.

The commands listed in Table 8-7 are available.

Figure 8-31. Defining page header of Report

Table 8-7. Commands to define page header

Command Description

Header Height Specify the height of the header, in mm.

Number of 
Columns

Number of columns for the defined text item(s) 
displayed in the header.

Fill Order Define the order in which text items populate 
the previously defined number of columns.

Show Header 
Image

If selected, the defined image is displayed in the 
right corner of the header.
See “Image” on page 8-26.

Texts List of text items that are displayed in the header.
See “Header and Footer Text Items” on 
page 8-31.
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Page Footer

The settings of the page footer of the Report can be defined here, see 
Figure 8-32.

The commands listed in Table 8-8 are available.

Figure 8-32. Defining page footer of Report

Table 8-8. Commands to define page footer

Command Description

Footer Height Specify the height of the footer, in mm.

Fill Order Define the order in which text items populate 
the previously defined number of columns.

Texts List of text items that are displayed in the footer.
See “Header and Footer Text Items” on 
page 8-31.
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Header and Footer Text Items

Text items are used to define the content of the header and the footer of 
a Report. The items are arranged in a table-based layout. The table is 
filled as specified in the Fill Order and in Number of Columns fields. 
See Table 8-9 and Table 8-10 as two examples.

Placeholders

Text items can contain placeholders to include Report specific 
information. The placeholders listed in Table 8-11 are available.

Table 8-9. Header and footer text items - Example 1

Example Result

Number of columns: 2

Fill Order: Vertical

Text 1 Text 3

Texts: Text 1, Text 2, Text 3 Text 2

Table 8-10. Header and footer text items - Example 2

Example Result

Number of columns: 2

Fill Order: Horizontal

Text 1 Text 2

Texts: Text 1, Text 2, Text 3 Text 3

Table 8-11. Placeholders in text items

Placeholder Description

Report date and time Creation date and time of the Report.

Report date Creation date of the Report.

Report time Creation time of the Report.

Current user The user name of the currently logged in 
Windows account.

Page number The current page number of the Report.

Page count Total number of pages.

Report name The name of the Report as specified in 
the Content section of the Report.
See “Content” on page 8-33.

Report file name The file name of the Report.

Acquired by user The user name of the currently logged in 
Windows account when the LabBook was 
added to the acquisition queue.

Instrument serial number The serial number of the instrument used 
for acquisition of the LabBook.
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Header and Footer Editor

The header and footer editor is shown in Figure 8-33.

The commands listed in Table 8-12 are available.

For each text item, the properties listed in Table 8-13 are available.

Figure 8-33. Header and footer editor

Table 8-12. Commands for header and footer editor

Command Description

Number of columns Number of columns for the defined text 
item(s) displayed in the header or footer.

Fill Order Order in which text items populate the 
previously defined number of columns.

Texts The list of text items that are displayed in the 
header or footer.

Adds a text item.

Removes the selected text item(s).

Move the selected text item(s) up.

Move the selected text item(s) down.

Table 8-13. Properties for text items

Placeholder Description

Text The text to be displayed in the Report.

Placeholders The list of available placeholders.
See “Placeholders” on page 8-31.

Font Family The font used for the text.
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Report Content Items

Content

The Content item is used to define additional Report information, see 
Figure 8-34.

The fields listed in Table 8-14 are available.

Font Size The font size in point.

Bold If checked, the text is rendered in bold style.

Italic If checked, the text is rendered in italic style.

Text Color The color in which the text is rendered.

Background Color The background color applied to the text.

Alignment The text alignment (Left, Center, Right).

Table 8-13. Properties for text items, continued

Placeholder Description

Figure 8-34. Content settings

Table 8-14. Fields of content settings

Field Description

Name The name of the Report, which is used in the 
Report Name placeholder.

Description An optional description for the selected Report.
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Chart

The Chart item is used to display values as a chart. This tool is used to 
generate a Performance Report or any type of mass or intensity diagram. 
The data input sheet offers several setting parameters, see Figure 8-35.

The fields listed in Table 8-15 are available.

Figure 8-35. Chart settings

Table 8-15. Chart settings fields (Sheet 1 of 5)

Field Description

Name The name that is displayed in the Report content area 
for this item. By default, the name is Chart.

Description An optional description.

Use in 
Report

If selected, this item is rendered when the Report is 
created.

Source The data source of any column. Your selection will 
show the appropriate columns. Select one of the 
following sources: Additional acquisition parameters, 
Analytes, Instrument Information, Interference Correction, 
LabBook Summary, Measurement Modes, QC MXS 
Table, Ratios, Results, Sample List, Standard Details, 
Standards, Survey Scan Settings.

Select 
Unique 
Values

If selected, duplicates are not listed in the table.

Layout area The Layout area provides some optional parameters. 
Type or tick the option only if you want the parameter 
to be visible in each chart.
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Title Type a title, for example, “Results” 
that is shown on top of the chart.

Show Legend Tick this box to display a legend in 
the top left corner of each chart that 
explains your color selection from 
the Data Column area.

Flip Coordinates Tick this box to swap the X- and 
Y-Axis.

Width [mm] When auto size is not selected, type 
the width of your chart into the edit 
box. Use this option to show the 
chart in another size than Qtegra 
proposes.

Height [mm] When auto size is not selected, type 
the height of your chart into the edit 
box. Use this option to show the 
chart in another size than Qtegra 
proposes.

Auto Size Set by default. If selected, the chart 
is sized as big as possible to fit into 
the paper format.

Columns List of available columns specific to the selected Source. 
Click the item to select and press <Ctrl> or <Shift> for 
multiple selection. 
-or-
Press the mouse button and drag over the items to select 
a range.
Selected Columns fields may be added to the Data 
Definition section, the Sorting tab and the Conditions 
tab on the lower area.

Table 8-15. Chart settings fields (Sheet 2 of 5)

Field Description
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Axis 
Definition

Section that provides parameters to define the axis 
display.

Label Double-click the field and type a 
label that is shown on the axes. Each 
axis gets its own label.

Number Format See Table 8-19 for details on 
formatting the numeric output.

Rotation Select a rotation angle, for example, 
45°, from the drop-down list to 
show clockwise rotated labels. 
Supported range is 0 to 90°.

Data Column From the drop-down list for the 
X-Axis, select the data column. The 
drop-down list contains all columns 
according to the selected source. If 
nothing is selected, single “steps” are 
shown.

Label Column From the drop-down list for the 
X-Axis, select the label column. The 
drop-down list contains all columns 
according to the selected source.

Data 
Definition

List of columns that are used for the ordinate (Y-Axis) 
in the chart. Define chart display parameters for each 
data column item.

Title Double-click into this cell and type 
a title if you want to change the 
default that is copied from the data 
column.

Usage As all the data value appear in the 
ordinate, select the main Y-Axis or 
second Y2-Axis.

Table 8-15. Chart settings fields (Sheet 3 of 5)

Field Description
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The values for the Y2-Axis are 
auto-scaled and let the curves use 
the full height of the chart.

Chart Type Qtegra provides Bar, Line, 
Mountain, Scatter, and Stern 
diagrams as chart type. Select the 
type for each data column.

Color Qtegra provides a huge number of 
colors for the selected chart type. 
From the drop-down list, select the 
color for each data column.

Number Format From the drop-down list, select an 
item that represents the data 
column. The number format is set 
in the Axis Definition area.

Unit Column From the drop-down list, select an 
item that represents the data 
column.

Sorting Allows the returned data to be sorted.
See “Sorting” on page 8-53.

Table 8-15. Chart settings fields (Sheet 4 of 5)

Field Description
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Example chart to visualize QC Recoveries

The settings shown in Figure 8-36 are used to compile a scatter chart of 
the QC recovery.

In the Axis Definition table, select Label as Data Column and Start 
Time as Label Column for the X-Axis and rotate the items by 90°. Type 
Recovery (%) as Label for the Y-Axis.

From the Columns list, select the analytes and add the Source Results to 
the Data Definition table. In the Data Definition table, select Scatter as 
Chart type for all analytes.

In the Conditions table, add Category from the Columns list and define 
Recovery Percentage as Condition with the is equal to Operator.

Conditions Filters the data.
See “Conditions” on page 8-54.

Bookmark 
Tab

See “Bookmarks” on page 8-52.

Figure 8-36. Configuration of QC Recovery example chart

Table 8-15. Chart settings fields (Sheet 5 of 5)

Field Description
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Click the Execute Report icon on the toolbar (see “Previewing a 
Report” on page 8-25) to compile a Report that looks as shown in 
Figure 8-37.

This example shows that all QC recoveries are in the range of 92 to 
102%.

Example chart to visualize Internal Standard Recoveries

The settings shown in Figure 8-38 are used to compile a scatter chart of 
the Internal Standard recovery.

Configure the Layout, Axis Definition, Data Definition, and 
Conditions as described above.

Figure 8-37. Compiled Report of QC Recovery example chart

Figure 8-38. Configuration of IS Recovery example chart
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Click the Execute Report icon on the toolbar (see “Previewing a 
Report” on page 8-25) to compile a Report that looks as shown in 
Figure 8-39.

This example shows the IS recovery for a complete dataset with values in 
the range of 93 to 101%.

Data

The Data item is used for values in a table-based layout, see Figure 8-40.

Figure 8-39. Compiled Report of IS Recovery example chart

Figure 8-40. Data settings
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The fields listed in Table 8-16 are available.

Result Columns

Result Columns displays the columns that have been selected from the 
chosen Source. Columns from multiple sources cannot be combined.

For each column the options listed in Table 8-17 can be specified.

Table 8-16. Data settings fields

Field Description

Name The name that is displayed in the Report 
content area for this item.

Description An optional description.

Use in Report If selected, this item is rendered when the 
Report is created.

Columns Tab

Source The data source of any column.

Select Unique Values If selected, duplicates are not listed in the 
table.

Columns List of available columns specific to the 
selected Source.

Result columns List of columns that are displayed in the 
Report.

Sorting Allows the returned data to be sorted.
See “Sorting” on page 8-53.

Conditions Filters the data.
See “Conditions” on page 8-54.

Calculations Tab See “Calculations” on page 8-56.

Layout Tab See “Layout” on page 8-57.

Bookmark Tab See “Bookmarks” on page 8-52.

Table 8-17. Options for result columns

Option Description

Common

Name The column title as defined in Qtegra.

Caption User-definable text to represent the Qtegra-defined 
column title. In this way, data can be displayed 
under column titles specific to individual 
requirements.

Repeat If selected, the column caption is repeated on a new 
line when the table is too wide for a single line.
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Table 8-18 shows the standard numeric format strings.

Visible If selected, the column is visible in the table.

Width Column width
By selecting Auto, the column width is calculated 
based on the longest entry for the column in the 
whole table.
Otherwise, column width is entered in points.

Merge

Column If specified, the content of the current column is 
merged with the content of the column defined 
here and displayed as one single column.

Separator Text used to separate merged columns.
Format

Column Reserved for future software versions.
Calculations

Use for Label The selected column(s) are displayed in the label 
text of any calculations defined in the Calculations 
tab.

Text Defines the formatting of any text returned for a 
defined column. The text formatting possibilities 
depend on the column type.
See Table 8-18 to Table 8-21.

Table 8-18. Numeric format strings

Notation Summary Example

C or c Adds the currency symbol $ in front 
of the value and rounds the value 
with two decimals.

$ 123.45

E or e Exponential notation. -1.052033E+003

F or f Integral and decimal digits with 
optional negative sign.

-1234.57

G or g The most compact of either 
fixed-point or scientific notation.

-1.234567890E-25
or -123.456

N or n Integral and decimal digits, group 
separators, and a decimal.

1,234.57

Table 8-17. Options for result columns, continued

Option Description
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Custom numeric format strings are summarized in Table 8-19.

Standard date and time format strings are summarized in Table 8-20.

P or p Shows the value as percentage value 
with two decimals. 
Note: The original unit remains and 
will therefore appear next to the % 
symbol.

12,345.67 % ppb

R or r Displays the value as a real number 
with 17 digits and a decimal 
separator.

123.45678901234567

. or # Rounds the value up or down to an 
integer value without any group 
separator.

123

Table 8-19. Custom numeric format strings

Notation Before After

000.00 1.2 001.20

###.## 1.2 1.2

##,#.## 123456789.123 123,456,789.12

#0.0e+0 987654 98.8e4

#,#.##' °K’ 12345.678 12,345.68 °K

Table 8-20. Standard date and time format strings

Notation Summary Example for
6/15/2009 1:45:30 PM

d Short date pattern 6/15/2009

D Long date pattern Monday, June 15, 2009

f Full date/time pattern
(short time)

Monday, June 15, 2009 1:45 PM

F Full date/time pattern
(long time)

Monday, June 15, 2009 1:45:30 PM

g General date/time 
pattern (short time)

6/15/2009 1:45 PM

G General date/time 
pattern (long time)

6/15/2009 1:45:30 PM

Table 8-18. Numeric format strings, continued

Notation Summary Example
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Custom date and time format strings are summarized in Table 8-21.

Graph

The Graph item is used to display calibration graphs in the Report, see 
Figure 8-41.

The fields listed in Table 8-22 are available.

You define how many graphs are shown in one row.
The x-axis of each graph represents concentration, the y-axis intensity.
Below the graph you will find the formula of the function f(x) and the 
values for R2, BEC and LOD.

Table 8-21. Custom date and time format strings

Notation Summary Example

yyyy-MM-dd 
HH:mm:ss

6/15/2009 1:45:30 PM 2009-06-15 13:45:30

Figure 8-41. Graph content type commands

Table 8-22. Graph content type fields

Field Description

Name The name that is displayed in the Report 
content area of this item.

Description An optional description.

Use in Report If selected, this item is rendered when the 
Report is created.

Details Tab

Number of columns The number of graphs displayed across the 
page.

Bookmark Tab See “Bookmarks” on page 8-52.



Qtegra Reports
Using the Qtegra Report Editor

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 8-45

Group By

The Group By item is used to group data based upon criteria defined by 
another data source. This allows the combination of (multiple) content 
types per analysis to allow the display, for example, of analysis-specific 
groups of data, see Figure 8-42.

Figure 8-42. Options for a Group By content item
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The fields listed in Table 8-23 are available.

In the example shown in Figure 8-42 from the supplied Report 
Calibration, a grouping content item has been added to the Report 
calibration (1). The data source Results - Index (2) is used to define the 
content that will be grouped together but only when Sample 
Type = STD (3).

In this example, for each item that meets the defined grouping criteria 
(an analysis that has a result and has been defined as a STD), a series of 
content items are displayed, see Figure 8-43.

Table 8-23. Fields of Group By content type

Field Description

Name The name that is displayed in the Report 
content area of this item.

Description An optional description.

Use in Report If selected this item is rendered when the 
Report is created.

Details Tab

Source The data source used to group data by.

Columns List of available columns specific to the 
selected source.

Result columns List of column(s) used to define the Group By 
source. Supported columns for grouping are 
LabBook Summary: Filename, Sample List: 
Index and Results: Index.

Sorting Allows the returned data to be sorted.
See “Sorting” on page 8-53.

Conditions Filters the data.
See “Conditions” on page 8-54.

Tip This module is for structuring only and must be followed by a 
Data module, a Graph module or a Result Data Table module to show 
values.

Figure 8-43. Content items defined for analyses that meet the Grouping: 
Group by Results Index criteria
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Each of the grouped content items have their specific definitions as 
usual. The Report used in this example, Calibration, is supplied with 
Qtegra ISDS Software.

New Lines/Page Breaks

The New Lines/Page Breaks item is used to add empty lines and/or 
page breaks, see Figure 8-44.

The fields listed in Table 8-24 are available.

Result Data Table

The Result Data Table item is used to display calculated results from a 
LabBook. The following features are automatically applied to a Result 
Data Table item:

Figure 8-44. New Line/Page Break content type commands

Table 8-24. Fields of New Line/Page Break content type

Field Description

Name The name that is displayed in the Report 
content area of this item.

Description An optional description.

Use in Report If selected this item is rendered when the 
Report is created.

Perform Page Break If selected, page breaks are inserted.

Number of Page 
Breaks

The number of page breaks inserted.

Perform New Line If selected, empty lines are added to the 
Report.

Number of New Lines The number of empty lines that are added to 
the Report.
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• Columns that contain no values are hidden.

• The corresponding unit identifier is automatically attached to each 
analyte column.

• The Category column (from the Source Sample List) can be used 
to the displayed name of the text in the Rows tab.

• Data listed underneath the Category column is sorted automatically 
using a non user-definable order.

• If selecting Analytes, two options are available:

a. To add all defined analytes to the Report, select the Analytes 
column.

b. Specific analytes can be added to the Report by selecting them 
individually from the drop down list under the Analytes 
column.

• The width of all non-repeated columns is identical.

• All analyte results are automatically formatted. The format column 
is ignored.

The options for the Result Data Table content type are shown in 
Figure 8-45.

The fields listed in Table 8-25 are available.

Figure 8-45. Options for Result Data Table content type

Table 8-25. Result Data Table content type fields

Field Description

Common Section

Name The name that is displayed in the Report content 
area of this item.
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Special Columns

Some of the possible columns have special properties as summarized in 
Table 8-26.

Description An optional description.

Use in Report If selected this item is rendered when the Report is 
created.

Columns Tab

Columns List of available columns. They are grouped 
together under descriptive headings. Click the 
triangle next to each header to expand the group.

Result columns List of columns that are displayed in the Report.
See “Result Columns” on page 8-50.

Hide Units If selected, the unit text for a column is displayed 
in the header, but only if all entries in the column 
have the same unit type. If different units are used, 
this button has no effect.

Sorting Allows the returned data to be sorted.
See “Sorting” on page 8-53.

Conditions Filters the data.
See “Conditions” on page 8-54.

Rows Tab See “Rows” on page 8-50.
Calculations Tab See “Calculations” on page 8-56.
Layout Tab See “Layout” on page 8-57.
Bookmark Tab See “Bookmarks” on page 8-52.

Table 8-25. Result Data Table content type fields, continued

Field Description

Table 8-26. Special functions of certain columns

Function Description

Sample List: 
Category

This column must be added to allow the name of 
the lines as selected at the Rows tab to be included. 
In the example Report Concentrations (as shown 
in Figure 8-45), this column is renamed (using the 
Caption function) to Wavelength to allow for 
easier identification.

Analytes
Analyte Ratios
Analytes (Survey)

Analytes, Analyte Ratios, and Analytes (Survey) 
are used as the row or column header in the final 
results grid.
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Result Columns

Result columns displays the columns that have been selected from the 
chosen source. Columns from multiple column sources can be 
combined.

Rows

The Rows tab is used to select the numerical results displayed in the 
result table. If no rows are selected, the table displayed in the final 
Report is empty.

❖ To add or remove results to or from the table

Select them from either the Available or Selected list using the buttons 
at the bottom of the Rows tab as shown in Figure 8-46.
-or-
Double-click the item.

Figure 8-46. Adding or removing data types to or from Result Data Tables

Remove selected itemAdd selected item
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Text

The Text item is used to add custom text to the Report, see Figure 8-47.

The fields listed in Table 8-27 are available.

Figure 8-47. Text content type commands

Table 8-27. Fields of Text content type

Field Description

Name The name that is displayed in the Report 
content area of this item.

Description An optional description.

Use in Report If selected this item is rendered when the Report 
is created.

Text The text displayed in the Report.
Style

Font Family The font used for the text.

Font Size The font size in point.

Bold If checked, the text is rendered in bold style.

Italic If checked, the text is rendered in italic style.

Text Color The color in which the text is rendered.
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Common Items

Bookmarks

Bookmarks are used to generate a table of contents when the Report is 
saved as a PDF file. If available, a Placeholders drop-down menu 
contains a list of fields, which can be used to define content displayed as 
bookmark text.

Bookmarks can be created for any Report content item - even those 
nested inside a Group By content item, see Figure 8-48.

The fields listed in Table 8-28 are available.

Background Color The background color applied to the text.

Alignment The alignment of the text (Left, Center, Right).

Table 8-27. Fields of Text content type, continued

Field Description

Figure 8-48. Options for bookmark items

Table 8-28. Fields of Bookmark content type

Field Description

Create Bookmark If selected, a bookmark is created.

Level Select Auto to automatically determine the level 
of the bookmark in the final PDF file. Otherwise, 
specify the level that should be used in the table of 
contents.

Placeholders Contains the list of placeholders that are currently 
available. For a Data item and a Result Data Table 
item, this is the list of result columns selected.

Text The text that is displayed for the bookmark. 
Placeholder-specific text will be entered here 
automatically.
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Sorting

The Sorting function allows data to be sorted in a user defined order 
and is used by the following Report content items:

• Data

• Group By

• Result Data Table

❖ To select a column for sorting displayed data

1. Select the required column from the list of available columns.

2. On the Sorting list toolbar, click Add, see Figure 8-49.

The Sorting list toolbar contains the commands summarized in 
Table 8-29.

The fields listed in Table 8-30 are available.

Figure 8-49. Options for sorting commands

Table 8-29. Commands of Sorting list toolbar

Command Description

Adds the selected columns to the sorting list.

Deletes the selected sorting item(s).

Moves the selected sorting item(s) up the list.

Moves the selected sorting item(s) down the list.

Table 8-30. Sorting content type fields

Field Description

Name The name of the selected column to be used to 
sort data.

Sort Order Specify ascending or descending sort order.
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Conditions

The Conditions function allows data to be filtered by user defined 
criteria and is used by the following Report content items:

• Data

• Group By

• Result Data Table

Multiple conditions from different columns can be defined by using 
different operators (see Table 8-32).

❖ To use a column as a condition to display data

1. Select the required column from the list of available columns.

2. On the Conditions list toolbar, click Add.

Figure 8-50 shows the operators for Conditions commands.

The Conditions toolbar contains the commands summarized in 
Table 8-31.

Figure 8-50. Options for Conditions commands

Table 8-31. Commands of Conditions toolbar

Command Description

Adds the selected columns to the conditions list.

Deletes the selected condition item(s).
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The fields listed in Table 8-32 are available.
Table 8-32. Fields of Conditions content type

Field Description

Name The name of the column used for sorting. For example, 
select Category to provide a collection of Conditions 
(Concentration average, Intensity average, Recovery 
Percentage).

Operator The operator used to filter the data depends on the 
selected column, i.e., not all operators shown below are 
valid for all columns.

Is equal to Specifies a single value that is used to filter 
the data in the selected column. Select this 
value from the Condition drop-down list.

Is not equal Specifies a single value that is excluded 
from the data in the selected column. 
Select this value from the Condition 
drop-down list.

Is in list Specifies one or more values that are used 
to filter the data in the selected column. 
Tick the required values from the 
Condition drop-down list.

Is not in list Specifies a single value that is excluded 
from the data in the selected column. Tick 
the rejected values from the Condition 
drop-down list.

Contains Use the wildcard * to filter the data in the 
selected column. Type the required value in 
the Condition field.
Example: *myname* selects all values that 
contain “myname”.

Contains not Specifies a value that does not contain the 
string entered in the Condition field.
Example: STD excludes all values that 
contain “STD”.

Greater than Specifies a value that is greater than the 
value entered in the Condition field.

Less than Specifies a value that is less than the value 
entered in the Condition field.

Condition The conditions depend on the selected column and 
operator used.
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Calculations

Calculations are used to apply basic mathematical functions to selected 
data. Calculations are only available for:

• Data item

• Result Data Table item

Calculations can only be applied to the columns already defined in the 
result column list. Depending on the selected columns not all 
calculation types are available.

The options for Calculations are shown in Figure 8-51.

The Calculations toolbar contains the commands summarized in 
Table 8-33.

The fields listed in Table 8-34 are available.

Figure 8-51. Options for Calculations

Table 8-33. Commands of Calculations toolbar

Command Description

Adds a new calculation item to the calculation list.

Deletes the selected calculation item(s).

Moves the selected calculation item(s) up the list.

Moves the selected calculation item(s) down the list.

Table 8-34. Fields of Calculations content type

Field Description

Calculation Specifies the calculation type.
See “Calculations” on page 8-56.

Group Column If empty, the calculation is applied to all values 
of the selected columns once.
If a column is selected, the calculation is applied 
every time the value of the column changes.

Label The text displayed in the table for the 
calculation.

Unit The text for the unit displayed for the 
calculation.
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The calculation types available are listed in Table 8-35.

Layout

The Layout tab is used to define the display of table-related Report 
Content Items such as Data and Result Data Table.

The Layout options are shown in Figure 8-52.

Format The format used when displaying the 
calculation result.
See “Result Columns” on page 8-41.

Available Columns The columns listed are those specified in the 
Result Columns tab.

Table 8-35. Available calculation types

Calculation type Description

Entry Count Number of entries

Minimum Calculates the minimum

Maximum Calculates the maximum

Sum Calculates the sum

Value Replacement Allows re-ordering of rows in Reports

Average Calculates the average

Standard Deviation Calculates the standard deviation

RSD Calculates the relative standard deviation 
(% RSD)

Figure 8-52. Layout options

Table 8-34. Fields of Calculations content type, continued

Field Description
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The check boxes or fields listed in Table 8-36 are available.

Table 8-37 shows two examples of using Number of Columns and Fill 
Order.

Use Column Layout works fine for small data volumes such as showing 
Index and Sample Type above grouped tables. Use Table Layout is 
suitable for all tables sizes.

Modifying the Performance Report

As an example for changing an originally supplied Report the 
Performance Report shall be prepared to show “Per-run” data.

❖ To add Run Data to the Performance Report

1. From the Qtegra - [Home Page], open Qtegra > File Manager > 
Reports > Performance Report to see all available Performance 
Reports.

2. Double-click the Report you wish to modify.
The Report opens in a Qtegra tab.

Table 8-36. Check boxes or fields at Layout tab

Check box or field Description

Wrap Column Captions If checked, the text in the table header is 
wrapped to save space.

Switch Rows to Columns If checked, the contents of the defined 
rows are displayed in columns. This is 
similar to the Transpose function in 
Microsoft Excel.

Number of Columns The number of columns used to display 
data.

Fill Order The fill order used to display data.

Table 8-37. Two examples for using Number of Columns and Fill Order

Example 1 Result

Number of Columns: 1
Fill Order: Vertical

Label Col 1 Col 1

Label Col 2 Col 2

Label Col 3 Col 3
Example 2 Result

Number of Columns: 2
Fill Order: Vertical

Label Col 1 Col 1 Label Col 3 Col 3

Label Col 2 Col 2

Tip Replace the sub-folder and Report to change another Report 
accordingly.
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3. On the toolbar, click Edit Report to open a new tab with the 
Report editor.

4. Expand the Add button and select Data.

The is appended to the Report content and the main 
area shows the edit boxes.

5. From the Source listbox in the Columns tab, select Sensitivity Run 
Data.

All analytes used in the Performance Report are shown.

6. Select the desired analyte (or press <Ctrl> and click to select 
multiple analytes) and click Add on the Result columns toolbar.

The analytes are listed and may be modified for display as shown 
above.

7. On the Report Editor toolbar, click Execute Report to create the 
new Report.

8. To change further properties, click Edit Report again and change 
your items accordingly.

Support for Spectra

Spectra information from Survey Scans and Main Runs from eQuant 
analyses can be added to Reports. 

The following examples show how to set up different spectra Reports.

Figure 8-53. Source listbox
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❖ To add Spectra into a Report

1. From the Reports toolbar, select Add > Chart.

2. From the Source selection box, select Survey and Main Run 
Intensities.

3. In the Axis Definition section, define the Labels to be displayed for 
the X- and Y-Axis. These should normally be Mass for X and 
Intensity for Y.

4. In the Axis Definition section, select the Data Column to be used 
for display on the X-Axis (normally Mass).
With this defined, you can set the Min and Max mass values to 
allow a specific mass range to be used. 
-or-
Select AutoMin and AutoMax to display the entire mass range.

5. In the Data Definition section, select the Data Column to be 
displayed. This should be either Main Run Intensity or Survey Run 
Intensity and should be displayed on either the Y- or Y2-Axis. You 

Figure 8-54. Chart item in Add menu

Figure 8-55. Defining the X- and Y-Axes for a ‘Spectra Main Runs’ 
Report
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can select from a range of Chart Types (Bar, Scatter or Stem) and the 
chart Color as required.

6. The examples in Figure 8-56 and Figure 8-57 show the definition 
and resulting display from the supplied ‘Spectra Main Runs’ Report 
Template.

The chart shows the mass spectrum over the whole mass range.

Figure 8-56. Example definition of a ‘Spectra Main Runs’ Report 
Template

Figure 8-57. Resulting output from an example ‘Spectra Main Runs’ 
Report



Qtegra Reports
Using the Qtegra Report Editor

8-62 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

❖ To display Recoveries for Internal Standards as charts

1. From the Reports toolbar, select Add > Chart.

2. From the Source selection box, select Analysis Result Table.

3. In the Axis Definition section, define the Labels to be displayed for 
the X- and Y-Axis. For example, use Sample Index for X and 
IS Recovery (%) for Y.

4. In the Axis Definition section, select the Data Column to be used 
for display on the X-Axis. This should be Sample Index and you can 
use this value again for the Label Column. For the X-Axis (Sample 
Index), select AutoMin and AutoMax to display recoveries from all 
analyses in the LabBook. For the Y-Axis (IS Recovery (%)), set the 
Min and Max recovery values (expressed as a percentage) to allow a 
specific range of recoveries to be displayed (for example, as defined 
by a SOP).
-or-
Select AutoMin and AutoMax to display the entire range of 
recoveries measured.

Figure 8-58. Defining the X- and Y-Axes for an IS Recovery Report
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5. In the Data Definition section, select the Internal Standard Recovery 
Data Column. You can select from a range of Chart Types (Bar, 
Scatter or Stem) and the chart Color as required.

6. The examples in Figure 8-59 and Figure 8-60 show the definition 
and resulting display from the supplied ‘IS_Recoveries’ Report 
Template. 

The chart shows the Internal Standard recoveries from the entire 
LabBook.

Figure 8-59. Example definition of an IS Recovery Report Template

Tip You can add a Condition to, for example, select recoveries for 
specific Internal Standards to be displayed.

Tip It is not currently possible to display the response from 
individual Internal Standards, or to label the responses in the 
chart.

Figure 8-60. Example for an Internal Standard Recovery chart
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❖ To display Recoveries for Quality Control values as charts

1. From the Reports toolbar, select Add > Chart.

2. From the Source selection box, select Quality Control Values.

3. In the Axis Definition section, define the Labels to be displayed for 
the X- and Y-Axis. For example, use Sample Index for X and 
QC Recovery (%) for Y.

4. In the Axis Definition section, select the Data Column to be used 
for display on the X-Axis. This should be Sample Index and you can 
use this value again for the Label Column. For the X-Axis (Sample 
Index), select AutoMin and AutoMax to display recoveries from all 
analyses in the LabBook. For the Y-Axis (QC Recovery (%)), set the 
Min and Max recovery values (expressed as a percentage) to allow a 
specific range of recoveries to be displayed (for example, as defined 
by a SOP).
-or-
Select AutoMin and AutoMax to display the entire range of 
recoveries measured.

Figure 8-61. Defining the X- and Y-Axes for a Quality Control Recovery 
Report
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5. In the Data Definition section, select the Recovery Data Column. 
You can select from a range of Chart Types (Bar, Scatter or Stem) 
and the chart Color as required.

6. The examples in Figure 8-62 and Figure 8-63 show the definition 
and resulting display from the supplied ‘QC_Recoveries’ Report 
Template. 

The chart shows the Quality Control recoveries from the entire 
LabBook.

Figure 8-62. Example definition of a Quality Control Recovery Report 
Template

Tip You can add a Condition to, for example, select recoveries for 
specific analytes or specific QC types to be displayed.

Figure 8-63. Example for a Quality Control Recovery chart
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Qtegra Report Preview
This chapter describes how to work with the Qtegra Report Preview.

The Report Preview is used to display the generated Report based on a 
selected Report template. The Report Preview window for the supplied 
Concentrations Report template is shown in Figure 8-64.

The Report Preview has the components:

• Report Preview toolbar

• Preview Area

Report Preview Toolbar

The Report Preview toolbar provides functions to:

• Print and export the Report

• Zoom and navigate through the pages in the Report

The commands of the Report Preview toolbar are listed in Table 8-38.

Figure 8-64. Report Preview window for Concentration Report template

Table 8-38. Commands of Report Preview toolbar

Command Description

Prints the current Report.

Saves the Report in PDF or RTF format. Saves the XML 
file in XML format.

Zooms in the display.
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Preview Area

In the preview area, one page of the current Report is displayed at the 
currently selected zoom level. You can navigate through the Report with 
the page command buttons or by rotating the mouse wheel.

Zooms out the display.

Zoom Select one of the listed zoom levels.

Go to first page.

Go to previous page.

Go to next page.

Go to last page.

Table 8-38. Commands of Report Preview toolbar, continued

Command Description
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9
Method Parameters

The Method Parameters within a LabBook are dependent on the 
evaluation method assigned to the LabBook (see “Evaluation Methods” 
on page 9-2). For every application an appropriate LabBook can be 
created.

Contents

• Evaluation Methods on page 9-2

• Method Parameters Settings on page 9-3

- Analytes

- Measure Modes

- Acquisition Parameters

- Intelligent Uptake and Rinse

- Inter-Element Correction

- Standards

- Quantification

- Ratios

- Quality Control (eQuant only)

- Defining Detection Limits (eQuant only)

- Defining QC Settings in Sample Definition (eQuant only)
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Evaluation Methods
Qtegra ISDS Software offers a range of Evaluation methods (see 
Figure 9-1) to be selected when creating a LabBook to accommodate 
any type of analysis required.

The main applications for the evaluations are summarized in Table 9-1.

Figure 9-1. Evaluation types drop-down menu

Tip Any values entered that are not within the given range are marked 
with an .

Table 9-1. Evaluation methods

Evaluation Description

eQuant Uses external element concentrations to quantify 
element concentrations in an unknown sample.

For the analysis of unknown samples with matching 
standards, calibration graphs can be acquired and used 
for the fully quantitative analysis of unknown samples.

Raw Data Displays the acquired raw intensities, which are then 
used by the different evaluations.
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Method Parameters Settings
In the Method Parameters section, you define all measurement settings 
for your analytes. The availability of each parameter is controlled by the 
type of evaluation defined for the Template. 

All Method Parameters and the evaluation method for which they are 
available are listed in Table 9-2.

Analytes

For all Template types, the analytes to be acquired during the 
measurement are selected in the Method Parameters view Analytes.

Table 9-2. Method Parameters of Qtegra

Method Parameter Evaluation

Analytes eQuant, Raw Data

Measure Modes eQuant, Raw Data

Acquisition parameters eQuant, Raw Data

Monitor Analytes / 
Intelligent Uptake and Rinse

eQuant, Raw Data

Inter-Element Correction eQuant, Raw Data

Standards eQuant

Quantification eQuant

Ratios eQuant

Quality Control eQuant (after activating “Use QC” in 
the Quantification view)



Method Parameters
Method Parameters Settings

9-4 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

Analytes can be selected from the periodic table display in the Elements 
page, see Figure 9-2.

See “Color Scheme of the Periodic Table” on page 14-62 for details on 
the periodic table.

Default element properties defined in the database are automatically 
selected for wavelength, relative intensity, state, and possible 
interferences of the selected element . These element properties can be 
redefined by the Administrator in “Acquisition Parameters” on 
page 9-14.

Figure 9-2. Analytes
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In the Analyte Library, see Figure 9-3, lines can be selected from a 
tabulated list where the availability for analysis or choice to use as 
default can be defined. Lines can also be deleted or new lines can be 
added.

For some elements, several analytical wavelengths are displayed in 
descending order of relative intensity. Usually, one of the wavelengths is 
more sensitive, and performs better (improved precision and detection 
limits) than the others for particular applications.

❖ To open the Analytes view of a LabBook

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. Expand Method Parameters and click Analytes to open the 
Analytes view of the LabBook.

❖ To select lines for analytes intensity

1. Open the Analytes view of the Template.

2. Right-click an element in the periodic table.

Figure 9-3. Analyte Library
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The details of the element are displayed with symbol, wavelength, 
relative intensity, state and known interferences as stored in the 
element database, see Figure 9-4.

The wavelength of the analyte is displayed in the yellow graph.

3. Select a check box for a Line on the left to show the interferences of 
the selected line for the analyte, see Figure 9-5.

The wavelength of the interference is displayed in the red graph.

Figure 9-4. Details and interferences of an element

Figure 9-5. Selected interferences of an element
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4. Click .
The Analyte Library for this element is displayed, see Figure 9-6.

5. Select the Available for Analysis and Use as Default check boxes as 
appropriate.

6. Click OK.
The changes are applied to the data base.

❖ To add a line to the analyte library

1. Open the Analytes view of the Template.

2. Right-click an element in the periodic table.

The details of the element are displayed with symbol, wavelength, 
relative intensity, state and known interferences as stored in the 
element database, see Figure 9-7.

Figure 9-6. Editing Analyte Library

Figure 9-7. Details of an element
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3. Click .

The Analyte Library for this element is displayed, see Figure 9-8.

4. Click .
Here you can also delete a line.

The Extend Analyte Library dialog for this element is displayed, 
see Figure 9-9.

5. Select a line from the table to be added.

6. Click .
The Analyte Library dialog opens.

❖ To create a new line in the analyte library

1. Open the Analytes view of the Template.

Figure 9-8. Editing Analyte Library

Figure 9-9. Extend Analyte Library
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2. Right-click an element in the periodic table.

The details of the element are displayed (see Figure 9-10) with 
symbol, wavelength, relative intensity, state and known interferences 
as stored in the element database.

3. Click .

The Analyte Library for this element is displayed, see Figure 9-11.

4. Click .

Figure 9-10. Details of an element

Figure 9-11. Editing the Analyte Library
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The Extend Analyte Library dialog for this element is displayed, 
see Figure 9-12.

5. Click .

The Create a Line dialog opens, see Figure 9-13.

6. Enter Wavelength and Relative Intensity.

7. Select a State from the drop-down list.

8. Click OK.
The Analyte Library dialog opens.

9. Click OK.

10. Click Save to save the changes.

❖ To delete a line from the analyte library

1. Open the Analytes view of the Template.

Figure 9-12. Extend Analyte Library

Figure 9-13. Create a Line dialog
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2. Right-click an element in the periodic table and click 
.

The Analyte Library for this element is displayed, see Figure 9-14.

3. Select the line you wish to delete and click , see 
Figure 9-15.

The line is deleted from the Analyte Library for this element in the 
global database.

4. Click OK to close the Analyte Library dialog.

5. Click Save to save the changes to the global database.

Figure 9-14. Analyte Library example

Figure 9-15. Deleting a line from the Analyte Library
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Measure Modes

In the Method Parameter view Measure Modes of Qtegra, the analysis 
conditions such as radial/axial view, exposure time, RF (radio frequency) 
power and nebulizer gas flow either in the UV range or in the Visible 
range, and the flows for the coolant gas, auxiliary gas and additional gas, 
are defined.

These conditions can be saved as different Modes of analysis that can 
then be chosen in the Acquisition Parameters section for each of the 
selected analytes, see Figure 9-16.

The parameters of the Measure Modes view are explained in Table 9-3.

Figure 9-16. Measure Modes

Table 9-3. Measure Modes parameters

Parameter Description

Exposure Time (s) The longest period in seconds that the signal will be collected prior to 
processing. Depending on instrument configuration and analytical 
wavelengths selected in the method, up to four separate maximum 
integration periods may be required.
UV range: 1 to 120 and Visible range: 1 to 120.
For typical applications, a reasonable starting point is 15 seconds for 
the low wavelength range, and 5 seconds for the high wavelength 
range.

Tip UV/Visible range selection is useful for optimizing the method as 
you can set the high wavelengths, for example, alkali metals, to have a 
lower RF power and higher nebulizer flow, and leave the optimal 
parameters for the lower wavelengths (UV) in the same method.

RF Power (W) The RF power value can be adjusted from 750 to 1350 W (or to 
1600 W, depending on the model).
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Measure Modes parameters are defined in order to optimize the analysis 
by the radial and/or axial configurations.

In the radial configuration, the plasma is viewed from the side. The 
radial plasma view offers less sensitivity than the axial view, however, it is 
preferable for analyzing difficult samples such as organics or very high 
dissolved solid matrices, as the plasma viewing position can be 
optimized to reduce background emissions.

In the axial configuration, the plasma is viewed end-on (along the length 
of the plasma). The axially viewed plasma configuration offers greater 
sensitivity. It is used for applications requiring the lowest detection 

Tip All Duo instruments are software restricted to 1350 W RF as the 
highest value. The radial iCAP 7400 instrument is restricted to 
1600 W RF as its highest value. The iCAP 7200 instrument uses a 
single fixed RF value of 1150 W.

Nebulizer Gas Flow (L/min) The nebulizer gas flow value can be adjusted from 0 to 1.5 L/min.

Tip This option is only displayed for iCAP 7400 and 7600 
instruments.

Capture Full Frame A Full Frame image includes all lines that are emitted by the sample 
within the selected wavelength range. Two Full Frame images are 
required to fully describe the sample.
Yes activates full frame acquisition and Full Frame Exposure Time can 
be entered.
No deactivates Full Frame Exposure Time and full frame acquisition 
is not performed.
With IntelliFrame the system collects a series of images at various 
times (0.03 s, 0.3 s, 3.0 s, 10 s and 30 s) and then determines the 
appropriate period of time to collect intensity data for each line, to 
avoid saturation. Full Frame Exposure Time is deactivated.

Full Frame Exposure Time (s) Exposure time of full frame acquisition. Activated when Captured Full 
Frame is set to Yes.

Coolant Gas Flow (L/min) The coolant gas flow is fixed at 12 L/min for all iCAP 7200 and 7400 
instruments, and is only adjustable for iCAP 7600 instruments from 
10 to 20 L/min.

Auxiliary Gas Flow (L/min) The auxiliary gas flow can be adjusted from 0 to 2 L/min (iCAP 7600 
instrument), or 0 to 1.5 L/min (iCAP 7200 and 7400).

Additional Gas Flow (L/min) This option only appears where an additional gas Mass Flow 
Controller is fitted. It is an accessory that is exclusive to the iCAP 7600 
instrument and can be used, for example, to remove Carbon from 
organics applications.
The additional gas flow can be adjusted from 0 to 200 mL/min.

Table 9-3. Measure Modes parameters, continued

Parameter Description
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limits, than radial configuration, but has higher susceptibility to matrix 
interferences, as the entire plasma is viewed, increasing the quantity of 
light observed from both analyte and background emissions.

❖ To open the Measure Modes view

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. Expand Method Parameters and click Measure Modes to open the 
Measure Modes view.

❖ To define Measure Modes for the analysis

1. Open the Method Parameters > Measure Modes view.

2. Select the Radial or Axial View.

3. Define the Exposure Time (s), RF Power (W) and Neb Gas Flow 
(L/min) for UV Range and in VIS Range.

4. Enter the flows in L/min for Coolant, Auxiliary and Additional 
Gas Flow.

Acquisition Parameters

For all LabBook types, the list of analytes selected for the LabBook is 
displayed in the Acquisition Parameters view of the Qtegra tool. 
Acquisition details such as analysis mode, pump details and laser 
triggering settings as well as measure modes, left and right background, 
start and stop time, and intensity factor can be defined.

The Acquisition Parameters view is shown in Figure 9-17.

Figure 9-17. Acquisition Parameters view
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The Analysis Mode parameters are explained in Table 9-4.

Table 9-4. Analysis Mode parameters

Parameter Description

Analysis Mode Normal mode is the traditional analysis 
mode which is per replicate.

Speed mode is a unique mode of analysis 
which analyzes all radial/high wavelength 
elements for all replicates, then all axial/low 
wavelength elements for all replicates. Speed 
mode of analysis saves time as it removes the 
need for settle times when switching from 
one plasma view to the other.

Sprint mode operates in a similar manner to 
Speed. This mode removes any overhead 
time associated with the pre-exposure 
ensuring minimum sample analysis time. 
The mode is ideally suited for trend analysis 
and where sample numbers are high.

Tip These options are only available for 
iCAP 7600 instruments. The iCAP 7200 
instrument uses only the Normal mode and 
the iCAP 7400 instrument uses the Normal 
and the Speed modes for analysis.

Pump Speed (RPM) Speed of pump in revolution per minute 
(RPM). Pump rate for analysis. The range is 
0 to 125 rpm.

Flush Pump Speed 
(RPM)

Speed of flush pump in revolution per 
minute (RPM). Pump Speed for uptake. The 
range is 0 to 125 rpm.
Setting this value higher than the Pump 
Speed will enable faster sample throughput.
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The Acquisition Parameters are explained in Table 9-5.

Pump Stabilization 
Time (s)

Pump stabilization time in seconds.
This is the time taken to change from the 
Flush Pump Speed to the Pump Speed. The 
range is 0 to 1000 seconds. If different values 
are set for the Flush Pump Speed and the 
Pump Speed, then it is recommended to use 
at least a 5-second stabilization delay as this 
allows the pump to slow down incrementally 
and avoids wearing the pump tubing out 
unnecessarily quickly.

Sample Introduction Nebulizer uses the nebulizer settings.

With SSEA, the values for Frequency, Power 
Level, Gas Flush Time (s), and Preburn 
Time (s) can be entered, and the Door 
Trigger can be set to First Repeat Only or 
Each Repeat.

For Laser, you can trigger the laser for each 
sub-exposure or each sample.
If Trigger On is set to Each Sample, Apply 
Gas Flush Time is set to Before Each 
Sample.

If Trigger On is set to Each Sub-Exposure, 
Apply Gas Flush Time can be selected from 
the drop-down list as Before Each 
Sub-Exposure or Before First Sub-Exposure 
Only.
The Gas Flush Time (s) can be defined for 
each.

Table 9-4. Analysis Mode parameters, continued

Parameter Description

Table 9-5. Acquisition parameters

Column Description

Symbol Symbol for the element.

Wavelength (nm)/Order Wavelength for the element as defined in the Analyte Library.

Slit Position Displays the position of the slit. It is automatically set (High or Low) 
according to the wavelength chosen for the element.

Measure Mode Measure Mode for the element. The drop-down list shows all Measure 
Modes defined for this Template (LabBook).

The plasma may be viewed axially for applications requiring the lowest 
detection limits or radially to minimize matrix effects.
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For this method parameter, the toolbar of the Template (LabBook) 
additionally offers the AutoPeak function. During Auto Peak Adjust, 
the peak locations for the method lines associated with each high 
standards will be finely adjusted. The usual way to perform this routine 
is by aspirating the highest concentration calibration standard for the 
method. The CID (Charge Injection Device) will then fine tune the 
position of each method line onto the chip. This will then be used as the 
default position for this line until the next auto peak adjustment takes 
place.

If the iCAP 7000 Plus Series ICP-OES has been switched off (by the 
main power supply) for a longer period of time, an auto peak 
adjustment should be carried out to optimize the peak location on the 
CID camera. A standard that contains all of the lines of interest is used 
and the system automatically makes the appropriate fine adjustment.

Width The width of the subarray for each wavelength/element can be defined 
individually. Default value is 13.

Height Default values are 5 for UV and 2 for Visible. 

Left Bkg Left background correction.
None Turns off the background correction for that side.

Fixed is the default option. Allows you to define where the background 
should be placed.

Auto Allows the software to choose the lowest background point in the 
subarray. The Qtegra ISDS Software will only select background 
correction points which are plus or minus one pixel of the positions 
that the user set.

Right Bkg Right background correction.
None Turns off the background correction for that side.

Fixed is the default option. Allows you to define where the background 
should be placed.

Auto Allows the software to choose the lowest background point in the 
subarray. The Qtegra ISDS Software will only select background 
correction points which are plus or minus one pixel of the positions 
that the user set.

Start Time (s) Displays the start time of the measurement in seconds.

Stop Time (s) Displays the stop time of the measurement in seconds.

Intensity Factor Multiplies the signal counts by the entered value to achieve a scale 
expansion. The default is 1 or no scale expansion. The valid range for 
the intensity factor is 0.0001 to 1000.

Table 9-5. Acquisition parameters, continued

Column Description
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If the AutoPeak routine is unsuccessful, there are two general scenarios 
to this. Either the solution is too weak for the line analyzed, or too 
strong. Simply aspirate a more suitable solution.

Another additional function on the toolbar is Time Study. Time Study 
performs a basic transient signal analysis and is a helpful tool during 
method development. For example, it can be used to determine the 
correct uptake and wash time for the analysis.

❖ To open the Acquisition Parameters view

1. From the Qtegra - [Home Page] navigation pane, open a LabBook 
or Template.

2. Expand Method Parameters and click Acquisition parameters to 
open the Acquisition Parameters view.

❖ To duplicate analyte rows

1. Open the Method Parameters > Acquisition Parameters view.

2. Click the gray field in front of the row or rows to select the analytes 
you wish to duplicate.
This way, analytes in one sample can be defined to be measured with 
different settings.

3. Right-click the selected rows.
A shortcut menu opens, see Figure 9-18.

4. Select Duplicate Analyte > Axial (or Radial as offered) from the 
shortcut menu.
The selected line is duplicated.

Tip If an argon humidifier is configured with the sample 
introduction, you may need to allow a delay after failures before 
re-initializing the AutoPeak routine.

Figure 9-18. Duplicate rows of Acquisition Parameters

Tip To delete a row, select the row, then press <Delete> and confirm 
the message dialog.
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❖ To define the Acquisition parameters

1. Open the Method Parameters > Acquisition Parameters view.
The Symbol column lists all analytes selected for this LabBook.

The Wavelength (nm) /Order for each analyte is shown as defined 
in “Analytes” on page 9-3.

The Slit Position is automatically set.

2. Select a Measure Mode from the drop-down menu.

3. Define the Width and Height of the subarray for the wavelength.

4. For each analyte, select the background identification mode in 
Left Bkg and Right Bkg from the drop-down list.

5. Enter Start Time and Stop Time where applicable and define the 
Intensity Factor.

6. Select the Analysis Mode from the drop-down list.

7. Define the Pump Speed, Flash Pump Speed and Pump 
Stabilization Time.

8. Select the Sample Introduction system and define the 
corresponding parameters (see Table 9-4).

9. Click Save in the toolbar to save the changes to your LabBook.

❖ To adjust AutoPeak

1. Open the Method Parameters > Acquisition Parameters view.

2. On the toolbar, click AutoPeak.
The Select analytes dialog opens, see Figure 9-19.

Figure 9-19. Select AutoPeak analytes
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3. Select the analytes you wish to perform AutoPeak for.

4. Click OK.
The Waiting for user response dialog opens, see Figure 9-20.

5. Start aspirating the high concentration standard solution for some 
seconds.

6. Click OK.

7. Aspirate until the test is finished.
The progress and result of the test is shown in the message bar at the 

bottom of Qtegra .

❖ To start Time Study wizard

1. Open the Method Parameters > Acquisition Parameters view.

2. On the toolbar, click Time Study.
The Time Study Wizard opens, see Figure 9-21.

Figure 9-20. AutoPeak user response dialog

Figure 9-21. Time Study Wizard
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The Time Study Wizard includes settings for Acquisition 
Parameters on the left and settings for Analytes on the right.

3. Select Radial or Axial from the drop-down list for Measure Mode 
on the left.

4. Select High or Low from the drop-down list for Wavelength 
Range.

5. Enter a value for Duration (s).

6. Enter a value for Interval (s).

7. In the Available Analytes list, select the elements to be analyzed and 
click Select.
The elements are moved to the Selected Analytes list.

8. Click Next.
The Time Study Wizard changes to shows a graphical display with 
a progress bar during exposure, see Figure 9-22.

Tip Press <Ctrl> to select multiple analytes.

Figure 9-22. Time Study Wizard with graphical display and progress bar of exposure
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After exposure you can view the results, see Figure 9-23.

9. Right-click the graph to open a shortcut menu, see Figure 9-24.

The items of the shortcut menu allow you to change the zoom and 
page setup, copy, print or save the image, show point values or 
export the data. You can also click and drag to zoom into the graph.

10. Click Finished to close the Time Study Wizard.

Figure 9-23. Time Study Wizard exposure finished

Figure 9-24. Time Study Wizard shortcut menu
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Intelligent Uptake and Rinse

For all LabBook types, the Intelligent Uptake and Rinse view of 
Qtegra is available.

In the Intelligent Uptake and Rinse view, the minimum and 
maximum delays are defined in the upper part of the view. Parameters 
for each analyte are set in the table in the lower part, see Figure 9-25.

The Intelligent Uptake and Rinse section can be used to trigger the 
data acquisition of the instrument to decrease the overall measurement 
time and increase reproducibility. The Uptake starts when the signal for 
the specified value for the analyte or analytes is stable. If this value falls 
below the specified value after the measurement has been completed, the 
Wash (Rinse) procedure starts.

❖ To open the Intelligent Uptake and Rinse view of a LabBook

1. From the Qtegra - [Home Page] navigation pane, open a LabBook 
as described in “Opening a Template” on page 4-37.

2. Expand the Method Parameters and click Intelligent Uptake and 
Rinse to open the Intelligent Uptake and Rinse view.

❖ To define the Intelligent Uptake and Rinse settings

1. Open the Intelligent Uptake and Rinse view.

2. Enter the Uptake and Rinse values for Minimum Delay (s) and 
Maximum Delay (s).
The default values 30 and 300 are the recommended ones when 
using standard tubes.

3. Select a Measure Mode Radial or Axial from the drop-down list.

4. In the table, click in the first cell in the Symbol column, and enter 
an element abbreviation.
The corresponding (default) Wavelength is displayed as soon as you 
select another cell.

Figure 9-25. Intelligent Uptake and Rinse
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5. Press <Enter>.
The new line is added to the table.

6. Select Uptake to activate Signal Above, Stability and On Failure 
for this line and element.
Define the values and select the action to be performed when failing 
from the drop-down list.

7. Select Rinse to activate Signal Below and On Failure for this line 
and element.
Define the value and select the action to be performed when failing 
from the drop-down list.

8. Define the settings for each sample line in the table.

Inter-Element Correction

In the Inter-Element Correction view in Qtegra, corrections for direct 
spectral interferences can be defined.

❖ To open the Inter-Element Correction view

1. From the Qtegra - [Home Page] navigation pane, open a LabBook 
as described in “Opening a LabBook” on page 4-23.

2. Expand Method Parameters and click Inter-Element Correction to 
open the Inter-Element Correction view.

❖ To define inter-element corrections

1. Open the Inter-Element Correction view.

2. Select Enable for the element you wish to define the correction for, 
see Figure 9-26.

Figure 9-26. Select element for correction



Method Parameters
Method Parameters Settings

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 9-25

3. In the Formula column, double-click the cell next to the selected 
element.
A second table opens on the right, see Figure 9-27.

4. Select Enable for the interfering element and enter the formula for 
the correction. Use a capital “X” to represent the interfering 
element. Use mathematical symbols, like * (multiply with), / (divide 
by), + (plus), or - (minus) for operational commands. Stop typing 
the formula with <Enter>. The correction formula is then shown in 
the left table.

5. Repeat step 4 for each element you wish to define a correction for.

Standards

For all LabBook types, the Standards view in the Qtegra tool allows you 
to define standards based on the selected evaluation.

Standards are materials containing a known concentration of an analyte. 
They provide a reference to determine unknown concentrations or to 
calibrate analytical instruments.

The accuracy of an analytical measurement is how close a result comes 
to the true value. Determining the accuracy of a measurement usually 
requires calibration of the analytical method with a known standard. 
This is often done with standards of several concentrations to make a 
calibration or working curve.

This section defines all information about the solutions used to calibrate 
the instrument. For aQuant and eQuant, additionally calibration types 
can be defined in the Quantification view.

Figure 9-27. Enter formula for correction

Tip Inter-Element Corrections can also be defined in a measured 
LabBook, see “Intensities” on page 10-46.
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Once a standard is created, the elements of the standard can be selected 
in the periodic table, see Figure 9-28.

The columns of the table above the periodic table define the properties 
of the elements, see Table 9-6.

Figure 9-28. Standards view

Table 9-6. Specification of standard elements

Column Description

No Automatically assigned number in ascending order.

Element Displays the symbol for the chemical element 
contained in this standard file.
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The commands of the Standards view of a LabBook are summarized in 
Table 9-7.

Concentration Displays the concentration for the element in the 
standard file. By default, the concentration is set to 
10. This default can be changed and stored, see 
Table 9-7.

Recommendation for quantification standards is to 
prepare standards at concentrations that cover the 
concentration range expected in the samples.

Recommendation for Internal Standards is to use 
an internal standard analyte, which is not present 
in any of the samples. Then add it in equal 
concentration to all samples and standards or by 
spiking manually into all samples. The analytical 
lines referenced to an Internal Standard report a 
corrected concentration value based on the ratio of 
analyte to Internal Standard intensities.

Unit Displays the concentration unit for the element in 
the standard file. By default, the unit is set to ppm. 
This default can be changed and stored, see 
Table 9-7.

Table 9-7. Commands of the Standards view

Command Description

To create a new list of standards or of Internal 
Standards (for eQuant), see “Creating New 
Standards” on page 9-30.

To delete the selected standards list.
In the list of Standard(s), select the standards 
you want to delete. Click this button, or 
right-click and select Delete from the shortcut 
menu to delete the selected standards. Confirm 
the message dialog.

Table 9-6. Specification of standard elements, continued

Column Description
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To load standards from the global standards 
database.
The Load Standard dialog opens:

Select a standard from the list and click OK
-or-
Double-click to load the standards into the 
Standards view.

To edit the default concentration and unit.
The Set Default Concentration dialog opens:

In this example, the Default Concentration of 
the analytes in the solutions is set to 10 ppb and 
will therefore be used for every new analyte 
added to the table.

Table 9-7. Commands of the Standards view, continued

Command Description
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The shortcut menu of the Standard(s) list provides two further 
commands, shown in Table 9-8:

To view, compare and export the history of a 
LabBook.
The History dialog for this LabBook opens.

To compare the history entries, press <Ctrl> or 
<Shift> and select the range of history entries 
you wish to compare.

Table 9-8. Shortcut menu commands of the Standards view

Command Description

To copy the selected standards list.
The Select Dilution Factor dialog opens:

Type the dilution factor the copy shall use. Click 
OK to create a standards list getting the name of 
the source including the suffix “_Copy”. The 
concentration of all elements is automatically 
recalculated on the dilution factor you entered.

To save the selected standards list to the global 
database.
In the list of Standard(s), select the standards 
you want to pass to the global database. 
Right-click and select Pass to global from the 
shortcut menu to save the selected standards to 
the global database.

Table 9-7. Commands of the Standards view, continued

Command Description
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The accuracy of an analytical measurement is how close a result comes 
to the true value. Determining the accuracy of a measurement usually 
requires calibration of the analytical method with a known standard. 
Internal Standards are materials containing a known set of analytes. 
Internal Standards are used to correct for instrumental drifts in 
sensitivity and sample specific signal suppression or enhancement. 
Internal standardization can help compensate for sample viscosity effects 
and plasma loading to improve the accuracy and precision of analytical 
results in Inductively Coupled Plasma - Optical Emission Spectrometry 
(ICP-OES).

Quantification standards are materials containing a known 
concentration of an analyte. They provide a reference to determine 
unknown concentrations or to calibrate analytical instruments.

The quantification standard defined here can be selected and used in the 
“Sample Definition for a Template” on page 5-5. When defining the 
calibration standards in that section, dilution factors can be applied to 
the standard.

Internal Standards used for quantification are also created here. Their 
definition as Internal Standards is done in the Quantification view, see 
“Quantification” on page 9-33.

❖ To open the Standards view

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. Expand Method Parameters and click Standards to open the 
Standards view.

Creating New Standards

Standards created in the Standards view of a LabBook or Template in 
the Qtegra tool are created for the current LabBook but can be saved to 
the global database.

❖ To create a new standard

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. Open the Method Parameters > Standards view.

3. Before entering the elements of the standards, you may define the 
default concentration. On the toolbar, click Set default 
concentration to open a dialog, where you can select the mainly 
used concentration and unit, for example, ppb or μg/L.

Tip Global database standards are created in the Configurator applet, 
see “Standards” on page 3-31.
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4. Expand  to select the standards type (Elemental Standard, 
Internal Standard, Concentration Ratio Standard, Summation to 100 
percent) from the drop-down menu.

5. In the Add New Standard dialog, type the Standard Name and 
optionally a Standard Description.
For Elemental Standards and Isotope Dilution Standards, tick 
Create standard using analyte list if you want to use the standards 
as defined.

6. Select the analytes. The way of selection depends on the selected 
standard.

a. Elemental standards with a known concentration of an analyte 
provide a reference to determine unknown concentrations or to 
calibrate analytical instruments. For Elemental Standards, click 
the elements in the periodic table to add or remove analytes.

i. Define the properties of the analyte as required.

b. Internal Standards (elemental) are used to monitor any drift in 
signal sensitivity with time during a set of analyses. Corrections 
are made by comparing the sensitivity for the Internal Standards 
in each run of a sample with the sensitivity of the internal 
standard at a reference point at the start of the experiment. The 
results of this comparison are then used to correct all of the 
other analytes in the sample on a per-run basis. It is 
recommended to use at least one Internal Standard in any 
multi-element determination.

i. Add the analyte to the table by clicking the element in the 
periodic table.

ii. Define the properties of the analytes as required.

c. For the Concentration Ratio Standard you define a base 
element. The base element is the main element in the mixture 
(for example, alloys). This element depends on the analysis to be 
made.

i. Add the analyte to the table by clicking the element in the 
periodic table.
The default line of the element is added to the table. 
Concentration ans Unit are added according to the default 
concentration.

ii. To remove the analyte, click the respective element in the 
periodic table again.

iii. In the table, right-click the element you wish to define as 
base element.
A shortcut menu opens.
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In this section, the exclamation mark  indicates that the base 
element has not been selected yet.

iv. Select Set as base element from the shortcut menu.
The exclamation mark  disappears.

v. Enter the Concentration for each element.

vi. Enter the Residual Concentration [%], see Figure 9-29.

The Residual Concentration represents the concentrations of 
residual elements in the sample (for example, impurities). A limit 
(percentage) needs to be defined.

vii. Define the properties of the analytes as required.

d. Summation to 100% is a special case where no base 
concentration is stated. The element list is populated with all 
elements. A provision is made for a small residual. When you 
specify this mode, the residual is initially 100% and reduces as 
you enter the concentrations of elements. As in the case of 
Concentration Ratios, the final value of the residual should be 
well below 1%. The standard concentrations for all elements 
including the residual will add up to 100%.

i. Add the analyte to the table by clicking the element in the 
periodic table.
The default line of the element is added to the table.

Figure 9-29. Enter Residual Concentration
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ii. Enter the Concentration for each analyte.
The Residual Concentration is automatically subtracted 
from the initial value of 100%.

iii. To remove the analyte, click the respective element in the 
periodic table again.

iv. Define the properties of the analytes as required.

Loading Standards

As an Administrator, you can generate standards by use of the 
Configurator tool, see “Standards” on page 3-31. As a User, you may 
load these standards into your Template or LabBook. 

❖ To load standards

1. Open the Method Parameters > Standards view of the LabBook.

2. To import a list of standards into your LabBook.

a. On the toolbar, click Open to get a list of all preset standards.

b. Double-click the standard you wish to load into your LabBook. 
The associated elements and their concentration in the standard 
solution are displayed on the right-hand pane.

Editing an Existing Standard File

Existing standards can be edited and saved to your Template or 
LabBook.

❖ To edit an existing standard file

1. Open the Method Parameters > Standards view.

2. In the Standards list, select the standard to be edited.

3. If required, change the default concentration.

4. Click the elements in the periodic table to add or remove analytes.

Quantification

The Quantification view in Qtegra allows you to set the calibration and 
quantification strategy for each analyte.
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All analytes selected in the Analytes view are shown in the 
Quantification view, see Figure 9-30.

For eQuant Templates only, the Use Quality Control check box (see 
Figure 9-30) is available to enable the Quality Control Method 
Parameter of Qtegra ISDS Software, see “Quality Control” on 
page 10-5.

For trace analyses such as oxide analysis, traces can be added or 
customized in the Customized Traces table. This feature allows 
converting an element concentration into a molecule concentration, see 
page 9-38.

Calculation Traces can be added to allow calculation of average, 
maximum, minimum, standard deviation, and sum, see page 9-39.

Multi-Calibration trace is a tool that will enable switching from a 
sensitive wavelength to a less sensitive wavelength depending on the 
measured concentration.

For eQuant evaluations only, if an Internal Standard is used, warning 
limits and failure limits of its recovery can be entered (as percent values) 
into the fields of the IS Recovery section at the bottom of the page. In 
the results view, after measurement, results outside these warning limits 
are indicated with yellow, and if they are outside the failure limits, the 
values will be shown in red. This Internal Standard Test can also be 
found on the Quality Control page, see “Internal Standard Test” on 
page 10-24.

Figure 9-30. Quantification view with Use Quality Control check box
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The parameters that can be defined for the Quantification table are 
summarized in Table 9-9.

Table 9-9. Parameters of Quantification table

Column Description

Analyte Displays analytes selected in the analytes view (see “Analytes” on 
page 9-3).

The analytes are listed in ascending order according to atomic mass.

Measurement Mode Shows the Measurement Mode defined for this analyte.

Quantify Defines whether this analyte is to be quantified or not.
Yes is automatically selected for all elements in the analyte list of the 
acquisition parameters.

No is displayed for analytes that have been selected as internal 
standards in the Internal Standard column. They are removed from 
the list of Quantified wavelengths. 

No is also displayed for any analyte that has been selected from the 
Molecule section, for example, doubly charged ions, oxides, 
background ions. See “Analytes” on page 9-3.

Internal Standard Once Internal Standards are defined they are added to the drop-down 
list of the cells in the Internal Standard column. The operator may 
define any Internal Standard wavelength desired.

If Use as Internal Standard is selected, this line is shown with a green 
background.

Standard Range To control the calibration range. Values outside this range are excluded 
from calibration.

Switch Point Switch Point is used in conjunction with the Multi-Calibration Trace 
as it will indicate the concentration from which the next wavelength 
for a set element will be used.

For example, if you have line1, line2 and line3 for element A, switch 
points can be defined as X1 for line1 and X2 for line2 with X1 < X2. 
Then, concentrations displayed for A will be measured from line1 and 
will switch to line2 if the concentration measured using line1 is > X1, 
same for line2 and X2. For line3, the switch point can be left “open” 
and any results will be reported or X3 can be entered, which will act as 
a limit over which results should not be reported.

This feature enhances linearity of the calibration for an element and 
can be used in conjunction with the Standard Range to define the 
best calibration range for each wavelength.
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Fit Type By default the calibration fit is set to Linear. All concentration 
calibrations should be linear with the signal response in the 
instrument. Nearly cancels out the weighting of higher amounts, 
which means a nearly equal weighting for low and high 
concentrations.

In the rare case that a non-linear calibration is acquired, you can define 
a 2nd Order calibration fit. Leads to a disproportionate weighting of 
smaller amounts.

Weighting By default set to None, where higher weighting of higher amounts or 
signal values results. With the default setting, calibration points of 
higher concentrations have a stronger influence on calibration than 
calibration points of lower concentrations. As a result, the slope line of 
the calibration curve is influenced more strongly by the calibration 
points of the higher concentrations. This makes sense, as the 
determined area values of lower concentrations often show a stronger 
scattering, which can lead to a distortion of the result.

If Absolute SD is selected, Absolute Standard Deviation is used. The 
standard deviation calibration variable is the square root of the 
Variance calibration variable. The Absolute SD estimates the standard 
deviation based on a random sample. The standard deviation is a 
measure for the deviation from the average value (the mean).

If Relative SD is selected, Relative Standard Deviation (RSD) is used. 
The RSD is the standard deviation in relation to the size of the 
measured values (average); that is, the standard deviation is 
normalized. In contrast to absolute standard deviations, relative 
standard deviations can be compared (for values around 1000 a 
standard deviation of 1 is minor, for values around 10, this is a major 
deviation).

If 1/Concentration is selected, Blanks are ignored (as their 
concentration is 0) and Forcing is set to Blank. Each measured point is 
weighted by its concentration. This setting is used to increase the 
influence of smaller values.

If 1/Concentration2 is selected, Blanks are ignored (as their 
concentration is 0) and Forcing is set to Blank. Each measured point is 
weighted by its squared concentration. This setting is used to extra 
increase the influence of smaller values.

Table 9-9. Parameters of Quantification table, continued

Column Description
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❖ To open the Quantification view

1. Expand Method Parameters and click Quantification to open the 
Quantification view of the LabBook.

❖ To activate Quality Control (QC) for eQuant evaluations

1. Open the Method Parameters > Quantification view of the 
LabBook.

2. Select Use Quality Control above the table, see Figure 9-31.

The new Method Parameter Quality Control is displayed 
immediately.

❖ To set the quantification parameters

1. Open the Method Parameters > Quantification view of the 
LabBook.

2. Click  in the cell of the Internal Standard column to open the 
drop-down list.

a. Select Use as Internal Standard to define this analyte to be used as 
Internal Standard.
If you set the value to No in the Quantify column, this 
wavelength will not be quantified.

Forcing No forcing for the calibration.

If Zero is selected, the calibration curve is forced through zero.

If Blank (not for aQuant evaluation) is selected, the forcing of the 
calibration is set to run through the blank. Default setting is Blank.

If Zero Standard is selected, the calibration curve is forced through 
the concentration of the Zero Standard. Here, forcing through Blank 
or forcing through Zero cannot be used as the Zero Standard 
concentration is different from zero.

Table 9-9. Parameters of Quantification table, continued

Column Description

Figure 9-31. Activating Quality Control in Quantification view
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b. In the lines of the other analytes (with Yes in the Quantify 
column), select the defined Internal Standard from the 
drop-down list.

3. Define the IS Recovery settings at the bottom of the page.

4. Define the values and units for Standard Range, if applicable.

5. Define the value and unit for Switch Point, if applicable.

6. Click  in the cell of the Fit Type column to open the drop-down 
list and select an entry to distinguish between Linear and 2nd Order.

7. Click  in the cell of the Weighting column to select Absolute SD, 
Relative SD, 1/Concentration, or 1/Concentration2. See Table 9-9 for 
details on the weighting options.

8. Click  in the cell of the Forcing column to open the drop-down 
list.

a. Select Zero to define that calibration is forced through zero for 
this analyte.

b. If you select Blank, the calibration is set to run through the 
blank for this analyte.

c. If you select Zero Standard, the calibration curve is forced 
through the concentration of the Zero Standard.

d. If you select No, no forcing for the calibration is performed.

9. Repeat for all analytes or use the fill-down option to apply a setting 
to more than one analyte.

Adding Traces

Traces are used to add additional information to the quantification. 
Traces can be added from the shortcut menu of selected analytes on the 
Quantification view.

❖ To add Customized Traces to the Quantification

1. Open the Method Parameters > Quantification view of the 
LabBook.

2. Right-click the desired analyte in the table you wish to customize 
the trace for, see .

3. From the shortcut menu, select Add customized trace or Add 
customized multi-calibration trace.
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A new table Customized Traces is added to the Quantification view 
below the Analyte table, see Figure 9-32.

4. If you selected Add customize multi-calibration trace, define the 
Switch Point for the trace, and select Reference Trace(s) from the 
drop-down list.

5. Define Representation, select the Enable check box to activate the 
line, type a Formula, for example, a product like X*1.5, and select a 
Unit from the drop-down list, see Figure 9-33.

6. To delete a line from this Customized Traces table, select the line 
and press <Del>.

❖ To add Calculation Traces to the Quantification

1. Open the Method Parameters > Quantification view

2. Right-click multiple selected analytes you wish to calculate the traces 
for.

Figure 9-32. Customized Traces table

Figure 9-33. Customized trace formula entered
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3. On the shortcut menu, expand Add calculation trace and select the 
operator you wish to use, see Figure 9-34.

4. Below the table with the analytes, the Customized Traces table and 
Calculation Trace view are shown. The trace is shown with the name 
of the operator but the name can be changed.

In the Calculation Trace, the Operation listbox shows your 
selection from the shortcut menu. Here, you can change to another 
operator if desired. This change does not affect the trace name.

Beside All the Analyte Selection listbox provides Contains, In list, 
Not contains, Not in list for fast and easy selection of all desired 
analytes.
Tick Ignore Internal Standards to exclude Internal Standards from 
the analyte selection.
The List Filter box is filled from your selection of analytes, which 
can be modified afterward.

5. After your LabBook is measured you can view the customized traces 
in the Evaluation Results > Concentrations list and also add the 
traces to a Report.

Ratios

The Ratios view of all LabBook types in the Qtegra tool allows you to 
define analyte ratios for the measurement.

Figure 9-34. Calculation traces from shortcut menu of a LabBook

Tip As Qtegra does not allow to use the same trace name in 
multiple lines, a further selection of the operator already used 
causes an error. In this case, double-click the existing trace name 
and change the name.
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The Ratios table shows the ratio of Analyte 1 and Analyte 2, see 
Figure 9-35.

The parameters that can be defined for the Ratios view are summarized 
in Table 9-10.

❖ To open the Ratios view

1. From the Qtegra - [Home Page] navigation pane, open a LabBook.

2. Expand Method Parameters and click Ratios to open the Ratios 
view of the LabBook.

❖ To define analyte ratios 

1. Open the Method Parameters > Ratios view of the LabBook.

2. Expand the cell of the column 1 to display the list of available 
analytes.

3. Select an analyte for column 1. 
The analyte selected in this column 1 is the numerator in the Ratio 
column.

Figure 9-35. Ratios

Table 9-10. Columns of Ratios table

Column Description

No Automatically assigned number in ascending 
order.

Ratio Displays the ratio of Analyte 1 and Analyte 2 
columns.

Analyte 1 First analyte to be selected for Ratio (numerator). 
All analytes selected for this LabBook in the 
Analytes view are displayed in the drop-down list.

Analyte 2 Second analyte to be selected for Ratio 
(denominator). 
All analytes selected for this LabBook in the 
Analytes view are displayed in the drop-down list.
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4. Expand the cell of the column 2 to display the list of available 
analytes.

5. Select an analyte for column 2.
The analyte selected in column 2 is the denominator in the Ratio 
column.

The ratio of both analytes is displayed in the Ratio column.

6. Click Save to save your LabBook.

❖ To delete rows

1. Open the Method Parameters > Ratios view.

2. Right-click the cell in front of a row.
A shortcut menu opens, see Figure 9-36.

3. Select Delete selected rows.
A dialog opens.

4. Click Yes to delete the selected row.

Quality Control (eQuant only)

For eQuant evaluations only, the Quality Control view in the Qtegra 
tool allows a full quality control (QC) methodology. QC samples 
interspersed at strategic points in a batch of samples are used to gauge 
how well the instrument and the analytical method are performing. For 
details, see “Quality Control” on page 10-5.

Defining Detection Limits (eQuant only)

The Detection Limits are used by some of the QC types to determine 
whether the sample has passed or failed or even whether the test should 
be performed in the first place. For details, see “Defining Detection 
Limits for eQuant LabBooks” on page 10-25.

Figure 9-36. Ratio table shortcut menu
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Defining QC Settings in Sample Definition (eQuant only)

The QC settings are specified for each sample in the Sample Definition 
section of the eQuant LabBook in the Qtegra tool. The Sample List of 
the LabBook is generated from the definition given in the Sample 
Definition section. For details, see “Defining QC Settings in Sample 
Definition of eQuant Templates” on page 10-30.
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10
Analysis with eQuant Evaluation

The evaluation method eQuant is typically employed for routine 
analyses of liquid samples. It uses external element concentrations to 
quantify concentrations of elements in an unknown sample. Calibration 
graphs can be acquired and used for the fully quantitative analysis of 
unknown samples. A different evaluation strategy can be chosen for each 
analyte and also for each wavelength of an analyte.

Employment of the iCAP 7000 Plus Series ICP-OES instrument with 
an autosampler allows for high throughput of samples in the daily work 
of a laboratory.

Contents

• Setting Up the Template on page 10-2

• Quality Control on page 10-5

• Creating a LabBook for Analysis with eQuant Evaluation on page 
10-35

• Acquiring Data with an eQuant LabBook on page 10-36

• Results and Post Analysis Data Evaluation on page 10-37

Tip Be sure a Configuration has been created for your system setup, 
see “Experiment Configurator” on page 3-15.
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Setting Up the Template
In the Qtegra tool, all settings for your measurement are entered in the 
Template. For analysis with eQuant evaluation this includes defining the 
elements in your calibration solution as well as the analytes of your 
samples.

❖ To define Template settings

1. Create a Template with the Configuration for your system with 
iCAP 7000 Plus Series ICP-OES, the eQuant evaluation, and, for 
example, an autosampler.

2. Open the Method Parameters > Analytes view of the Template.
See “Analytes” on page 9-3 for a general explanation.

3. In the periodic table, select the analytes of your calibration solution 
and your samples.
First, the calibration curve of known samples must be acquired for 
later comparison of the intensities of analytes with this calibration 
curve.

4. Open the Measure Modes view of the Template.

5. Define the parameters for the Radial and Axial View, as 
appropriate.
See “Measure Modes” on page 9-12 for details.

6. Open the Method Parameters > Acquisition Parameters view of 
the template.
See “Acquisition Parameters” on page 9-14 for a general explanation.

7. For each analyte, select the background identification mode in 
Left Bkg and Right Bkg from the drop-down list, enter the Start 
and Stop Time, and enter the Intensity Factor.

8. Open the Method Parameters > Intelligent Uptake and Rinse 
view of the Template.

9. Set the delays and parameters for the analytes.
For details, see “Intelligent Uptake and Rinse” on page 9-23.

10. Open the Method Parameters > Inter-Element Correction view of 
the Template.

11. Define the corrections for direct spectral interferences.
For details, see “Inter-Element Correction” on page 9-24.

12. Open the Method Parameters > Standards view of the Template.

Tip For a detailed description of all parameters in a Template, see 
“Method Parameters Settings” on page 9-3.
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13. Click New to define a Standard as described in “Creating New 
Standards” on page 9-30.

14. Click New to define an Internal Standard as described in “Creating 
New Standards” on page 9-30.

For definition of an Internal Standard, choose an element that is not 
present in your sample, but that is as near as possible to the mass of 
the analyte you wish to quantify. This element should then be added 
with the same concentration to each sample and standard. The 
elements of the InternalStandard should not react with the analytes 
or generate additional spectral interferences on the masses of the 
analytes. Obviously, also no interferences of the analytes should lie 
on the spectra of the elements in the Internal Standard.

15. Open the Method Parameters > Quantification view of the 
Template.

16. Type and select the values as described in “Quantification” on 
page 9-33.
Fit Type in most cases is Linear.
For analytes selected to be used as Internal Standard the setting for 
Quantify is automatically set to No.

17. Select the Use Quality Control check box if you wish to use this 
feature.
The additional Method Parameter Quality Control is shown 
immediately.

18. Open the Method Parameters > Ratios view of the Template.

19. Select the Analyte 1 and Analyte 2 from the drop-down lists.
The Ratios page provides the option to set several user defined 
ratios, which are displayed after the measurement of the LabBook.
For details, see “Ratios” on page 9-40.

❖ To define Sample Definition

1. Open a Template with the Configuration for your system with 
iCAP 7000 Plus Series ICP-OES, the eQuant evaluation, and, for 
example, an autosampler.

2. Define Initial Actions, Continuing Actions and End Actions as 
appropriate.
To define Initial Actions and End Actions rows is typically 
appropriate for a high amount of analyses with a routine method.

3. In the Continuing Actions section, define Label for each row.

Tip For details on the Quality Control tests, see “Quality Control 
(eQuant only)” on page 9-42.

Tip For details on all parameters, see “Method Parameters 
Settings” on page 9-3.
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4. Enter a value for Repeats.
The value 3 is typically appropriate.

5. For Sample Type, select STD for the calibration solution from the 
drop-down list, UNKNOWN for the samples, and BLK or 
AVERAGE BLK for blanks.

When analyzing samples with complex matrices using the standard 
addition mode, the ZERO STD should be selected as the calibration 
blank. A series of spikes (Spike 1, Spike 2, etc.) of that same sample 
are used to construct a calibration curve. The curve is then 
interpolated to determine the concentration of the original 
unknown sample and subsequent other samples can be determined 
against this calibration.

6. Select the previously created Internal Standard from the drop-down 
list.

7. In the columns for rack and vials, set the positions of the samples in 
the autosampler.
The titles of these columns vary with the autosamplers.
Tip For details, see “Sample Definition for a Template” on 
page 5-5.
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Quality Control
The Quality Control view of Qtegra allows a full quality control (QC) 
methodology. QC samples interspersed at strategic points in a batch of 
samples can be used to monitor a range of aspects of the analytical run 
being performed.

The Quality Control view, see Figure 10-1, allows you to set quality 
control tests for the measurement.

Quality Control tests can only be defined before a LabBook is placed on 
the Scheduler. A limited series of Quality Control parameters can be 
changed post analysis. Please see “Post Analysis Modification of QC 
Parameters” on page 10-33.

❖ To open the Quality Control view

1. Expand Method Parameters and open the Quality Control (QC) 
view.

Figure 10-1. Quality Control page of Qtegra

Tip The Quality Control settings are displayed under Method 
Parameter only when the Use Quality Control check box has been 
selected in the parameter “Quantification” on page 9-33.

Tip The Quality Control view is only available after Use Quality 
Control has been ticked in the Quantification view.
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Quality Control Failure Rules

Failure rules for QC tests are defined in the Method Parameter Quality 
Control in Qtegra, see Figure 10-2.

In the first part of Test details, the number of failures can be defined, 
see Table 10-1.

If the QC test fails, a number of options can be defined individually in 
the second part of Test details in the case that:

• The QC fails

Figure 10-2. Quality control failure rules in the Test details area for each QC test

Table 10-1. Settings for number of failures

Parameter Description

Number of analyte failures to 
generate a QC failure

To define how many analytes must fail before the flag message is 
generated.

Click  to change the value.
-or-
Type the new value directly.

Recommended setting: 1

Number of analyte warnings to 
generate a QC failure

The number of successive warnings to generate a QC failure can be set 
separately. This defines the number of successive warning states for an 
analyte in a given QC sample type to go through before becoming an 
absolute failure.

Click  to change the value.
-or-
Type the new value directly.

Recommended setting: 3
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• The QC fails again

• The QC fails a final time

The options available are listed and explained in Table 10-2.

If a QC test fails, the first action is normally to rinse and repeat the test. 
If the test fails again, it might be advisable to recalibrate and repeat or to 
ignore and continue.

Each incident of this test will have exactly the same condition. Once 
defined, for example, whenever an ICB is defined in the Sample List, the 
same conditions will be used every time. The parameters can be set 
separately for each of the tests, for example, CCB can use one set of 
tests, whereas ICB uses a tighter set.

Quality Control Test Parameters

In the lower right pane of the Quality Control view, Qtegra provides a 
list, which is populated with all analytes defined in your LabBook. The 
QC Test Parameters list also shows the Warning and Failure limits.

❖ To copy a set of limit values to the Test Parameters grid

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

Table 10-2. Settings for failure rules

Action Description

Ignore and continue from the next 
sample

This action ignores that a QC failure has been registered and 
continues acquiring the Sample List.

Rinse and repeat test This action repeats the test after a rinse step has been performed. A 
failed QC will automatically trigger an identical copy of the QC 
sample to be inserted into the Sample List after the failed QC. This 
step will be repeated once.

Recalibrate, recalculate, and 
reacquire from a previous sample 

Upon QC failure, this action will automatically insert a copy of the 
calibration block and the QC sample immediately after the failed QC 
sample. A QC pass from the repeated tests will then allow the Sample 
List to be resumed from a named sample, which is defined in the QC 
Restart column in the Sample Definition table.

Pause the experiment and wait for 
restart

Upon QC failure, the LabBook will be paused and waiting to be 
restarted, giving the user time to manually find and remove the root 
cause for the failure.

Abort the LabBook and continue 
with the queue

Upon QC failure, the LabBook will be aborted and the Scheduler will 
continue with other scheduled LabBooks if there are any.
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3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. In the Test Parameters table, double-click the Warning Limit or 
Failure Limit cell you wish to change the entry and type the new 
value.

5. Click anywhere in the table.
-or-
Press <Enter> to enter the value.

6. Click and drag the mouse pointer from this first entry you wish to 
copy over all cells of the column to be changed with this value.

7. Right-click your selected range to open the shortcut menu, see 
Figure 10-3.

8. Select Fill down or Fill up, as appropriate.
The entries from the first selected cell are copied down or up to all 
cells selected.
-or-
Press <Ctrl> + <D> or <Ctrl> + <U> to copy the initial value.

Quality Control Tests

Qtegra is supplied with predefined settings for QC test types. These 
settings can be edited according to your requirements and saved in the 
Qtegra Template or LabBook.

❖ To create a new Quality Control Test

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

Figure 10-3. Quality Control Test Parameters shortcut menu
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3. Select the Quality Control Test you wish to duplicate and define.

4. On the toolbar of Quality Control Tests, click New.
A dialog box opens, see Figure 10-4.

5. Type a Name and Description for the new quality control test.

6. Click OK.
The new test is added to the list. The Test details and Test 
Parameters are also copied and may be changed.

❖ To delete a new Quality Control Test

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to delete, see Figure 10-5.

Figure 10-4. Duplicate Quality Control Test window

Figure 10-5. Delete non-default Quality Control Test 

Tip Predefined Quality Control Tests can not be deleted.
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4. Click Delete.
The selected Quality Control Test is immediately deleted from the 
list.

Blank Verification Tests

Several types of blank verification tests are offered in the Method 
Parameter Quality Control in Qtegra, see Figure 10-6.

Anywhere in the Sample List, blanks can be analyzed and checked to see 
if the instrument background for the analyte has drifted either up or 
down.

The Blank Test types limits are based on contract required detection 
limits (CRDLs). The warning and failure QC limits are based on 
multiples of the set limits. The analyte will fail if the calculated value is 
above the failure limit.

The Blank Tests available for blank verification are summarized in 
Table 10-3. The last two columns show typical QC requirements of the 
US EPA.

Figure 10-6. QC settings for blank verification

Table 10-3. Quality control blank tests

Test 
type

Description Purpose Frequency Limits

CCB Continuing Calibration 
Blank

a continuing periodic check 
on the signal at blank levels

every 10 samples < 3 x IDL
(Instrumental 
Detection Limit)

ICB Initial Calibration Blank initial check of signal at 
blank level

after initial 
calibration

< 3 x IDL

MTB Memory Test Blank checks the level of memory 
(or carry over) of a high 
concentration sample into 
the subsequent sample

user definable user definable

PRB Preparation Blank checks the sample 
preparation methodology for 
possible contamination

required for each 
batch of samples

< 3 x IDL
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Warning and Failure Limits

The failure and warning limits are multiples of the detection limit, for 
example, if the detection limit is at 10 ppb, the warning might be at a 
blank concentration of 1.5 times the detection limit and the failure limit 
might be at 3 times the detection limit, in this case 15 and 30  ppb 
respectively.

❖ To define QC settings for blank tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. If desired, change the Number of analyte failures to generate a QC 
failure and change the Number of analyte warnings to generate a 
QC failure. For details, see “Quality Control Failure Rules” on 
page 10-6.

5. Select the action to take place If this QC fails.

6. Select the action to take place If this QC fails again.

7. Select the action to take place If this QC fails a final time.

8. Clear the Enabled check box next to the analyte to skip this analyte, 
see Figure 10-7.

By default, all analytes defined in the LabBook are included for the 
QC test. Although, by default the software only looks for those 
analytes that are included in the standard solution.
Analytes selected as Internal Standards are not considered for QC 
tests.

Figure 10-7. Quality Control blank test parameters
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9. Define the Warning Limit and Failure Limit for each analyte. For 
details, see “Quality Control Test Parameters” on page 10-7.

Calibration Verification Tests

Several types of calibration verification tests are offered in the Method 
Parameters, Quality Control view, see Figure 10-8.

Standards of known concentration are dispersed within the samples to 
check if the concentration calibration is still valid.

Each individual test is associated with a standard in the Sample 
Definition section and can be defined in the QC section with relative 
warning or failure limits, and the number of QC failures and warnings 
of individual analytes to generate a QC failure.

The Calibration Tests available for the external calibration verification 
are summarized in Table 10-4. The last two columns show typical QC 
requirements of the US EPA.

Figure 10-8. Table of QC settings for external calibration verification

Table 10-4. Quality Control calibration tests

Test 
type

Description Purpose Frequency Limits

CCV Continuing Calibration 
Verification

a continuing periodic check 
on accuracy and drift 

every 10 samples 90-110%

ICV Initial Calibration 
Verification

checks the calibration against 
a second calibration source

after initial 
calibration

90-110%

LCS Laboratory Control 
Sample

checks the accuracy of the 
entire analytical process 

every 20 samples 80-120%
(EPA Method 
6010C)

70-130%
ISM02.3D

QCS Quality Control 
Standard

checks the accuracy of the 
entire analytical process

once per batch ±10%
(EPA Method 
200.7)
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Warning and Failure Limits

For each analyte the lower and higher warning and failure limits can be 
set individually. A QC failure and a QC warning are different, the 
warning limit is always set to tighter specifications than the failure limit. 
If the QC exceeds the warning limits, a QC warning will be generated 
and a certain number of consecutive QC warnings for a particular 
analyte will then lead to a QC failure. If the QC test of the analyte gives 
results outside the QC failure limits, it will become an instant failure; if 
results are within the warning limits, the analysis carries on until it 
reaches the number of successive warnings specified for that QC test 
type and analyte. The next time it is outside the QC warning limit, it 
will then become a failure. If the QC value for the warning analyte in 
that QC test type passes the next test, the counter is reset to zero and the 
analysis continues. If warning limits are not required, they should be set 
to the same as the failure limits.

❖ To define QC settings for calibration tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. If desired, change the Number of analyte failures to generate a QC 
failure and change the Number of analyte warnings to generate a 
QC failure. For details, see “Quality Control Failure Rules” on 
page 10-6.

5. Select the action to take place If this QC fails. 

6. Select the action to take place If this QC fails again. 

7. Select the action to take place If this QC fails a final time.
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8. Clear the Enabled check box next to the analyte to skip this analyte, 
see Figure 10-9.

By default, all analytes defined in the LabBook are included for the 
QC test. Although, by default the software only looks for those 
analytes that are included in the standard solution.
Analytes selected as Internal Standards are not considered for QC 
tests.

9. Define the Low Failure Limit (%), Low Warning Limit (%), the 
High Warning Limit (%), and High Failure Limit (%) for each 
analyte. For details, see “Quality Control Test Parameters” on 
page 10-7.

Paired Sample Tests

Several types of paired sample tests are offered in the Method 
Parameters, Quality Control, see Figure 10-10.

Figure 10-9. Quality Control calibration test parameters

Figure 10-10. Table of QC settings for paired sample
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Paired samples are used to assess the method-reproducibility between 
two defined samples. The QC software will monitor the first defined 
sample and determine if the second sample is significantly above or 
below user defined recovery limits.

Whereas the Duplicate Test (DUP) determines the relative percent 
difference (RPD) between two identical samples, the Serial Dilution 
Test (SER) determines if the sample matrix affects the data quality by 
changing the percent recovery after a certain dilution of the sample. To 
perform an analytically meaningful comparison between the DUP and 
SER analyses, the concentration in the original sample must have a 
concentration at least a certain multiple above the detection limit, for 
example, 200 times higher. This reference detection limit is set via the 
Contract Required Detection Limits dialog (CRDL, see Figure 10-26) 
that is opened when you click the Edit the contract required detection 
limits button on the toolbar (see Figure 10-11).

Double-click an entry (see rectangle in Figure 10-10) to change the 
concentration and select the desired unit from the drop-down menu.

See “Defining Detection Limits for eQuant LabBooks” on page 10-25 
for a detailed description. The software will not perform the test if the 
sample is too close to the detection limit, as it would only lead to 
excessive failure generation.

cmeasured > Limit × CRDL

The Paired Sample Tests available are summarized in Table 10-5. The 
last two columns show typical QC requirements of the US EPA.

Figure 10-11. Quality Control Tests toolbar with CRDL button

Table 10-5. Quality control paired sample tests

Test 
type

Description Purpose Frequency Limits

DUP Duplicate checks the reproducibility of 
results by analyzing an 
unknown sample in duplicate

1 per 20 samples per 
matrix

±20% RPD

SER Serial Dilution checks for matrix effects by 
assessing the variation of 
result for an unknown 
sample before and after 
dilution

1 per 20 samples per 
matrix

±20% of the 
original undiluted 
result after dilution 
correction (EPA 
Method 6010D) 
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Warning and Failure Limits

The same rules as for other QC tests apply for setting the lower and 
higher warning and failure limits.

❖ To define QC settings for paired sample tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. If desired, change the Number of analyte failures to generate a QC 
failure and change the Number of analyte warnings to generate a 
QC failure. For details, see “Quality Control Failure Rules” on 
page 10-6.

5. Select the action to take place If this QC fails. 

6. Select the action to take place If this QC fails again. 

7. Select the action to take place If this QC fails a final time.

8. Clear the Enabled check box next to the analyte to skip this analyte, 
see Figure 10-12.

By default, all analytes defined in the LabBook are included for the 
QC test. Although, by default the software only looks for those 
analytes that are included in the standard solution.
Analytes selected as Internal Standards are not considered for QC 
tests.

Figure 10-12. Quality Control Paired Sample Test Parameters
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9. Define the Limit for each analyte. The QC test is only performed if 
the QC concentration is greater than the product of CRDL and 
specified limit. The default value is 100, corresponding to the 
following formula:

cmeasured > Limit × CRDL

where cmeasured is the concentration of the QC sample, CRDL the 
contract required detection limit, and Limit the value from the test 
parameter table. If the condition is not fulfilled, the QC step for this 
analyte is skipped and QC passes.

10. Define the Low Failure Limit (%), Low Warning Limit (%), the 
High Warning Limit (%), and High Failure Limit (%) for each 
analyte. For details, see “Quality Control Test Parameters” on 
page 10-7.

Paired Sample Tests (EPA)

Paired sample tests (EPA) are offered in the Method Parameter Quality 
Control in Qtegra, see Figure 10-13.

Paired samples are used to assess the method-reproducibility between 
two defined samples. These EPA tests only check an absolute limit 
value.

To keep the calculation independent from the (plain) DUP and SER 
paired sample tests, Qtegra ISDS Software provides paired sample tests 
following the EPA calculations with a different recovery calculation, see 
“Paired Sample Tests (EPA conform)” on page 13-6. In the Test 
Parameters table, only the Limit, Warning Limit, and Failure Limit can 
be defined, see Figure 10-14.

Define the Warning Limit (%) and Failure Limit (%) for each analyte. 
For details, see “Quality Control Test Parameters” on page 10-7.

Figure 10-13. Table of QC settings for paired sample tests (EPA)

Figure 10-14. Table of QC settings for paired sample tests (EPA conform)
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The Paired Sample Tests (EPA) available are summarized in 
Table 10-6.

Spike Tests / Spike Tests (ARC)

Several types of spike tests are offered in the Method Parameter Quality 
Control in Qtegra, see Figure 10-15.

Spike tests are used to determine the recovery of a known addition of 
analyte to a particular sample. The rightmost two columns in 
Table 10-7 show typical QC requirements of the US EPA.

Table 10-6. Quality control paired sample tests (EPA)

Test type Description Purpose Frequency Limits

DUP (EPA) Duplicate (EPA) checks the reproducibility of 
results by analyzing an 
unknown sample in duplicate

1 per 20 samples 
per matrix

±20% RPD

SER (EPA) Serial Dilution (EPA) checks for matrix effects by 
assessing the variation of result 
for an unknown sample before 
and after dilution

1 per 20 samples 
per matrix

±20% of the 
original 
undiluted result 
after dilution 
correction (EPA 
Method 6010D) 

Figure 10-15. Table of QC settings for spike recovery tests

Table 10-7. Quality control spike recovery

Test type Description Purpose Frequency Limits

LFB Laboratory Fortified 
Blank

checks the recovery of 
analytes in a matrix-free 
sample

every 20 to 30 
samples

85-115%
(EPA Method 
200.8)

MXS Matrix Spike checks the recovery of a spike 
in the sample matrix

every 20 samples 80-120%
(EPA Method 
6020A)

30-70%
ILM05.2D
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Warning and Failure Limits

Apply the same rules as for other QC tests for setting the lower and 
higher warning and failure limits.

❖ To define QC settings for spike tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. If desired, change the Number of analyte failures to generate a QC 
failure and change the Number of analyte warnings to generate a 
QC failure. For details, see “Quality Control Failure Rules” on 
page 10-6.

5. Select the action to take place If this QC fails.

6. Select the action to take place If this QC fails again.

7. Select the action to take place If this QC fails a final time.

PDS Post Digestion Spike checks the recovery of 
analytes spiked into an 
unknown sample after 
preparation (digestion)

1 per 20 samples 
per matrix

75-125%

MXS ARC Matrix Spike with 
Alternative Recovery 
Calculation

based on an alternative 
recovery calculation that 
avoids negative recoveries in 
cases where spike 
concentrations are too low 
compared to unspiked 
samples

Table 10-7. Quality control spike recovery

Test type Description Purpose Frequency Limits
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8. Clear the Enabled check box next to the analyte to skip this analyte, 
see Figure 10-16.

Generally, all analytes defined in the LabBook are included for the 
QC test. Although, by default the software only looks for those 
analytes that are included in the standard solution.
Analytes selected as Internal Standards are not considered for QC 
tests.

9. Define the Qualifier for each analyte. The QC test is only 
performed if the ratio of spike concentration and unspiked 
concentration is greater than the specified Qualifier. Default value is 
100, corresponding to a spike/unspiked ratio of 1/1, expressed in 
percent, following the formula:

where cspike is the concentration of the spike, cunspiked the 
concentration of the unspiked QC sample, and Qualifier the value 
from the test parameter table. If the condition is not fulfilled, the 
QC step for this analyte is skipped and QC passes.

10. Define the Low Failure Limit (%), Low Warning Limit (%), the 
High Warning Limit (%), and High Failure Limit (%) for each 
analyte. For details, see “Quality Control Test Parameters” on 
page 10-7.

Figure 10-16. Quality Control spike test parameters

cspike
cunspiked
------------------ 100⋅ Qualifier>
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Continuous Tests

Several types of continuous tests are offered in the Method Parameter 
Quality Control in Qtegra, see Figure 10-17.

The continuous test RCV checks the correlation coefficient of the 
calibration to make sure that only accurate calibration data is used for 
the quantification of unknown samples.

With the continuous test RSV, the relative stability of the obtained 
signal can be verified. A certain threshold value can be defined, either 
related to signal intensity in CPS or concentration, so that sample 
concentrations not greater than the threshold value are not included in 
this QC test. This way, QC failures for very low concentrations or 
intensities can be avoided.

Continuous tests are active for all BLKs, standards and samples to 
continuously monitor the performance during analysis.

Two different Continuous Tests are available. The last two columns in 
Table 10-8 show typical QC requirements of the US EPA.

Warning and Failure Limits

The same rules as for other QC tests apply for setting the lower and 
higher warning and failure limits.

❖ To define QC settings for continuous tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

Figure 10-17. Table of QC settings for continuous tests

Table 10-8. Quality control spike recovery

Test 
type

Description Purpose Frequency Limits

RCV Regression Coefficient 
Verification

checks that the linearity of 
the calibration is within 
(above) the specified warning 
and failure limits

every calibration 0.95
Failure 0.9

RSV Relative Stability 
Deviation Verification

checks that the relative signal 
stability of the main run data 
is within (below) the 
specified warning and failure 
limits

every samples 5%
Failure 10%
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2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define.
On the right, the corresponding Test details and Test Parameters 
are shown.

4. If desired, change the Number of analyte failures to generate a QC 
failure and change the Number of analyte warnings to generate a 
QC failure. For details, see “Quality Control Failure Rules” on 
page 10-6.

5. Select the action to take place If this QC fails.

6. Select the action to take place If this QC fails again.

7. Select the action to take place If this QC fails a final time.

8. Clear the Enabled check box next to the analyte to skip this analyte, 
see Figure 10-18.

By default, all analytes defined in the LabBook are included for the 
QC test. Although, by default the software only looks for those 
analytes that are included in the standard solution.

9. For the continuous test RCV, define the Warning Limit and Failure 
Limit for the analytes. For details, see “Quality Control Test 
Parameters” on page 10-7.

Figure 10-18. Quality Control: continuous test RCV parameters
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10. For the Continuous Test RSV, select the parameters to be verified 
for each analyte from the drop-down list Verify, see Figure 10-19.

11. Set the value for Ignore Concentration Below and define a Unit, if 
activated.
Set the Concentration Warning Limit (%) and Concentration 
Failure Limit (%).

12. Set the value for Ignore Intensities Below, if activated.
Set the Intensity Warning Limit (%)and Intensity Failure Limit 
(%), see Figure 10-20.

Figure 10-19. Quality Control: continuous test RSV parameters, left part

Figure 10-20. Quality Control: continuous test RSV parameters, right part
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Internal Standard Test

An Internal Standard test is offered in the Method Parameter Quality 
Control in Qtegra, see Figure 10-21.

Like the continuous test, the Internal Standard test is activated for every 
entry in the Sample List to evaluate performance and make sure that 
potentially occurring matrix effects can be corrected for.

If an Internal Standard is used, warning limits and failure limits of its 
recovery in percent can be entered.

❖ To define QC settings for Internal Standard Tests

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.
On the left, the available Quality Control Tests are listed, see 
Figure 10-1.

3. Select the Quality Control Test you wish to define, for example.
On the right, the corresponding Test details are shown, see 
Figure 10-21.

4. Tick Internal Standard Test enabled to activate this feature.

5. Define the Low Warning Limit (%) and High Warning Limit (%) 
for the analytes.

6. Define the Low Failure Limit (%) and High Failure Limit (%) for 
the analytes.

Figure 10-21. Quality Control: test details for IST

Tip The Internal Standard test can also be found in the 
Quantification view, in the field of the IS Recovery pane at the 
bottom of the view, see “Quantification” on page 9-33.
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Defining Detection Limits for eQuant LabBooks

The Detection Limits are used by some of the QC types to determine 
whether the sample has passed or failed or even whether the test should 
be performed in the first place.

The Quality Control view of the eQuant LabBook in Qtegra allows the 
definition of contract-required detection limits for the measurement, see 
Figure 10-22.

The contract required detection limits are defined by the laboratory 
operator and can be either experimentally derived from data previously 
acquired or set as values that are prescribed by regulators such as the US 
EPA. They are used as part of the Blank Verification QC tests and also 
as a pre-test validation for the Paired Sample Tests.

Figure 10-22. Opening contract-required detection limits
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The detection limits are edited in the dialog Contract Required 
Detection Limits. It is also possible to import or export detection 
limits. The elements of the dialog are summarized in Table 10-9.

❖ To enter detection limits for the defined analytes

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.

Table 10-9. Detection limits

Column Description

Symbol Displays the analytes selected for the 
Template (LabBook).

Concentration Defines the detection limit for this 
analyte.

Unit This column defines the unit of the 
detection limit. By default, the unit is 
ppm. Several units are offered to be 
selected from the drop-down list.
The units can be different for each 
analyte. The detection limits are used 
later in certain QC tests.

Import Import Contract Required Detection 
Limits. See “To import an existing 
analyte list” on page 10-27.

Export Export Contract Required Detection 
Limits. See “To export the currently 
loaded analyte list” on page 10-29.

Tip Any analytes (cells) that are not required for the LOD checks can 
be left blank.
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3. On the toolbar, click Edit the contract required detection limits.
A dialog opens, see Figure 10-23.

4. Click the Concentration cell next to an analyte and type a value for 
the detection limit.

5. Expand the Unit cell to select a unit from the drop-down list.
The default unit is ppm.

6. Repeat until all detection limits are set.

7. Click Close.

❖ To import an existing analyte list

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.

Figure 10-23. Contract Required Detection Limits dialog
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3. On the toolbar, click Edit the contract required detection limits.
A dialog opens, see Figure 10-24.

4. Click Import to open the Import detection limits dialog.

5. Select the directory of your CSV file.

6. Select the CSV file you wish to import, see Figure 10-25.

7. Click Open to load the file.
The CSV file is imported into the table to be edited as required.

8. Click Close to close the Contract Required Detection Limits 
dialog.

Figure 10-24. Contract Required Detection Limits import

Figure 10-25. Import detection limits dialog
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❖ To export the currently loaded analyte list

1. Open a LabBook with the eQuant evaluation and activated Quality 
Control.

2. Open the Method Parameters > Quality Control view.

3. Click Settings.
A dialog opens, see Figure 10-26.

4. Click Export to open the Export detection limits dialog, see 
Figure 10-27.

5. Select the directory of your CSV file.

Figure 10-26. Contract Required Detection Limits export

Figure 10-27. Export detection limits dialog
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6. Type a name for the CSV file you wish to export.

7. Click Save to save the file.
The CSV file is exported.

8. Click Close to close the Contract Required Detection Limits 
dialog.

Defining QC Settings in Sample Definition of eQuant Templates

The QC settings are specified for each sample in the Sample Definition 
section of the eQuant Template in Qtegra. The Sample List of the 
LabBook is generated from the definition given in the Sample 
Definition section.

QC samples can be defined as Initial Actions, for example, ICB or ICV, 
as Continuing Actions with the appropriate value for Interval, or in 
special cases as End Actions.

❖ To define QC settings in Sample Definition

1. Open a Template with the eQuant evaluation and activated Use 
Quality Control, see “Quantification” on page 9-33.

2. Define your Quality Control Test, see “Quality Control” on 
page 10-5.

3. Click  Sample Definition to open the 
Sample Definition view of the Template.

4. Add as many Initial, Continuing and End Actions rows as you 
need for your experiment.

5. Type a Label for each row and define the columns to your needs.

6. Type a Label and select QC for the column Sample Type for your 
QC rows.

Tip For details on Quality Control, see “Quality Control” on 
page 10-5.

Tip Initial and End Actions rows will only be done once at the 
beginning and respectively the end of the experiment. A single row 
in the Continuing Actions block will be repeated according to the 
Intervals specified. The Continuing Actions rows block will be 
repeated as required depending on the number of samples entered 
when creating a LabBook from this Templates, see “Creating 
LabBooks” on page 4-24.

Tip For details on the columns, see “Sample Definition for a 
Template” on page 5-5.
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7. For your Initial Actions QC row, select a QC test type, for example, 
ICB or ICV from the drop-down list to specify the QC Action.

8. Select a Standard where required by the QC test, see Figure 10-28.

9. Select an action from the drop-down list for the column QC Restart 
for your Initial Actions QC row.
This action takes effect if the QC test failed.

10. For Continuing Actions rows, type a Label and select QC for the 
column Sample Type for your QC test rows.
The color of the row changes to light red to indicate a QC sample 
type.

11. Select a Standard where required by the QC test, and select an 
action from the QC Restart and QC Action drop-down lists, see 
Figure 10-29.

In our example, all QC samples are shown once correctly defined for 
purely demonstrative reasons. Usually, you choose only one or two 
QC types in your experiment.

Figure 10-28. QC action ICV defined as Initial Actions row

Figure 10-29. QC test types example definitions in Sample Definition
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For some QC test types, for example MXS, you may refer to this 
QC test row with a <unique ID>. The <unique ID> can be freely 
defined. This exact same <unique ID> needs to be entered for QC 
Reference in the sample row from which you wish to refer.

12. Type a <unique ID>, in this example, BLK and Sample 1, in the QC 
Reference column of the appropriate UNKNOWN sample rows.

13. Repeat this <unique ID> in the appropriate QC test row.
In this example, BLK is repeated in the QC Reference column for 
the QC Action column LFB, and Sample 1 is repeated in the QC 
Reference column for the QC Action column DUP, SER, MXS, 
and PDS.

14. Define End Actions rows, as appropriate, see Figure 10-30.

In this example, the QC Action column entries are defined as None.

15. Create a LabBook from this Template as described in “Creating a 
LabBook for Analysis with eQuant Evaluation” on page 10-35.

❖ To use averaged unspiked analyses

For the QC tests Paired Sample, Paired Sample EPA, Spike and Spike 
ARC, an average calculated from multiple unspiked samples can be used 
in recovery calculations.

1. Assign multiple unspiked analyses their own individual 
QC Reference tag.

Figure 10-30. QC Sample Definition End Actions
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2. Enter these tags in the QC Reference for the Spike Recovery 
QC test. The average of the tagged unknown analyses will be used 
in the Spike Recovery calculation.

Post Analysis Modification of QC Parameters

If you want to make changes in the defined QC tests after the LabBook 
is completed, you must grant the relevant Qtegra user group with the 
appropriate access rights. For details, see “Granting Access Rights” on 
page 3-4. 

❖ To change QC parameters

1. With the correct access rights, open your LabBook and select the 
Sample List, see Figure 10-32.

Figure 10-31. Assigning multiple unspiked unknown analyses for use in 
a MXS recovery QC test

Tip Use a comma as a separator for multiple QC Reference tags.

Tip Initially, no Qtegra user group has appropriate access rights to 
make these changes.

Figure 10-32. Initial view of a Sample List

Tip Only the QC parameters QC Action and QC Reference can 
be edited post analysis.
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2. For example, when changing the QC Action to a Spike Test (in the 
example change from CCV to MXS), the QC Reference must 
sometimes also be modified.

3. Tag the QC Reference for an Unknown (in rows 9 up to 12, see 
Figure 10-34) with a unique (string and/or number) identifier.

4. Enter the sample identifier for the QC Reference in the QC sample 
(row 14, see Figure 10-34).
The red warning symbol disappears when all tags are referenced.

Figure 10-33. Changed QC Action with red indicator showing that a 
QC Reference must be provided before continuing

Figure 10-34. QC Action with tagged QC Reference
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Creating a LabBook for Analysis with eQuant Evaluation
The LabBook should be based on the Template that you created for 
your eQuant analysis in Qtegra.

❖ To create the LabBook for your eQuant analysis

1. From the Qtegra - [Home Page] navigation pane, click LabBooks.
The LabBooks view of Qtegra opens.

2. Type a Name for the LabBook and select a Location, see 
Figure 10-35.

3. Select Create a new LabBook from a Template.

4. Select your eQuant Template Name from the drop-down list.

5. Type a number for Samples.
To import a Sample List, click Import from CSV, and select a CSV 
name and a Mapping Name from the drop-down list.

6. Click Create LabBook to create the new LabBook.
A new tab opens for the new LabBook.

7. Check all Method Parameters.

8. Check the Sample List.

9. Make sure that the settings for the autosampler are corresponding to 
the actual position of vials in the autosampler.

Figure 10-35. Typing the name for an eQuant LabBook
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Acquiring Data with an eQuant LabBook
Intensity and concentration data can be reviewed in Qtegra ISDS 
Software for completed analyses. Spectra View furthermore offers the 
possibility to look at the emission spectra acquired during the Full 
Frames runs.

❖ To run a LabBook

1. From the Qtegra - [Home Page] navigation pane, click LabBooks.
The LabBooks view opens.

2. On the lower part of this view, click Open.
The Browse for LabBook dialog opens.

3. Select the LabBook.

4. Click OK to open the LabBook in a new tab.

5. Click Schedule to add the LabBook to the Scheduler.
If Automatic has been selected for Start Queue in the Options 
settings of the Scheduler (see “Customizing Scheduler Settings” on 
page 4-76), the LabBook is started immediately.

During the start of the measurement, the instrument is checked 
automatically. This check includes a check of the slide valve that may 
have been set into a closed state. If so, Qtegra indicates Opening Slide 
Valve in the status bar to inform the user about the current state. The 
slide valve then is opened automatically. Qtegra waits for 5 seconds and 
repeats the opening procedure if the closed state remains. After a third 
insufficient trial the LabBook is suspended.
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Results and Post Analysis Data Evaluation
For details on viewing results, see “Viewing the Results of a 
Measurement” on page 6-32.

Depending on the needs of your laboratory, additional, post analysis 
data evaluation of results may be required.

By inspecting the measured LabBook you may be able to identify 
potential issues with the measurement and correct or minimize their 
effect through re-evaluation.

Any changes to the calculated data stored in a LabBook are recorded and 
can be saved with comments. At no time is the raw, acquisition data in 
the LabBook modified.

Concentrations

In the Evaluation Results Concentrations view of the LabBook in 
Qtegra, the results of the quantitative analysis are summarized. As with 
the Sample List, blanks (BLK) are displayed in blue, standards (STD) in 
yellow, QCs in red and UNKNOWNs in white. The mean, standard 
deviation (SD) and relative standard deviation (RSD) values as well as 
the results of each main run are shown when you expand the line. An 
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entry can be added or removed from the calculation by right-clicking 
and selecting Include entry or Exclude entry from the shortcut menu, 
see Figure 10-36.

From the shortcut menu (see Figure 10-36), click Jump to raw data for 
an entry to open the Intensities view that shows the corresponding 
intensity value. This allows you to verify the value.

Figure 10-36. Evaluation Results: Concentrations with shortcut menu

Tip When using a very large LabBook, a recalculation, for example, 
initiated by excluding or including an entry, takes time to display final 
results. For this busy state, Qtegra displays an additional icon on the 
toolbar of the Intensities view, the Concentrations view, and the 
Concentration Ratios view to indicate the calculation running in the 
background, see Figure 10-37. You can proceed with your next steps, 
but be aware that the displayed values may change as long as the 
animated indicator is shown.

Figure 10-37. Busy indicator for background calculation
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Values in brackets represent the expected concentration of the standard. 
The recovery of the internal standard is displayed in percent relative to 
the first sample acquired. Double-click one of these values to plot the 
recovery against the sample number.

❖ To display details

1. In the Evaluation Results Concentrations list, click the first cell (1 in 
Figure 10-38) of the desired line to select one sample.
The selected sample is indicated by a triangle and highlighted with 
yellow background.

2. On the toolbar, click Display Details (2 in Figure 10-38),
-or-
Double-click a cell with the concentration value,
-or-
Click [+] in front of the sample line to expand the entry and 
double-click the thumbnail of the calibration curve.

An enlarged graph of the calibration curve is displayed on the lower left 
side (8 in Figure 10-38), including the calculated values for the 
background equivalent concentration (BEC), the instrumental detection 
limit (IDL) as well as the most common statistical data to assess the 
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quality of the fit. The green area in the graph represents the confidence 
delta at 90% while each point is displayed with its standard deviation, 
see Figure 10-38.

The values are automatically updated when values are included or 
excluded or the settings in the “Quantification” on page 9-33 view of 
the Method Parameters are changed.

You can further enlarge the graph by clicking Maximize (6 in 
Figure 10-38). Right-click the graph to display options to copy or save 
the graph or to display the data logarithmically.

Click Restore to fit the graph back to its initial pane.

Comments for each sample line can be added by clicking Add 
Comment (5 in Figure 10-38) in the right tile of the Details view.

Labeled Components: 1=Triangle as selection indicator, 2=Details button, 3=selected line, 4=thumbnail of calibration 
curve, 5=Comment tile, 6=Maximize button, 7=Calibration Properties tile, 8=Details view with parameter table

Figure 10-38. Evaluation Results: Concentrations details
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78 6
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Calibration Properties (7 in Figure 10-38) may be adjusted locally 
from this view as well. Any change in calibration properties made to an 
element here is applied locally to both the calibration and displayed 
results in the Concentrations view.

The toolbar of the Concentrations view offers a button to perform a 
Recalculation.

Buttons with correction functions allow to switch on/off the 
mathematical Interference Correction and to switch on/off the Use of 
Internal Standards. In the Comment tile, the Quality Control results 
are always shown based on the correction functions (including the 
Blank Correction) enabled. In case you have copied a LabBook from a 
LabBook where the correction functions of the Method Parameters are 
not used, the Quality Control nevertheless shows the values with 
correction functions. 

Click Blank Correction to switch on/off the blank correction. If no 
ZERO STD is selected, the blank correction includes the measured 
intensity of the different wavelengths into the calibration plot with a 
concentration of 0 (BLK). If one or more samples in the Sample List are 
indicated as ZERO STD (to perform a standard addition), the 
correction is done by subtraction of the intensities determined for this 
sample.
Blank correction can lead into negative concentrations as Qtegra 
consequently calculates the measured concentration minus BLK 
concentration, see Figure 10-39.

The history of the changes made to the LabBook are displayed by 
clicking History on the toolbar. Options to export the results are shown 
by clicking Export (see Figure 6-3). The button Create allows you to set 
up a new LabBook or Template from the one already measured with its 
current settings. See also “LabBook Toolbar” on page 6-2.

Figure 10-39. Analyte concentration before and after Blank correction



Analysis with eQuant Evaluation
Results and Post Analysis Data Evaluation

10-42 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific

Internal Standard Correction

The reference value of an Internal Standard (IS) is defined by the 
average intensity of the Internal Standard analyte in the first blank of the 
current standard block or by the first standard in case a blank is not 
present.

Internal Standard correction is applied on a per run basis. That means, 
the per run intensities of both the analyte and its defined internal 
standard are ratioed to generate the internal standard corrected 
intensities which carried through in the calculation process.

You can change an Internal Standard correction for each measured 
sample after completion of the LabBook.

❖ To change an Internal Standard correction

1. Open your finished LabBook.

2. Select Concentrations from the Evaluation Results section to 
display the table of all measured samples.
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3. Right-click the concentration cell of an UNKNOWN or QC 
sample to open the shortcut menu, see Figure 10-40.

4. Open the sub-menus from Internal Standard to select the desired 
Internal Standard for this element.
The currently selected choice for IS correction is highlighted by a 
check mark.

5. At the same time you will see the change made in the Details view of 
the calibration curve for that analysis, see the red arrow on 
Figure 10-40, where the element and its corresponding IS are 
shown.

Figure 10-40. Shortcut menu for Internal Standard

Tip When you select a series of cells either per element (column), per 
analysis (line), or by freehand selection and select an Internal Standard 
from the shortcut menu, you are changing the IS for the selected cells 
only. Right-click selection of the Internal Standard is only possible for 
the UNKNOWN and QC sample types. If your selection contains the 
sample types BLK, STD, AVERAGE BLK, ZERO STD, right-click 
choice of Internal Standard is not available.
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Through this right-click selection of Internal Standard you are not 
changing the selected IS in non-selected cells or for the Blanks and 
Standards in the LabBook.

To change the IS selection used in the calibration (BLKs and STDs) you 
must update the Quantification.

Changes to IS selection in the Quantification page overwrite any 
changes made locally in Concentrations and set the IS in all analyses 
(BLK, STD, UNKNOWN etc).

❖ To reset Internal Standard settings of one analyte

1. To set the Internal Standard of the current selection back to the 
default, right-click the current selected concentration cell to open 
the shortcut menu.

2. Select Internal Standard > Default.
The Internal Standard changes to the default element, which is 
defined in the Quantification view.

❖ To reset all Internal Standard settings

1. To set the Internal Standard settings for all analytes back to the 
defaults, right-click anywhere in the Concentrations table to open 
the shortcut menu.

Figure 10-41. Shortcut menu with Internal Standard item

Tip Resetting the Internal Standard to Default does not affect the 
Calibration Properties parameters shown in the Details view. This 
command only sets the Internal Standard back to the default 
element.

Figure 10-42. Shortcut menu with Reset all Internal Standard item
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2. Select Reset all Internal Standard settings to default.
All Internal Standards change to the respective elements, which are 
defined in the Quantification view.

Dependencies between the Quantification and the Concentrations View

To understand the effect for the Concentrations view on changes on 
the Quantification view, some user actions will be described.

As shown above, changes to the Internal Standard can be performed per 
analyte. You can also change the Calibration Properties per analyte. 
These changes remain as set by you and are shown in the Details tile on 
the Concentrations view. Further activities on the Concentrations 
view, for example, changing or resetting Internal Standards, do not 
affect the Calibration Properties.

When you change parameters in the Quantification view, it will affect 
the calculation shown on the Concentrations view. That means, all 
changes on the Quantification view have an impact on the evaluation 
results. If, for example, the IS for an analyte has been changed in the 
Concentrations view and the IS for the same analyte is then later set to 
another item on the Quantification view, the selection in the 
Quantification takes priority.

Tip Resetting all Internal Standard settings to default does not 
affect the Calibration Properties parameters shown in the Details 
view. This command only sets all Internal Standards back to the 
defaults.

Tip When copying a LabBook from a LabBook, the Internal 
Standards are taken from the default settings defined in the 
Quantification view.
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Concentration Ratios

The Evaluation Results Concentration Ratios view of the LabBook 
shows the ratios for each pair of wavelengths entered in the Method 
Parameters section related to the determined concentrations, see 
Figure 10-43.

Intensities

The Evaluation Results Intensities view of the LabBook in Qtegra 
displays the raw intensities. If the entries are shown in bold type, at least 
one sweep within one main run was measured using the analog mode of 
the detector. If the entries are displayed in blue instead of black, they 

Figure 10-43. Evaluation Results: Concentration Ratios
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were manually edited, for example, the result of one main run was 
removed from the calculation of the average after the measurement, see 
Figure 10-44.

From the shortcut menu, select Jump to result for an entry to open the 
Concentrations view showing the corresponding concentration value. 
This allows you to verify the value.

Figure 10-44. Evaluation Results: Intensities with shortcut menu
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Expand a line to display the mean as well as the standard deviation (SD) 
and relative standard deviation (RSD) values. In the thumbnails, filled 
circles indicate that the value was measured in the analog mode, red 
circles represent excluded entries. The blue line in the Details view 
represents the mean of the different main runs, see Figure 10-45.

From the Intensities view, right-click the intensity of one of the repeats 
to open the shortcut menu. When direct spectral overlaps occur, the 
Inter-Element Correction attempts to correct those (and subsequent 
contaminated data) by applying a ratioed correction factor to all 
samples.

Inter-Element interferences occur when elements in the sample emit 
light at wavelengths so close to that of the analyte that they contribute to 
the intensity of the light from the analyte. If such conditions exist, the 
calculation will yield a high concentration for the analyte. Applying 
Inter-Element Corrections removes the effects of these non-analyte 
emissions.

Figure 10-45. Evaluation Results: Concentrations Details
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❖ To apply inter-element corrections

1. Select Inter-Element Correction to open the dialog as shown in 
Figure 10-46.

2. Tick the Enable check box to activate the correction for the element 
of the line. 
Click the refresh button  of the Formula column to show the 
corresponding correction formula. 
Double-click the formula to change it.

3. Click OK to close the dialog and to apply the changes.

The  method parameter allows to visualize 
all the selected corrections and to select/deselect them. Double-click the 
intended element(s) to change the formulas. This will prompt a second 
table where this information can be typed.

Figure 10-46. Inter-Element Correction dialog
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Double-click the intensity of one of the repeats to open the subarray 
plot in the bottom (left side) along with a table (right side), see 
Figure 10-47.

The subarray plot represents the region of the CID that has been 
allocated to that particular element and can be used to determine if a 
line for a given element is free of interference from lines of other 
elements. Subarrays are normally examined to check for interferences 
and ensure that the analytical peak is covered by the central integration 
area (marked C on the subarray plots).

Relevant information related to the analysis is displayed right next to he 
graph. Wavelength and Intensity change according to the position of the 
mouse in the graph. Corrected Peak, Peak, Average Background, and 
Left and Right background change according to the setting in the graph 
(number of pixels selected).

Figure 10-47. Evaluation Results: Intensities subarray plot
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Right-click the graph to open the shortcut menu, see Figure 10-48.

Without selection, the subarray plot is presented (bar chart). If 
Smoothed Plot is selected, the subarray plot is drawn as a graph, 
without selection you will see the subarray plot as a bar chart. Show 
Background/Center highlights the central pixel.

The table on the right of the graph is the Wavelength Finder and it 
displays the Symbols with corresponding wavelength (Line), State and 
Intensity. On the Comments tab, click  to open the 
User Comment dialog and to type comments for the selected sample 
line.

In the toolbar of the Details view on the left,  Maximize enlarges 

the graph. Click  to change the pre-defined central pixel. Click  

and  to change the pre-defined left and right background pixels 
respectively. Click an empty square to select additional pixels.

Figure 10-48. shortcut menu of Intensities graph
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Click the analyte column in the Intensities table (right next to Label) to 
overlap the plots of all samples. You can choose the repeat and samples 
in the drop-down menu, see Figure 10-49.

Select the next or previous analyte with the arrows buttons  in 

the toolbar of the Details view. Changes are applied with .

Figure 10-49. Detail subarray plot with drop-down menu
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Intensity Ratios

The Evaluation Results Intensity Ratios view of the LabBook in Qtegra 
shows the data with reference to the raw intensities. The shortcut menu 
offers functions to include or exclude single entries, see Figure 10-50.

Figure 10-50. Evaluation Results: Intensity Ratios with shortcut menu
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Full Frames

With the Evaluation Results Full Frames view of the LabBook in 
Qtegra you can identify all the elements present. Method elements are 
shown on the right in the Elements panel, see Figure 10-51.

The table of Elements shows elements and wavelengths that are 
available.

Figure 10-51. Evaluation Results: Full Frames view
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Click a sample line listed below Full Frame to show the graphical 
representation, see Figure 10-52.

A Full Frame is a graphical depiction of the CID chip. The Full Frame 
image presents a complete spectrum of all lines that are emitted by the 
sample.

Figure 10-52. Full Frame results with graphical representation
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If additional elements of interest are observed, you can identify them 
using the wavelength finder function that becomes available on the right 
side below Elements when you click an element in the graphical 
representation, see Figure 10-53.

The Cursor section on the top right displays the Position, 
Wavelength/Order, Intensity, and Raw Intensity information for the 
Range View selected when you clicked into the full frame image.

You can identify method and non-method elements at the click of a 
button using the wavelength finder. The zoom function  allows you 
to focus on a particular area of interest. Click  to zoom out again.

Figure 10-53. Full Frame results showing the wavelength finder
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Right-click a line in Elements to zoom into or to remove the selected 
line, see Figure 10-54.

From the wavelength list, right-click the element you wish to view, and 
select Show <element> line or the Show primary <element> lines 
from the shortcut menu, see Figure 10-55.

The selected item will be highlighted on the Full Frame display. 
Right-click the selected element in the wavelength finder to remove it 
from the display.

Full Frame subtraction allows you to identify contaminants from one 
batch to the next by subtracting one sample from the other.

Figure 10-54. Full Frame results showing the Elements shortcut items

Figure 10-55. Full Frame result view showing the shortcut menu of the wavelength finder
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Alternatively, a blank sample can be subtracted in order to remove the 
background, see Figure 10-56.

When you are working with a Full Frame image, concentrate on the 
many wavelengths appearing as bright spots in the lower wavelength 
region of the image.

The top of the image may appear overexposed due to the large amount 
of background. This background results mainly from argon continuum 
emission.

The bright spots are elements in your sample. The brightness of the spot 
is proportional to the concentration of the element, which emits light at 
that specific wavelength. The brighter the spot, the higher the 
concentration.

Figure 10-56. Full Frame results view Subtract



Analysis with eQuant Evaluation
Results and Post Analysis Data Evaluation

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 10-59

The Lighten  and Darken  tools are provided for ease of 
discrimination between areas of different intensity, so that it is easier to 
see a line, see Figure 10-57.

Figure 10-57. Full Frame results view lightened
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11

Basic Mathematical Methods

This chapter describes the basic mathematical methods used by Qtegra 
ISDS Software. It includes information about statistical calculations, 
linear and polynomial regression as well as Gaussian error estimation for 
regression analysis.

Contents

• Statistical Calculations on page 11-2

• Least Squares Fits (LQF) on page 11-3

• Error Estimation and Confidence Intervals on page 11-5

• Reporting Calculations on page 11-7
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Statistical Calculations

Average

For k given values x1, x2...xk the average or mean  is defined by 

Standard Deviation (SD)

For k given values x1, x2...xk the standard deviation SD is defined by 

Relative Standard Deviation (RSD)

With ¹ 0, the relative standard deviation RSD of the k values 
x1, x2...xk is given by 

Relative Standard Error (RSE)

United States EPA SW-846 method 8000D includes the request to use 
the RSE evaluate in the acceptability of a calibration by evaluating the 
difference between the measured and true concentrations in a 
calibration.

With xi = actual concentration of the calibration level i, x´i = calculated 
concentration at level i, n = number of calibration points, and 
p = number of terms in the fitting equation (linear = 2, quadratic = 3), 
the relative standard error (RSE, expressed as %) is given by
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Least Squares Fits (LQF)
For given data pairs (x0,y0), (x1,y1)...(xk,yk) and the polynomial function 
f(x)=abx

b+...a2x
2+a1x+a0 the solution of a least squares fit is given as the 

set of parameters a0, a1...ab which minimizes the sum:

or in case of weighting (see Table 13-2):

Linear Least Squares Fit (LLQF)

The curve used for solving the least squares fit problem is given as 
f(x)=a1x+a0. This kind of least squares fit is also commonly known as 
the determination of the linear regression curve. Its parameters a1, a0 can 
be determined by calculating:

 

Weighting can be applied to the formula.
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Quadratic Least Squares Fit (QLQF)

The QLQF uses the same basic algorithm with the difference that f(x) is 
defined as f(x)=a2x

2+a1x+a0. Solving the following system of linear 
equations solves the problem: 

Weighting can be applied to the formula.

Correlation Coefficient (R)

The Pearson correlation coefficient, R, is a measure of the strength and 
direction of the linear relationship between two variables that is defined 
as the covariance of the variables divided by the product of their 
standard deviations. In Qtegra ISDS Software, the correlation 
coefficient is calculated as the square root of the coefficient of 
determination:

Coefficient of Determination (R2)

For n given values y1, y2...yn the general definition of the coefficient of 
determination R2 is given by

 with  and 

R2 can be related to the unexplained variance since the second term 
compares the unexplained variance (variance of the model’s errors) with 
the total variance.

A
a0

a1

a2

1
i 0=

k

 xi
i 0=

k

 xi
2

i 0=

k



xi
i 0=

k

 xi
2

i 0=

k

 xi
3

i 0=

k



xi
2

i 0=

k

 xi
3

i 0=

k

 xi
4

i 0=

k



a0

a1

a2

⋅

yi
i 0=

k



xiyi
i 0=

k



xi
2yi

i 0=

k



= =

R R2=

Tip In linear least squares regression with an estimated intercept term, 
R2 equals the square of the Pearson correlation coefficient between the 
observed and modeled data values of the dependent variable.

R2 1
ssres
sstot
--------–= ssres yi fi–[ ]2

i 1=

n

= sstot yi y–[ ]2

i 1=

n

=
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Error Estimation and Confidence Intervals

Error Estimation for Linear Regression

Let y = a1x + a0 be the formula resulting for the linear regression where 
(xi, yi)1...n are the defining data points. The residual ei (residuum) is 
defined as

and the sum of squared errors (SSE) is given by

Since errors are obtained after calculating two regression parameters 
from the data, errors have n-2 degrees of freedom. Therefore the mean 
squared errors (MSE) result in

Using the MSE, the standard error for the parameters a1 and a0 can be 
written as:

The relative standard error can be obtained by dividing the standard 
error by the corresponding value of the parameter. The standard error 
(half of the confidence delta) of the estimated linear function value at x 
can be calculated by

 (Gaussian Error Estimation)

ei yi yi–=

SSE ei
2

i 1=

n

=

se
2 MSE SSE

n 2–
------------= =

sa0
se

1
n
--- x2

xi
i 1=

n

 nx2–
 
 
 
 
---------------------------------+

 
 
 
 
 
 
 
 
 

=

sa1

se

xi
i 1=

n

 nx2–
 
 
 
 

-------------------------------------=

error x( ) sa0
( )2 x sa1

⋅( )2+=
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The

confidence intervals for a0 and a1 can be computed using

— the 1 - α/2 quantile of the t distribution with n-2 degrees of freedom. 
The confidence intervals are

and 

Tip If a confidence interval includes zero the regression parameter 
cannot be considered to be different from zero at the  
confidence level. In case of a preset parameter (for example, forcing 
through a value) there are n-1 degrees of freedom.

100 1 α–( )%⋅

t 1 α 2⁄– n 2–,[ ]

a1 tsa1
– a1 tsa1

+,[ ]

a0 tsa0
– a0 tsa0

+,[ ]

100 1 α–( )%⋅
11-6 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific



Basic Mathematical Methods
Reporting Calculations
Reporting Calculations
This chapter describes the functionality and available methods 
supported by the “Calculations” feature given in the Reporting of 
Qtegra ISDS Software.

Calculations

The Report items Result Data Table and Data offer the additional 
“Calculations” feature. Adding additional column calculations via the 
below shown control adds additional information to the resulting report 
table, that is adding, for example, an Average calculation to one of the 
available columns adds an extra line at the end of the table showing the 
mean of the lines summarized before. See Figure 11-1.

Various calculations are available. The full variety of calculations is only 
available for numerical columns, whereas Entry Count is available for 
any given column. Multiple calculations can be added to a grid. The 
natural order given by the defining control also defines the order of 
addition to the Report page. The Group Column feature can be also 
used to bind a calculation to a certain table column.

Label defines the label value displayed in the final report table. Unit and 
Format – a numerical format string, that is 0.000 for displaying three 
significant digits – are used to format the displayed value.

Tip New Reports are created in the Qtegra tool of Qtegra ISDS 
Software, refer to the Help or Software Manual of the system.

Figure 11-1. Report Calculations
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For example, in case of “Average”, selecting the Index column results in 
executing the averaging for every sample, see Figure 11-2.

Available Calculation Types

Let k be the number of given values x1, x2...xk from the column using the 
selected calculation, then the following calculations are done for the list 
entries of the Calculation column, see Table 11-1:

Figure 11-2. Averaging for every sample

Table 11-1. Calculation types

Calculation Type Calculation

Average

Maximum

Minimum

RSD

Standard Deviation

Sum

x

xi
i 1=

k


k

-------------=

Max x1 x2 ... xk,, ,[ ]

Min x1 x2 ... xk,, ,[ ]

SD
x

------- 100%⋅

SD 1
k 1–
----------- xi x–( )2

i 1=

k

=

xi
i 1=

k
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Value Replacement offers an additional dialog for setting up the 
replacement criteria. This dialog is identical with the control used for 
filter conditions, see Figure 11-3.

Entry Count k

Value Replacement Removes Report table lines, meeting 
defined criteria, and adds the value 
in the added line.

Figure 11-3. Value Replacement Criteria

Table 11-1. Calculation types, continued

Calculation Type Calculation
Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 11-9



Basic Mathematical Methods
Reporting Calculations
11-10 iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) Thermo Scientific



12

Raw Data Processing Algorithms

The Qtegra ISDS Software Data Evaluation is handled by different 
evaluation modules called Virtual Evaluations (VE). The system 
currently knows the following common evaluation modules for 
quantification:

• Raw Data

• eQuant (External Calibration) 

This chapter describes the Raw Data structure. The raw data interface, 
which knows already certain mathematical methods to manipulate the 
given raw data, is also used by eQuant. Therefore, it is necessary to give 
a short overview, which data is used as a basis for the evaluation 
modules.

Contents

• Raw Data Handling on page 12-2

• Interference Correction on page 12-4
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Raw Data Handling
The evaluation methods use the structures supported by the Raw Data 
evaluation method to handle raw data streams. Raw Data itself allows 
displaying the streams and offers the possibilities to apply an 
interference correction.

An exemplary Sample List is shown in Figure 12-1.

Exemplary acquisition parameters are shown in Figure 12-2.

In Raw Data mode, eQuant offers an interface for external 
manipulation of the intensity values. This interface is available for each 
trace on the Intensities View via the Details View. In case of iCAP OES 
the background correction and the integration area can be defined, see 
Figure 12-3.

Tip From the programmer’s point of view the Data Adapter is the 
interface offering access to the raw data used by the evaluation 
methods. Raw data values are based on the number of runs given in 
the corresponding line of the Sample List.

Figure 12-1. Sample list (eQuant with iCAP OES)

Figure 12-2. Acquisition Parameters (eQuant with iCAP OES)

Figure 12-3. Details view (eQuant with iCAP OES)
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Raw Data Handling
The measured analyte intensity iA is defined as the average intensity at 
the center pixel position’s AverageC corrected by the average background 
intensity AverageBkg.

The slope of the background curve SlopeBkg is calculated from the 
difference of the intensities of the left background LBkg and right 
background RBkg divided by the difference of pixel positions of left and 
right background PixelLR. If multiple pixels are selected, the average 
pixel position is used.

 (per pixel)

with

The average background intensity AverageBkg is calculated from the 
intensities of left background LBkg minus the difference of pixel 
positions between left background and center position PixelLC 
multiplied by the slope of the background curve SlopeBkg.

with

This way of calculation leads to different average background values if 
the Center or Left/Right background positions are moved or changed, 
that means, set or remove the C on the subarray plot.

iA AverageC AverageBkg–=

SlopeBkg
LBkg RBkg–( )

PixelLR
---------------------------------=

PixelLR PixelR PixelL–=

AverageBkg LBkg PixelLC SlopeBkg×( )–=

PixelLC PixelC PixelL–=
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Interference Correction
The interference correction is the first data correction applied on raw 
data values.

The nature of the interference correction is always the same. The 
intensity values of the desired emission lines are interfered by emission 
lines of other elements (spectral overlap). By measuring these interfering 
emission lines, a linear correction with k interfering intensities given as 
values i1, i2...ik and the related correction factors f1, f2...fk can be applied 
to the measured intensity i with

The iCAP OES system offers Inter-Element Correction for the external 
interference correction, see Figure 12-4:

icorrected i fj
j 1=

k

 ij⋅+=

Figure 12-4. Inter-Element Correction with iCAP 7000 Series ICP-OES
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Data Processing Algorithms for eQuant

This chapter describes the evaluation algorithms for the Qtegra ISDS 
Software used in eQuant evaluation algorithms.

Contents

• External Calibration - eQuant on page 13-1

• Standards on page 13-8

• Standard Addition within eQuant on page 13-18

External Calibration - eQuant
The eQuant VE is the most complex module of the quantification 
series. It currently offers seven Sample Types to specify measurement 
blocks using the Sample List. The Standard Editor is used for specifying 
standards and Internal Standards. The Method Parameters of the VE 
specify Internal Standards for given emission lines as well as settings for 
certain calibration properties. The following Sample Types are 
supported in Table 13-1:

Table 13-1. Sample Types

Sample Types Chapter/Figure

UNKNOWN Defines a sample where the contained 
elements are quantified using the 
calibration curve from the preceding 
standard block, or using the 
Semi-Quant feature if applicable.

STD The sample line is treated as a 
standard.

BLK The last blank value of a blank block 
is used for blank correction.

AVERAGE BLK The mean of all average blanks in the 
current measurement block defines 
the blank to be used for blank 
correction.

ZERO STD Allows working in standard addition 
mode inside the external calibration 
module eQuant.
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The sample lines in Figure 13-1 define a valid measurement block 
consisting of a BLK, four standards, four QC samples and three 
unknown samples:

A minimal measurement block consists of at least one STD sample line 
and one UNKNOWN sample line. However, only multiple 
measurement results assure statistically useful data.

Internal Standardization

Internal Standard emission lines for the Internal Standard correction are 
defined on the Quantification Page or via the Standard Editor and the 
Sample List.

Internal Standard Correction

In case Internal Standard correction has been activated and Internal 
Standard emission lines have been defined, the Internal Standard 
correction is applied.

The first blank and, in case of the absence of a blank, the first standard 
defines the reference value for the Internal Standard correction. All other 
sample lines belonging to this standard block (in means of 

UPDATE CALIB Used to correct the current calibration 
curve.

QC Defines a sample as quality control 
sample and applies the selected 
actions. From the point of evaluation, 
a QC sample is handled in the same 
way as an UNKNOWN sample.

Tip For a detailed description of the different available QC modes, 
refer to the Help or Software Manual of the system.

Table 13-1. Sample Types, continued

Sample Types Chapter/Figure

Figure 13-1. Valid measurement block
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External Calibration - eQuant
quantification) will be corrected against that reference. Every measured 
intensity i will be corrected with the appropriate Internal Standard 
correction factor gISC.

Using the reference sample gISC is calculated by

where sr and st are the reference and target sensitivity of the Internal 
Standard emission line 

 and 

with  as the average intensity in the reference sample over all runs, it as 
the target intensity in the corrected sample, and cr, cs as the known 
concentration of the reference and the corrected sample, respectively. 
The target sensitivity is calculated for every run in every sample differing 
from the reference.

For every none-standard emission line with an Internal Standard 
defined, the measured run intensity will be corrected according to

The concentrations cr and cs are only applied if Internal Standards with 
different concentrations are defined. The most common way is to use an 
equally concentrated spike as an Internal Standard for the whole 
measurement block. In this case the concentrations cr and cs can be 
ignored.

Differently concentrated Internal Standards can be defined.

Blanks

A blank analysis represents the baseline above which a signal is detected. 
Blanks may be measured singularly or in a series of consecutive analyses 
(a blank block).

In the simplest case, a single analysis is defined as a blank by setting the 
Sample Type to ‘BLK’ in the Sample List.

In a blank block however, Qtegra can work with blanks in two ways, 
depending on the choice of Sample Type:

Tip The quotient sr / st is calculated on a “per run” basis. This means 
that the averaged quotient for each main run is used to correct the 
intensities and not the quotient of the averaged values.

gISC
sr
st
---=

sr
ir
cr
---= st

it
cs
---=

ir

icorr i gISC⋅=
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• If all of the blank block analyses are defined as Sample Type ‘BLK’, 
the last measured blank analysis is taken as the blank intensity.

• If more than one blank block analysis is defined as Sample Type 
‘AVERAGE BLK’, the average of these analyses is taken as the blank 
intensity.

By default, the blank is defined as the zero intensity point in the 
calibration. For a ZERO STD analysis however, the blank correction is 
made by subtracting the intensity value of the measured blank from the 
ZERO STD.

Limit of Detection (LOD)

The Limit of Detection (LOD) or Instrumental Detection Limit (IDL) 
of an emission line is defined as a multiple of the standard deviation of 
blank analysis (SDBlank) associated to a calibration that is converted into 
a concentration value using the slope of the calibration function (a1). 
For eQuant, the following formula specifies the LOD:

Method Quantification Limit (MQL)

The Method Quantification Limit (MQL) of an emission line is defined 
as a multiple of the standard deviation of blank analysis (SDBlank) 
associated to a calibration that is converted into a concentration value 
using the slope of the calibration function (a1). This value is then 

Tip Blank correction is not performed on analytes used as Internal 
Standards. If a calibration curve is available, this curve will be used to 
convert the measured intensities into concentrations. The 
concentration values returned are dependent on the options used for 
the calibration. For example, only setting ‘Forcing = Blank’ guarantees 
a zero concentration.

iBlankEmission line

iBlank
j 1=

#blank block lines


#blank block lines
-------------------------------------------=

Tip An LOD value can be reported for both types of blank: BLK or 
AVERAGE BLK.

Tip In the Concentrations Evaluation Results view, LODs are only 
displayed when a concentration equivalent can be calculated. An LOD 
value is only calculated for a linear regression calibration. Thus, no 
LOD value is calculated for a 2nd order calibration.

LOD
3 SDBlank×

a1
----------------------------- 
 =
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corrected by the Total Dilution Factor (TDF, see “Intelligent Dilution” 
on page 13-7) applied to the analysis. For eQuant, the following 
formula specifies the MQL:

Background Equivalent Concentration (BEC)

The Background Equivalent Concentration (BEC) for the given 
emission line is defined based on its current calibration curve f(x) with

the intercept of the calibration curve.

Quality Control (QC)

The QC tests and the recovery calculations are always based on total 
(measured) concentrations according to the equations mentioned in 
“Standard Addition within eQuant” on page 13-18. Thus, factors like 
Dilution, Amount, and Final Quantity are already included.

Currently, Qtegra knows several Quality Control Tests, which are 
grouped in several sub-categories according to their respective 
calculation.

Blank Tests

The test value is calculated based on a comparison of the total 
(measured) concentration (TMC) to the user defined Contract Required 
Detection Limits (CRDL). Afterward, the test value is compared to the 
defined warning and failure limit. Note that the unit of the Contract 
Required Detection Limits can be different to the ones defined for the 
standards.

Tip The MQL can be sample specific due to different dilution factors 
used in a LabBook.

MQL
10 SDBlank×

a1
-------------------------------- 
  TDF×=

BEC f 1– 0( )–=

Test value TMC
CRDL
---------------- 100%⋅=
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Calibration Tests

The recovery for calibration tests is calculated by comparing the total 
(measured) concentration (TMC) to the theoretical standard 
concentration (TSC).

Paired Sample Tests

For Paired Sample Tests, the recovery is calculated by comparing the 
total (measured) concentration (TMC) to the concentration of a 
reference sample (RSC).

Paired Sample Tests (EPA conform)

For EPA conform Paired Sample Tests, the relative percentage difference 
(RPD) is calculated of the total (measured) concentration (TMC) and 
the concentration of a reference sample (RSC) using the following 
formula:

Spike Tests

Using a Spike Test, the recovery is calculated by comparing the 
measured concentration (Total Measured Concentration (TMC) of the 
spiked QC sample minus Unspiked Sample Concentration (USC) of a 
reference sample) with the expected (theoretical) spike concentration 
(SC).

Spike Tests (ARC)

With an Alternative Recovery Calculation (ARC), the Spike Test has 
been modified to avoid negative recoveries in case where spike 
concentrations are too low compared to unspiked samples. ARC is 

Recovery TMC
TSC
-------------- 100%⋅=

Recovery TMC
RSC
-------------- 100%⋅=

RPD TMC RSC–
TMC RSC+( ) 2⁄-------------------------------------------- 100%⋅=

Recovery TMC USC–
SC

-------------------------------- 100%⋅=
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calculated as quotient of the total measured concentration of the spiked 
QC sample (TMC) and the sum of unspiked sample concentration 
(USC) and expected (theoretical) spike concentration (SC).

Continuous Tests

Using the Regression Coefficient Verification (RCV), the Coefficient of 
Determination R2 is compared to the entered warning and failure limits. 
The RCV test is performed at the end of a standard block.

The Relative Stability Verification (RSV) is performed for each line. It 
compares the RSD value of the final calculated concentration and/or the 
measured intensity against the entered warning and failure limit. Note 
that the limit of the concentration above which the test is performed can 
have a different unit than used for the standards.

Internal Standard Tests

The Internal Standard Tests compare the recovery of the Internal 
Standards against the entered limits.

Intelligent Dilution

For the Intelligent Dilution option Calibration Range, the measured 
concentration for each analyte (TMC) is compared to the entered limit, 
which is the percentage of the highest calibration point for this analyte 
(Highest Standard Concentration, HSC). The needed dilution is then 
calculated using the following equation:

The Total Dilution Factor (abbreviated with TDF) is calculated using 
the following equation:

Recovery TMC
USC SC+-------------------------- 100%⋅=

Dilution Factor TMC
HSC Target %( )⋅----------------------------------------------=

Total Dilution Factor Autodilution Factor Dilution Factor×=
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Standards
Standards consist of elements with known concentrations, which are the 
basis of any comparing quantification method. Consecutive standard 
sample lines are handled as a so-called standard block. Each standard 
sample line generates one intensity value for each measured emission 
line. Together with the concentration of the element (known from the 
standard) this pair of values forms a data point of the calibration curve 
f(x).

Standard Calibration Properties

The available options for calculating a calibration curve are listed in 
Table 13-2:

Table 13-2. Options for calibration curve calculation

Option Description

Fit Type Linear A linear regression curve with 

is calculated using the given data 
points.

2nd order A quadratic polynomial fit with 

will be used.

Both fit types use the least squares fitting method 
described in “Least Squares Fits (LQF)” on page 11-3.

Forcing None Value y for x = 0 is not manipulated.

Zero The calibration curve will be forced to 
fulfill f(0) = 0 which is equivalent to 
set a0 = 0.

Blank Defines the calibration curve f(x) with 
x = 0 as

 
-or- 

depending on the current blank block 
mode.

f x( ) a1x a0+=

f x( ) a2x2 a1x a0+ +=

f 0( ) iEmission line
BLK=

f 0( ) iEmission line
AVERAGE BLK=
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Units to be Displayed

The units used to display the calculation results for an analyte depend 
on the first appearance of that given analyte in a standard. Unit 
selections are set for the whole experiment.

Quantification of UNKNOWN/QC Samples

Based on the calibration curve f(x) the original concentration c of the 
analyte in an UNKNOWN sample is calculated using

Weighting None Value will not be weighted.

Absolute SD Weight

Each point is weighted by the 
standard deviation SDk of the analyte 
over the runs in the sample.

Relative SD Weight

 

Each point is weighted by the 
standard deviation  of the analyte 
over the runs in the sample relative to 
the mean .

1/Concentration Weight

Each point is weighted by the 
concentration ck of the analyte. Blanks 
are ignored as their concentration is 0.

1/Concentration2 Weight

Each point is weighted by the squared 
concentration of the analyte. 
Blanks are ignored as their 
concentration is 0.

Table 13-2. Options for calibration curve calculation, continued

Option Description

ωk 1 SDk
2⁄=

ωk 1 SDk ik⁄( )
2

⁄=

SDk

ik

ωk 1 ck⁄=

ωk 1 ck
2⁄=

ck
2

c f 1– x( )=
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where x is the measured intensity. QC samples are handled in the same 
way as UNKNOWN samples - with the exception that in case where a 
recovery needs to be used and displayed (for example, CCV) the 
percentage is calculated based on the before calculated concentration 
and compared the with defining concentration.

Final Quantity, Amount, and Dilution

If Final Quantity q, Amount a, and Dilution d are specified in the 
Sample List, the concentration value is corrected by

Unspecified values are set to 1. The dilution is differently handled for 
standards. Dilution, Amount and Final Quantity are applied to the 
concentration of the stock solution cstock to calculate the expected 
concentrations cexp for the calibration curve using

 

Update Calibration

Considering the fact of a drifting instrument without wanting to 
measure all standards again, it is possible to use a so-called Update 
Calibration sample line (UPDATE CALIB). This sample is used to 
calculate a correction value, which will be applied on the preceding 
calibration block. Therefore, it is necessary that the Update Calibration 
line uses the same concentration as the correspondent sample line in the 
standard block (STD).

Consider

to be the intensity of a measured emission line for a certain 
concentration, which was also measured inside the preceding standard 
block sample line with

ccorr c d q
a
--⋅ ⋅=

cexp cstock
1
d
--- a

q
--⋅ ⋅=

Tip After any Update Calibration, the calibration function is 
recalculated. There is no difference in the calculated result in the 
sample following 6 separate Update Calibrations (according to 6 STDs 
for example) from using all 6 or just one. 

iEmission line
UPDATE CALIB

iEmission line
STD
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The resulting factor

is used for scaling any intensity value of the calibration curve for the 
subsequent sample lines.

The ZERO STD sample type feature offers the same possibilities as 
described in “Standard Addition within eQuant” on page 13-18 with 
the chance of combining them with all other available sample types 
inside the eQuant evaluation.

Quantification Steps

In order to quantify an element, the following methods are applied:

1. Application of Inter-Element Correction if activated and available.

2. Calculation of Internal Standards - a correction will only be applied 
if activated.

3. If zero standards exist, blank correction is implemented as 
subtraction blank.

4. Generation of calibration curves based on standards and zero 
standards.

5. Based on the pre-calculated information the element quantification 
takes place.

Post-Quantification Calculations

Post-quantification calculations are defined as calculations applied after 
finishing the element quantification for the current LabBook. The 
calculation is based on the concentration of the samples, but not on the 
measured intensities. 

Special Blank

The Sample List allows specifying a special blank for each available 
sample. The sample line defining the use of a special blank will be 
post-quantification corrected by the subtraction of the average value of 
the blank concentration (corrected by TDF) from its corresponding 

Tip If a zero standard is used, all blank corrections will be performed 
by subtracting intensity values.

cUPDATE CALIB
iEmission line
UPDATE CALIB

iEmission line
STD------------------------------------=
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unknown concentration (corrected by TDF). In case of 
UNKNOWN/QC samples the subtraction takes place using the run 
values.

If a LabBook looks similar to this example (see Figure 13-2), the 
concentration of a sample corrected by a special blank is calculated as 
follows:

Let, for example, the concentration of Sample 1 be 5 ppb and the 
concentration of Sample 2 be 15 ppb. As Sample 1 is used as special 
blank for Sample 2 the concentration of Sample 2 is 10 ppb (15-5 ppb).

To understand how a Special Blank correction is calculated by Qtegra 
and how recursion can occur, read the following examples carefully.

Example 1

Imagine a LabBook with four samples. None of these samples is Special 
Blank corrected, see Figure 13-3.

The measured concentration of Sample 1 is 114,290 μg/L, of Sample 2 
73,273 μg/L, of Sample 3 (Special Blank) 5 μg/L, and Sample 4 
47,648 μg/L are not corrected.

Tip The calculation is performed in sequential order. Recursion is not 
allowed. Each sample line is calculated only once.

cspBLK csample TDFsample×( ) cBLK TDFBLK×( )–=

Figure 13-2. Example of LabBook with Special Blank correction

Figure 13-3. Sample List and Concentrations view of LabBook without Special Blank correction
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Standards
Example 2

Imagine a LabBook with four samples. Samples 1, 2, and 4 are Special 
Blank corrected by Sample 3 (concentration of 5 μg/L). In this case, 
the measured concentration of your samples is decreased by the Special 
Blank concentration, for example, the measured concentration of 
Sample 1 is 114,290 μg/L but is shown as 114,285 μg/L (corrected by 
114,290 - 5 = 114,285 μg/L), see Figure 13-4.

The measured concentration of Sample 2 of 73,273 μg/L is shown as 
73,268 μg/L (corrected by 73,273 - 5 = 73,268 μg/L).

Sample 3 is the Special Blank itself and will therefore not be corrected. 
The measured concentration of 5 μg/L is shown as 5 μg/L.

Finally, the measured concentration of Sample 4 of 47,648 μg/L is 
shown as 47,643 μg/L (corrected by 47,648 - 5 = 47,643 μg/L).

Figure 13-4. Sample List and Concentrations view of LabBook with Special Blank correction
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Standards
Example 3 - Pitfall

Imagine a LabBook with four samples. All samples including the Special 
Blank (Sample 3) are Special Blank corrected. In this case, the 
measured concentration of all your analytes is shown as corrected values, 
see Figure 13-5.

The measured concentration of Sample 1 of 114,290 μg/L is shown as 
114,285 μg/L (corrected by 114,290 - 5 = 114,285 μg/L).

The measured concentration of Sample 2 of 73,273 μg/L is shown as 
73,268 μg/L (corrected by 73,273 - 5 = 73,268 μg/L).

Finally, the measured concentration of Sample 4 of 47,648 μg/L is 
shown as 47,648 μg/L (corrected by 47,648 - 0 = 47,648 μg/L).

Example 4 - Moving a Special Blank

In the Sample List, let one sample refer to a Special Blank, i.e., the 
Special Blank column shows an entry with a line indicator. Click the 
gray field in front of the line and drag the line up or down. Release the 
mouse button to drop the sample on the desired position.

Figure 13-5. Sample List and Concentrations view of LabBook with recurred Special Blank correction

Tip Sample 3 is the Special Blank itself and will also be corrected. The 
measured concentration of 5 μg/L is shown as 0 μg/L (5 - 5 = 0 μg/L). 
From now on, the Special Blank has a concentration of 0 μg/L!

Tip If the sample line of the Special Blank is moved, then the Special 
Blank column has to be updated according to the new position of the 
Special Blank. Therefore, open the drop-down list and click to assign 
the correct Special Blank with its new line indicator.
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Alternative Special Blank

By default the blank concentration (corrected by TDF) is subtracted 
from the unknown concentration (corrected by TDF) of the sample.

With Qtegra ISDS version 2.8 SR1, an alternative Special Blank 
(AltSpBLK) calculation has been introduced:

where DF is the Dilution Factor, q the Final Quantity value and a the 
Amount specified in the Sample List (see “Final Quantity, Amount, and 
Dilution” on page 13-10).

To use this alternative Special Blank calculation instead of the Special 
Blank correction, open the Display Settings dialog of your LabBook and 
set the Quantification Setting to True, see Figure 13-6.

Thus, the setting is only valid for the current LabBook.

Blank Corrected Intensity

The blank corrected intensity per run is calculated from the Internal 
Standard corrected intensity (per run) subtracted by its zero 
concentration intensity (intercept, izero) using 

Figure 13-6. Display Settings dialog showing the Quantification Settings

cspBLK csample TDFsample×( ) cBLK TDFBLK×( )–=

cAltSpBLK csample DFsample×( ) cBLK DFBLK×( )–( ) q
a
--×=

iBLKcorr icorr izero–=
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Standards
The blank corrected intensity average  is calculated from the IS 
corrected intensity average  subtracted by its zero concentration 
intensity (intercept, izero) using 

Relative Atom Percent (RelAt%) and Relative Weight Percent (RelWt%)

Relative atom percent (RelAt%) and relative weight percent (RelWt%) 
are calculated for analytes on the following conditions:

• A multi-calculation trace with “Sum” operator is defined.

• The analyte matches the selection defined for the multi-calculation 
trace.

• A concentration is available for the analyte.

The relative atom percent (RelAt%) is calculated using

The relative weight percent (RelWt%) is calculated using

with the description shown in Table 13-3.

iBLKcorr
icorr

iBLKcorr icorr izero–=

Table 13-3. Description for RelAt% and RelWt% parameters

Parameter Description

RelAt%Analyte Relative atom percent of analyte of interest.

RelWt%Analyte Relative weight percent of analyte of interest.

ConcentrationAnalyte Concentration of analyte of interest.

MassAnalyte Mass of analyte of interest.

RelAt%Analyte

ConcentrationAnalyte
MassAnalyte

----------------------------------------------------

ConcentrationNthAnalyte
MassNthAnalyte

------------------------------------------------------------
NthAnalyte 1=

n



------------------------------------------------------------------------------------------- 100⋅=

RelWt%Analyte
ConcentrationAnalyte

ConcentrationNthAnalyte
NthAnalyte 1=

n



------------------------------------------------------------------------------------------- 100⋅=
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Standards
Example

If a multi-calculation trace is defined in the quantification view of 
eQuant (as shown in Figure 13-7), the relative atom percent and relative 
weight percent are calculated for all but the Internal Standard analytes.

Tip For isotopical standards, the isotope mass 
is used for calculation. For elemental 
standards, the element mass is used for 
calculation.

n Amount of analytes matching the selection 
and having a valid concentration.

Figure 13-7. Multi-calculation trace sum to ignore IS

Table 13-3. Description for RelAt% and RelWt% parameters, continued

Parameter Description
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Standard Addition within eQuant
Standard Addition within eQuant
With Standard Addition mode, two sample types – ZERO STD 
defining the sample without a spiked concentration and STD for spiked 
samples to set up measurement – can be used. A valid zero standard 
block in the Sample List consists of one ZERO STD measured at the 
beginning of a sequence of standards. For each ZERO STD and STD 
block, a 1st order calibration curve is produced for every analyte defined 
as standard. The curve is constructed from the mean results of given 
runs using the given concentrations.

The first-order calibration curve is calculated using a linear least squares 
fit. The available options are listed in Table 13-4:

Table 13-4. Options for calibration curve calculation

Option Description

Forcing No Value will not be manipulated.

Zero The calibration curve will be forced 
through standard defined as zero spike.
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Standard Addition within eQuant
Based on the calibration curve, the original concentration c of the 
analyte in the standard samples is calculated using

where x is the measured intensity. Having

the measured concentration of the zero standard is calculated as

Weighting None Value will not be weighted.

Absolute SD Weight

Each point is weighted by the standard 
deviation  of the analyte over the 
runs in the sample.

Relative SD Weight

 

Each point is weighted by the standard 
deviation  of the analyte over the 
runs in the sample relative to the mean 

.

1/Concentration Weight

Each point is weighted by the 
concentration ck of the analyte. Blanks 
are ignored as their concentration is 0.

1/Concentration2 Weight

Each point is weighted by the squared 
concentration of the analyte. 
Blanks are ignored as their 
concentration is 0.

Table 13-4. Options for calibration curve calculation, continued

Option Description

ωk 1 SDk
2⁄=

SDk

ωk 1 SDk ik⁄( )
2

⁄=

SDk

ik

ωk 1 ck⁄=

ωk 1 ck
2⁄=

ck
2

c f 1– x( )=

f x( ) a1x a0+=

cZERO STD
a0
a1
-----=
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Standard Addition within eQuant
Final Quantity, Amount, and Dilution

If Final Quantity q, Amount a, and Dilution d are specified in the 
Sample List, the concentration value is corrected by:

 

Unspecified values are set be 1.

If Standard Addition in eQuant is used, the derived function f(x) can 
also be utilized for the calculation of concentrations in subsequent 
UNKNOWN samples. The concentration of the reference standards 
used to calculate

is hereby calculated by:

Units to be displayed

The units used to display the calculation results for an analyte depend 
on the first appearance of that given analyte in a standard. Unit 
selections are set for the complete experiment.

cZERO STDcorr cZERO STD d q
a
--⋅ ⋅=

f 1– x( )

cSTDcorr cSTD cZERO STD+=

Tip Weighting for the calibration curve is only available if all standard 
measurements in the current block of the Sample List consist of at 
least two runs. In all other cases, the option is disabled. Any leading 
standard samples before the first unspiked sample will be ignored.
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14
Settings

This chapter of the iCAP 7000 Plus Series ICP-OES Software Manual 
describes the setting of peripherals that is done prior to the creation of a 
Template and LabBook.

Contents

• Peripherals on page 14-2

• Automatic Dilution Processes on page 14-16

• CETAC SDX High Performance Liquid Dilution System on page 
14-35

• Manual Sample Control on page 14-47

• Designing the LabBook Table on page 14-48

• Color Scheme of the Periodic Table on page 14-62

• The Qtegra Backup Tool on page 14-64
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Peripherals
The settings for peripherals such as LC pumps or LC autosamplers can 
be adjusted in the corresponding view of the Template in Qtegra.

Teledyne CETAC ASX-520 / ASX-560 / ASX-1400 Autosampler

The Teledyne CETAC™ Technologies ASX-520 autosampler offers 4 
racks and an autotune function. The schematic view and settings 
described in the following are similar to the Teledyne CETAC 
Technologies ASX-560, and the Teledyne CETAC Technologies 
ASX-1400 are therefore valid for these peripherals.

❖ To adjust the Teledyne CETAC autosampler settings

1. Open a Template with a Configuration including the Teledyne 
CETAC ASX-520, Teledyne CETAC ASX-560, or Teledyne 
CETAC ASX-1400 autosampler.

2. Click  to open the autosampler view, see Figure 14-1.

Tip Peripherals are added to the Configuration in the Configurator 
tool of Qtegra ISDS Software by your Administrator or Thermo 
Fisher Scientific field service engineer (see “Experiment Configurator” 
on page 3-15).

Figure 14-1. Teledyne CETAC ASX-520 settings
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3. Select the Rack settings from the drop-down menus. On most 
CETAC autosamplers you can choose between 21-, 24-, 40-, 60-, 
and 90-Vials layout.
The Schematic View shows the selected rack configuration.

4. Under Time settings, type the Wash Time [s] and the Uptake 
Time [s].

5. Under Autotune Settings, select the Autotune Rack from the 
drop-down menu and type the Autotune Vial number.

6. Under Rinse Settings, select the Rinse Rack from the drop-down 
menu and type the Rinse Vial if the setting is not Rinse Station.

Teledyne CETAC ASX-260 / ASX-280 Autosampler

The Teledyne CETAC Technologies ASX-260 autosampler offers 2 
racks and an autotune function. The schematic view and settings 
described in the following are similar to the Teledyne CETAC 
Technologies ASX-280 and are therefore valid for these peripherals.

❖ To adjust the Teledyne CETAC autosampler settings

1. Open a Template with a Configuration including the Teledyne 
CETAC ASX-260 or ASX-280 autosampler.
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2. Click  to open the autosampler view, see Figure 14-2.

3. Select the Rack settings from the drop-down menus. You can 
choose between 21-, 24-, 40-, 60- and 90-Vials layout.
The Schematic View shows the selected rack configuration.

4. Under Time settings, type the Wash Time [s] and the Uptake 
Time [s].

5. Under Autotune Settings, select the Autotune Rack from the 
drop-down menu and type the Autotune Vial number.

6. Under Rinse Settings, select the Rinse Rack from the drop-down 
menu and type the Rinse Vial if the setting is not Rinse Station.

Teledyne CETAC ASX-100 / ASX-112FR Autosampler

The Teledyne CETAC Technologies ASX-100 autosampler offers 1 rack 
and an autotune function. The schematic view and settings described in 
the following are similar to the Teledyne CETAC Technologies 
ASX-112FR and are therefore valid for these peripherals.

❖ To adjust the Teledyne CETAC autosampler settings

1. Open a Template with a Configuration including the Teledyne 
CETAC ASX-100, or ASX-112FR autosampler.

Figure 14-2. Teledyne CETAC ASX-280 settings
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2. Click  to open the autosampler view, see 
Figure 14-3.

3. Select the Rack settings from the drop-down menu. You can choose 
between 24-, 48- and 96-Vials layout.
The Schematic View shows the selected rack configuration.

4. Under Time settings, type the Wash Time [s] and the Uptake 
Time [s].

5. Under Autotune Settings, select the Autotune Rack from the 
drop-down menu and type the Autotune Vial number.

6. Under Rinse Settings, select the Rinse Rack from the drop-down 
menu and type the Rinse Vial if the setting is not Rinse Station.

Teledyne CETAC XLR-8 / XLR-860 Autosampler

The Teledyne CETAC Technologies XLR-8 autosampler offers 8 racks 
and an autotune function. The schematic view and settings described in 
the following are similar to the Teledyne CETAC Technologies 
XLR-860 and are therefore valid for these peripherals.

Figure 14-3. Teledyne CETAC ASX-112FR settings
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❖ To adjust the Teledyne CETAC autosampler settings

1. Open a Template with a Configuration including the Teledyne 
CETAC XLR-8 or XLR-860 autosampler.

2. Click  to open the autosampler view, see Figure 14-4.

3. Select the Rack settings from the drop-down menus. You can 
choose between 21-, 24-, 40-, 60- and 90-Vials layout.
The Schematic View shows the selected rack configuration.

4. Under Time settings, type the Wash Time [s] and the Uptake 
Time [s].

5. Under Autotune Settings, select the Autotune Rack from the 
drop-down menu and type the Autotune Vial number.

6. Under Rinse Settings, select the Rinse Rack from the drop-down 
menu and type the Rinse Vial if the setting is not Rinse Station.

Figure 14-4. Teledyne CETAC XLR-8 settings
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ESI SC-2DX / SC-4Q / SC-8DX Autosampler

Several ESI autosamplers can be connected to your iCAP 7000 
Plus Series ICP-OES. The ESI autosamplers including an autodilutor 
(ESI SC-2DX, ESI SC-4Q, ESI SC-8DX) are configured by the same 
interface of Qtegra and will therefore be described together.

❖ To adjust the ESI autosampler settings

1. Open a Template with a Configuration including the ESI 
autosampler.

2. In the Content pane, double-click the desired ESI autosampler to 
expand the entry and to display Method Settings, FAST Methods 
and Intelligent Dilution.

3. Click  to open the autosampler view, see 
Figure 14-5.

4. Select Settings > Racks.

Tip The settings for Uptake and Wash in the Monitor Analytes view 
of Qtegra will overwrite these settings for the autosampler.

Figure 14-5. ESI SC-4Q settings

Tip The right-hand tile shows a racks layout of your specific ESI 
autosampler and may vary from the screenshots in this manual.
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The ESI SC-4Q autosampler offers 5 racks and a rinse station, see 
Figure 14-5.
The ESI SC-2DX autosampler offers 3 racks and a rinse station, see 
Figure 14-6.

The ESI SC-8DX autosampler offers 12 racks and a rinse station, 
see Figure 14-7.

Figure 14-6. ESI SC-2DX settings

Figure 14-7. ESI SC-8DX settings
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5. Select the settings for Layout for Tray, Region, Type and Probe 
Depth for Rack, and Rack and Vial for Autotune.

6. Select Settings > Analysis, see Figure 14-8.

7. Under Sample, type the Uptake Time [s]. The Wash Time [s] is set 
to 10 seconds.

8. Under Rinse 1, type Wash Time [s], select Max Pump On [s] or 
Max Pump Off [s], and type Additional Flush [s].

9. Under Rinse 2, type Wash Time [s], select Max Pump On [s] or 
Max Pump Off [s], and type Additional Flush [s].

10. Select Settings > Post-Analysis and then select the action after 
analysis completed from the drop-down menu, see Figure 14-9.

a. With Continue Washing, set the Rinse 1 and Rinse 2 
parameters as shown in Figure 14-8. When selected, after 
analysis completed the probe moves to the rinse vial and cleans 
for the specified time.

Figure 14-8. ESI autosampler Analysis Settings

Figure 14-9. Post Analysis drop-down menu
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b. With Move Home, type a Home Shutdown Time value. When 
selected, after analysis completed the probe moves to the home 
position and stops the peristaltic pump.

c. With Next LabBook, no additional setting is required. When 
selected, after analysis completed the next LabBook is started 
from the Scheduler.

11. Click  to open the Internal Standard and 
Calibration setting page, see Figure 14-10.

12. Set the parameters for Internal Standard (see “Calibration Curve 
created by Autodilution” on page 14-21) and Calibration as 
described in detail, see “Intelligent Dilution Settings” on 
page 14-16.

Tip For , see “Autodilution Using the ESI 
prepFAST II Method” on page 14-24.
See “Using ESI Autosamplers without FAST Method” on 
page 14-13 for a Configuration without FAST Methods.

Figure 14-10. ESI Intelligent Dilution settings
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ESI SC-4DX / SC-14DX Autosampler

The ESI SC-14DX autosampler offers 15 racks and a rinse station. The 
ESI autosamplers ESI SC-4DX and ESI SC-14DX are configured by 
the same interface of Qtegra and will therefore be described together.

❖ To adjust the ESI autosampler settings

1. Open a Template with a Configuration including your ESI 
autosampler.

2. Select  to show the autosampler rack layout, see 
Figure 14-11.

Tip The settings for Uptake and Wash in the Monitor Analytes view 
of Qtegra will overwrite these settings for the autosampler.

Figure 14-11. ESI SC-14DX settings
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3. Select Settings > Racks, see Figure 14-12 for the ESI SC-4DX 
autosampler.

4. Select the settings for Layout for Tray, Region, Type and Probe 
Depth for Rack, and Rack and Vial for Autotune.

5. Select Settings > Analysis, see Figure 14-13.

Figure 14-12. ESI SC-4DX settings

Figure 14-13. ESI autosampler Analysis Settings
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6. Under Sample, type the Uptake Time [s]. The Wash Time [s] is set 
to 10 seconds.

7. Under Rinse 1, type Wash Time [s], select Max Pump On [s] or 
Max Pump Off [s], and type Additional Flush [s].

8. Under Rinse 2, type Wash Time [s], select Max Pump On [s] or 
Max Pump Off [s], and type Additional Flush [s].

9. Select Settings > Post-Analysis, and select the action after analysis 
completed from the drop-down menu, see Figure 14-14.

a. With Continue Washing, set the Rinse 1 and Rinse 2 
parameters as shown in Figure 14-13. When selected, after 
analysis completed the probe moves to the rinse vial and cleans 
for the defined time.

b. When Move Home selected, after analysis completed the probe 
moves to the home position.
If a Home Shutdown Time is defined, the probe moves to the 
home position for the set time before the next LabBook from 
the Scheduler is started.

c. With Next LabBook, no additional setting is required. When 
selected, after analysis completed the next LabBook is started 
from the Scheduler without moving the probe to the home 
position or continuing washing.

10. For , see “Autodilution Using the ESI 
prepFAST II Method” on page 14-24.
See “Using ESI Autosamplers without FAST Method” on 
page 14-13 for a Configuration without FAST Methods.

Using ESI Autosamplers without FAST Method

This section describes how to set up an ESI autosampler without using 
the FAST valve. 

Figure 14-14. Analysis Completed drop-down menu
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❖ To configure the autosampler without using the FAST valve

1. In the Configurator tool, create the Configuration based on your 
instrument and peripheral as usual, see “To create a new 
Configuration” on page 3-16.

No further Configuration settings are necessary as the defaults can 
be used.

If desired check the correct settings as follows.

a. In the Experiment Configurator applet, right-click the ESI 
peripheral (for example, ESI SC-4DX) and select Edit settings 
from the shortcut menu, see Figure 3-11.
The Settings dialog opens, see Figure 14-15.

b. Below the racks layout, select the FAST Setup tab.

c. Leave the Max FAST Pump time, Enable prepFAST Dilution 
and FAST System drop-down unchanged.

2. Load the Configuration in the Qtegra ISDS Software.

Figure 14-15. Autosampler tab of ESI autosampler

Figure 14-16. FAST Setup tab of ESI autosampler
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3. On the Dashboard, select the ESI autosampler from the peripheral 
selector. Define settings for racks, rinse and motors.

4. Select the FAST Method tab, see Figure 14-17.

5. Make sure that no FAST Method is selected from the dialog options 
on this page.

6. You can now create and schedule your LabBook as usual. The 
autosampler is used with your definition of racks, rinse and motors. 
No FAST method is used.

7. To ensure the FAST Methods settings in your LabBook, expand the 
ESI autosampler in the Content pane and select FAST Methods, see 
Figure 14-18.

8. Make sure that no FAST Method is selected from the dialog options 
on this page.

Figure 14-17. FAST Method tab of ESI autosampler on Dashboard

Figure 14-18. FAST Methods of LabBook
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Automatic Dilution Processes

Intelligent Dilution

Intelligent Dilution is an automated iterative process that dilutes 
samples, which have shown analyte concentrations to be outside the 
calibration range. It also dilutes samples when one or more of the 
Internal Standards show an unacceptable recovery due to matrix effects.

Experimental Setup

The setup is shown in Figure 14-19.

Intelligent Dilution Settings

When using the prepFAST II with the iCAP 7400 ICP-OES, it is 
possible to automatically dilute samples, which have concentrations that 
are higher than the calibration range. It also provides the option to 

Labeled Components: 1=7-port valve (valve 2), 2=PFA nebulizer, 3=6-port valve (valve 1), 4=S400V 4 syringe pump 
dilution module, 5=Supporting cart

Figure 14-19. The complete prepFAST II autodilution system
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dilute samples, which show matrix effects for the Internal Standard. 
This is often the case for environmental or industrial samples. The 
settings, which define the autodilution parameters, are available in the 
LabBook on the dedicated Intelligent Dilution view, see Figure 14-20.

To get a short help, just point to the desired item of this page. A tooltip 
shows the definition.

For the Internal Standard an Upper and a Lower Limit can be defined, 
between which the recovery of the Internal Standard has to lie. If the 
recovery rate of any Internal Standard within the LabBook does not 
meet this criterion, the sample will be diluted according to the set 
Autodilution Factor, e.g. 10. If the recovery of at least one Internal 
Standard is still not within the defined limits, the prepFAST II system 
will try to dilute it further, e.g. by a factor of 20, until the Maximum 
Number of Autodilutions has been reached. In this case, the action 
defined by the Action on Failure drop-down menu will be performed.

For the Calibration Range a Limit can be set. If at least one of the 
investigated analytes shows a concentration above this limit, the sample 
will be autodiluted. This value is the percentage of the highest 
calibration standard (STD sample) for any measured analyte. If for 
example, the highest calibration point is 1 ppm and the limit was set to 
120%, each sample with an analyte concentration above 1.2 ppm will 
be autodiluted to the Target value. If more than one analyte is out of the 
calibration range, the highest dilution factor will be applied 
automatically. This value is again a percentage of the highest calibration 

Figure 14-20. Enabling the Autodilution for Internal Standard and 
Calibration Range
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point. With the aforementioned example this would mean that the 
1.2 ppm sample is diluted by a factor of 2 to achieve a concentration of 
0.6 ppm (60% of the highest calibration point).

❖ To edit the Internal Standard parameters

1. Check Enable to activate the Internal Standard (IS) section. For 
details on IS, see “Calibration Curve created by Autodilution” on 
page 14-21.

2. Type an Upper Limit to set the maximum value with regard to the 
Internal Standard recovery compared to the BLK Internal Standards 
signal. Usually, the upper limit is set 25% above the maximum value 
of the Internal Standard recovery, i.e., type a value like 125%. Values 
exceeding this limit will then be highlighted in red font in the 
Concentrations table.

3. Type a Lower Limit to set the minimum value with regard to the 
Internal Standard recovery. Usually, the lower limit is set 25% below 
the maximum value of the Internal Standard recovery, i.e., type a 
value like 75%. Values below this limit will then be highlighted in 
red font in the Concentrations table.

4. Type an Autodilution Factor to dilute your sample solution. With 
regard to the number of autodilution cycles (see step 5) make sure to 
type a useful factor. To decrease the concentration slightly, type a 
small value, for example, 2 or 3. 3 means 2 parts of diluent and 1 
part of your sample.

5. Type the Max. Number of Autodilutions to define the maximum 
number of dilution cycles. A typical number of cycles is 3.
The autodilution cycle ends automatically when the IS is in range.

6. From the Action on Failure list box, select a procedure that follows 
the dilution process. 
Select Wash and Continue to run your experiment as if there is no 
failure.
-or-
Select Abort LabBook to stop the analysis of the current LabBook 
and run the next LabBook of your Scheduler.
-or-
Select Abort Scheduler to stop your experiment.

❖ To edit the Calibration parameters

1. Check Enable to activate the Calibration section.

2. Type a Limit that defines how much the concentration of the 
unknown sample can exceed the range. Typically, the limit is set to 
100%.
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3. Type a Target that is used by the autodilutor when your unknown 
sample exceeds the limit setting. Typically, the target is set to 60% of 
the maximum concentration.

4. From the list box Action on Failure, select a procedure that follows 
the calibration process.
Select Wash and Continue to run your experiment as if there is no 
failure.
-or-
Select Abort LabBook to stop the analysis of the current LabBook 
and run the next LabBook of your Scheduler.
-or-
Select Abort Scheduler to stop your experiment.

When the Internal Standard signal recovery is out of range (exceeds 
upper or lower limit), check these values in the Evaluation Results > 
Concentrations view. For example, on this LabBook, sample containing 
0.25 ppm Pb in 3% NaCl in line 9 on the Sample List (1 in 
Figure 14-21), the Internal Standard recovery for Y 224.306 shows 
75.2% (2 in Figure 14-21) and for Y 324.228 it shows 76.4%. These 
values are out of range and the status is indicated with red and orange 
font in the Results view.

Qtegra adds the new sample automatically (line 10) and runs the sample 
with the Autodilution Factor. The new sample is prepared with 3 fold 
dilution and the Internal Standard recovery achieved inside the range 
with Y 224.306 = 83.6% and Y 324.228 = 81.3% (3 in Figure 14-21).

If the autodilution fails, that means if the Internal Standard recovery 
remains out of range, then the autodilution process will dilute the IS as 
often as specified in the Max. Number of Autodilutions or until the IS 
concentration remains inside the calibration limits.

From the Action on Failure listbox, for this LabBook, Wash and 
Continue is selected.

Labeled Components: 1=line number, 2=out of range values, 3=inside range values after autodilution

Figure 14-21. Example of LabBook missing the limits of Internal Standard recovery

2 31
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For example on this LabBook, line 12 (1 in Figure 14-21) shows 1 ppm 
Cd out of range of the Limit setting due to the maximum calibration 
concentration of 0.5 ppm.

The calibration curve is shown in Figure 14-22.

The autodilutor therefore automatically starts the dilution process. In 
the Evaluation Results view, double-click the entry of line 12 to display 
the Details and Comment pane.

Figure 14-22. Calibration curve of line 12 of LabBook
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In the example LabBook, the Target is set to 60%. The autodilution 
process adds the sample 1.0 ppm Cd to line 13 and runs with the Total 
Dilution Factor 3.814 (see Figure 14-27), calculated via f(x) = b × x + a, 
see Figure 14-23.

The concentration of about 0.26 ppm is therefore reaching the target 
range (60% of 0.5 ppm).

Autodilution

Autodilution is an automated process used to dilute one sample solution 
into a desired number of analytes with a specific concentration.

Experimental Setup

The setup is shown in Figure 14-19 and is therefore not different from 
the experimental setup used for intelligent dilution.

Calibration Curve created by Autodilution

An autodilutor creates a multi point standard calibration curve from one 
standard mix stock solution (which can contain multiple analytes) by 
the autodilution process. The following screenshots are taken from a 
demonstration LabBook.

Figure 14-23. Calibration curve and details view of line 13 of LabBook
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❖ To create a calibration curve

1. For example, Y is selected as the Internal Standard analyte (IS) and 
Cd is selected as the quantification analyte, see Figure 14-24 and 
Figure 14-25.

2. Set the blank solution (BLK) into rack 3, vial 1 and the standard 
stock solution (STD) METS into rack 3, vial 2, see blue rectangle in 
Figure 14-26. Make sure all solutions contain an IS. 

Figure 14-24. Selection of analytes from the periodic table of elements

Figure 14-25. Presentation of quantification analytes in the LabBook
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3. To create the Sample List for the multi-point standard calibration 
curve, in the Sample List, select the BLK as first sample, the STD as 
second and third samples, see Figure 14-26.

4. Type the prepFAST DF (Dilution Factor) for the STD entries. The 
autodilutor needs to dilute the 4- and 2-fold dilution to create the 
calibration curve for the standard mix solution, see the resulting 
Total Dilution Factor (red rectangle) in Figure 14-26.

5. The STD entries are prepared by autodilution from the same 
solution. Therefore, the rack and vial positions are the same for all 
standards, see blue rectangle in Figure 14-26.

6. Save this LabBook.

7. Schedule your LabBook.

8. The finished LabBook (see Figure 14-27) shows the calibration 
curve, see Figure 14-28.

Labeled Components: blue rectangle=selection of rack and vial, red rectangle=Total Dilution Factor for STD

Figure 14-26. Sort order of BLK and STD

Figure 14-27. Sample List of finished LabBook
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9. Double-click the STD entry to see the details of the calibration 
curve, see Figure 14-28.

Autodilution Using the ESI prepFAST II Method

The ESI prepFAST II Method is available as part of the ESI SC-2DX, 
ESI SC-4DX, ESI SC-8DX and ESI SC-14DX autosamplers. Several 
models are offered with different valves and vacuum pumps.

❖ To create an ESI prepFAST II Configuration

1. From the Configurator, select Experiment Configurator.

2. Click New to create a new Configuration. Type a name and drag the 
instruments from the list of Available Items to the new 
Configuration on the left of the window to assign the instruments to 
the new Configuration. The new configuration should include the 
Thermo Scientific iCAP 7000 Plus Series ICP-OES as well as the 
ESI autosampler equipped with the prepFAST system, e.g., the ESI 
SC-2DX.

Figure 14-28. Calibration curve based on STD with 2 points of Total Dilution Factors (TDF)

TDF = 2

TDF = 4

Tip This section describes actions to be performed in the 
Configurator tool, see “Configurator” on page 3-1.
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3. In the list of Configurations, right-click the Instrument you wish to 
edit the settings for, see Figure 14-29.

4. Click  to open the Settings 
window.

5. On the lower part, select the FAST Setup tab, see Figure 14-30.

6. Select the Enable prepFAST Dilution check box.

7. From the FAST System list box, select prepFAST II.

8. Click OK to close the Settings window.

Figure 14-29. Shortcut menu to edit settings

Figure 14-30. Settings window for FAST Setup
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9. Save the Configuration.

❖ To create a prepFAST method

1. With a FAST System based Configuration loaded, on the 
Dashboard, select the ESI autosampler.

Tip All other instrument settings of the Thermo Scientific 
iCAP 7000 Plus Series ICP-OES and the ESI autosampler 
provided inside the Experiment Configurator can be adjusted 
according to the demands of your analysis. However, Thermo 
Fisher Scientific recommends disabling the FAST Uptake and 
Wash option available for the iCAP 7000 Plus Series ICP-OES 
when using any FAST based sampling accessory. Additionally, the 
options Optimization and Optimization Uptake Delay should 
be disabled for the ESI autosampler in combination with the 
prepFAST.

Figure 14-31. Initial Dashboard view of ESI autosampler



Settings
Automatic Dilution Processes

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 14-27

2. From the lower tabs, select FAST Method to display the initial view, 
see Figure 14-32.

3. Click Create New to create a new blank method.

-or-

Create a new FAST method from a supplied template by selecting 
one from the New user method from a prepFAST II template 
drop-down list. 

To keep the original method always unchanged, any modifications 
to this template are automatically saved to a user method when the 
Save button is clicked.

Figure 14-32. Initial view of ESI FAST method selection screen
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The modified template can then be selected from the Open a user 
method drop-down list (which initially is empty).

4. The FAST method tab initially shows the name New Method with 
an empty grid, see Figure 14-33. Each line of the grid can contain 
one action in the FAST method. All actions are carried out in order 
from top to bottom of the grid.

5. To build your FAST method, drag an Event from the list of Events 
and drop it to the first cell. Usually, Method Start is used as first 
sample line, that means,

a. Select On Method.

b. Drag this item to the first cell. This On Method event 
automatically changes to On SubMethods: Completed, see 
Figure 14-34.

c. In the pop-up dialog, specify the details, that means, select On 
this Method Started from the list box.

Figure 14-33. Blank ESI FAST template (left), once saved (right)

Figure 14-34. First ESI FAST Event
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d. Click anywhere into your grid to close the pop-up dialog.
Method Start is inserted as your first event.

6. Assign Actions steps in the same way, that means, drag the desired 
action from the list of Actions and drop it into the current line of 
your template.

7. Specify the details for the action by editing the pop-up dialog. The 
following screenshots show an example on how you can select 
several features from the pop-up dialog to specify the action, see 
Figure 14-35. Note that sub-menu items become visible when you 
click the triangle.

The example shown in Figure 14-35 creates S400V-V1 Dispense 
from the selected FAST Valve 1 Load Action.

8. Entries can be overwritten by selecting a new Event or Action item 
that is dropped into a currently used step.

9. Each step of your template is represented by its own line. By default, 
the lowest line is empty and may be filled with a new Event or 
Action. You can insert blank lines by use of the shortcut menu that 
is displayed when you right-click the left-most cell. Select Insert 
Row from the shortcut menu to insert a line below the selected line.

10. To remove a line, right-click the left-most cell of this line to open 
the shortcut menu and select Delete Row.
Note that no confirmation message is shown while you remove the 
line.

As the line completely is removed, you need to insert a new line to 
add an Event or Action on this step. Alternatively, just overwrite the 
current Event or Action as described above.

Figure 14-35. Pop-up Dialog with Detailed Specification of First Action Item

Tip Note that no confirmation message is shown while you 
overwrite the item.
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11. To link an Action and Event together, select a color from the pop-up 
dialog.

12. To change the detailed specification of an Event or Action, 
double-click the item to open the pop-up dialog.

Finally, your FAST method could look like the example in 
Figure 14-36.

13. Save the completed FAST method.

❖ To open ESI prepFAST settings

1. On the Qtegra Dashboard, select the ESI autosampler selector.

Figure 14-36. Final view of your FAST method

Tip It may be easier to use the supplied FAST methods as templates to 
edit to meet your requirements rather than create new FAST method.
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2. Open the FAST Methods view, see Figure 14-37.

3. From the + tab, select one option to open the FAST Method.

a. Select a user method from the drop-down list.
-or-
Click the Browse button to choose a user method.

b. Select an original prepFAST II template from the drop-down 
list.
-or-
Click the Browse button to choose an original template.

4. The method settings open in a new tab and show a list of the Events 
and Actions, see Figure 14-38.

❖ To run an ESI prepFAST experiment

1. Prepare your reagents. In case of ESI SC-2DX

Figure 14-37. Opening a FAST Method from the FAST Methods tab

Figure 14-38. ESI FAST methods, loaded from templates delivered with Qtegra

Tip You can only change the settings via the Qtegra Dashboard.
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a. Prepare the prepFAST Carrier/Diluent solution by filling the 
appropriately labeled bottle with nitric acid at a concentration 
that matches the matrix of your samples. Make the solution 
from acid and ultrapure water, which are suitable for trace 
elemental analysis by ICP-OES.

b. Place the tubing labeled prepFAST Carrier/Diluent in the bottle.

c. Prepare the prepFAST Internal Standard solution by filling the 
appropriately labeled bottle with nitric acid at a concentration 
that matches the matrix of your samples. Make the solution 
from acid and ultrapure water, which are suitable for trace 
elemental analysis by ICP-OES.

d. Place the tubing labeled prepFAST Internal Standard in the 
bottle.

e. Keep in mind that the Internal Standard is also diluted by a 
factor of 6, if the FAST methods are used, which were provided 
with the instrument.

2. On the Qtegra Dashboard, select the Configuration you saved in the 
Configurator tool.

a. Open the autosampler display by clicking the headline, see 
Figure 14-39.

b. From the lower tabs, select FAST Method to open a template of 
FAST Methods.

c. From the Template listbox, select prepFAST 2_Prime.
-or-
Create a new Template. See “To create a prepFAST method” on 
page 14-26 for details.

3. Click the green Play button to prime the syringes.
The peripheral will need to be primed a minimum of 3 times before 
analyses begin.

Figure 14-39. Opening the autosampler view
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4. To run the performance checks, open Qtegra and click the Get 
Ready button.

5. Open and schedule the correct LabBook for the configuration being 
used.

6. Run the LabBook after the instrument has completed the Get Ready 
process.

N/A Indicator in Concentrations List

Intelligent Dilution is automatically performed if measured 
concentrations are outside the defined calibration range. This behavior 
may effect the Internal Standard as well as your sample solution, see 
Figure 14-40.

The example displayed in Figure 14-40 shows a typical sample analysis. 
The concentration of the first analyte (Pb 220.353 nm) is outside the 
calibration range (1 in Figure 14-40) while the concentration of the 
second analyte (Cd 228.802 nm) is within the calibration range (2 in 
Figure 14-40).

As a result of the out of range concentration of Pb, a new sample line is 
added into the Sample List and the sample gets diluted in order to make 
it fit into the range. The analysis will only be evaluated for the analyte 

Labeled Components: 1=analyte 1 outside range, 2=analyte 2 inside range, 3=analyte 1 indicated by “N/A”, 4=added 
new sample line

Figure 14-40. Indicating sample with N/A

1

2

3

4
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that was previously out of range, Pb in this case (4 in Figure 14-40). For 
the other analyte (Cd) no evaluation will be performed and N/A is 
displayed instead (3 in Figure 14-40).
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CETAC SDX High Performance Liquid Dilution System
This chapter describes how to use the Teledyne CETAC SDXHPLD with 
the Qtegra ISDS Software. Once the SDX plug-in is installed and 
enabled, you need to select the appropriate settings in several places:

• ASX-560 autosampler settings in the Configurator tool.

• Sprint Valve settings in the Configurator tool.

• Instrument Controls.

• Method Editor.

The CETAC SDXHPLD adds automated dilution to the capabilities of 
the ASX-560 autosampler. The autosampler draws a volume of sample 
from a sample vial, then injects it into a vortex mixing vessel along with 
a volume of diluent. After vortexing, the diluted sample is sent to the 
ICP-OES or other analytical instrument, and the sample probe and 
vortex vessel are thoroughly rinsed.

The SDXHPLD system is often used along with the Teledyne CETAC 
ASXPRESS PLUS rapid sample introduction system, a 6-port valve system, 
which enables rapid sample loading and probe wash out. The 
ASXPRESS PLUS greatly improves throughput, by moving the sample 
close to nebulizer quickly, and then rinsing the sample line while the 
sample is being analyzed.

Reference Documentation

In addition to this iCAP 7000 Plus Series ICP-OES Software Manual it is 
recommended to read the SDXHPLD Operator’s Manual delivered with 
the CETAC peripheral.

Installing the Plug-in

You will need to have administrative privileges on the computer to 
install the software.

1. Run the ASX-560/Sprint Valve/SDX plug-in installation package, 
accepting all default options. For details on installing the plug-in, 
refer to the Installation Guide.

2. Patch the Microsoft .NET framework software, if necessary.

Tip Do not operate the SDX syringe pump until the software has been 
configured. Software settings depend on the diameter of the probe. 
Incorrect settings will result in motor failure and valve damage.
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Up to version Qtegra 2.8 only the .NET 4.5 libraries are installed. 
There are several bugs in .NET 4.5, which will cause the 
ASX-560/SDX plug-in to be laid out oddly. Please install the 
.NET 4.5.1 patch, which can be acquired free from Microsoft.

3. In the Configurator tool, create a Configuration that includes the 
ASX-560 autosampler. Right-click the ASX-560 autosampler you 
wish to edit the settings for.

4. Click Edit settings to open the Settings dialog, see Figure 14-41.

5. In the Accessories section, select Enable SDX and double-click to 
set the value to True.

The SDX tab is shown, see Figure 14-42.

Figure 14-41. Settings dialog for the ASX-560 autosampler

Figure 14-42. Initial settings for SDX



Settings
CETAC SDX High Performance Liquid Dilution System

Thermo Scientific iCAP 7000 Plus Series ICP-OES Software Manual (P/N BRE0015330, Revision C) 14-37

6. Set the values as described in Table 14-1.

Table 14-1. SDX setting parameters

Section Description

Communications 
Settings

Apart from the SDX settings, make 
sure that the right COM port is set for 
communication. Refer to the Operator’s 
Manual for details on how to detect 
the correct COM Port.

Dilution Settings The dilution range that the SDX is 
capable of is a dilution of 2 up to 5000 
fold. The minimum and maximum 
dilution factors have a large effect on 
the accuracy and speed of your 
analysis. High dilution factors require 
small quantities of the sample, 
therefore any error in the volume will 
be magnified in the dilution. Low 
dilution factors below 10 lead to long 
aspiration times.

For dilution factors over 100, serial 
dilution is used. To provide the greatest 
accuracy throughout the dilution 
range, serial dilution always begins 
with a 50 fold dilution.

Mixing Vessel Settings To reduce carryover between dilutions, 
up to four Vessel Wash Cycles can be 
prescribed. Each wash cycle takes 
about 10 seconds. For most 
quantitative analyses, 2 or 3 wash 
cycles should be sufficient. In general, 
optimal carryover results from using 
3% nitric acid for the vortex rinse 
solution.

The Vortexing Speed should always be 
2500.

Syringe Settings The syringe settings have a big impact 
on the accuracy and speed of the 
method and also on the correct 
functioning of the system.

A pre-sample Air Gap Volume is 
always inserted between the solvent in 
the probe line and the sample being 
aspirated. For most applications a 
50 μL gap is sufficient.
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The Aspiration Speed - Diluent has a 
default setting of 1800 μL/s and can be 
left as is.

The Aspiration Speed - Sample of 
170 μL/s works well for most samples. 
For the 0.5 mm probe, use 50 μL/s.

Note that slower sample aspiration 
speeds are more accurate, but lead to 
increase of the dilution time.

The Dispense Speed depends on the 
diameter of the sample probe, which is 
indicated by different coloring of the 
probe bands. The 0.8 mm probe is 
used with ICP-OES and 600 μL/s 
dispense speed. When the Sprint Valve 
or ASXPRESS PLUS is coupled to the 
SDX and the instrument, the 1 mm 
probe can be used with a dispense 
speed of 1800 μL/s.

If the dispense speed is too fast, the 
syringe pump may stall and the 
commonly acidic solvent may be 
forced out of the syringe valve, 
potentially causing damage and 
generate an error.

The Syringe Delay parameter allows 
liquid and air pressure to equalize 
throughout all of the tubing after a 
syringe movement is complete. This 
pressure equalization improves the 
quantitative sample transfer accuracy. 
The optimum value depends on 
solvent viscosity and sample tubing 
diameter. If it is suspected there may be 
oscillations, increase the delay for 
maximum accuracy and repeatability.

Table 14-1. SDX setting parameters, continued

Section Description
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7. Select the Autosampler tab for the final settings.

8. Set the values as described in Table 14-2. All other values may 
remain in the default status.

Configuration with Sprint Valve or ASXPRESS PLUS

In case the Sprint Valve or ASXPRESS PLUS is used together with the 
instrument and the SDXHPLD system the following parameters should 
be set.

1. In the Configurator tool, create a Configuration that includes the 
ASX-560 autosampler. Right-click the ASX-560 autosampler you 
wish to edit the settings for.

Figure 14-43. Tray settings for Autosampler

Table 14-2. Autosampler settings

Section Description

CETAC Autosampler 
Settings

Select the correct Com Port for the 
autosampler. Refer to the Operator’s 
Manual for details on how to detect 
the correct Com Port that is different 
from port number of the SDX.

As the SDXHPLD system comes with a 
specialized standards rack, there are 
two new options available under Tray: 
the SDX Conical-bottom Standard Vials 
and SDX Flat-bottom Standard Vials. 
Make the selection dependent on the 
type of vials used for your standards 
rack.
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2. Click Edit settings to open the Settings dialog, see Figure 14-44.

3. In the Accessories section, select Enable Sprint Valve and 
double-click to set the value to True.

The Sprint Valve tab is shown, see Figure 14-45.

Refer to the ASXPRESS PLUS Operator’s Manual for details on the 
Sprint Valve parameters.

Preparing the LabBook

In this section, examples are shown for demonstration purposes. For 
your measurements other values than shown here may be used. On the 
Qtegra ISDS Dashboard, load the SDX Configuration.

Figure 14-44. Settings dialog for the ASX-560 autosampler

Figure 14-45. Typical settings for Sprint Valve
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1. Click the ASX-560 tile to show the rack layout, see Figure 14-46.

The standard rack layout matches the layout used by the SDXHPLD 
system.

2. Select the SDX tab to show the manual control parameters for the 
Syringe Pump, Mixing Vessel, and Operations, see Figure 14-47.

Figure 14-46. ASX-560 Rack Layout tab

Figure 14-47. ASX-560 SDX tab
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Most of the controls are for diagnostic purposes. However, some 
controls are relevant before and during routine usage and are 
described in Table 14-3.

.

3. Select the Sprint Valve tab to show the manual control parameters 
for the Function Tests of the valve and the pump, see Figure 14-48.

Prescriptive and Intelligent Dilution

The SDX has two main functions: prescriptive dilution and intelligent 
dilution due to certain parameters being outside specified ranges. In the 
following these functions are explained with an example LabBook.

Table 14-3. Manual control parameters

Section Description

SDX Syringe Pump Before using the SDXHPLD system the 
first time, all lines of the SDX need to 
be filled with diluent. This is done by 
the Prime Syringe function.

SDX Operations Run Dilution allows a test run of the 
dilution process, and can be used to 
verify that all fittings are properly 
tightened.

SDX Mixing Vessel Use the Fill/Drain Vessel function to 
flush the vortex vessel and the SDX 
rinse tubing.

Figure 14-48. ASX-560 Sprint Valve tab

Tip When creating a LabBook with the SDX and the Sprint Valve, 
make sure the autosampler wash time is set to 0 (zero). To do so, 
open the ASX-560 view from the Content pane. Under Time 
settings, set Wash Time to 0.
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1. The SDX example LabBook contains already preselected standards 
and analytes. For a better overview the Sample List only shows the 
following columns: Label, Status, Sample Type, Standard, Rack, 
Vial, Autodilution Factor.

The prescriptive dilution comes from the Autodilution factor 
column. Values between the minimum and maximum dilution 
factor set up in the Configuration can be entered here. The SDX 
will then do an autodilution on the sample in the position specified 
through Rack and Vial.

A calibration is defined though a blank and 4 standards. The 
standards have different autodilution factors (100, 10, 5, 2), but 
have the same stock solution and autosampler positions (Rack, Vial) 
defined.

2. In the SDX Autodilutor view, two sections are shown, the Internal 
Standard and the Calibration Range.

Figure 14-49. Part of the example LabBook with focus on a few columns

Figure 14-50. SDX Autodilutor view
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If the Internal Standard is enabled (see Figure 14-50), a dilution is 
automatically performed when the Internal Standard recovery falls 
outside the prescribed range. The desired Autodilution Factor and 
the Maximum Number of Autodilutions can be entered.

If the Calibration Range is enabled (see Figure 14-51), a dilution is 
performed when the sample concentration exceeds the Limit [%] of 
the concentration of the highest calibration standard. Qtegra will 
use the SDX to dilute the concentration to the level entered in 
Target [%]. The software will use the element, which is furthest 
from the range to calculate the dilution factor. The actual dilution 
performed may be constrained by the dilution limits specified in the 
Configurator settings.

3. Whenever a sample result triggers an Intelligent Dilution, a sample 
will be added to the Sample List. The intelligent addition is 
indicated by a green plus sign next to the status lamp.

❖ Intelligent Dilution triggered by Internal Standard Recovery

1. In the SDX Autodilutor view (see Figure 14-50), the limits are set to 
110% and 90% of the Internal Standard Recovery.

2. The measured sample has an Internal Standard Recovery of 86%.

Figure 14-51. SDX Autodilutor view: Calibration Range

Figure 14-52. Details and Comments panes of Evaluation Results view for Internal Standard recovery
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The Details pane and a Comments pane are shown. The reasons for 
trigger are written, for example, “Internal standard concentration 
out of range”, see Figure 14-52. All affected analytes are listed. In 
the Details pane, the used dilution factor for the diluted sample is 
shown, for example, “Measured with corrected dilution factor of 
10.”

❖ Intelligent Dilution triggered by Calibration Range

1. In the SDX Autodilutor view (see Figure 14-50), the limits are set to 
100% and 60%.

2. The measured sample has a concentration outside these Calibration 
Range limits.

Figure 14-53. Details and Comments panes of Evaluation Results view for Internal Standard recovery with corrected 
dilution factor

Figure 14-54. Details and Comments panes of Evaluation Results view for Calibration Range
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The Details pane and a Comments pane are shown. In the Details 
pane, the calculated dilution factor used to dilute the analyte to its 
target value is shown. A message, for example, “Measured with 
corrected dilution factor of 4.201.” summarizes the details, see 
Figure 14-55.

The Sample List shows the autodilution factors in the Autodilution 
Factor column, see Figure 14-56.

Figure 14-55. Details and Comments panes for a calculated dilution factor

Figure 14-56. Autodilution Factor column of the LabBook
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Manual Sample Control
Manual Sample Control can be added to your Configuration in the 
Configurator to enter samples without autosampler.

In the Manual Sample Control view in Qtegra, Uptake and Wash Time 
can be defined, see Figure 14-57.
??

❖ To define the Uptake and the Wash Time for manual sampling

1. From the Qtegra - [Home Page] navigation pane, open a Template 
as described in “Opening a Template” on page 4-37.
Be sure to open a Template with a Configuration including Manual 
Sample Control.

2. Click  to open the Manual Sample 
Control view of the Template.

3. Select Use Manual Sample Control.

4. Type the values for Uptake Time (s) and Wash Time (s).
While the setting for the Uptake Time mainly depends on the 
length of the probe capillary and the uptake rate, the value of the 
Wash Time should be increased when going for high analyte 
concentrations or tough matrices to avoid carry-over effects.

Tip Configurations are created by your Administrator or Thermo 
Fisher Scientific field service engineer, see “Experiment Configurator” 
on page 3-15.

Figure 14-57. Manual Sample Control view
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Designing the LabBook Table
There are several ways to adapt the table layout according to your needs 
as a User. Dependent from your current selection in the Content tree, 
not all shortcut menu items are available on all LabBook tables.

Resizing the Width of the LabBook Table

The shortcut menu offers a fast way to execute design commands for 
your LabBook table. Select the desired command from the shortcut 
menu that opens when you right-click an item in the first column.

The description is explained in Table 14-4.
Tip The commands effect on the line above, when you insert items. 
You can only modify sample actions, when the current sample line is 
yet not finished (green indicator in Status column).

Table 14-4. Shortcut menu of a LabBook Sample List

Command Description

Insert Rows Inserts a number of blank lines above the current cursor position. A 
dialog opens to type the number of lines you wish to add. Select the 
desired label from the shortcut menu to fill the cells as far as possible.

Delete Selected Rows In some cases you may modify existing LabBooks to adapt them to 
your needs. To delete actions, select the desired line and then select 
this shortcut menu item. Confirm the message dialog.

Fit Cells To Grid The table consists of several columns that use space according to their 
width. Depending on your screen the table extends outside the 
program window. A slider below that table indicates that you will find 
additional columns to the right. 
Select this shortcut menu item, when you need all columns to fit the 
current screen. This command can help to get an overview but most of 
the columns are cut!

Fit Cells To Content In some cases, you may need to enlarge the table with regard to their 
content.
Select this shortcut menu item, when you want to resize all columns to 
display the whole content and column header.

Cut Selected Rows
<Ctrl> + <X>

When you want to move an action to another position of your 
LabBook, then select the desired lines and cut them with this shortcut 
menu item, before you insert or paste the lines.
Lines that are currently cut, are indicated with a light gray frame.
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Fixing Columns in the LabBook Table

When your LabBook table extends the Qtegra program window, a 
bottom slider helps to navigate to hidden columns. To keep the desired 
line you can freeze the left column(s).

❖ To fix a column

1. On the header, click the pin icon to move the selected column to the 
next free position on the left. The pin rotates into an upright 
position to indicate the frozen state. All frozen columns are grouped 
on the left side. See Figure 14-58.

Copy Selected Rows
<Ctrl> + <C>

❖ To duplicate the selected actions

1. Click and drag the left most column to select the desired source 
lines. Your selection is highlighted.

2. Select this shortcut menu item to copy the selected lines.

3. Select the destination lines and paste your selection.

Paste Copied Rows
<Ctrl> + <V>

You can overwrite the current line with the currently copied action. 
Use this shortcut menu item to paste the action into the currently 
selected line. Note that you will never get a warning message, when 
overwriting existing lines.

Insert Copied Rows To finalize a copy procedure, select this shortcut menu item. The 
copied lines are inserted above the currently selected line.

Append Copied Rows In cases you need to add actions at the end of the current LabBook, 
copy existing lines and then select this shortcut menu item to append 
the lines.

Export To Excel For presentation or documentation purposes it may be helpful to run 
further calculations in an Excel spreadsheet. Use this shortcut menu 
item to export the table into an *.xls format. The resulting file includes 
the column header as well as the colored indicators of the Status 
column.

Jump To Evaluation Results To quickly navigate into the details of the evaluation results, select this 
shortcut menu item. The target grid already focuses the desired item.

Suspend Before The Measurement 
Of This Sample

In cases you need to interrupt or pause the measurement process, you 
may add this suspend marker that is displayed next to the current line 
number of the grid.

When the action above this selection is finished, the measurement 
process will stop and is awaiting your interaction. Proceed with 
clicking the Run button of the Scheduler tab.

Table 14-4. Shortcut menu of a LabBook Sample List, continued

Command Description
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2. Click that pin again to remove the desired column from the frozen 
state. When you click a column within the frozen group it is moved 
to the next free position right from this group. The pin rotates back 
to its horizontal position.

When columns of the LabBook table are frozen, you can scroll the grid 
and display hidden columns by simultaneously seeing the frozen 
columns.

Moving Columns in the LabBook Table

When you want your LabBook table to be displayed in another order 
you can move a selected column to the desired position.

❖ To move a column

1. Click the column header you want to move. The column then is 
highlighted to indicate the focus.

2. Click and hold your mouse button and drag the column to the 
desired position. A black line indicates the current insert position.

3. Release your mouse button to insert the column on the selected 
position.

Sample Definition and Sample List

The columns and functionality in the Sample List is dependent on both 
the evaluation method defined in the LabBook/Template and the 
accessory plug-ins defined in the loaded Configuration. All columns 
that may be shown in Sample Definition and Sample List are listed in 
Table 14-5, Table 14-6, Table 14-7, Table 14-8, and Table 14-9. 
Depending on the evaluation method selected for the Template, the 
columns of the components may differ.

Figure 14-58. Two Fixed Columns of a LabBook Sample List

Tip When moving a column into the frozen group, the currently 
selected column also gets frozen.

Table 14-5. General columns of Sample Definition/Sample List

Column Header Description

Index Line number to indicate the sample position in the Sample List. Click 
the index to select the entire sample line. <Ctrl> + click or <Shift> + 
click to select a range of sample lines.

Label User defined identification (name) for the sample line.
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Status Column in Sample List of a LabBook.
Colored lamps indicate the status of this sample line.
• green arrow: Currently running sample line.
• gray: Analysis has not been scheduled yet.
• green: Analysis was executed as defined in the LabBook/Template 

and did not trigger a QC warning or failure.
• yellow: Analysis was executed with measured values in the warning 

range.
• red: Analysis was aborted.

Plus sign: Indicates a sample line automatically added by a QC rule or 
Intelligent Dilution. Helps you to identify samples also when QC is 
not enabled.

Comment Double-click the cell to enter user definable text.

Evaluate (check box) Column in Sample List of a LabBook.
Clear the Evaluate box to hide samples from display. If the Evaluate 
box is cleared, the sample line will be hidden in the Evaluation Results 
as well as in Exports, Queries and Reports. This function is useful 
when a sample has to be remeasured, for example, when the 
concentration exceeds the calibration range and has to be diluted. The 
faulty sample can then be hidden.

Standard To select a standard from the drop-down list if the sample type is a 
standard or a certain type of a quality control sample. See also Method 
Parameters view “Standards” on page 9-25.

Special Blank Column in Sample List of a LabBook. Used in eQuant evaluation.
Value is selected from a drop-down list. Refer to “Special Blank” on 
page 13-11.

Repeats The number of times that a given sample should be analyzed. Typically 
3 repeats are sufficient.

Full Frame Full Frame option as defined in “Measure Modes” on page 9-12.

Table 14-5. General columns of Sample Definition/Sample List, continued

Column Header Description

Table 14-6. Dilution factor columns in Sample Definition/Sample List

Column Header Description

Dilution Factor Dilution of sample independent from the sample type. Used to define 
different calibration concentrations.
The Dilution Factor (DF) of the Sample List view is automatically 
applied to any value displayed in the Concentrations view. For 
example, when you change the DF for an UNKNOWN in the Sample 
List from 1 into 10, the concentration shown for the selected analysis 
automatically changes from 2 ppb to 20 ppb.
DF is one component used in the calculation of the TDF.

Tip When you open a LabBook from older versions the DF 
automatically is recalculated from the ADF and is therefore changed.
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Total Dilution Factor This column is only displayed if your Configuration includes an 
autodilution system.
The Total Dilution Factor (TDF) is the total dilution factor applied to 
an analysis. It is calculated as a product of Dilution Factor (DF) and 
Autodilution Factor (ADF). The value shown here is calculated 
automatically and can not be edited.
TDF = DF × ADF
TDF displays the cumulative dilution factor. It is dynamically updated 
to reflect any changes (automatically or by user input) in the dilution 
factor used. TDF does not take into account any dilution generated 
from Sample Weight and Final Quantity however.

Autodilution Factor This column is only displayed if your Configuration includes an 
autodilution system.
Set the Autodilution Factor (ADF) to let the autodilutor automatically 
dilute your STD to get several points on the calibration curve. For 
example, a STD solution of 50 ppm gets an ADF of 2 to run the 
calibration according a 25 ppm solution. Type an ADF of 5 to run the 
calibration according a 10 ppm solution. In all these cases, the same 
rack and vial with your STD may be selected.
ADF is one component used in the calculation of the TDF.

Amount
only in combination with 
Final Quantity

The Amount and Final Quantity define any additional dilution 
performed during sample preparation. For example, the dilution of 
one solution by another or the digestion/dissolution of a solid into a 
solution.
In a completed LabBook, the Amount and Final Quantity defined in 
the Sample List view are automatically applied to any value displayed 
in the Concentrations view.

If Final Quantity q, Amount a, and Dilution Factor df are specified in 
the Sample List, any concentration value displayed in the 
Concentrations view is corrected by a combination of all factors:

 

Any unspecified values are set to 1.

Table 14-6. Dilution factor columns in Sample Definition/Sample List, continued

Column Header Description

ccorr c 1
df
---- q a⁄⋅ ⋅=
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Table 14-7. Evaluation specific columns of Sample Definition/Sample List

Column Description

Survey Runs The number of survey runs (scans of the mass spectrum) performed. 
The number of runs can be set from 0 to 100. By default, the number 
is set to 0.

The spectral regions to be acquired during a survey run are defined in 
the method parameters view.

Recommended settings: It is recommended to run at least one survey 
run per sample when eQuant was selected as evaluation method.

Tip High concentration matrix components that may be scanned as 
part of the survey run leading to unnecessary exposure of the detector 
to high count rates, shortening its lifetime. Choose the skip mass 
ranges and detector mode used in Survey Scans accordingly.

Main Runs Number of main runs (peak jumping acquisition) performed. The 
number of runs can be set from 1 to 1000000. By default, the number 
is set to 1. 

Recommended settings: It is recommended to run at least three main 
runs per sample.

Tip Sweeps are defined in the Advanced Parameters section of the 
Acquisition Parameters view. See “Acquisition Parameters” on 
page 9-14.

Sample Type Definition of the sample type, e.g., BLK, STD, UNKNOWN, QC. See 
Table 13-1 for sample types supported.

Internal Standard To select a previously defined Internal Standard from drop-down list, 
which should be used to correct the signal of the corresponding 
sample. See also Method Parameters view “Standards” on page 9-25.

If the Internal Standard column in the Sample List is empty, all 
analyses (BLKs, STDs, UNKNOWNs, QCs, etc.) are assumed to have 
the same IS created as 'Internal Standard (Isotopical)' in the LabBook.

Alternatively, Qtegra allows the use of analysis specific Internal 
Standards at different concentrations. This can be useful, for example, 
when the calibration standard used contains one or more of the 
elements used as Internal Standard.
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Individual columns in the Sample List

Qtegra ISDS Software provides an option to add individual columns to 
the Sample List. By default, the Label column is used to type sample 
information. Additional columns may be used to show more sample 
information, which then also is accessible in Query and Reports. The 
following sections describe how to set up Qtegra ISDS.

• In the Configurator, create a Configuration with a Generic 
Instrument.

• With the Windows Explorer, navigate to the new folder and create 
the XML file.

• In Qtegra, load the new or updated Configuration.

• Create a LabBook and check the Sample List for the new columns.

• Under LabBook > Automatic Export, the new columns are available 
for Query.

Table 14-8. QC columns of Sample Definition/Sample List

Column Header Description

QC Action Used in eQuant evaluations. QC test type.
Value is selected from drop-down list. Relates sample to set of rules 
defined for this QC test type. See method parameters view “Quality 
Control” on page 10-5.

QC Restart Used in eQuant evaluations.
Defines restart point in a Sample List for certain QC tests. Value is 
selected from a drop-down list.

QC Reference Used in eQuant evaluations.
If QC test type, for example, DUP or SER (see Table 10-5) is selected 
in a Template, a <unique ID> can be entered and used to connect the 
linked analyses.

Table 14-9. Autosampler columns of Sample Definition/Sample List

Column Header Description

Rack (Teledyne CETAC)
-or- 
Rack Number (ESI)

Rack number specifies autosampler rack of the solution in the 
autosampler.

Vial (Teledyne CETAC, Accela)
-or-
Vial Number (ESI)

Vial number specifies autosampler vial of the solution in the 
autosampler.

Block/Tray (Accela) Block and tray numbers specify Accela autosampler block and tray of 
the solution in the Accela autosampler.
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• Under LabBook > Reports, the new columns are available.

Configuration using a Generic Instrument

Additional columns become part of your Configuration.

❖ To create a Configuration using a Generic Instrument

1. Open the Configurator tool and select the Experiment Configurator 
applet.

2. In the pane of Available Items > Instruments, right-click and select 
Add Generic Instrument from the shortcut menu.
A box “GenericInstrument” is appended to the list.

3. In the box, type a name, for example, “AdditionalColumns”.

4. Create a new Configuration or select an existing Configuration to 
change its settings.

Figure 14-59. Adding a Generic Instrument
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5. Drag the Generic Instrument “AdditionalColumns” to your 
Configuration.

6. Save the Configuration.

XML File providing Layout Information

The name and optional parameters of the individual columns are 
controlled by an XML file.

❖ To edit the XML file

1. When creating a new Generic Instrument (see step 2 above), a folder 
is automatically created under _Application Data\PluginData. 
The new folder name is created from the name you have typed for 
the Generic Instrument, for example AdditionalColumns. Blanks are 
removed.

2. Create your XML file within this new folder. The name of the XML 
file must match the folder name. In this example, the file is named 

Figure 14-60. Configuration with “AdditionalColumns”

Figure 14-61. New “AdditionalColumns” folder under PluginData
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AdditionalColumns.SampleList.xml. Note the prefix “.SampleList”, 
which is essential.

Figure 14-62 shows the structure of the XML file with some 
highlighted sections.

3. Change the <Caption> text (for each column) to change the column 
header name displayed in the Sample List.

4. Change the <Type> (for each column) to define what type of entry 
is allowed, for example, ‘string’ can be anything but ‘int’ will only 
allow integer values to be accepted.

5. Change the <Default> (for each column) to define the default value 
displayed in the cells of the column. Use XML code for special 
characters, like “&lt;” to display “<“.

6. Optionally, add a list of allowed values (as shown in the definition 
for column #2 in Figure 14-62). If such a list is defined, the user can 
not add a value, but only select one item from a list.

Labeled Components: 1=definition for column #1, 2=definition for column 
#2.

Figure 14-62. Structure of the AdditionalColumns.SampleList.xml

1

2
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Loading the Configuration

❖ To load the Configuration

1. Open Qtegra and click the currently loaded Configuration or the 
instrument image on the Dashboard page.

2. From the dialog, select the new or updated Configuration and click 
OK.

Creating a new LabBook

❖ To create a LabBook with the additional columns

1. On the LabBooks page of Qtegra, create a LabBook.

2. In the Content pane of the LabBook, navigate to Sample List.

3. See the new columns appended to the Sample List.

Querying the new columns

The additional columns are available in all Qtegra export formats 
Automatic Export (see “Automatic Export - Template” on page 5-10), 
Export (see “To export LabBook data” on page 6-3), Query (see 
“Query” on page 6-44), and Reports (see “Reports” on page 6-52). 
Some examples are sown below.

Figure 14-63. Clicking dashboard to select another Configuration

Figure 14-64. LabBook Sample List with new columns
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❖ To query the new columns

1. After a LabBook is completed, several query options allow to read 
the data of the additional columns. For example, select Query from 
the Content pane, and then select the Categories and least the new 
columns from the Columns pane, see Figure 14-65.

2. Click Refresh or press <F5> to see the result of your query.

-or-

3. If the LabBook has not been measured, select Automatic Export 
from the Content pane to see the new columns provided for CSV 
Export or SpreadsheetML Export.

-or-

4. Click Export or press <Ctrl> + <E> to open the Export data dialog. 
The Export function provides the new columns.

Figure 14-65. LabBook Query with new columns

Figure 14-66. LabBook Automatic Export with new columns
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5. In the Export data dialog, select the Exporter (SpreadsheetML Export 
or CSV Export). From the Available data area, expand Sample List > 
AdditionalColumns to select the new columns for the exported file.

Displaying the new columns in a Report

❖ To display the new columns in a Report

1. As shown for the queries, the new columns are also available in 
Reports. For example, under Reports, edit the Sample List Summary 
Report. The new columns are available in the 
Table: Sample Summary as shown in Figure 14-68. Add the new 
columns to the Result columns table.

Figure 14-67. LabBook Export with new columns

Figure 14-68. LabBook Reports with new columns available
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2. Click Execute Report to see the new columns in your Report.

Figure 14-69. LabBook Report example with new columns
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Color Scheme of the Periodic Table
The periodic table of elements, see Figure 14-70, is part of the Analytes 
section of the Method Parameters in Qtegra, independent from the 
Evaluation defined for the Template. Qtegra offers several different, 
colored presentations of the periodic table. Each color scheme represents 
specific characteristics of the elements.

Selected analytes are indicated by red colored squares.

❖ To change the color scheme of the periodic table

1. From the Qtegra - [Home Page] navigation pane, open a Template 
as described in “Opening a Template” on page 4-37.

2. Expand the Method Parameters and select the Analytes view.

3. Right-click next to the periodic table (but not on the table itself ) to 
open the shortcut menu, see Table 14-10.

Figure 14-70. Periodic table with shortcut menu

Table 14-10. Color scheme of periodic table

Scheme Description

Uncolored All elements in the periodic table are 
displayed as gray boxes.

Series The elements are color-coded in groups 
according to their chemical properties or 
series.
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4. Select a scheme from the shortcut menu.
The color in the periodic table changes accordingly.

Block The elements are color-coded in blocks, 
where the respective highest-energy electrons 
in each element in a block belong to the 
same atomic orbital type. Use this scheme to 
distinguish between s, p, d, and f-electrons.

Individual All elements are marked individually, for 
example, each showing a different color.

Table 14-10. Color scheme of periodic table, continued

Scheme Description
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The Qtegra Backup Tool
A separate tool for managing automatic backups of LabBooks was 
introduced with Qtegra ISDS Software version 2.8 SR3. The Qtegra 
Backup tool runs as a service in the background and is set up in the 
Configurator tool.

During the installation of Qtegra ISDS Software, you can activate the 
automatic startup of this Qtegra Backup tool, see the wizard page in 
Figure 14-71.

The Qtegra Backup tool runs in the background and is shown as a 
service in the notification area of Windows.

❖ To set the Qtegra Backup parameters

1. If the Qtegra Backup tool is not automatically started, select the 
entry from the Start menu.

Figure 14-71. Qtegra installation wizard page
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The empty window is shown. Monitoring is not started and yet not 
necessary to be started.

2. Open the Configurator tool and select the Settings applet.

Figure 14-72. Qtegra Backup window

Figure 14-73. Configurator Settings for Automatic LabBook backup
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3. If desired, change the Value entry as described in Table 14-11.

4. After setting parameters have been changed, the Qtegra Backup tool 
must be stopped and restarted to make the parameters available.

❖ To start monitoring

1. Open the Qtegra Backup tool from the notification area of 
Windows.

2. On the toolbar, select Start Monitoring.
The Qtegra Backup tool checks the Workspace > LabBooks folder 
and all subfolders for changes and is waiting for LabBooks to 
backup.

3. In Qtegra, create or select a LabBook and drag it into the Scheduler. 
Run the Scheduler.

4. After the LabBook is finished, open the Qtegra Backup tool to 
check the Activity Log.
Log entries in bold letters give a hint for errors. Log entries like 
“Successfully copy file from 
_Application Data\Workspace\LabBooks\MyLabBook.imexp to 
<Backup folder>\<Date>_<Time>_MyLabBook.imexp” show a 
successful backup process.

❖ To stop monitoring

1. Open the Qtegra Backup tool from the notification area of 
Windows.

Table 14-11. Automatic LabBook backup settings

Setting parameter Description

Automatic backup after 
analysis

Select True to activate the Qtegra 
Backup tool, that means, the LabBook is 
copied after acquisition to the specified 
backup folder. Select False to disable this 
function.

Backup folder Initially, the Qtegra path to the 
LabBooks is shown as 
C:\ProgramData\Thermo\Qtegra\_Applica

tion Data\Workspace. Enter the new path 
to the folder, where the backup files are 
stored. Any folder or linked folder can be 
set that is used by the Qtegra File 
Manager.

Backup suffix The backup files always are named with 
the current date and time stamp as a 
prefix. Type the suffix that is appended 
to the backup name if required.
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2. On the toolbar, select Stop Monitoring.
The Windows service of the Qtegra Backup tool is stopped. The 
Qtegra Backup tool may be restarted for monitoring. With a 
Windows restart, monitoring is automatically started once the 
Qtegra Backup Autostart (see Figure 14-71) was ticked.

❖ To close the Qtegra Backup application

1. Open the Qtegra Backup tool from the notification area of 
Windows.

If the Close button is disabled, first stop monitoring.

2. On the toolbar, select Close Application.
The Qtegra Backup tool stops running and is removed from the 
notification area.

3. After a Windows restart, the Qtegra Backup application is 
automatically started again.

❖ To permanently stop the Qtegra Backup tool

1. Open the Configurator tool and select the Settings applet.

2. Expand the LabBook Backup tree view item and select Automatic 
backup after analysis, see Figure 14-73.

3. Change the Value to False to disable the backup function.

Alternatively, you can stop the Qtegra Backup tool via the Task 
Manager.

1. Press <Ctrl> + <Shift> + <Esc> to open the Task Manager.

2. Select the Startup tab.

3. From the list of automatically started programs, select Qtegra 
Backup and right-click to select Disable from the shortcut menu.

4. After a Windows restart, Qtegra Backup remains disabled.

Figure 14-74. Qtegra Backup tool in the Task Manager
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